1099 Pro Help Manual

Professional, Enterprise, and Corporate Suite Editions

by 1099 Pro

1099 Pro offers the easiest and most advanced software products for all your electronic filing needs. It produces all forms in the 1099 / 1098 / 392X / 5498 / W-2G series. It also prints to plain paper, preprinted forms and continuous forms.

This help manual instructs users on the utilities and features of 1099 Pro Professional, Enterprise and Corporate Suite editions.
Disclaimer

All rights reserved. No parts of this work may be reproduced in any form or by any means - graphic, electronic, or mechanical, including photocopying, recording, taping, or information storage and retrieval systems - without the written permission of the publisher.

Products that are referred to in this document may be either trademarks and/or registered trademarks of the respective owners. The publisher and the author make no claim to these trademarks.

While every precaution has been taken in the preparation of this document, the publisher and the author assume no responsibility for errors or omissions, or for damages resulting from the use of information contained in this document or from the use of programs and source code that may accompany it. In no event shall the publisher and the author be liable for any loss of profit or any other commercial damage caused or alleged to have been caused directly or indirectly by this document.
# Table of Contents

## Foreword

**Part I Getting Started**

1. Disclaimer ........................................................................................................................................ 16
2. About 1099 Pro, Inc. .......................................................................................................................... 16
3. Quick Tour .......................................................................................................................................... 18
4. Registration & Upgrades ..................................................................................................................... 20
5. Software Updates ............................................................................................................................... 21
6. System Requirements .......................................................................................................................... 22

## Part II Important Dates

1. Filing Deadlines .................................................................................................................................... 23

## Part III The User Interface

1. 1099 Pro Central ................................................................................................................................... 25
2. Keyboard Shortcuts ............................................................................................................................... 25
3. Task Panel ........................................................................................................................................... 26
   - Preparing My Forms .......................................................................................................................... 26
   - Printing & Mailing .............................................................................................................................. 27
   - Filing My Forms ................................................................................................................................. 27
   - Help & Extras .................................................................................................................................... 28
   - Print Preview Toolbar ......................................................................................................................... 28
4. Task Panel - Corporate Suite Version ................................................................................................. 29
   - Create/Print Forms Toolbar .............................................................................................................. 30
   - Filing Forms Toolbar ......................................................................................................................... 30
   - Service Bureau Toolbar .................................................................................................................... 30

## Part IV ASP.net for Corporate Suite

1. Multi-Year Lookup ............................................................................................................................... 31
2. Custom Queries ..................................................................................................................................... 32
3. Security ................................................................................................................................................ 33
4. Recipient Printable Forms (Recipient Module) ..................................................................................... 34
5. Custom Column Views .......................................................................................................................... 34

## Part V Browse Filers

1. Add a Filer ............................................................................................................................................ 36
2. Change a Filer ....................................................................................................................................... 37
3. Sponsored Entity / Intermediary .......................................................................................................... 37
4. Contact Persons ................................................................................................................................... 37
5. Delete a Filer ......................................................................................................................................... 38
<table>
<thead>
<tr>
<th>Part</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>VI</td>
<td>Browse Recipients</td>
<td>43</td>
</tr>
<tr>
<td>1</td>
<td>Recipient Record Details</td>
<td>44</td>
</tr>
<tr>
<td>2</td>
<td>Recipient Lookup Screen</td>
<td>45</td>
</tr>
<tr>
<td></td>
<td>Recipient Lookup Account Selection</td>
<td>46</td>
</tr>
<tr>
<td>3</td>
<td>Add Recipients</td>
<td>47</td>
</tr>
<tr>
<td>4</td>
<td>Select Recipients</td>
<td>48</td>
</tr>
<tr>
<td></td>
<td>Tag Recipients</td>
<td>48</td>
</tr>
<tr>
<td>5</td>
<td>Change a Recipient</td>
<td>49</td>
</tr>
<tr>
<td>6</td>
<td>Delete Recipients</td>
<td>49</td>
</tr>
<tr>
<td>7</td>
<td>Forms Issued Report</td>
<td>49</td>
</tr>
<tr>
<td>8</td>
<td>Recipient Listing Report</td>
<td>50</td>
</tr>
<tr>
<td>9</td>
<td>Group Actions</td>
<td>50</td>
</tr>
<tr>
<td>10</td>
<td>Multiple Recipients - One TIN</td>
<td>51</td>
</tr>
<tr>
<td>VII</td>
<td>Helpful Hints</td>
<td>51</td>
</tr>
<tr>
<td>1</td>
<td>Adobe Acrobat</td>
<td>51</td>
</tr>
<tr>
<td>2</td>
<td>Alternative Import Layout</td>
<td>51</td>
</tr>
<tr>
<td>3</td>
<td>Canadian Postal Code Rules</td>
<td>51</td>
</tr>
<tr>
<td>4</td>
<td>Compliance Seminars</td>
<td>52</td>
</tr>
<tr>
<td>5</td>
<td>Form Status Overview</td>
<td>52</td>
</tr>
<tr>
<td>6</td>
<td>Form Status Values</td>
<td>53</td>
</tr>
<tr>
<td>7</td>
<td>Map by Name Import</td>
<td>54</td>
</tr>
<tr>
<td>8</td>
<td>Master Audit Trail Browser</td>
<td>54</td>
</tr>
<tr>
<td>9</td>
<td>Master Tax Form</td>
<td>55</td>
</tr>
<tr>
<td>10</td>
<td>Menu Bar</td>
<td>55</td>
</tr>
<tr>
<td>11</td>
<td>Online Help Tutorials</td>
<td>55</td>
</tr>
<tr>
<td>12</td>
<td>Online Knowledge Base</td>
<td>55</td>
</tr>
<tr>
<td>13</td>
<td>Registration Code</td>
<td>55</td>
</tr>
<tr>
<td>14</td>
<td>Welcome Wizard</td>
<td>56</td>
</tr>
<tr>
<td>15</td>
<td>eFile Archiving</td>
<td>56</td>
</tr>
<tr>
<td>VIII</td>
<td>Transmission Overview</td>
<td>57</td>
</tr>
<tr>
<td>1</td>
<td>Form Transmission Wizard</td>
<td>58</td>
</tr>
<tr>
<td></td>
<td>Assign Paper Filed Status</td>
<td>58</td>
</tr>
<tr>
<td></td>
<td>Transmission Not Filed</td>
<td>59</td>
</tr>
</tbody>
</table>
Part XI  Security and Administration ....................................................... 81

1 Security Overview ........................................................................... 84
   System Security Settings/Password Requirements: Step 1 .................. 84
   Security - Access Groups: Step 2 .................................................... 85
   Security - Manage Profiles: Step 3 ............................................... 86
   Security - Add/Update Individual Users: Step 4 .............................. 87
   Security - Add Users to a Profile: Step 5 ...................................... 88
   Turn On/Off Security .................................................................. 88
   Passwords ..................................................................................... 89
   Security Reports ........................................................................... 90
   Security Access Log ..................................................................... 90

2 Data Maintenance .......................................................................... 91
   Backup Data ................................................................................. 91

Part X  Account Generation Wizard .................................................. 80

1 How To Generate Account Numbers ............................................. 81

Part IX  Corrections ........................................................................... 70

1 Auto Corrections (CS Version only) .................................................. 71
2 Correction of a Correction (CS Version only) ................................. 71
3 One-to-Many Corrections (CS Version only) .................................... 73
4 Corrected Options ......................................................................... 74
5 Create Corrections ........................................................................ 75
6 Delete Corrected forms .................................................................. 76
7 Protected Forms ............................................................................ 77
8 Reprint Corrections ....................................................................... 78
9 Reprint Originals ........................................................................... 79
10 Types of Corrections ..................................................................... 79

Copyright 1099 Pro® 2017
# Contents

3 Rules and Options .................................................................................................................. 92

## 1099 Module Preferences
- Global ................................................................................................................................. 93
- Local ..................................................................................................................................... 93
- Updates Checking .................................................................................................................. 94
- Limits ..................................................................................................................................... 94
- Update Options ..................................................................................................................... 94
- RCP Options ........................................................................................................................ 95
- 1099 Corporate Suite and Professional/Enterprise comparison ........................................... 98

## Tax Form Print Codes & Custom Messages
- Using Print Codes (CS version only) .................................................................................... 107
- Preferences .......................................................................................................................... 108
- ASP.net preferences ............................................................................................................ 110
- Custom Tax Form Validation Rules ..................................................................................... 110
- Manage PS/ACL Access Control (CS version only) ............................................................ 112

4 Reporting Thresholds.............................................................................................................. 112

## State Reporting Thresholds .................................................................................................. 112

## State Reporting - Manage State CFS Limits and Settings (CS Only) ................................. 115

5 SUTA Information (CS Version only)..................................................................................... 116

## Browse Region Code/SUTA State Table ............................................................................. 116

## Edit Region Code/SUTA State - CS ....................................................................................... 117

6 Create and Manage Custom Codes (CS Version only).......................................................... 117

## Update or Change Custom Code .......................................................................................... 117

7 Hosted Solutions (CS version only)....................................................................................... 118

8 Installing ............................................................................................................................... 119

9 Logging in as a Different User ............................................................................................... 120

10 Optional Field Filters ......................................................................................................... 121

11 1099-MISC Optional Fields ................................................................................................. 121

12 Set Aggregation Rules (CS Version only)........................................................................... 123

13 Un-Installing ....................................................................................................................... 124

## Part XII Audit Trails .............................................................................................................. 125

1 Audit Trails Activity Report ................................................................................................... 126

2 Deleted Record Detail ........................................................................................................... 127

3 Master Audit Trail Browser .................................................................................................. 127

4 Purge ..................................................................................................................................... 127

5 Record History ...................................................................................................................... 127

6 Turn Audit Trails On/Off ...................................................................................................... 128

7 Audit Trail Report Filters ..................................................................................................... 128

## Part XIII Browse Records .................................................................................................... 130

1 Browse IRS Instructions ......................................................................................................... 132

2 Entry Forms .......................................................................................................................... 134

- 1099 Aggregation Feature (CS Version only) ............................................................... 136

- Viewing Transactions (CS Version only) ............................................................................. 136
Part XIV  Current Sort/View ................................................................. 153
  1 Current Sort/View ................................................................. 153
  2 Custom Sort Order .......................................................... 154
  3 Dynamic Queries (CS Version Only) .............................. 154

Part XV  Error & Validation Checking .............................................. 156
  1 Warnings and Errors Scan Screen .................................... 157
  2 Filing Problems ................................................................. 158
  3 Penalties ........................................................................... 158

Part XVI  Exports ....................................................................... 159
  1 Export ASCII Wizard ......................................................... 159
  2 Export Map Wizard .......................................................... 160
  3 Moore Wallace (CS Version only) ...................................... 162
     Important Note for MW Export (CS Version only) ............. 163
     Tagging for Test Printing (ASP Version only) ................. 164
  4 Bulk TIN Matching ............................................................. 164
Part XVII  Electronic Filing  170

1  eFile Overview ................................................................. 170
    Electronic Filing Session Window ........................................ 171
    The Advantage of Filing Electronically ................................. 173
    1099 Electronic Filing Wizard .............................................. 173
    Affordable Care Act (ACA) .................................................. 175
    CA-592 Quarterly eFile Wizard (CS Edition) ......................... 176
    Electronic Filing Module .................................................... 178
    eFile States Subset File Wizard .......................................... 179
    How do I Generate State Subset ........................................... 179
    State ID Number ............................................................... 180
    What can I expect from the States Subset File Wizard .......... 181
    State File Generation Wizard ............................................. 181
    Special Cases for State Filing ............................................. 184
    FIRE System ................................................................ 187
    FIRE Upload Process ........................................................ 188
    Electronic File IN Edits ...................................................... 192
    Combined Federal/State Filing Program ............................... 193
    Federal Thresholds (CS Version only) .................................. 194
    IRS Name Control ............................................................. 194
    Reset E-File Session .......................................................... 195
    Rule-of-250 .................................................................... 196

Part XVIII  eFile Viewer Overview  197

1  Installation and Registration .............................................. 198
    License Agreement ............................................................ 198
    eFile Viewer Main Screen ................................................ 201
    Viewing Options .............................................................. 202
2  File Format .................................................................... 203
3  Loading and Viewing Files ............................................... 204
4  Exporting a File .............................................................. 204
    Limitations of Export ....................................................... 204

Part XIX  Form Status Overview  206

1  Printed ........................................................................... 206
    Electronic Sessions Summary Report .................................. 206
    Print Sessions ................................................................ 207
    Printed Status ................................................................ 207
2  Print Status Overview ..................................................... 208
3  Forms Status Values ........................................................ 209

Part XX  Imports Overview  210

1  Import Data ................................................................. 211
    Import Wizard ................................................................ 211

Copyright 1099 Pro® 2017
Part XXI  Printing Overview

1 Advanced Print Options
   Inserting a Custom Print Message .......................................................... 251
   Forcing an X ......................................................................................... 252

2 Form Limits Overview ........................................................................ 253

3 PDF File Generation Overview ............................................................ 253
   Initial PDF Options ............................................................................. 254

4 Printing Blank Forms Overview ........................................................ 254
   Print IRS Form & Instructions ............................................................. 255

5 Pressure Seal Forms............................................................................ 255
   Pressure Seal and Alternate Printing Formats ............................... 255
   Pressure Seal and Alternate Printing Tutorial ............................... 258
# Contents

## Part XXIV  Scheduler Overview (CS Version)

1. Administrative Configuration ................................................. 292
   - Set Email Server And Account ......................................... 293
   - Manage Email Recipient Lists .......................................... 294
   - Add or Update Scheduler Email Recipients ......................... 295
   - Manage Automated Email Messages/Text ............................ 295
   - Add or Update Email Templates ........................................ 296
2. Using the Scheduler (Browse Jobs) ...................................... 296
   - Adding or Changing a Job .............................................. 297

## Part XXIII  Reports

1. Form Control Totals .......................................................... 283
   - Troubleshooting Control Totals ........................................ 284
2. State Quarterly eFile Wizard (CS Edition) ............................ 284
3. CA-592 Quarterly eFile Wizard (CS Edition) ....................... 286
5. Form Counts ................................................................. 289
6. Forms Issued By Filer ...................................................... 290
7. Import Map Reports ....................................................... 290
8. Corrections/Late Add Report ............................................. 290

## Part XXII  Queries

1. Custom Query using Manual Override ................................. 281
2. Custom Query Wizard .................................................... 282
3. Select a User ............................................................... 282

## Copyright

Copyright 1099 Pro® 2017
Part XXV Service Bureau Overview

1 Service Bureau Packages ................................................................. 313
2 Service Bureau Overview & Upload Process ................................. 314
   Service Bureau Upload Wizard .................................................... 315
   Step 1 - Creating an Upload File for Print/Mail or E-File ............. 315
   Step 2 - Submit Service Bureau Upload ...................................... 319
   Reset/Void Service Bureau Upload ............................................. 320
3 Using Bulk TIN Matching............................................................... 321
   Bulk TIN Matching .................................................................... 321
   Step 1 - Creating an Upload File for Bulk TIN Matching .......... 322
   Step 2 - Submit Service Bureau Upload ...................................... 323
   Bulk TIN Matching Results ....................................................... 325

Part XXVI Tax Supplies ................................................................. 326
1 Blank Copier Paper ...................................................................... 326
2 Preprinted Paper ......................................................................... 327
3 Pressure Seal Forms .................................................................... 327

Part XXVII Transmitter/Submitter Information .............................. 328
1 Create Transmitter/Submitter ....................................................... 329

Part XXVIII Year-to-Date Imports and Zero Drops ....................... 330
1 Year-to-Date Import Zero Drop Overview .................................. 330
2 Year-to-Date Import and Zero Drop Process ............................... 331
3 Drop by Date Range .................................................................... 331
4 Void a Zero Drop Session ......................................................... 332
5 Drop by Import Session ............................................................ 332
   Select Import Session .............................................................. 332
6 Zero Drop Process Confirmation ............................................... 333

Part XXIX Information Requests / W-9s ...................................... 333
1 Information Request Overview .................................................. 333
2 Manage Information Requests .................................................... 334
3 Information Request Summary Report ...................................... 336
4 Browse Information Requests .................................................... 337
5 Information Request Wizard ...................................................... 338

Copyright 1099 Pro® 2017
Part XXX Error Messages

1  Invalid Record Declaration (47)................................................................. 344
2  Unable to Open Required File (ProTips): 2 – File Not Found................... 345
3  Unable to Open Required File (ProTips): 3 - Path Not Found................... 345
4  Unable to Open SystemID: 2 - File Not Found........................................ 346
5  Unable to Open SystemID: 3 - Path Not Found........................................ 346
6  Unable to Open SystemID: 5 - Access Denied......................................... 347
7  Unable to Open SystemID File: 53 - Invalid Clarion File......................... 347
8  EC002 – Unable to Open Files!................................................................. 348
9  File Not Found - Information Request.................................................... 348
10 Could Not Load DLL Library \USER32.DLL.............................................. 349
11 Clarion Trappable Runtime Errors............................................................ 349
12 Single User Version Error........................................................................... 354

Part XXXI Additional Services

1  TINCheck................................................................................................. 354
   Manage my TINCheck account .................................................................. 356
   Manage my results .................................................................................... 358
   History Requests .................................................................................... 359
   TINCheck Integration ............................................................................ 360
   Status Icons ............................................................................................ 367
2  Managed Services...................................................................................... 369
3  Form CA-592 New.................................................................................... 369

Part XXXII Glossary

1  Alignment............................................................................................... 379
2  Business Rules......................................................................................... 379
3  ASCII........................................................................................................ 379
4  Cascading updates.................................................................................... 380
5  Corrected options..................................................................................... 380
6  End of Payer "C" Record.......................................................................... 380
7  End of Transmission "F" Record............................................................... 380
8  Filer........................................................................................................... 380
9  Hotspot..................................................................................................... 380
10 Import Map............................................................................................. 381
11 Location code.......................................................................................... 381
12 Payee "B" Record..................................................................................... 381
<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>Payer &quot;A&quot; Record</td>
<td></td>
<td>381</td>
</tr>
<tr>
<td>14</td>
<td>Pending Status</td>
<td></td>
<td>381</td>
</tr>
<tr>
<td>15</td>
<td>Recipient Employee</td>
<td></td>
<td>381</td>
</tr>
<tr>
<td>16</td>
<td>Roll Forward Utility</td>
<td></td>
<td>381</td>
</tr>
<tr>
<td>17</td>
<td>Rule-of-250</td>
<td></td>
<td>383</td>
</tr>
<tr>
<td>18</td>
<td>SSAE 16 SOC I Type II</td>
<td></td>
<td>383</td>
</tr>
<tr>
<td>19</td>
<td>SSN</td>
<td></td>
<td>384</td>
</tr>
<tr>
<td>20</td>
<td>State Totals &quot;K&quot; Records</td>
<td></td>
<td>384</td>
</tr>
<tr>
<td>21</td>
<td>Tag</td>
<td></td>
<td>384</td>
</tr>
<tr>
<td>22</td>
<td>Task Panel</td>
<td></td>
<td>384</td>
</tr>
<tr>
<td>23</td>
<td>TCC</td>
<td></td>
<td>384</td>
</tr>
<tr>
<td>24</td>
<td>TIN</td>
<td></td>
<td>385</td>
</tr>
<tr>
<td>25</td>
<td>TIN (SSN) Masking</td>
<td></td>
<td>385</td>
</tr>
<tr>
<td>26</td>
<td>Transmitter &quot;T&quot; Record</td>
<td></td>
<td>386</td>
</tr>
</tbody>
</table>

**Index**  387
1 Getting Started

Welcome to 1099 Pro for Tax Year 2017

1099 Pro Basic Software Functionality
Add a Filer
Add a Record
Add a Recipient
Import Data || Sample Import Files ||
Roll Forward Data
Software Updates
Support

------------
Important Dates - See 1099-MISC, Box 7/NEC, Deadline
Penalties

------------

Corporate Suite Advanced Functionality
Features available to Corporate Suite edition only:
1099 Pro State Quarterly eFile Wizard
1099 Pro Aggregation Feature
945 Federal and State Balancing Report
Creating a Correction of a Correction
Customize Fixed Field
Hosted Solutions
Reporting Thresholds
Set Aggregation Rule
Transactional Imports
Year-to-Date Import Zero Drop Overview
Schedule Imports and Reporting

New 2016 Corporate Suite Features:
• ACA Forms 1095-B/C - Import corrections, import forms via the automated Scheduler, reset multiple print logs at once
• Forms W-9, W-9S, W-8 series and 1st B-Notices - "Date Printed" displays at bottom of forms
• Form 592-B - Print composite statements and generate quarterly electronic files

ASP.net Features
Advantages of using the ASP.net edition of our software:
1.1 Disclaimer

Disclaimer

The 1099 Pro, Inc. methodology of flagging errors and warnings is merely a tool to help detect some of the possible inconsistencies or omissions in your data. 1099 Pro, Inc. does not assert that our system of detecting Errors and Warnings matches that of the IRS/SSA or that our system will detect any or all errors in your data. You may in fact have records that flag no Errors or Warnings and the IRS/SSA may both reject your files and or records and assess significant penalties on the data or lack of data that you submitted or did not submit. 1099 Pro, Inc. assumes no responsibility or liability for the detection of errors, omissions, inconsistencies, warnings, formatting, accuracy or complete filing or processing of your data. This software application identifies many, but not all, of the most common format errors in information compliance submissions. The likelihood of submission rejection, though not eliminated, is greatly reduced when utilizing this application. Even if no errors are identified by this software, your submission could be returned or you could be penalized because of other errors.

1.2 About 1099 Pro, Inc.

About 1099 Pro, Inc.

1099 Pro, Inc.

Founded in 1989, 1099 Pro, Inc. is a market-leading provider of information-reporting solutions and services for 1099, W-2 and 1042-S filers. 1099 Pro develops and markets a comprehensive range of products that enable any size business or institution to effectively manage and be compliant with IRS requirements. 1099 Pro products range from Client Server / ASP applications (capable of filing over 100 million records) utilizing an MS SQL back end with a multi-year presentation of forms via Internet Explorer, to desktop software products for filing from 20 – 100,000 forms, to www.eFileMyForms.com for internet filing of < 20 forms. Adjunct products include secure Hosting and Services for information processing, printing, filing and penalty abatement. With the ever-changing IRS laws and regulations, 1099 Pro develops new services, solutions, and software enhancements, remaining ahead of the curve of the industry. 1099 Pro is a Microsoft Certified Partner; MBE certified and has received SSAE 16 SOC I Type II certification.

Software offered by 1099 Pro, Inc.

1099 Pro Professional

Professional edition offers a streamlined and cost effective answer to your tax season. Prepares printing and paper filing for all forms in the 1098, 1099, 3921, 3922, 5498 and W-2G series. For an additional fee, upload data to our Service Bureau for printing, mailing, and electronic filing to the IRS/SSA.
1099 Pro Enterprise
Enterprise software is a powerful information reporting solution designed with simplicity in mind. Enterprise supports the processing, printing, and paper or electronic filing of forms from series 1098, 1099, 3921, 3922, 5498, and W-2G. Through the software users may generate a formatted transmittal file for the IRS FIRE site, or for an additional fee, upload data to our Service Bureau for printing, mailing, and electronic filing to the IRS/SSA.

W-2 Pro
Prepares forms W-2, W-2C, W-3 and W-3C transmittals. Supports printing to blank or preprinted forms. Through the software users can generate a formatted transmittal file for the SSA site, or for an additional fee, upload data to our Service Bureau for printing, mailing, and electronic filing.

1042-S Pro
Prepares form 1042-S on plain paper and allows users to print recipient copies B, C, and D on one page with instructions on a separate page. Through the software users can generate a formatted transmittal file for the IRS Fire site, or for an additional fee, upload data to our Service Bureau for printing, mailing, and electronic filing.

1099 Pro Corporate Suite
The 1099 Pro, Inc. Corporate Suite software combines the power of our Professional and Enterprise software with the speed, performance, and security of Microsoft’s SQL Server technology, making it the ultimate solution for businesses. Corporate Suite supports the processing, printing, and paper or electronic filing of forms from series 1095 (ACA Compliance), 1097, 1098, 1099, 3921, 3922, 5498, 592-B*, W-2, W-2G, 1042-S and Puerto Rico. Through the software users can generate a formatted transmittal file for the IRS Fire site, or for an additional fee, upload data to our Service Bureau for printing, mailing, and electronic filing to the IRS.

8966 Pro
1099 Pro provides secure and intuitive FATCA Form 8966 software capable of tax form management and IRS XML reporting. The IRS is quickly finalizing the FATCA reporting requirements and will require Foreign Financial Institutions (FFIs) from Model 2 countries to report FATCA Form 8966, the FATCA report, directly to the IRS. FFIs from Model 1 countries, that must report to their host country who in turn transmits to the IRS, still must manage their FATCA Reports in one centralized location for ease of reporting.

CRS PRO
Coming June 2017.

The 1099 Pro Service Bureau
The 1099 Pro, Inc. Service Bureau was established for the purpose of helping companies successfully ease through the tax season. The Service Bureau features a highly secure SSAE 16 SOC I Type II and PCI Compliant environment, configured to process an unlimited amount of records and form types. The Service Bureau can print and mail records to your recipients, display records online securely via the Web Presentment service, and electronically file your records with the IRS. Continue reading to learn more about the services that 1099 Pro offers. Using the simple upload wizard and secure FTP agent available in your 1099 Pro software, users can easily transmit records for printing, mailing, or filing. To make sure users are taking full advantage of our information reporting solutions, we offer free technical support via phone or live chat.

Services offered by 1099 Pro and the Service Bureau Include:
**Filing**
We can handle any volume of records for electronic filing. An upload feature, which safely sends your file directly to our Service Bureau, is built-in to every version of the 1099 Pro, Inc. software.

**Print & Mail Services**
Printing, mailing, and electronic delivery services are available! Our SSAE 16 SOC I Type II Service Bureau offers a secure, efficient, and friendly solution.

**Bulk TIN Matching**
The Service Bureau can transmit your file to the IRS Bulk TIN Matching Program. A transmission of up to 100,000 records is simple via the 1099 Pro software’s upload wizard and secure FTP agent.

**Hosting**
Our hosted service provides unparalleled speed, security, and bandwidth in which to run 1099 Pro software. Our Qwest CyberCenter facilities are connected with OC-768 bandwidth to our state-of-the-art fiber optic IP network.

**Electronic Delivery**
Give your recipients the option to access their forms from a secure internet site instead of receiving a mailed form. The electronic delivery option significantly reduces costs.

**Printing & Mailing with Web Presentment**
The Service Bureau can make your forms available for online viewing and reprinting via our secure internet site.

**Web Presentment Only**
Print and mail your forms in-house and have them available to view via our secure internet site.

**Pressure Seal Printing**
Our Pressure Seal paper stock, for customers uploading forms for printing and mailing, adds additional security for recipients. This eliminates the possibility for information to be viewed through an envelope window.

**Full Service**
Throughout the year, our regulatory team will work with your team to process your payee and payment information, imports, and balances, as well as reconcile posted information to your business areas. Additionally, we will produce all federal/state returns, act as a transmitter on your company’s behalf, and generate payee statement files, B Notices, and management reports for you.

* The Service Bureau does not print, mail or electronically file Form 592-B.

**1.3 Quick Tour**

**Quick Tour**

**Overview of Information Reporting**

**What is a 1099 Form?**
According to the IRS and Federal tax law, you must report to the IRS payments totaling $600 or more made to independent contractors over the course of the calendar year. When a person is paid on the
form, 1099-MISC for example, all money earned by the individual is paid on an untaxed basis. It is then the responsibility of the individual to file and pay the appropriate taxes. These taxes can be owed to Federal, State and Local governments. Workers compensation and unemployment issues also must be addressed independently.

Who Are We?
1099 Pro, Inc. provides award-winning 1099 software for filing tax forms 1099, 1098, W-2, 1042-S and many others. For your convenience, 1099 Pro carries a complete line of tax supplies including: 1099 forms, W-2 forms, 1042-S forms and envelopes. We also offer Print/Mail/E-Filing services through our Service Bureau. To save you time and money, 1099 Pro continues to offer complimentary technical support with the purchase of any of our software products.

The 1099 Pro Service Bureau
The Service Bureau is a Print/Mail/E-Filing service offered to users of 1099 Pro software. All of our software products allow the creation of a data UPLOAD file which can be easily transmitted to our Service Bureau. We can then print and mail the appropriate forms on your behalf and/or electronically submit your file to the IRS. We can process any number of filers, recipients, and form types.

Why should I Use the Service Bureau?
The 1099 Pro Service Bureau has provided Print/Mail/E-Filing services to thousands of our users. Our customers utilize the Service Bureau to save money, minimize administrative headaches, safeguard their sensitive data, and benefit from our extensive experience. We've made the process simple:

1. Purchase the appropriate 1099 Pro software package.
2. Call or E-Mail our Service Bureau to set an appointment date. We must have your data by the agreed upon appointment date to ensure that it is mailed or filed by the IRS deadline.
3. Manually enter or import your data into the 1099 Pro software.
4. Create an upload file within 1099 Pro software.
5. E-Mail or FTP your upload file to us on or before your appointment date.

Why Is It Important to Comply?
If you don’t file information returns, you face various penalties. For example, failing to file correct information returns by the due date results in penalties that range from $50 to $260 per Form W-2 or Form 1099, depending on how late you file the return, and the size of your business. The maximum annual penalty ranges from $532,000 to $3,193,000 ($186,000 to $1,064,000 for small businesses).

There are three exceptions to these filing penalties:
- If you can demonstrate that your omission was due to an event that was beyond your control or due to some significant mitigating factor and was not willful neglect, you may avoid the penalty. You must also show that you acted in a responsible manner and took steps to avoid the failure to file.
- An inconsequential error or omission is not considered a failure to include correct information because it doesn't prevent or hinder the SSA/IRS from processing the Form W-2, or from correlating the information required to be shown on the form with the information shown on the payee's tax return.
- The IRS also has a de minimis rule for corrections when certain requirements are met. Basically, if the value provided to an employee is less than it would cost to fix the return, it may sink beneath notice. See the IRS Topic: De Minimis (Minimal) Benefits.

Filing Accurate Information Returns
The IRS issues very detailed and exacting instructions for filling out information returns. For instance, the
IRS has very definite preferences for which forms can be used, what font you should use (no script characters), where you should place the data in the blocks, and where you can use zeros.

So follow the instructions carefully. If the IRS can't interpret your forms, you may be subject to a penalty of $50 for each return in an improper format.

1.4 Registration & Upgrades

Software Activation
To activate a "DEMO" version of software, users must enter their 14 character authorization code. Activating a demo provides the user access to all software features and retains their existing data. Purchase the software online or contact Sales to obtain an authorization code. Follow these steps to activate your software:
1. From within the software, at the top of the menu bar click Utilities > Registration And Upgrades.
2. At the Product Registration/Demo Activation screen enter your Authorization Code and click the "Activate Now" button.
3. If your code does not work, please verify the correct version of the purchased software is installed. For example, a 1099 Pro Enterprise Authorization Code is incompatible with a 1099 Pro Professional installation.

How To Obtain an Authorization Code
Internet: go to www.1099pro.com and purchase the software from our web site.
Phone: call toll-free (888) 776-1099 or (888) pro-1099 from 6am-5pm PST or call (818) 876-0200
E-Mail: sales@1099 Pro.com

Upgrading Transaction Limits
Transactions are the number of actual tax forms that may be entered or imported, regardless of print status, into 1099 Pro. A standard installation allows for 5,000 transactions. To enter additional transactions users must upgrade 1099 Pro with a bump code. Bump codes may be purchased online at www.1099pro.com or by contacting Sales at (888) 776-1099.

To Upgrade Transactions (Bump Codes)
1. At the menu bar go to Utilities > Registration And Upgrades.
2. Enter your Upgrade/Bump Code and click "Upgrade Now". Newly entered Bump Codes are immediately reflected in the Current Record Limit.
   - In multi-user environments, the Bump Code must be entered at the Admin or Web Update workstation; this option may not be available at individual workstations (depending on access rights).

How Many Transactions Do I Have?
To track records or transactions, refer to the Product Registration/Demo Activation screen:
1. At the menu bar go to Utilities > Software Registration/Demo Activation.
2. The Product Registration/Demo Activation screen displays both the Current Record Limit and Current Record Total.
1.5 Software Updates

Software Updates

1099 Pro, Inc. regularly publishes software updates to keep up with the evolving rules and regulations of the IRS, SSA, and state agencies. To ensure your compliance, frequently check for software updates. By default, the software checks for updates occasionally during the summer, more frequently as tax season approaches and every day at the height of tax season. Users are strongly encouraged to take advantage of this process; an active internet connection is required.

Users may verify they are running the most up-to-date version of 1099 Pro 2017 software the following ways:

- When starting any version of the software, a pop-up prompts to run a software update, OR
- Perform a Manual Update (as discussed below), OR
- Visit our WIKI download site at host.1099pro.com

For information on advanced update preferences for Corporate Suite, please see Update Options section.

Manual Updates

There are two methods to manually check for software updates.

Method 1
1. From the menu bar select Help > Check for Updates to 1099 Pro.
2. Use the "Check for Updates" button to run an update. Your computer must have an active Internet connection.

Method 2
1. Close the 1099 Pro software.
2. Use the Windows Start button to locate your 1099 Pro software and select "Check for Updates" to initiate the Web Update Wizard.
3. Follow the prompts by clicking "Next". If there is a new version, a message displays the version number and provides a brief summary of items included in the update. Download the update and allow the update to install. This process should begin automatically.
4. After the process is finished, confirm that the new version number of the software corresponds with the version number of the update by opening 1099 Pro and at the menu bar selecting Help > About.

Users experiencing issues downloading updates may have a firewall on their network or local machine preventing them from retrieving updates. Check with your Administrator, IT personnel or temporarily disable the firewall.

☐ All updates are available for download at the 1099 Pro WIKI site host.1099pro.com.

Update Options

Users can modify the frequency and/or type of software updates performed by 1099 Pro. To edit these settings see Preferences.

Considerations:
- If an installation of 1099 Pro has Security enabled, the User must have Administrator level access to
modify the Checking for Updates options.

- For multi-user installations only the Server (not the Workstations) can view and modify the Checking for Updates option.
- Workstations cannot run the actual web update process -- they can only check for new versions. Once your Server has been updated, each workstation automatically updates itself the next time 1099 Pro is run on that machine.

1.6 System Requirements

System Requirements

1099 Pro minimum system requirements include:

- 32 or 64 bit operating system compatible
- Intel Pentium II/Celeron or AMD Athlon/Sempron/Turion (Minimum)
- 256MB RAM (512MB or more preferred)
- 100+MB free hard drive space
- For use with ANY Windows compatible printer
- Windows compatible network (optional)

CORPORATE SUITE ONLY

Requirements for Corporate Suite Workstations:
- 32 or 64 bit operating system compatible
- Intel Pentium II/Celeron or AMD Athlon/Sempron/Turion (Minimum)
- 256MB RAM (512MB or more preferred)
- 100+MB free hard drive space
- For use with ANY Windows compatible printer
- Internet Explorer® 7.0 or higher (ASP.net only)

Requirements for Web Server:
- Minimum of an Intel Xeon, i7 or equivalent
- Processor Speed of 2 GHZ
- Memory of 4GB or higher
- MS .NET Framework 4.0

Requirements for SQL Server:
- MS SQL Server 2008 or higher

1099 Pro also requires display settings of 800x600 and small fonts to properly display windows and type. Some Deskjet, Inkjet or Bubblejet printers may not print to the bottom 1/2-inch of paper.
Important Dates

2 Important Dates

2.1 Filing Deadlines

Filing Deadlines

1099 Pro, Inc. strongly recommends verifying all filing deadlines and addresses and assumes no liability for inaccuracies or changes contained herein.

See Penalties

1099 Informational Returns

Recipient Copy "B" Mailing Deadlines

Deadline to mail recipient Copy B paper returns is generally January 31, 2018 for the 2017 tax year. Exceptions include:

- Forms 5498 containing FMV/RMD must be mailed by January 31, 2018; those containing Traditional IRA, Roth IRA, SEP IRA, or SIMPLE IRA contributions must be mailed by May 31, 2018.
- Form 5498-ESA by April 30, 2018.
- Form 5498-SA by May 31, 2018.
- Forms 1099-B, 1099-S, and 1099-MISC reporting payments in Boxes 8 or 14 must be mailed by February 15, 2018.

Under some circumstances it is acceptable to issue Copy B earlier. Please review the IRS Instructions for specific details.

IRS Paper Filing Deadline via Mail

Deadline to mail IRS Copy A is generally February 28, 2018. Exceptions include:

- **IMPORTANT**: File Form 1099-MISC by January 31, 2018 if reporting non-employee compensation in box 7.
  - Public Law 114-113, Division Q, section 201, requires Form 1099-MISC to be filed on or before January 31, 2018, when you are reporting nonemployee compensation payments in box 7.

Electronic Filing Deadline via the FIRE Site

- File Forms 1099, 1098, 3921/3922 and W-2G electronically by April 02, 2018 for the 2017 tax year.
- File Forms 5498, 5498-ESA, and 5498-SA electronically by May 31, 2018 for the 2017 tax year.
- **IMPORTANT**: File Form 1099-MISC by January 31, 2018 if reporting non-employee compensation in box 7.
  - Public Law 114-113, Division Q, section 201, requires Form 1099-MISC to be filed on or before January 31, 2018, when you are reporting nonemployee compensation payments in box 7.
  - Otherwise, file by February 28, 2018, if you file on paper, or by April 2, 2018, if you file electronically.

**Federal Extension**

See Form 8809, Application for Extension of Time to File Information Returns.

**State Filing Deadlines**

The deadline to file state returns varies by state and localities. Please check with your state(s) to verify dates.

**Where To File**

File Copy A and 1096 Transmittal returns at the IRS Center Address corresponding to the state your business, office or agency is located using the list below.

<table>
<thead>
<tr>
<th>If your business is located in:</th>
<th>File to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alabama, Arizona, Arkansas, Connecticut, Delaware, Florida, Georgia, Kentucky, Louisiana, Maine,</td>
<td>Department of the Treasury</td>
</tr>
<tr>
<td>Massachusetts, Mississippi, New Hampshire, New Jersey, New Mexico, New York, North Carolina, Ohio,</td>
<td>Internal Revenue Service Center</td>
</tr>
<tr>
<td>Pennsylvania, Rhode Island, Texas, Vermont, Virginia, West Virginia</td>
<td>Austin, TX 73301</td>
</tr>
<tr>
<td>Alaska, California, Colorado, District of Columbia, Hawaii, Idaho, Illinois, Indiana, Iowa,</td>
<td>Department of the Treasury</td>
</tr>
<tr>
<td>Kansas, Maryland, Michigan, Minnesota, Missouri, Montana, Nebraska, Nevada, North Dakota,</td>
<td>Internal Revenue Service Center</td>
</tr>
<tr>
<td>Oklahoma, Oregon, South Carolina, South Dakota, Tennessee, Utah, Washington, Wisconsin,</td>
<td>Kansas City, MO 64999</td>
</tr>
<tr>
<td>Wyoming</td>
<td></td>
</tr>
<tr>
<td>If your legal residence or principal place of business or principal office or agency is outside</td>
<td>Department of the Treasury</td>
</tr>
<tr>
<td>the United States</td>
<td>Internal Revenue Service Center</td>
</tr>
<tr>
<td></td>
<td>Austin, TX 73301</td>
</tr>
</tbody>
</table>

For more information on filing Forms 1099 please review the [IRS Instructions](https://www.irs.gov/)

**Affordable Care Act (ACA) Compliance**

Available to Corporate Suite users only.

**Recipient Copy Mailing Deadlines**

- Mail Form 1095-B recipient copy paper returns by N/A for the 2017 tax year.
- Mail Form 1095-C employee copy paper returns by N/A for the 2017 tax year.

**IRS Paper Filing Deadline via Mail**

- Form 1095-B: Deadline to mail IRS Copy A is N/A.
- Form 1095-C: Deadline to mail IRS Copy A is N/A.

**Electronic Filing Deadline via the AIR System**

Deadline to file Affordable Care Act (ACA) Forms 1095-B and 1095-C electronically is N/A.

3 The User Interface

3.1 1099 Pro Central

1099 Pro Central

The 1099 Pro Central Screen provides rapid access to important information!

**Overview:**
General layout of the tax form filing process from start to finish!

**To-Do:**
Keeps track of important dates/form status. Also allows users to create custom notes and To-Do Lists!

**Help/Videos:**
Provides links to technical support resources, contact information for support, and Online Tutorials.

**Compliance:**
Information on tax form compliance such as additional services, tools, consultation, support, and Online Tutorials.

**Services:**
1099 Pro, Inc. offers many additional services such as our Service Bureau.

3.2 Keyboard Shortcuts

**Keyboard Shortcuts**

**<Alt>**:
Use the <Alt> key and the underlined letter (or number) of any menu bar item to access a drop menu. For example, ALT + R to access "Reports".

**<F1>**:
Access context-sensitive help at any screen.

**<F2> or Right-Click Mouse**:
With your cursor in the appropriate box, use the <F2> key or right-click your mouse to access box specific data:
- **Recipient TIN field**: Access the Select a Recipient database.
- **State/Payer's State ID No.**: Access the Select Filer State & ID database (available at 1099-MISC box 17, 1099-R box 11 and W-2G box 13)
- **Calendar**: Access a multi-year calendar (available at 1099-A box 1, 1099-B box 1, 1099-C box 1, 1099-S box 1, W-2G box 4 and 1099-LTC).

**Incremental Search**:
Access any recipient or filer via the Search Name field.

**Drop Menu**: 

Right click your mouse to view a pop-up box with options to add, change or delete records.

*Available at the Recipients List, Filers List (Manage) and Work With My Tax Forms screens only.

3.3 Task Panel

Task Panel

The task panel is the blue bar on the left side of the 1099 Pro screen and provides quick access to common tasks. Click on the links for details on the options contained within each task panel area.

Select Filer
Preparing My Forms
Printing & Mailing
Filing My Forms
Help & Extras

3.3.1 Preparing My Forms

Preparing My Forms

From the Preparing My Forms task panel users can:

Work With My Tax Forms
View records, Add or Change a record, Delete a record, Void a record, Quick-Print Forms, Email Tax Forms and run various reports.

Import New Tax Forms
View import sessions, Void import sessions, Import comma delimited files or tab delimited files.

Form Totals Reports
Customize a Control Totals report with the option to generate a listing of any errors and/or warnings.
3.3.2 Printing & Mailing

Printing & Mailing Task Panel

From the Printing & Mailing task panel section users can:

- **Printing/Mail**: Print via the Print Wizard, Reset Print Sessions.
- **Via the Service Bureau**: Access the Printing, Mailing, Filing and Bulk TIN Matching screen where users can begin a new Service Bureau session for Printing & Mailing or E-Delivery Upload or Bulk TIN Matching Upload as well as Reset Uploads.
- **Export Forms for Print/Mail**: Export Forms to an ASCII text file suitable for opening in Excel, Access, etc.

3.3.3 Filing My Forms

Filing My Forms

From the Filing My Forms task panel users can:

- **File on Paper (via)**: Initiate a Form 1096 print session, Reset the print status of Form 1096, Reprint Form 1096, Run a 1096 Filing Session report.
- **Electronic Filing**: Generate Electronic Files for use via the IRS FIRE system.
- **Via the Service Bureau**: Access the Printing, Mailing, Filing and Bulk TIN Matching screen where users can begin a new Service Bureau session for Printing & Mailing, E-Delivery Upload or Bulk TIN Matching Upload. Upload Sessions...
can be Reset/Voided and various reports are available.

3.3.4 Help & Extras

Help & Extras

From the Help & Extras task panel users can access:

Help and Tutorials:
Go directly to the 1099 Pro Central Help/Videos Screen.

Correcting Filed Forms:
Create Corrections, Reprint Corrected or Original Forms

About the Service Bureau:
Offers more help regarding the 1099 Pro, Inc. Service Bureau

IRS Pubs & Links
View a list of IRS publications included with 1099 Pro, plus links to the IRS and SSA websites

Recipients List:
View all recipients, Add or change recipients, Delete recipients, Run a recipient report

W-9/B-Notice:
Initiate a W-9 or B-notice request for solicitation of Recipient TIN numbers.

3.3.5 Print Preview Toolbar

Print Preview Toolbar

The Preview screen allows users to view a form or a report and check it for accuracy before printing. Use the following icons located at the top of the Preview screen:

1. Use to print THIS page only.
2. Use to VIEW the previous page.
3. Use to view the NEXT page.
4. Use to toggle STAY after printing.
5. Use to Search for characters within a report.
Use the “Print” icon to access the “Print Setup” screen to print the entire report. See Duplex Printing.

Use to exit the preview report WITHOUT printing.

Use to view the preview report in full WIDTH view.

Use to view the preview report in full HEIGHT view.

Use to save in PDF format when printing.

Additional options available for this screen include:
- "Zoom PCT" defaults to 98% (may vary depending on monitor) and adjusts from 25 - 250% viewing.
- If the preview consists of more than one page, scroll forward / backward with the double arrow icons.

3.4 Task Panel - Corporate Suite Version

Task Panel

The task panel is the blue bar on the left side of the Corporate Suite screen and provides quick access to common tasks. Please click on the links below for details on the options contained within each task panel area.

Filers List:
View all filers, Add or change filers, Delete filers, Run a filer report

Recipients List:
View all recipients, Add or change recipients, Delete recipients, Run a recipient report

W-9/B-Notice:
Allows you to initiate a W-9 or B-notice request for solicitation of Recipient TIN numbers.

Preferences:
Modify backup prompt, Set data entry options, Enable range checking, And more...

Import Forms:
Data View import sessions, Void import sessions, Import comma delimited files or tab delimited files.

Export Forms:
Export Forms to an ASCII text file for import into other programs.
3.4.1  Create/Print Forms Toolbar

**Forms & Printing**

Within Corporate Suite use the **Forms & Printing** task panel to:

**Browse, Enter & Edit:**
View records, Add or change a record, Delete a record, Run a Control Totals report

**Print Tax Forms:**
Print via the Print Wizard

**Form Totals Reports:**
Customize a Control Totals report

**PDF Forms & IRS Instructions:**
Print Form W-9 and view IRS Instructions

3.4.2  Filing Forms Toolbar

**Filing & Corrections Task Panel**

From the Filing & Corrections task panel section users can:

**File via 1096 (paper):**
Initiate a Form 1096 print session, Reset the print status of Form 1096, Reprint Form 1096, Run a 1096 Filing Session report.

**File via eFile or disk:**
Generate Electronic Files

**Correcting Filed Forms:**
Create Corrections, Reprint Corrected or Original Forms

3.4.3  Service Bureau Toolbar

**Service Bureau Task Panel**

From the Service Bureau task panel users can:

**Printing & Mailing:**
Takes you to the Printing, Mailing & Filing screen where you can begin a new Service Bureau sessions or view existing completed or voided Service Bureau sessions.

**Filing with the IRS:**
Takes you to the Service Bureau Upload screen to generate an upload file.

**More Information:**
Offers more help regarding the 1099 Pro, Inc. Service Bureau
4 ASP.net for Corporate Suite

The features contained within this section are available exclusively to users of the 1099 Pro.net edition of our software.

- 1099 Pro.net utilizes the advanced capabilities of the SQL database coupled with ASPs enhanced dynamically created web pages to present a compact, powerful package aimed directly at large scale businesses.

- An Internet browser based interface make setting up multiple users quick and simple, if they have Internet Explorer, they have access to the program, access to the internet is not necessary as all users need is access to the server where 1099 Pro.net is installed via intranet or internet.

- Multi Year lookup makes digging through multiple pieces of software or files obsolete. All tax year information entered into the SQL database (Searchable back to year 1997) can be accessed from the same interface, by using a simple drop down menu.

- Information stored in the SQL database can be easily accessed using customizable queries, multiple search criteria can be used, one at a time or in conjunction with one another. This information is further narrowed by different operators.

- High level encryption keeps your information secure, utilizing up to 256-bit levels of encryption. Note: Security levels are configurable by the administrator.

- Output forms as Adobe Acrobat PDFs so that they can easily be e-mailed, printed or transferred to recipients, or stored in their completed format outside the SQL database.

4.1 Multi-Year Lookup

The features contained within this section are available exclusively to users of the 1099 Pro.net edition of our software.

1099 Pro.net includes the ability to look up multiple years worth of information, all drawn from the same database.

Using a simple drop down menu (A1) users have the ability to go through past filer information that has been entered into the SQL database – no more checking through multiple programs or digging through cabinets and drawers confirming last year's returns! (Search-able back to tax year 1997.)
Select a tax year then use our improved search screen (I.E. A2) to find your necessary information.

(A2)

4.2 Custom Queries

Custom Queries

The features contained within this section are available exclusively to users of the 1099 Pro.net edition of our software.

The SQL advanced database features are incredibly easy to use and offer significant time saving search criteria. (A1)

Search for Information by:
Recipient TIN
Account
Last Name/Company
First Name
PCode
Tax Year

Note: Use information from multiple search fields to narrow down information from the database. For users with multiple filers this is great for speeding up searches.

Within each search field users can further narrow their search by the following operators. (A2)

Equal: Use to return the exact information placed in the search criteria field.
Not Equal: Use to return all information NOT corresponding with the information placed in the search criteria field.
Starts with: Use to return all results starting with the information placed in the search criteria field.
Ends with: Use to return all results ending with the information placed in the search criteria field.
Contains: Use to return all results containing the information placed in the search criteria field.

Note: Use multiple search fields in conjunction with different operator types to narrow down a search. For example, use the Search Field "First Name" with the Operators "Starts With" and "Ends With" concurrently.

4.3 Security

Security

The features contained within this section are available exclusively to users of the 1099 Pro.net edition of our software.
With administrator configurable encryption going up to 256-bit your information can now be trusted to users outside the local area network. Now users from multiple locations can safely and securely draw upon the information stored in your SQL database to both input information and print.

1099 Pro.net offers unparalleled levels of access restrictions. Administrators have the ability to limit the areas users have access to. If you don't want certain forms or boxes changed after certain times of the year, you can now limit that, this can also save time from mistakes potentially being made.

### 4.4 Recipient Printable Forms (Recipient Module)

**Recipient Printable Forms**

The features contained within this section are available exclusively to users of the 1099 Pro.net edition of our software.

Information can be easily exported in the commonly used Adobe Acrobat PDF format, without the need for Adobe to be installed on the user's machine. Exporting forms in PDF format simplifies sending forms to recipients -- simply e-mail or transfer the forms to the recipient. With this advanced feature recipients can now have records of their forms accessible to them almost immediately!

### 4.5 Custom Column Views

**Custom Column Views**

The features contained within this section are available exclusively to users of the 1099 Pro.net edition of our software.

As part of the 1099 Pro.NET module users can modify the Work With My Tax Forms screen to display the information most relevant information to them! This information is customized per user and can be shared amongst users. In addition to being able to select columns to display, users can rename them and/or select a default custom sort order to display the information.
5 **Browse Filers**

**Browse Filers**

The Filer Master List screen allows users to view/sort filers and Add, Change or Delete filers. To quickly jump between existing filers use the Select Filer button.

**Filer Highlights**
- 1099 Pro accepts multiple filers with one TIN. This is useful for companies that issue forms from multiple departments or for batch processors.
- 1099 Pro allows US, Canadian and foreign filers.

- See Filer Record Details for a thorough explanation on each filer specific field.
Views and Queries
- **Current Sort/View Order** - Users may sort filers by Filer Name, TIN or PCode.
- **Current Query/Filter** - By default all filers are displayed. Users can display a subset of the filers by clicking on the "Current Query" drop menu and use an alternate ready-made query, e.g. "Combined Fed/State Filing" or "TIN Is An EIN" or create their own custom query, e.g. "Address Type Code = Other Foreign", etc.

**Add a Filer**
1099 Pro allows unlimited filers.
See [Adding a Filer](#)

**Change a Filer**
Changes made to a filer affect only records with a *Pending* status. To switch between existing filers use the Select Filer button.
See [Changing a Filer](#)

**Delete a Filer**
A filer can only be deleted if it is NOT associated with any recipient records.
See [Deleting a Filer](#)

**Run Filer Report**
The Filer/Employer/Payer Listing provides detailed information on filers including Name, TIN, Contact Information, State ID Numbers and a history of any address changes.
See [Running Filer Reports](#)

**Select a Filer**
Use the Select Filer screen to select a filer.
See [Selecting a Filer](#)

**Tag Filers**
1099 Pro allows users to manually tag (select) filers for inclusion in a print session.
See [Tagging Filers](#)

## 5.1 Add a Filer

### Add a Filer

1099 Pro allows unlimited filers.

*Please visit [https://www.1099pro.com/videos.asp](https://www.1099pro.com/videos.asp) and view the "How to Add a Filer" video for a brief tutorial on the filer process.*

**Add a Filer**
1. From the menu bar select File > Filer List.
2. At the Filer Master List screen click "Add".
3. At the Adding a Filer Record screen complete all fields and click "OK" to save the filer.

☐ See [Filer Record Details](#) for a thorough explanation on each entry field.
5.2 Change a Filer

Change a Filer

Changes made to a filer only apply to records with a Pending status. To switch between existing filers use the Select Another Filer button.

To Change a Filer
1. From the menu bar click File > Filer List”.
2. At the Filer Master List screen click “Change”.
3. At the Changing a Filer Record screen make changes and click “OK”.
4. The Administrator prompts to update all pending records with the new filer information. Click ”Yes” to update filer or “Cancel” to abort changes and exit the screen.

See Filer Record Details for a thorough explanation of each entry field.

5.3 Sponsored Entity / Intermediary

Sponsored Entity / Intermediary

8966 Pro users can review or add Sponsored Entity or Intermediary List information via the Reporting FI task panel > "Intermediary/Sponsored Entity” link. Please review the IRS 2017 Instructions for Form 8966 for specific definitions of Intermediaries and Sponsored Entities.

Modify Indicators on Existing Data
Users can edit Sponsored Entity / Intermediary information on existing Forms 8966. First add the Sponsored Entity or Intermediary as outlined above. Then at the Work With My Tax Forms screen open the appropriate record and use the “Spon ENT Type” drop menu to select "No Spon ENT Type", "Intermediary" or "Sponsored Entity". Tab to the TIN field and right-click your mouse to display available Sponsored Entities or Intermediaries to auto-populate the form.

Another option is to re-import your data by creating a new map with the "Spon ENT Type” field added to your data file as outlined below.

Import File Conventions
Mark the "Spon ENT Type” column in the 8966 sample import file as follows:
- 1 / I / i = Intermediary
- 2 / S / s = Sponsored Entity

5.4 Contact Persons

Contact Information

At the Filer Record screen add or edit a Contact Person, Department and Phone Number. Adding multiple contacts allows users to change the contact information on different records. At least one
contact is required. The contact phone number prints on all copies and 1096/W-3/1042-T Transmittals. The Transmitter/Submitter contact name is included in electronic files.

To Add/Edit Contacts:
1. On the menu bar select File > Filers List.
2. At the Filer Master List screen highlight a filer and click the "Change" button.
3. At the Filer Record screen (General tab) use the "Add", "Change" or "Delete" buttons as appropriate.
   - Dept. Code - The filer's internal reference such as AP, Sales, HR, LA Office, NY Office, etc. A maximum of 15 characters is allowed.
   - Default - Only one contact may be selected as default.
4. Use the "Save" button to save changes or "Cancel" to abort changes and exit.

5.5 Delete a Filer

Delete a Filer

A filer can only be deleted if it is NOT associated with any recipient records.

To Delete a Filer
1. From the menu bar click File > Filer List".
2. At the Filer Master List screen highlight the filer and click "Delete".
3. At the Confirm Delete screen click "Yes" to delete the filer or "No" to cancel.

5.6 Filer Record Details

Filer Record Details

General Tab

Taxpayer Identification Number
If the filer does not have a TIN but has applied for one, enter "Applied For" in this field.
- Filers with an EIN or SSN may issue 1099 Informational Returns.
- Filers with an "Applied For" status may issue forms but cannot generate an electronic file or 1096 Transmittal until a TIN is entered.
- A filer's TIN prints on all tax records; it cannot be masked.

Location/Estab. No. (Optional)
- Use to set up multiple filers with the same TIN; allows different return addresses for different forms.
- Multiple filers sharing one TIN (or batch processors grouping by month) can enter a Location Code of up to 4 alpha-numeric characters in this field. The Location Code appears in the filer name and in all reports.
- If applicable, enter an SSA assigned Establishment Number in this field.
- This field flows through to the B record positions 41-44 as the "Payer's Office Code" (applies to electronic filers only). Per the IRS, this code must also appear on backup withholding notices.

Payer Code (Required)
For the user's internal reference only, a Payer Code (or PCode) is an alphanumeric shorthand used to identify a Payer/Filer in the system. Users may set up several Filers with the same TIN in the system and the Payer Code is an easy way to identify the unique business. For example, use a Payer Code of
‘BOD’ if reporting for the Board of Directors. Typically security and/or the return address is different for each Payer Code. Additionally, in an import file with recipient/tax form data for more than one Payer/Filer, Payer codes can be used to define which Payer/Filer the recipient/tax form data should be posted to.

Payer Codes must be unique. If an already in use Payer Code is entered, the system prompts to create a new one for the user.

**Country**
Defaults to USA. Selecting Canada or a foreign country automatically reformats the address fields.

**Filer Name**
Prints on all tax records.

**Filer Name Line 2**
Prints on all forms.

**Address**
Prints on all tax records.

**Contact Information (Required)**
Use the "Add" button to add a Contact Person, Department and Phone Number. Adding multiple contacts allows users to change the contact information on different records (use the Dept. field at the Adding a Form Record screen). At least one contact is required. The phone number prints on all copies and IRS/SSA paper Transmittals. The Transmitter/Submitter contact name is included in electronic files.

**Combined Federal/State Filer**
Applies to users of the 1099 Pro Service Bureau and/or Electronic filers. By default this box is checked for all filers.
- Service Bureau users may leave this box checked to participate in the [Combined Federal/State Filing Program](https://example.com) at no additional charge.
- Electronic Filers should leave this box checked to participate in the [Combined Federal/State Filing Program](https://example.com) ONLY if they have a qualified TCC number.

**RTN**
Routing Transit Numbers are used by banks and other financial institutions. If entered, this information appears only on Form 1099-INT.

**Fax**
This field is optional.

**E-mail**
This field is optional.

**Notes**
Enter notes specific to a Filer/Pcode for reference purposes.

**State I.D. Number(s) Tab**

**State ID Numbers**
These numbers are assigned by the individual state. For example, in California the Employer Development Department (EDD) assigns a state ID number. Users should check with an accountant or attorney to determine if their company has a state ID number. Use the “Add” button to add as many state ID numbers as necessary.
For more information, see [State ID Number](#).

**Prior Address Tab**
This tab displays only if a filer's address has been modified. Preserves prior filer address information for reference purposes. This information cannot be changed.

**1099-K Options Tab**
This tab enables users to specify form 1099-K preferences, including:

**Filer Classification**
- Not applicable (does not file 1099-K forms) - default selection
- PSE - Payment Settlement Entity
- EPF - Electronic Payment Facilitator
- TPP - Third Party Payer

**Additional Payment Settlement Entity (PSE) Information**
This section is only enabled after selecting "PSE" as the Filer Classification, enter the following information:
- PSE Name
- PSE Phone

**Tax Form and Visual Options Tab**
*(Corporate Suite only)*
Use this tab to access tax form specific settings for Forms 1099/1042-S, W-2 and 1099-K. The Visual/Print Options tab allows users to select Recipient TIN Masking options specific to the filer.

**Extra Options Tab**
Set the default preference for recipient TIN masking for the selected filer per the IRS guidelines. Please see [TIN Masking](#) for more information.

### 5.7 Filer Reports

**Filers List Report**

The Filer/Employer/Payer Listing provides detailed Filer specific information including Name, TIN, Contact Information, State ID Numbers and a history of any address changes. All filers are automatically included in the report.

- See Summary of Forms Issued by Filer report for a detail of forms issued by filer including Form Counts, Recipient Name / TIN / Address and each record's respective status.

**To Run Filers List Report**
1. From the menu bar select File > Filers List.
2. At the Filer/Employer/Payer Master List screen click "Run Filer Report".
3. The Administrator prompts to "Print One Filer Per Page" and preview the report. Select as appropriate.
5.8 Select Another Filer

Select Another Filer

Use the "Select Another Filer" button, located at the top left of the task panel, to select a filer.

To Select Filers
1. On the task panel click the "Select Another Filer" button.
2. At the Browse the Filers File screen highlight the filer to use and click "Select".
   Note: The Current Filer is displayed at the top of the Select Filer box.

To Add/Edit Filers
- On the task panel click the "Manage" button to access the Filer Master List screen or see Browse Filers.

5.9 Tag Filers

Tag Filers

1099 Pro allows users to manually tag (or select) filers for inclusion in a print session.

To Tag Records
1. On the Printing & Mailing task panel click "Print/Mail Forms Myself". Use the Current Form drop menu to select the form type to process.
2. At the Printing Tax Forms screen choose the "All Pending Forms for Selected Filers" option.
3. Click the "Begin a New Print Process" button.
4. At the Browse the Filers File screen click the "Tag" button to select filers. A red check mark appears beside each tagged filer. (See Tag Key Shortcuts below.)
   - To sort filers prior to tagging, use the View drop menu.
5. After tagging all filers, click "Proceed" to initiate the Print Wizard.

Tag Key Shortcuts
- Tag: Use this button (or ALT + T) to tag individual filers.
- Tag All: Use this button (or ALT + A) to tag all filers.
- Untag: Use this button (or ALT + U) to untag an individual filer.
- Untag All: Use this button to untag all filers.
- Flip: Use this button (or ALT + F) to reverse the tag status of an individual filer.
- Flip All: Use this button (or ALT + L) to reverse the tag status of all filers. For example, if there are three filers and only one filer is tagged, the Flip All button will tag the two previously untagged filers.
and untag the original filer.

- **Prev Tag:** Use this button (or ALT + P) to scroll backwards through tagged filers.
- **Next Tag:** Use this button (or ALT + N) to scroll forwards through tagged filers.

### 5.10 Advanced Pcode Filter

#### Advanced PCode Filter

Available in Corporate Suite only, the Advanced PCode filter allows for additional targeted searches over multiple Filers/PCodes for easier Filer/PCode tagging when printing or filing. This feature also allows users to locate filers based on a range of characters within the Pcode itself.

**To Enable Advanced PCODE Filter**

1. At the Select the Filer to Use screen click the "Current Query" drop menu and select "Custom Query".
2. In the Query Wizard click the "Manual" button.
3. From the Field List select "Payer Code". Enter the Payer Code like 'abc' in the Query Wizard Manual Override box.
4. Click Finish and choose to save the query, name the query appropriately.
5. When running the newly created query you should be presented with the fields you've given to your 1099 Pro account manager.

Shown below is an example of the labeling assigned to a particular character range when using the advance pcode feature.

![Runtime Query 'Ask For' PCode Filter](image)

The 1099 Pro .NET interface features the advanced Pcode lookup on multiple pages; Form Lookup, Filer Browse, and various Filer selection pop-up windows. To enable this feature click the checkbox for Advanced PCODE Filter when it’s available, and additional filters will be displayed as shown below:

.NET Advanced PCODE Filter on Form Lookup
To activate this feature in .NET provide your 1099 Pro account manager with the desired Titles for each segment of your Pcode and we'll send you an activation SQL script.

6 Browse Recipients

Browse Recipients

Use the Recipient Master List screen to add, change or delete recipients. To access these recipients at any data entry form, use the <F2> key or right-click your mouse in the recipient ID Number field.

☐ See Recipient Record Details

Add

1099 Pro allows unlimited recipients.

See Add Recipients

Change

Changes made to a recipient only affect records with a Pending status. When making manual changes to the filer and/or recipient master list in 1099 Pro, those changes cascade or update throughout all tax forms with a status of Pending. Cascading updates help ensure that the entire filer and recipient information - regardless of the tax form - synchronizes quickly and uniformly. These changes are NOT tracked through the Record History screen; only direct changes to a tax form are tracked under record history.

See Change a Recipient

Delete

A recipient cannot be deleted if any records are associated with it.

See Delete Recipients

Run Forms Issued Report

The Forms Issued for Recipient report details all forms issued to each recipient. Includes filer, recipient address, and form status.

See Running Forms Issued Reports

Group Actions

Group Actions allow users to tag/select a number of items and then perform a single action on them. In all instances the user is prompted to confirm their choice before the action is taken.
See Group Actions

Multiple Recipients - One TIN
Occasionally a filer may issue multiple forms to the same recipient or issue forms to two individuals sharing one SSN or EIN. For example, Jane Doe DBA Jane's Courier Service and Jane Doe both use an SSN of 123-45-6789. However, Jane Doe DBA and Jane Doe have different addresses. To enter both recipients follow this procedure:
See Multiple Recipients - One TIN

Run Recipient Report
The Recipient Listing includes the Name, TIN, and Address of all recipients in the 1099 Pro database. For more detailed recipient information, including Account Numbers and status of any forms, use the Control Totals report.
See Recipient Listing Report

Select a Recipient
All recipient records are stored in a master database that is accessible at any tax form. To access this information at any data entry screen place your cursor in the Recipient TIN field and hit the <F2> key or right-click your mouse. The Select a Recipient screen appears with ALL recipients for ALL filers available for selection. At the Select a Recipient screen, highlight a recipient and click "Select" or double-click the recipient.
See Selecting Recipients

Tagging Recipients
1099 Pro allows users to manually tag (select) records for inclusion in a print session.
See Tagging Recipients

Recipient Lookup Feature
Use the Recipient Lookup feature to run a program wide search for a recipient and view a list of associated form types with detailed information including form(s) status / error status, Filer TIN, Payer Code and Filer Name. This is a quick and powerful tool for locating a single recipient for those users with a large volume of records and multiple filers.
See Recipient Lookup Feature

W-9 New Request for Recipient Indicator
Column shows if there have been requests for a recipient.
See W-9 Main Screen

Issue a W-9 or B-Notice
This button initiates the wizard to generate a W-9 for the selected recipient. This allows the user to issue forms individually without creating a batch.
See W-9 Wizard

6.1 Recipient Record Details

Recipient Record Details

General Tab
SSN/EIN - The placement of the dash in the TIN field is critical. The entry of an SSN or EIN determines the formatting of the Name and Company fields. For 1099 Informational Returns if the TIN is unknown or applied for, leave this field blank.
First Name (SSN) - Enter the recipient's First Name.

Last Name (SSN) - Enter the recipient's Last Name.

Company (EIN) - Enter the recipient's Company.

Name Line 2 - Enter a second name or DBA, as appropriate.

Address Type - Defaults to USA. Selecting Canada or Other reformats the address fields. See Canadian Postal Code Rules.

Address - Enter the recipient's Address.

E-mail - This field is optional but is useful for e-mailing encrypted tax forms to recipients upon request.

Accounts/Name 2 Tab
Name Line 2 - This field is for reference only and reflects entries made at the data entry screen.

Account Numbers - Enter as many account numbers as necessary. Access this information at the Account Number field at any data entry screen via the <F2> key.

W-9/B-Notices Request Tab
This tab is only displayed if an open information request exists for the recipient. Use this tab to update a recipient's TIN/Name and change the status of the request. The tab is not displayed if there are no open requests for the selected recipient. See Information Request Overview.

Status request options include:
- **Leave the Request Open as Pending:** Any open requests remain in a Pending status.
- **Close the Request:** This option is used when corrected info has been received back from the recipient, etc.
- **Voided:** VOID the request, it should not have been issued. After a request is voided and changes are saved the request is no longer available for updates and is considered closed.
- **Escalated:** This option closes the existing request and opens the Information Request Wizard to create a new request. Options include Escalate to 1st B-Notice or 2nd B-Notice.

6.2 Recipient Lookup Screen

Recipient Lookup Screen

Use the Recipient Lookup feature to run a program wide search for a recipient and view a list of associated form types with detailed information including form(s) status / error status, Filer TIN, Payer Code and Filer Name. This is a quick and powerful tool for locating a single recipient for those users with a large volume of records and multiple filers.

- For a more refined search, use the Custom Query Wizard at the Recipient Master List screen to search by state, dollar amounts, dates, etc.
### 6.2.1 Recipient Lookup Account Selection

**Recipient Lookup Account Selection**

This screen is triggered by clicking on the "Account" button in the Recipient Lookup Screen. Accounts tied to criteria entered in the Search/Filter box are displayed in this secondary window. To reset or remove the filter applied to this screen, click the "Show All (Remove Filter) button".

---

To Use Recipient Lookup*

1. At the menu bar select File > Recipients Lookup, OR at the Recipient Master List screen click the "Recipient Lookup" button.
2. Determine your search criteria; by TIN, Account Number or Last Name/Company. Enter the first few characters and then click on the corresponding "by TIN", "by Account" or "by Name" button.
3. All tax forms associated with the recipient are displayed, including their status and the associated filer.
4. From this screen forms may be viewed, changed or corrected as available per their status and printed via the Quick-Print button.

*The Recipient Lookup feature is not available in 1042-S Pro or 8966 Pro.
6.3 Add Recipients

Add Recipients

1099 Pro allows unlimited recipients. In a standard software installation up to 5,000 recipient transactions (tax records) are allowed; bump codes may be purchased at any time.

1099 Pro users may manually add individual recipient records; Corporate Suite Edition users may import recipient records. Most often users import data - including tax form and recipient information - thereby eliminating the need to manually add recipients, aside from the occasional record issued at the last minute. See Import Overview for more information.

Manually Add Individual Recipients
1. From the menu bar select File > Recipients List.
2. At the Recipient Master list screen click "Add".
3. At the Adding a Recipient Record screen complete all fields. Use the <F1> key at any time to access field specific information.
4. After completing all fields click "OK" to save the recipient.
   - Access the Recipient Master List at the Adding a Tax Form screen by placing your cursor in the "Recipient Identification Number" field and right-clicking your mouse OR via the <F2> key.

Import Recipients
Corporate Suite Edition allows users to import recipient records. Please see Import Wizard Step 1 - Import Data, Filers or Recipients.
6.4 Select Recipients

Select Recipients

Select a Recipient by TIN or Last Name
All recipient records are stored in a master database that is accessible at any tax form. To access this information at any data entry screen place your cursor in the Recipient TIN field and hit the <F2> key or right-click your mouse. The Select a Recipient screen appears with ALL recipients for ALL filers available for selection. At the Select a Recipient screen, highlight a recipient and click "Select" or double-click the recipient. All Recipient associated information (TIN, Name, Address) automatically populates the form.

To Filter Recipients
1. Place your cursor in the Search/Filter box.
2. Select the View by TIN (SSN/EIN) or View by Last Name tab.
3. Enter your search criteria and hit TAB on your keyboard. For example, to view only recipients with last names starting with the letter "B", type "B" and TAB.
4. To remove the filter click the "Show All (remove filter)" button.

6.4.1 Tag Recipients

Tag Recipients

1099 Pro allows users to manually tag (select) records for inclusion in a print session.

Tag Records
1. At the Printing & Mailing task panel click "Print-Mail Forms Myself". Use the Current Form drop menu to select the form type to process.
2. At the Printing Tax Forms screen choose the "Manually select forms..." option.
3. Click the "Begin a New Print Process" button.
4. At the Selecting Form Records screen click the "Tag" button to select records. A red check mark appears beside each tagged record. (See Tag Key Shortcuts below.)
   o To sort records prior to tagging, use the View or Query drop menus.
5. After tagging all records, click "Proceed to Next Step" to initiate the Print Wizard.

Tag Key Shortcuts
- Tag: Use this button (or ALT + T) to tag individual records.
- Tag All: Use this button (or ALT + A) to tag all records.
- Untag: Use this button (or ALT + U) to untag an individual record.
- Untag All: Use this button to untag all records.
- Flip: Use this button (or ALT + F) to reverse the tag status of an individual record.
- Flip All: Use this button (or ALT + L) to reverse the tag status of all records. For example, if you have 3 records and only one record is tagged, the Flip All button will tag the two previously untagged records and untag the original record.
- Prev Tag: Use this button (or ALT + P) to scroll backwards through tagged records.
- Next Tag: Use this button (or ALT + N) to scroll forwards through tagged records.
6.5 Change a Recipient

Change a Recipient

Changes made to a recipient only effect associated records with a Pending status.

To Change a Recipient
1. From the menu bar select File > Recipients List.
2. At the Recipient Master list screen highlight the recipient and click "Change".
3. At the Changing a Recipient Record screen make changes and click "OK".
4. The Administrator prompts to update all pending records with the new recipient information. Records with a printed, filed or Filed 1096 status are not updated.

6.6 Delete Recipients

Delete Recipients

A recipient cannot be deleted if any records are associated with it; users must first delete all records (or tax forms) associated with the recipient. Users are strongly encouraged to backup data prior to deleting recipients.

To Delete INDIVIDUAL Recipients
1. From the menu bar select File > Recipients List.
2. At the Recipient Master list screen highlight the recipient and click "Delete".
3. At the Confirm Delete screen click "Yes" to delete the recipient or "No" to cancel.

To Delete Recipients With No Forms
1. From the menu bar select File > Recipients List.
2. At the Recipient Master list screen click "Delete All With No Forms".
3. The Administrator warns this action cannot be reversed. Click "Yes" to continue with deletion or "No" to cancel and exit this screen.

6.7 Forms Issued Report

Forms Issued for Recipients

The Forms Issued for Recipients report details all forms issued to each recipient including Form Type, Form Status, Form Filer (by TIN), Form Account Number, Date Created and Date Last Updated.

To Run Report
1. From the menu bar click "File" and "Recipients List".
2. At the Recipient Master List screen click the "Run Forms Issued Rpt" button.
3. The Administrator prompts, "Limit the report to just the selected recipient?"
   o Select "Yes" to run a report for ONLY the recipient selected (or highlighted) at the Recipient Master List screen.
   o Select "No" to run a report for ALL recipients in the database.
4. Click "Yes" to preview the report.
6.8 Recipient Listing Report

Recipient Listing Report

The Recipient Listing includes the Name, TIN, and Address of all recipients in the 1099 Pro database. For more detailed recipient information, including Account Numbers and status of any forms, use the Control Totals report.

To Run Report
1. At the menu bar select Reports > Recipients List, or alternately, at the Recipient Master List screen click the "Run Recipient Report" button.
2. At the Recipient Master List screen the Admin prompts to preview report, click "Yes".

6.9 Group Actions

Group Actions

The “Group Actions” button is located at the bottom of the Work With My Tax Forms screen and provides direct access to the following options:

QUICK-PRINT Pending Tax Forms
Users can tag any number of tax forms with a Pending status and print them via the Quick-Print option. To print IRS Copy A forms and update the status of the forms from Pending to Printing, use the Print Tax Forms Wizard. Quick-Printing does not allow for the updating of a record's print status.

QUICK-REPRINT Printed or Filed Tax Forms
Users can tag records in a group—regardless of print status—via the Reprint tab. To print any individual record use the Quick-Print option located at the Work With My Tax Forms screen.

ADD New Forms for Selected Recipients
Users can tag any number of recipients, and then loop through the list creating new forms for them. The program auto-populates the recipient information on each new form, only the specific box information for the form must be entered. For additional flexibility, users may add the forms by the following sort orders: Name, TIN, State or ZIP.

DELETE Pending Tax Forms
Users can tag any number of Pending tax forms and delete them with one operation. All notes associated with the form(s) are also deleted.

RESET Printed Tax Forms Back To Pending
Users can tag any number of forms with a Printed status and reset their status to Pending to make forms available for edits or deletions. The selected forms can belong to any print session.

VOID Printed Tax Forms
Users can tag any number of forms with a Printed status and change their status to Void to prevent them from being filed. The selected forms can belong to any print session.

UN-VOID Tax Forms
Users can tag any number of forms with a Void status, and reset their status Pending to make forms available for edits or deletions.
6.10 Multiple Recipients - One TIN

Multiple Recipients - One TIN

A Filer can issue multiple forms to the same recipient or issue forms to two individuals sharing one SSN or EIN. For example, Jane Doe DBA Jane's Courier Service and Jane Doe both use an SSN of 123-45-6789. However, Jane Doe DBA and Jane Doe have different addresses. To enter both recipients follow this procedure:

1. Enter Jane Doe as normal at any Adding a New Record screen. This will be the "master" recipient information for Jane Doe. Click "Save" to save Jane Doe's record.
2. At the next Adding a New Record screen, enter the shared TIN in the Recipient TIN field. Jane Doe's name and address automatically fill the screen.
3. Use SHIFT + TAB to move backwards through the fields and overwrite the name and/or address fields with Jane Doe DBA's information. Click "Save" to save changes.
4. The Administrator indicates a possible recipient information mismatch. Click "No" to not update Jane Doe DBA with the "master" record. Also uncheck the "Update All Other Pending Forms" checkbox.

At the Recipient Master List screen only the "master" record, Jane Doe, is listed. However, the recipient record does list the DBA under the Accounts/Name2 tab.

7 Helpful Hints

7.1 Adobe Acrobat

Adobe Acrobat

Use Acrobat Reader to open/view a PDF file. Download Acrobat Reader for free at ADOBE's website.

7.2 Alternative Import Layout

Alternative Import Layout

Standard Import vs. Alternative Import Layout
The standard import layout (as used in the sample import files) provides distinct City, State and Zip fields. The alternative import layout makes use of a single Combined City/ST/Zip field. Use one or the other layout in your import file.

See Sample Import Files

7.3 Canadian Postal Code Rules

Canadian Postal Code Rules
7.4 Compliance Seminars

Compliance Seminars

For information about 1099 Pro, Inc. sponsored seminars and conferences, visit our web site at http://www.1099 Pro.com/servTrainingSeminars.asp for more information.

7.5 Form Status Overview

Form Status Overview

Records with a Printed, Filed (1096/W-3/1042-T), Filed Mag, SB Filing, Corr/SB Filing or Void status are "protected" from changes or edits. Use the Protected Form Update Options screen to access these records. Available update options vary according to the record's status.

Protected Form Update Options screen

Use this screen to access protected records for viewing, reprints or generating corrections.

1. At the Preparing My Forms task panel click the "Work With My Tax Forms" link.

   - Corporate Suite Users: At the Forms & Printing task panel click the "Browse, Enter & Edit" link.

2. Highlight any record with any status except Pending.

3. Click the "Change" button to display the Protected Form Update Options screen.

<table>
<thead>
<tr>
<th>Record Status</th>
<th>Available Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending</td>
<td>These forms are ready to be printed and/or filed. Users may view, change or delete the form. Print the form and/or file the form (to paper* on IRS/SSA Copy A, electronically or through the Service Bureau).</td>
</tr>
<tr>
<td>Printed</td>
<td>These forms have been printed and are ready to be filed. Users may view the form, reset the form to pending print status, void the form, reprint the form or file the form (to paper* on IRS/SSA Copy A, electronically or through the Service Bureau). Records that were imported with a printed status cannot be void, reset or delete. The entire import session must be reset.</td>
</tr>
<tr>
<td>Voided</td>
<td>These forms have been voided. Users may view the form, unvoid the form or reprint the form</td>
</tr>
</tbody>
</table>
Deleted

These forms have been deleted and may not be undeleted. Users may view the form.

Filed 1096

These forms have been printed and filed via 1096 transmittal. Users may view the form, reprint the form or create corrections.

Filed Mag

These forms have been printed and filed electronically (magnetic media). Users may view the form, reprint the form or create corrections.

SB Filing

These forms have been submitted to the Service Bureau for electronic filing. Users may view the form, reprint the form or create corrections.

SB Print+Mail

These forms have been submitted to the Service Bureau for printing and mailing. Users may view the form, file the form (to paper* on IRS/SSA Copy A, electronically or via the Service Bureau), reprint the form or reset to pending.

Corr/Pending

These forms have been corrected and are ready to be printed and/or filed. Users may view the original or corrected form, reprint the original form. Print and/or file the corrected form (to paper* on IRS/SSA Copy A, electronically or through the Service Bureau). Change the corrected form or delete the correction.

Corr/Printed

These forms have been corrected and are ready to be filed. Users may view the original or corrected form, reprint the original or corrected form. File the corrected form (to paper* on IRS/SSA Copy A, electronically or through the Service Bureau). Reset the corrected form to pending status.

Corr/SB Filing

These forms have been corrected and submitted to the Service Bureau for electronic filing. Users may view the original or corrected form, reprint the original or corrected form.

Corr/Mag

These forms have been corrected and filed electronically (magnetic media). Users may view the original or corrected form, reprint the original or corrected form.

* Filers must file electronically if they have 250 or more forms of any one form type or risk IRS penalties.

Create Corrections

Refer to About Corrections and Create Corrections - A Tutorial

7.6 Form Status Values

Form Status Values

Database values are useful for generating Custom Queries in 1099 Pro or in an SQL database.
In the Query Wizard select **Form Status Code** = Optional, form statuses to return, accepts an array of integers. The default returns all printed status forms. If an original 1099 form has a correction, only the latest correction is returned. This includes both parts of a 2-part correction, the zero correction and the new part. The original or new corrected values can be requested and both parts are returned. Corrected W-2’s return the latest correction (W-2C) plus any superseded corrections and the original.

**ORIGINAL RECORDS**

<table>
<thead>
<tr>
<th>Code</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Original Pending</td>
</tr>
<tr>
<td>1</td>
<td>Original Printed</td>
</tr>
<tr>
<td>2</td>
<td>Original Printed and Voided</td>
</tr>
<tr>
<td>3</td>
<td>Original Printed and Filed Paper</td>
</tr>
<tr>
<td>4</td>
<td>Original Printed and e-Filed</td>
</tr>
<tr>
<td>5</td>
<td>Original SB Printed</td>
</tr>
<tr>
<td>6</td>
<td>Original Not Printed and e-Filed</td>
</tr>
<tr>
<td>7</td>
<td>Original Not Printed and SB e-Filed</td>
</tr>
<tr>
<td>8</td>
<td>Original SB Printed and SB e-Filed</td>
</tr>
</tbody>
</table>

**CORRECTION ZERO FORM (2-PART) / Correction (1-Part) / New Form (2-Part)**

<table>
<thead>
<tr>
<th>Code</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Corrected Pending</td>
</tr>
<tr>
<td>11</td>
<td>Corrected Printed</td>
</tr>
<tr>
<td>12</td>
<td>Corrected Printed and Voided</td>
</tr>
<tr>
<td>13</td>
<td>Corrected Printed and Filed Paper</td>
</tr>
<tr>
<td>14</td>
<td>Corrected Printed and e-Filed</td>
</tr>
<tr>
<td>15</td>
<td>Corrected SB Printed</td>
</tr>
<tr>
<td>16</td>
<td>Corrected Not Printed and e-Filed</td>
</tr>
<tr>
<td>17</td>
<td>Corrected Not Printed and SB e-Filed</td>
</tr>
<tr>
<td>18</td>
<td>Corrected SB Printed and SB e-Filed</td>
</tr>
<tr>
<td>20</td>
<td>Correction Pending</td>
</tr>
<tr>
<td>21</td>
<td>Correction Printed</td>
</tr>
<tr>
<td>22</td>
<td>Correction Printed and Voided</td>
</tr>
<tr>
<td>23</td>
<td>Correction Printed and Filed Paper</td>
</tr>
<tr>
<td>24</td>
<td>Correction Printed and e-Filed</td>
</tr>
<tr>
<td>25</td>
<td>Correction SB Printed</td>
</tr>
<tr>
<td>26</td>
<td>Correction Not Printed and e-Filed</td>
</tr>
<tr>
<td>27</td>
<td>Correction Not Printed and SB e-Filed</td>
</tr>
<tr>
<td>28</td>
<td>Correction SB Printed and SB e-Filed</td>
</tr>
</tbody>
</table>


**Error Status Values**

In the Query Wizard select **Error Status** = Optional.

<table>
<thead>
<tr>
<th>Code</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No Errors</td>
</tr>
<tr>
<td>1</td>
<td>Warnings</td>
</tr>
<tr>
<td>2</td>
<td>Errors</td>
</tr>
<tr>
<td>3</td>
<td>Warnings + Errors</td>
</tr>
<tr>
<td>4</td>
<td>Fatal / Major Errors</td>
</tr>
</tbody>
</table>

### 7.7 Map by Name Import

**Map By Name Import**

**Map By Name Import Method**

Use if your import file incorporates header records from one of our sample import files. Simply click the "Map By Name" button and the fields automatically assign themselves.

For more information see the Import Wizard and Map By Name topics.

### 7.8 Master Audit Trail Browser

**Master Audit Trail Browser**

The Master Audit Trail Browser is available only to Administrators or Users with administrative access.
rights. The Master Audit Trail Browser offers greater functionality than the Record History screen including the ability to view all records and make changes directly to records.

See Audit Trails

7.9 Master Tax Form

Master Tax Form

In terms of Aggregating data, the master tax form is considered to be the first tax form entered at the top of the transactions list.

7.10 Menu Bar

Menu Bar

The menu bar is a traditional navigational tool located at the top of the 1099 Pro screen. For example, use ALT + R to access "Reports".

7.11 Online Help Tutorials

Online Help Tutorials

Online Help Tutorials
Video tutorials are available to view for free at http://www.1099pro.com/videos.asp.

7.12 Online Knowledge Base

Online Knowledge Base

Provides a searchable database of over 200 solutions for all 1099 Pro, Inc. software products. Access the Knowledge Base at http://www.1099pro.com/support.asp.

7.13 Registration Code

Registration Code

A registration code (activation code) is provided upon proof of payment. Registration codes are 14 alpha/numeric characters (e.g., R91234567X0XSE). The algorithm of your registration code indicates the edition, user license and number of transactions purchased.

See Registration topic
7.14 Welcome Wizard

Welcome Wizard

Upon first entering 1099 Pro 2017, the Welcome Wizard walks users through creating their first filer and activating optional security features.

7.15 eFile Archiving

eFile Archiving

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

During Electronic File (Mag Media – State and Quarterly) creation in the Electronic Filing link, there is an option to “Archive a copy of this file”. Checking the “Archive a copy of this file” box creates an archived Electronic File in the 1099 Pro database. If an Electronic File is created and the “Archive a copy of this file” box is checked, the file can be restored if your files have been lost or corrupted.

To Restore Archived Data
1. On the Filing & Corrections task panel click the “Electronic Filing” link.
2. At the Completed [Tax Year] IRS e-File Generation Session List screen select (or highlight) the appropriate eFile session.
3. Click the “Restore Archived File” button at the bottom of the screen.
8 Transmission Overview

1096 Overview

The Purpose of the 1096
Use this form to transmit paper Forms 1099, 1098, 5498, and W-2G to the Internal Revenue Service. Do not use Form 1096 to transmit electronically. For electronic submissions, see Pub. 1220, specifications for Filing Forms 1098, 1099, 5498 and W-2G Electronically.

1096 Print Wizard
- A 1096 Transmittal can ONLY be generated for records with a printed status.
- Wait until mid to late February to print your transmittal (and associated Copy A's) to incorporate as many recipient change requests as possible.
- The red ink on the pre printed 1096 is invisible to the IRS scanners. Although your data should ideally align in the proper box, it is OK if the data slightly overlaps the red ink.
- Print a test page to blank paper to minimize form waste. Align margins if data does not align in the proper box.
- A corrected 1096 automatically prints "Filed to Correct TIN, Name &/or Address" or "Filed to Correct Document Type" at the bottom of the transmittal.

Ready to Print your 1096s? See 1096 Print Wizard for more details

Maintain Printed Status
Select this option if you are dissatisfied with the 1096 (destroy the printed 1096). The records in this print session maintain their printed status and are available for inclusion in another 1096 transmittal. See Maintaining Printed Status for more information

1096 Session Report
The Print Session report summarizes all data for the selected transmittal. See Printing 1096 Session Report

Assigning 1096 Filed Status
Select this option if the 1096 transmittal was completed properly and printed to your satisfaction. The records in this print session are assigned a Filed 1096 status and are no longer available for edits. See Assigning 1096 Filed Status

Reset 1096 Session
Void a 1096 and all records in that print session are automatically reset to printed status. See Voiding a 1096 Session

Reprint 1096 Form
Things to keep in mind:
- The red ink on the pre printed 1096 is invisible to the IRS/SSA scanners. Although your data should
ideally align in the proper box, it is OK if the data slightly overlaps the red ink.

- Print a test page to blank paper to minimize form waste. Align margins if data does not align in the proper box.

See Reprinting 1096 for more information

8.1 Form Transmission Wizard

1096 Print Wizard

The 1096 Print Wizard makes it easy to generate a 1096 Transmittal.

*Please visit https://www.1099pro.com/videos.asp and click the "Filing On Paper Via 1096 or W-3" video to watch a brief tutorial of the 1096 process.

Generate Transmittal

1. Go to the Filing My Forms task panel and click the "File via 1096 (paper)" icon.
2. Click the "Begin a New Form 1096 Process" button to access the Form 1096 Print Wizard. To proceed with the Print Wizard click "Next". Use the "Back" button at any time to go back a step.
3. Select the form type to process. Only records with a printed status are available for selection.
4. Tag print sessions. Multiple print sessions of the same form type may be included in this 1096. Click "Next" to proceed.
5. Verify Contact Name and Phone Number. E-mail Address and Fax Number are optional fields. Click "Next" to proceed.
6. Print a test alignment to minimize form waste. When satisfied with alignment click "Next" to proceed.
7. Review 1096 summary and if satisfied, click "Print" to begin printing.
8. 1099 Pro prompts the user to place the pre-printed 1096 form into the printer. Click "OK" when the printer is ready.
9. Indicate if the Transmittal is ready to send to the IRS:
   - "Yes- I have verified and/or printed my Finalized copies or Red copy A forms". Remember to mail your Copy A's and 1096 to the IRS by February 28, 2018. Your forms are assigned a 1096 Filed status and are no longer available for changes.
   - "No- I haven't Printed my Finalized or Red Copy A forms yet". Your forms continue to have a Printed status.
10. Click "Finish" to exit the 1096 Wizard.

8.1.1 Assign Paper Filed Status

Assign Filed 1096 Status

Select this option if the 1096 transmittal was completed properly and printed to your satisfaction. The records in this print session are assigned a Filed 1096 status and are no longer available for edits.

Remember to mail your Copy A's and 1096 transmittal to the IRS by the February 28, 2018 filing deadline. For TY 2017: File Form 1099-MISC by January 31, 2018 if reporting nonemployee compensation in box 7.

- Print Status Overview
- Import Status
8.1.2 Transmission Not Filed

1096 Not Filed

Select this option if dissatisfied with the 1096 (destroy the printed 1096). The records in this print session maintain their Printed status and are available for inclusion in another 1096 transmittal.

Print Status Overview

8.2 Technical Support & Maintenance

Technical Support

All 1099 Pro software products includes context-sensitive help screens as the first means of supporting your use of this product. In addition, 1099 Pro, Inc. offers many technical support options including; Online Help Tutorials and an Online Knowledge Base. These options are intended to provide customers with immediate solutions. If these sources do not contain the answers to your questions, contact technical support by phone or E-Mail. To help us better assist you, please provide the following information:

- Company name or Customer ID (CID) number
- Please be at the computer you are experiencing the problem with
• A list of what steps were taken prior to the problem
• Any error messages that you have encountered.

Technical Support Options
Help Tutorials and Knowledge Base
http://www.1099 Pro.com
Phone (888) 776-1099 (toll-free) or (818) 876-0200
E-mail support@1099 Pro.com

Service Bureau
Phone - (866) 444-3559
E-Mail - sb@1099 Pro.com

Normal Hours
Monday - Friday, 7:00 am - 5:00 pm PST
Saturday - Closed
Sunday - Closed

Tax Season Hours (January)
Monday - Friday, 5:00 am - 6:00 pm PST
Saturday - 8:00 am - 12:00 pm PST
Sunday - 8:00 am - 12:00 pm PST

Direct Links
Tutorials: http://www.1099pro.com/videos.asp
Software download location: http://host.1099 Pro.com

IRS Telephone Assistance: Information Reporting Customer Service Site
If you have questions about reporting on Forms 1096, 1098,1099, 5498, W-2, W-2G, and W-3, you may call a toll-free number, 1-866-455-7438. You may still use the original telephone number, 304-263-8700 (not toll free). For TTY/TDD equipment, call 304-267-3367 (not toll free). The call site can also be reached by E-Mail at mccirp@irs.gov. The hours of operation for the call site are Monday through Friday from 8:30a.m. to 4:30 p.m., Eastern time. For other tax information related to business returns or accounts, call 1-800-829-4933.

Complimentary technical support is limited to questions regarding 1099 Pro software. We are NOT authorized to provide accounting, tax or legal advice. Please direct such questions to your accountant or attorney. Calls may be limited during peak tax season.

8.2.1 System Requirements

System Requirements

1099 Pro minimum system requirements include:

• Windows 7/8/10/2008/2008 R2/2012/2012 R2/2014 - NEW
• 32 or 64 bit operating system compatible
• Intel Pentium II/Celeron or AMD Athlon/Sempron/Turion (Minimum)
• 256MB RAM (512MB or more preferred)
• 100+MB free hard drive space
• For use with ANY Windows compatible printer
• Windows compatible network (optional)

CORPORATE SUITE ONLY

Requirements for Corporate Suite Workstations:
• Windows Server 2008/2008 R2/2012/2012 R2/2014
• 32 or 64 bit operating system compatible
• Intel Pentium II/Celeron or AMD Athlon/Sempron/Turion (Minimum)
• 256MB RAM (512MB or more preferred)
• 100+MB free hard drive space
• For use with ANY Windows compatible printer
• Internet Explorer® 7.0 or higher (ASP.net only)

Requirements for Web Server:
• Minimum of an Intel Xeon, i7 or equivalent
• Processor Speed of 2 GHZ
• Memory of 4GB or higher
• MS .NET Framework 4.0

Requirements for SQL Server:
• MS SQL Server 2008 or higher

1099 Pro also requires display settings of 800x600 and small fonts to properly display windows and type. Some Deskjet, Inkjet or Bubblejet printers may not print to the bottom 1/2-inch of paper.

8.2.2 Install

Install Software

To download any 1099 Pro software product please visit: http://host.1099pro.com. All software installations are two-step; requiring both the Full Install and the most recent Update.

See Multi-User/Network Installations

To Install Single-User* or Demo
1. Insert the CD-ROM into your computer's CD-ROM drive.
2. On your Windows desktop click the "Start" button and select "Run".
3. In the Open field, type x:\setup.exe, where x is the name of the CD-ROM drive and setup.exe is the name of the 1099 Pro executable.
4. Click “OK” to start the setup program.
5. Follow the instructions provided by the setup program. If 1099 Pro prior year data is detected on your system the Roll Forward Utility activates.

Virus Checkers
Disable virus checkers (e.g., Norton, McAfee, ViruScan, etc.) PRIOR to installation to avoid potential corruption. Random errors in 1099 Pro are typically due to installation of software while running a virus checker. After a successful installation, re-enable the virus checker.
8.2.3 Multi-User Installations

Multi-User Installations

All 1099 Pro software products are available in single, multi-user or unlimited-user licenses. The algorithm of your registration code indicates the edition, user license and number of transactions purchased.

Upgrade From Single-User/DEMO to Multi-User Version

1. Close all applications including 1099 Pro.
2. On your Windows desktop click the "Start" button.
3. Go to "Settings", "Control Panel" and select "Add/Remove Programs".
4. Select "1099 Pro" for the year you are upgrading and click the "Add/Remove" button.
5. At the Select Uninstall Method screen choose "Uninstall the program, but KEEP data files and backups" and then click the "Next" button to start the uninstall program.
6. 1099 Pro prompts through the remainder of the uninstall routine.
7. Once the process is completed remove the "Admin" in the installation folder for the software year just uninstalled.
8. Proceed to the appropriate multi-user installation instructions below.

1099 Pro is network neutral; either a peer or server install is acceptable. The only requirement is that one machine be designated as server and all others as workstations.

Network Installation

1. Determine a network drive and folder to install 1099 Pro. All workstations must have rights to this folder. The software can use a UNC or a mapped network drive.

2. Install 1099 Pro on the server where the data will be stored. Enter your multi-user Registration code as prompted. Select Web Update Workstation as the Install Type. Allow the program files to reside on the local drive.

3. Upon successfully installing 1099 Pro to the network, click on the "1099 Pro icon" on your desktop. The Welcome Wizard prompts through setting up the software. By default, Audit Trails and Security are enabled*. Complete the Welcome Wizard and then re-enter the software. Administrators use "Administrator" and "NEW" to logon for the first time with enabled security. Administrator must create users and assign rights prior to installing 1099 Pro to workstations.

*We recommend enabling Security. If security is disabled ANY USER on ANY WORKSTATION can access 1099 Pro and view/modify Administrator settings and all data. This includes the potential for ANYONE to create himself as Administrator and lock you out of 1099 Pro!

Workstation Installations

1. Complete network installation prior to installing workstation(s).

2. Install 1099 Pro at the workstation. Enter your multi-user Registration code as prompted. Select Workstation Installation as the Install Type. Browse for the network drive and folder (e.g., X:\1099 Pro \Pro99T17 where "X" is the mapped network drive). Allow the program files to reside on the local drive.
3. If the Administrator enabled security, the workstation is deemed a "user". Upon first entering 1099 Pro at the workstation a User ID (as assigned by the Administrator) is required. For the Password enter “NEW”. The User is then required to create their own unique password.

Multi-User Installation with Remote Data/Program Location

1. **Install Server** - Installing software a code ending with ME or MP will trigger a Multi-user installation. ALWAYS install the "Server" first noting that this PC will be the only PC where software updates can be applied. Subsequent installations are "Workstations".

2. **Remote Data/Program Location** - When installing the 'Server', you are presented with an option to have your data and program DLL's reside on another PC, Novell drive or Network Attached Storage.
   - Check the box "Allow Remote Server Installation" to start the Remote Data/Program Location.
   - Click on the "Browse" button and select the destination directory. Note that the value under "Select Destination Directory" must end with a pathname of \Pro99T17 (or similar depending if you are installing 1099, W-2 or 1042-S Pro). Note that you may select a mapped network drive or you may use UNC such as //amd800/C in this case.
   - Next you will be prompted if you wish to roll forward data such as Filers, Security Settings, … from a prior year. Once you have finished installation you can open the software, click on "Help" and "About" and then click on the graphic icon for the software and you can see the data paths involved. Note that none of the data or program files are kept on the "Server", they are kept at the Remote Server/Data Location.

3. **Install Workstations** - Perform subsequent workstation installations as needed. Be sure that each workstation has read/write/delete rights to the Remote Data/Program Location. Note: each Workstation must communicate with the Remote Server/Data Location via UNC or a mapped letter drive. Workstations do not have to communicate with the "1st Multi-user Installation = 'Server' shown above.

4. **Web Updates** - When it is time to perform a Web Update you will have to perform it from the "Server" that you just installed. Web Updates are performed at the "Server" and in this case performing the update at the "Server" will result in the program files and the data files being updated on the "Remote Server" (based on the .ini file on the "Server"). Note that workstations will communicate with the Remote Server/Data Location only and not with the 'Server' where the software was originally installed from or the Web Update was run from.

**Note:** 1099 Pro uses a local .ini file to store the data path of your remote data. Verify the following: If the 1099 Pro install was done under a different account with a drive letter mapping then that same path will need to be mapped with the same drive letter. For example: If the Administrator of the computer has the remote drive as L: and the user has the mapped drive as a K: then the user will not be able to access the data.

See Multi-User Considerations

8.2.3.1 Multi-User Considerations

Multi-User Considerations
When running 1099 Pro software's multi-user versions, some tasks require exclusive control of certain files. These tasks are detailed below.

**Record Locking**
The multi-user version of 1099 Pro software utilizes record locking when two or more users concurrently open the same record. This allows users to simultaneously view the same record but prevents them from overriding each other's changes. For example, Users A and B open the same record. User A changes an amount and saves the record. User B then changes an amount and attempts to save the record. User B receives a "Record Was Not Updated" warning and the record is automatically updated with User A's changes. User B may then select a field to restore and use the <F4> key to re-populate what they had originally entered.

**Import Locking**
During the final step of the Import Wizard, Post Import Session, the software attempts to gain control of all records. If the software is unable to gain control of a record (because someone else has the record open) it will notify the user and offer to post the files the slow, non-locking way or allow them to cancel.

**Unlocking Records**
1. Navigate to "File"
2. Click on "Security and Administration"
3. In the "Business Rules and Options" section, click on "Browse System Process Locks"
4. Highlight User and click "Delete/Remove the Selected Lock"

### 8.2.4 Data Files

**Data Files**

1099 Pro data files are suffixed with ".TPS". For example, "filers.tps" contains filer data and "states.tps" contains state data. These files are located in the Data folder and in a typical installation may be found at C:\1099 Pro\Pro99T17\Data.

**INI File**
The INI file contains information specific to your installation such as data paths and version. For example:

NetPath=C:\1099 Pro\Pro99T17
LocalPath=C:\1099 Pro\Pro99T17
InstallVersion=2015.08.16
CurrentVersion=2015.16.05

In a standard installation the "Pro99T17.INI" file is located at C:\1099 Pro\Pro99T17\Admin.

The INI file may or may not be deleted during a custom uninstall. This file can be manually deleted to totally remove software from your system or to perform a clean re-installation. This file can remain if a users wants to reinstall the software but retain their settings.

### 8.2.5 Online Help

**Online Help**

**Context-Sensitive Help**
Use the <F1> key at any screen to access context-sensitive help screens.
To search for a topic
At the 1099 Pro menu bar click "Help", "Search the 1099 Pro Help file" and at the "Index" tab type the first few letters of the word you're looking for. For example, type "ali" to display the Align Margins topic.

To print a topic
- Click the "Print" button, or
- Use "CTRL + P" to display the Print dialog box.

8.2.6 Optimize Posting

Optimize Posting

When posting very large import files, your software may run out of RAM and terminate before the Post is complete. Users can modify their INI file to optimize the Post process according to the amount of RAM in the machine running the Post. By default, the Post pauses every 2,000 records to commit new records. Users can increase (or decrease) the number of records processed between commits to speed up the process. Unless you are importing large amounts of records and have a powerful machine with lots of RAM, there is no need to modify the default value of 2,000 records.

To Optimize Posting
1. Exit the 1099 Pro software.
2. In File Explorer go to C:\1099 Pro\Pro99T17\Admin and open Pro99T17.INI.
3. In the [System] section modify the Post Commit* entry accordingly (do not enter a comma in the numeric value):
   - 32 megs of RAM: Try the default and lower to 1000 if necessary
   - 64 megs of RAM: Use the default.
   - 96 megs of RAM: Use the default or try increasing to 4000
   - 128 megs of RAM: Try 10000
   - 256 megs of RAM: Try 20000
   - 512 megs of RAM: Try 50000
   - 512+ megs of RAM: **Experiment!** 1099 Pro beta testers have successfully imported over 128,000 records in a single commit on a machine with 1 gigabyte of RAM.
4. Save your changes and exit Pro99T17.INI.
5. Open the software and post your import.

* The Post Commit entry may need to be manually added to the [System] section. Your entry should look similar to this:

   [System]
   PostCommit=2000
8.2.7 Referential Integrity Delete Error

Referential Integrity Delete Error

The "Referential Integrity Delete Error" prohibits the deletion of a Filer, Recipient, State ID or State Abbreviation from the 1099 Pro database if used in any record. For Examples:

- "Jane Doe" can't be deleted at the Browse Recipients screen if a Form 1099-MISC exists for her. Note that recipients will be retained for deleted records as well.
- "Arizona or AZ" can't be deleted at the States/Provinces screen if a Form 1099-MISC uses "AZ" in the recipient address. First eliminate "AZ" in the 1099-MISC record and then delete "AZ" at the States/Provinces screen.

8.2.8 Repair Files

Repair Files

The Repair option restores deleted files, registry settings and DLL's. It works only if you have access to the original installation .EXE from which the application was initially installed. For example, if you downloaded a setup program from the Internet to your desktop, then installed the program while it was located on your desktop, the setup program must still be located on your desktop when you attempt to use the repair option. If you installed the application from a CD, then you are prompted to insert the original installation CD after you click "Next" in the Select Uninstall method dialog box.

Did you install 1099 Pro while simultaneously running a virus checker? If so, you may have a corrupt installation. Do not attempt to repair the files; instead backup your data files, perform a custom uninstall and then reinstall the software with the virus checker disabled.

To Repair Files
1. Close all applications including 1099 Pro.
2. Backup your 1099 Pro data files.
3. On your Windows desktop click the "Start" button.
4. Go to "Settings", "Control Panel" and select "Add/Remove Programs".
5. Select "1099 Pro" and click the "Add/Remove" button.
6. At the Select Uninstall Method screen choose "Repair" and then click the "Next" button.
7. Press "Finish" to start the repair. The repair prompts to replace .TPS (data) files. Although replacing these files will not affect your data, it may impact your settings. Thus when prompted to "Repair Newer File"? we recommend selecting "No" or "No to All".

8.2.9 Safeguard TIN

Safeguard TIN

When printing forms via the Combined Print option the TIN may sometimes show through the envelope. 1099 Pro, Inc. offers the following solutions to this problem:

1. Instead of having the top panel show through the envelope try having the bottom panel show. For example, if the Combined Print option for Form 1099-R shows the recipient's TIN with the top panel (Copy B) for the mailing address, then try folding the paper so the bottom panel (Copy 2) shows through instead.
2. Try a different print driver with your printer. For example, an HP 4Si with a PCL 5 driver will give different results than a PCL 6 driver.

3. Try envelopes and paper from 1099 Pro. For example, the #8888-1 envelope is specifically designed for the Combined Print option in conjunction with blank paper stock #5145. See Tax Supplies.

4. Take advantage of the **SSN masking** feature within 1099 Pro.

### 8.2.10 Special Help

**Special Help**

Some 1099 Pro Wizard screens offer a "?" button for quick access to special help topics. This button typically offers more detailed information than what is available via the standard "Help" button or <F1> key.

### 8.2.11 Video Display Issues

**Form Display Issues**

If the data on the form appears distorted or out of alignment please follow the directions below to correct your resolution and font settings.

**Windows 10**

Adjusting your resolution and DPI settings.
1. On your Windows desktop right-click your mouse and select Display Settings.
2. At the Customize Your Display screen verify the size of text is set at 100% (not larger). Then click
"Advanced Display Settings" and verify Resolution is set at 800 x 600 (or higher). Click "Apply" and "Keep Changes". You may need to restart for these settings to take effect.

**Windows 98/NT/2000**
Adjusting your resolution and DPI settings.
1. From your desktop click Start > Settings > Control Panel. Double-click the Display icon and click the Settings tab. Verify your screen area is set at 800 x 600 (or higher). Click "Apply" then "OK".
2. From the Settings tab click Advanced, and verify font size is set at small fonts. You may need to restart for these settings to take effect.

**Windows XP**
Adjusting your resolution and DPI settings.
1. On your Windows desktop right-click your mouse and select Properties > Settings. Verify Screen Resolution is set at 800 x 600 (or higher). Click "Apply" then "OK".
2. From the Settings tab click Advanced > General and verify the DPI setting is 96 DPI. You may need to restart for these settings to take effect.

**Windows Vista**
Adjusting your resolution and DPI settings.
1. On your Windows desktop right-click your mouse and select Personalize > Display Settings. Verify Resolution is set at 800 x 600 (or higher). Click "Apply" then "OK".
2. On the Personalization screen click Adjust font size (DPI). Verify your setting is Default scale (96 DPI) – fit more information. Click "Apply" then "OK". You may need to restart for these settings to take effect.

**Windows 7/8**
Adjusting your resolution and DPI settings.
1. On your Windows desktop right-click your mouse and select Personalize > Display. Click Adjust resolution, verify your display resolution is set at 800 x 600 (or higher). Click "Apply" then "OK".
2. On the Display screen click Set custom text size (DPI). Verify scale is set to 100% (96 pixels per inch). Click OK. You may need to restart for these settings to take effect.

### 8.2.12 Screen Resolution

**Screen Resolution**

Screen resolution should ideally be set at 800x600 or greater with small fonts.

### 8.2.13 Special Help Button

**Special Help Button**

Use the <F1> key at any screen to access context-sensitive help screens. The <F1> key is located on the upper left corner of your keyboard.

### 8.3 Transmission Session Report

**1096 Session Report**
Print Session Report
The Print Session report summarizes all data for the selected transmittal.

To Generate Report
2. At the Completed Form 1096 Print Session List highlight a 1096 print session and click the "View/Print Session Report" button. Review report options and click "Yes" to generate report.

8.4 Reprint Transmission Form

Reprint 1096 Form

1099 Pro makes it easy to reprint a 1096 Transmittal.

Things to keep in mind:
- The red ink on the pre-printed 1096 is invisible to the IRS/SSA scanners. Although your data should ideally align in the proper box, it is OK if the data slightly overlaps the red ink.
- Print a test page to blank paper to minimize form waste. Align margins if data does not align in the proper box.

To Reprint Transmittal
1. On the task panel select the "Filing & Corrections" section and the "File via 1096 (paper)" icon.
2. At the Completed Form 1096 Print Session List highlight a 1096 print session and click the "Reprint Form 1096" button.
3. At the Reprint a Form screen you may enter a message to print at the bottom of the 1096 transmittal.
4. Print a test alignment to blank paper to minimize form waste. When satisfied with alignment click the "Reprint Form Now" button.
5. Click "Exit" to close this screen.

8.5 Reset Transmission Session

Reset 1096 Session

Void a 1096 and all records in that print session are automatically reset to Printed status.

To Reset Session
1. On the task panel select the Filing & Corrections section and the File via 1096 (paper) icon.
2. At the Completed Form 1096 Print Session List highlight a 1096 print session and click the "Reset (Void) 1096" button.
3. 1099 Pro prompts, "Are you sure you want to void this transmittal?" Click "Yes" to proceed or "No" to cancel.
Corrections

About Corrections - An Overview

When do I need to create a correction?
If a return is filed with the IRS/SSA and an error is discovered it must be corrected as soon as possible. Some corrections require one return, others require two. 1099 Pro software intuitively creates the appropriate corrected return(s) based on the type of correction created. Additionally, users must provide corrected returns to recipients as soon as possible. Filers may be subject to penalties for failure to file correct information returns or furnish a correct payee statement.

☐ To begin the process of making a correction(s), see Correct a Record.

Do I need to file corrections with the IRS?
Filers only need to file a correction with the IRS/SSA if incorrect data was sent to the IRS. For example, if recipient copies were mailed in January and errors were changed prior to sending data to the IRS/SSA, then no correction is necessary.

Do I need to issue corrections to my Recipients?
The IRS requires filers to issue a "correct payee statement" to their recipients.

• If forms were sent with incorrect data to recipients, but not to the IRS, consider sending recipients a revised statement from 1099 Pro reflecting the accurate data. These forms will have a "Pending" or "Printed" status in the software. The corrected box is not marked; however, some filers manually check the box with a pen to aid the recipient in distinguishing the revised (good) form from the original issue form.
  o Filers may also force an "X" in the corrected box using the Advanced Print Options. Forcing an "X" does not qualify as a legitimate correction.

• If forms were sent with incorrect data to recipients AND filed with the IRS a formal correction is required and corrected copies must be sent to the recipient and filed with the IRS. After generating the corrections these forms have a "Corr/Pend" status and the corrected box on the recipient copy is automatically marked with an "X" when printed. See Correct a Record topic.

For More Information ...
Tax year 2017 form specific IRS/SSA instructions are available within 1099 Pro and are accessible via the Help & Extras task panel by selecting "IRS Pubs & Links". Double-click on any form or instruction to open, view or print it.

About Corrections Screen
The About Corrections screen lists all form types containing corrected records.

To View About Corrections Screen
On the Help & Extras task panel select the Correcting Filed Forms link. A red check mark appears beside any form type containing corrected records.
  o Corporate Suite Users: On the Filing & Corrections task panel select the Correcting Filed Forms link. Any form type for the selected tax year containing corrected records is listed.
9.1 Auto Corrections (CS Version only)

Auto Corrections

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

See One-To-Many Corrections

The Corrections Import Process is meant to update records already in the system; records in the corrections import not found in the system will be rejected as they are Originals and need to be imported as Originals. Corrections Imports work differently depending on the types of imports you for your various forms.

- Standard - Corrections Imports can be applied to Pending, Printed and Filed Forms.
- Transactional or YTD import – Corrections Imports can only be applied to Filed Forms.

Filed Forms will result in a formal correction, correction; Pending or Printed forms result in new Pending forms. Note: Address Corrections to filed forms will update the form but not in a correction.

Correction or Revision?
If the record being corrected has a Filed status, the Auto Corrections process creates a correction ONLY if it is a One-Part correction. A one-part correction is a change that does not require a Zero form to be issued to cancel out the previously filed form. If the record being correcting has a Pending or Printed status, the Auto Corrections process makes any type of change because the record has not yet been filed, it is technically not a correction at all, but a pre-filing revision. In that case, no zero forms are created and change is applied.

Correction Guidelines - Two-Part vs. One-Part

Two-Part Corrections include the following changes: TIN, Name, State Abbreviation or Account Number. In such instances, with the regular corrections process the software creates two forms; one new Corrected form, and one "Zero" form (a Zero form contains all information on the original form but with zeroed amounts across all dollar fields to cancel the original filing).

One-Part Corrections include the following changes: Amounts, Check boxes, State Amounts (same state, different amount), or Recipient Address. These changes require only one corrected form to be issued, to correct the mistake(s) on the original form.

9.2 Correction of a Correction (CS Version only)

Creating a Correction of a Correction

The features contained within this section are available exclusively to users of the Corporate Suite edition.

This simple tutorial guides users through the process of creating a correction of a correction. A corrected form must be filed with the IRS/SSA prior to correcting a correction; if the corrected form has not yet been filed it is only necessary to make changes and save the form. It may be necessary to file a Federal or State correction depending on what is done within the correction.
Effective As Of TY 2016: For 1099 Informational Returns de minimis corrections do not need to be printed or filed UNLESS the recipient specifically requests it. Filers are no longer required to create corrections if the amount difference is $100 or less and $25 or less for any tax withheld box. See the IRS General Instructions for Certain Information Returns for specific details.

To Correct a Corrected Form
1. On the Forms & Printing task panel select the "Browse, Enter & Edit" link. Verify the appropriate Tax Year and Form Type are selected.

2. At the Browse, Enter & Edit screen highlight the recipient record to perform the correction of a correction on and click the "Change" button.

3. At the Protected Form Update Options screen click the "Initiate a NEW Correction Process" button and "Yes" to continue.
   o Note: If more than one correction form was created for this record's previous correction (for example, there were both a State and a dollar amount change, thus generating two associated records; zero/pending and correction/pending), 1099 Pro automatically bases the initial values for this NEW correction on the most recently filed correction.

Example of Form before Second Correction

4. At the Adding a Correction screen modify the information for the correction. Any modified fields display in blue and the Correction Type box specifies the type of correction.

Example of Modifying a Corrected Form
5. After making all changes click the "Save Form" button.

6. Return to the Protected Form Update Options screen where all corrections associated with this record are detailed. Click the "Close" button to exit this screen. Remember to provide a corrected form to the recipient and file with the appropriate Federal or State agency.

Example of the screen showing the Associated Corrected and Corrections Forms

9.3 One-to-Many Corrections (CS Version only)

"One-to-Many" Corrections

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

A filer may issue a Form 1099 to one recipient when the Form 1099 should have been issued to multiple recipients. This type of correction is referred to as a "one-to-many correction". In this circumstance the filer must issue a corrected record to the original recipient or "parent" and issue a new record to the appropriate recipient(s) or "children".
For example, Bank XYZ issues a Form 1099-INT to Paula Parent for $1,000.00. The 1099-INT SHOULD have been issued to Anthony Basile for $500.00, Karen Basile for $150.00 and Ron Basile for $250.00. [See Image 2 below.] Note that the original and corrected dollar amounts may differ.

To process a "one to many correction"
1. Correct the "parent" as detailed in Create Corrections.
2. After saving the corrected "parent" record click the "Create Split" button at the Corrected Options screen.
3. The Administrator prompts to add a new form, click "Yes".
4. A blank form is presented for the "child".
5. After saving the "child" record you may use the "Add Related" button to continue to add additional "children".

9.4 Corrected Options

Corrected Options

The Corrected Options screen is a useful tool for viewing corrected and associated forms; as well as for
print corrected and original forms.

Considerations:
- All forms, both corrected and non-corrected, are available at the "Work with My Tax Forms" screen.
- A corrected form may not necessarily appear next to its original form. Forms may have different TINs or names and be sorted accordingly. Or corrections may be of different form types (for example, Forms 1099-INT and 1099-DIV per Image 1).
- Some types of corrections generate two forms, while others generate only one.
- All corrections may be submitted on paper UNLESS there are 250+ corrections per filer, per form type (in which case they must be filed electronically). This is true even if your original forms were filed electronically.
- Audit trails do not track changes for corrected forms.
- 1099 Pro does NOT process corrections of already corrected forms*. Prepare such corrections manually.

* Corporate Suite software prepares corrections of already corrected forms.

## 9.5 Create Corrections

### Correct a Record

This simple tutorial guides users through the process of correcting a record. Only forms that have been filed with the IRS/SSA may be corrected; prior to filing with the IRS/SSA it is only necessary to change (or update) the form.

**As of Tax Year 2016:** De minimis corrections do not need to be printed or filed UNLESS the recipient specifically requests it. Filers are no longer required to create corrections if the amount difference is $100 or less and $25 or less for any tax withheld box. See the IRS General Instructions for Certain Information Returns for specific details.

**To Correct a Form**
1. On the task panel go to Preparing My Forms and click the "Work With My Tax Forms" link.
2. At the Work With My Tax Forms screen highlight the recipient to correct and click the "Change" button.
3. At the Protected Form Update Options screen select "Create Corrections".

4. Users are presented with an unadjusted version of the record to correct. Click on any field to adjust and enter the revised value.
   - To change the TYPE of TIN delete the ENTIRE number and then enter it with the dashes placed as appropriate for an SSN or EIN.
   - All fields with revised information values turn blue.
   - The bottom of the form includes a brief summary of any changes in the "Correction Type" box.
   - **NOTE:** The Payer/Filer/Employer field is not available to correct at this screen. To correct this field please contact the Service Bureau for support.

5. When done with corrections click the "Save Form" button. The Protected Form Update Options screen displays with the ability to view the original form or the corrected form and to view its audit trail. Click "Close" to exit this screen.
   - Remember to mail a copy of the corrected form to the recipient, AND
   - File the correction with the IRS/SSA as soon as possible.

**To Correct a CORRECTED Form**

Use this process to correct an *already filed corrected form*. Corporate Suite users please see Creating a Correction of a Correction.

1. First create a NEW record with the same information as the FIRST corrected return.

2. Mark the record as FILED (this may be forced by generating a dummy 1096 transmittal or electronic filing for it).

3. Create a correction of that record as outlined above.

**To Correct a PRIOR YEAR Form**

Corrections to prior year forms must be handled in the appropriate program year version. For example, a 2016 correction must be created in 1099 Pro 2016. Users may send that correction to the Service Bureau for filing for a fee or contact the IRS at 1-800-TAX-FORM and request a Copy A and 1096 Transmittal for the appropriate tax year and form type. To electronically submit the file yourself to the IRS/SSA FIRE Site users must first manually edit the record. For information on manually editing a prior year correction please contact the Service Bureau.

### 9.6 Delete Corrected Forms

**Delete Corrected Forms**

Only corrected forms with a *Pending* print status are available for deletion. If a corrected form with a pending print status is associated with a corrected form with any other print status, deletion is not possible. You must first reset all associated forms to pending.

**To Delete Corrections**

1. At the Work with My Tax Forms screen highlight any corrected record (Corr/Pending). Click the "Delete" button.

2. At the Associated Corrected and Corrections Forms screen highlight the record and click the "Delete"
3. The Administrator prompts to confirm deletion. Click "Yes" to continue or "Cancel" to abort.

The deleted form immediately exits the Corrected Options screen and reverts to the Work with My Tax Forms screen with its pre-corrected print status.

9.7 Protected Forms

Form Status Overview

Records with a Printed, Filed (1096/W-3/1042-T), Filed Mag, SB Filing, Corr/SB Filing or Void status are "protected" from changes or edits. Use the Protected Form Update Options screen to access these records. Available update options vary according to the record's status.

Protected Form Update Options screen

Use this screen to access protected records for viewing, reprints or generating corrections.

1. At the Preparing My Forms task panel click the "Work With My Tax Forms" link.
   - Corporate Suite Users: At the Forms & Printing task panel click the "Browse, Enter & Edit" link.
2. Highlight any record with any status except Pending.
3. Click the "Change" button to display the Protected Form Update Options screen.

<table>
<thead>
<tr>
<th>Record Status</th>
<th>Available Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending</td>
<td>These forms are ready to be printed and/or filed. Users may view, change or delete the form. Print the form and/or file the form (to paper* on IRS/SSA Copy A, electronically or through the Service Bureau).</td>
</tr>
<tr>
<td>Printed</td>
<td>These forms have been printed and are ready to be filed. Users may view the form, reset the form to pending print status, void the form, reprint the form or file the form (to paper* on IRS/SSA Copy A, electronically or through the Service Bureau). Records that were imported with a printed status cannot be void, reset or delete. The entire import session must be reset.</td>
</tr>
<tr>
<td>Voided</td>
<td>These forms have been voided. Users may view the form, unvoid the form or reprint the form</td>
</tr>
<tr>
<td>Deleted</td>
<td>These forms have been deleted and may not be undeleted. Users may view the form.</td>
</tr>
<tr>
<td>Filed 1096</td>
<td>These forms have been printed and filed via 1096 transmittal. Users may view the form, reprint the form or create corrections.</td>
</tr>
<tr>
<td>Filed Mag</td>
<td>These forms have been printed and filed electronically (magnetic media). Users may view the form, reprint the form or create corrections.</td>
</tr>
</tbody>
</table>
SB Filing
These forms have been submitted to the Service Bureau for electronic filing. Users may view the form, reprint the form or create corrections.

SB Print+Mail
These forms have been submitted to the Service Bureau for printing and mailing. Users may view the form, file the form (to paper* on IRS/SSA Copy A, electronically or via the Service Bureau), reprint the form or reset to pending.

Corr/Pending
These forms have been corrected and are ready to be printed and/or filed. Users may view the original or corrected form, reprint the original form. Print and/or file the corrected form (to paper* on IRS/SSA Copy A, electronically or through the Service Bureau). Change the corrected form or delete the correction.

Corr/Printed
These forms have been corrected and are ready to be filed. Users may view the original or corrected form, reprint the original or corrected form. File the corrected form (to paper* on IRS/SSA Copy A, electronically or through the Service Bureau). Reset the corrected form to pending status.

Corr/SB Filing
These forms have been corrected and submitted to the Service Bureau for electronic filing. Users may view the original or corrected form, reprint the original or corrected form.

Corr/Mag
These forms have been corrected and filed electronically (magnetic media). Users may view the original or corrected form, reprint the original or corrected form.

* Filers must file electronically if they have 250 or more forms of any one form type or risk IRS penalties.

Create Corrections
Refer to About Corrections and Create Corrections - A Tutorial

9.8 Reprint Corrections

Reprint Corrections

To Reprint Corrections
1. At the Work with My Tax Forms screen highlight any corrected record without a Pending print status. Click the "Change" button.
2. At the Corrected Options screen click the "Reprint Correction Form" button.
3. The Administrator prompts to reprint ALL associated corrections or just the selected form.
4. At the Print Options screen select the paper type; preprinted laser, blank stock, or pressure seal.
   • If selecting preprinted laser adjust margin alignment as necessary.
5. Select the copies to print.
6. Select the sort order to print forms (this field is ghosted if only one record is selected for print):
   • By Last Name/Company Name (default)
   • By TIN
   • By Zip Code (use to presort mailings for the post office)
• By State Abbreviation
7. Enter an optional message to print in the upper right corner of the form(s).
8. When satisfied with all entries click the "Print Now" button. Click "Close" to exit this screen.

9.9 Reprint Originals

Reprint Originals

Use to reprint the original form prior to any corrections.

To Reprint Originals
1. At the Work with My Tax Forms screen highlight any corrected record. Click the “Change” button.
2. At the Corrected Options screen click the "Reprint Original Form" button.
3. At the Print Options screen select the paper type; preprinted laser, blank stock, or pressure seal.
   • If selecting preprinted laser forms you should adjust the margin alignment as necessary.
4. Select the copies to print.
5. The "Select the Sort Order to Print Forms" field is ghosted because only one record is selected for print.
6. Enter an optional message to print in the upper right corner of the form(s).
7. When satisfied with all entries click the "Print Now" button. Click "Close" to exit this screen.

9.10 Types of Corrections

Types of Corrections

Error Type 1
Original return was filed with one or more of the following errors:
a) Incorrect payment amount codes in the Payer "A" Record
b) Incorrect payment amounts in the Payee "B" Record
c) Incorrect code in the distribution code field in the Payee "B" Record
d) Incorrect payee address
e) Incorrect payee indicator

NOTE: These errors require only one return to make the correction If you must correct a TIN and/ or name and address, follow the instructions under Error.

Correcting an Error Type 1
A. Form 1098, 1099, 5498, or W-2G
   1. Prepare a new information return.
   2. Enter an "X" in the "CORRECTED" box ( and date optional) at the top of the form.
   3. Correct any recipient information such as money amounts and address. Report other information as per original return

B. Form 1096
   1. Prepare a new transmittal Form 1096.
   2. Provide all requested information on the form as it applies to Part A, 1 and 2.
   3. File form 1096 and Copy A of the return with the appropriate service center.
NOTE: Do not include a copy of the original return that was filed incorrectly.

Error Type 2
Two (2) separate transactions are required to make the following corrections properly. Follow the directions for both Transactions 1 and 2. Do not use the two step correction process to correct money amounts.

a) No payee TIN (SSN, ITIN or EIN)
b) Incorrect payee TIN
c) Incorrect payee name and address
d) Wrong type of return indicator. For example, a Form 1099- DIV was filed when a Form 1099-INT should have been filed.

NOTE: Two separate returns are required to make the correction properly. Follow all instructions for both Steps 1 and 2.

Correcting an Error Type 2
Step 1. Identify incorrect return submitted.
1. Prepare a new information return
2. Enter an "X" in the "CORRECTED" box (and date (optional) at the top of the form
3. Enter the payer, recipient, and account number information exactly as it appeared on the original incorrect return; however, enter 0 (zero) for all money amounts.

Step 2. Report correct information.
A. Form 1098, 1099, 5498, or W-2G
   1. Prepare a new transmittal Form 1096.
   2. Do not enter an "X" in the "CORRECTED" box at the top of the form. Prepare the new return as though it is an original.
   3. Include all the correct information on the form including the correct TIN, name, and address.

B. Form 1096
   1. Prepare a new transmittal Form 1096.
   2. Enter the words "Filed To Correct TIN", "Filed to Correct Name and Address", or "Filed to Correct Return" in the bottom margin of the form.
   3. Provide all requested information on the form as it applies to those returns prepared in Steps 1 and 2.
   4. File Form 1096 and Copy A of the return with the appropriate service center.

NOTE: Do not include a copy of the original return that was filed incorrectly.

10 Account Generation Wizard

Account Generation Wizard

1099 Pro includes an optional wizard to generate account numbers for those forms missing this information. Per IRS Publication 1220 (Rev. 10/16), page 65, the IRS requires account numbers, "Enter any number assigned by the payer to payee that can be used by the IRS to distinguish between information returns. This number must be unique for each information return ...". The IRS has indicated...
they will not reject files if they do not have account numbers but by having account numbers the IRS will be able to process any corrections that they encounter.

**Why would I need to generate Account Numbers?**
IRS Publication 1220 states that the IRS now requires account numbers: "Enter any number assigned by the payer to payee that can be used by the IRS to distinguish between information returns. This number must be unique for each information return ..."

The Generate Account Number wizard creates unique Account Numbers for tax forms that have not been filed to satisfy the requirement. Users can also individually specify the Filers and/or form types to process.

- Only forms with a status of Printed or Pending are updated.
- Any form with existing Account information is NEVER overwritten, regardless of status.
- Users can manually replace generated account numbers at any time before filing with the IRS/SSA.
- The Account Wizard algorithm is the first two letters of the Recipient's last name, the IRS form code and a number unique to that form. For example, one might look like this SM-M-0001234.

See [Generating Account Numbers](#) 10.1

**10.1 How To Generate Account Numbers**

**Generate Account Numbers**

**To Generate Account Numbers**:  
1. At the menu bar select Utilities > Generate Account Numbers.  
2. At the Account Number Generation Wizard click "Next" through the screens.  
3. Confirm the settings on the Account Number Generation summary screen.  
4. Click "Finish" to begin generating Account Numbers. Existing account numbers are NEVER overwritten.

* The Generate Account Number Wizard is also available within the Print Wizard, Upload File Wizard and Electronic File Wizard.

See [Account Generation Wizard](#)

**11 Security and Administration**

**Global Administrative Options**

Access the Global Administrative Options screen via the menu bar > File > Security and Administration.

**Security**
Through the use of settings and rights administrators can restrict users and thereby protect sensitive company data.

**Add/Update Individual Users**
Administrators can use the Add/Update Individual Users screen to create users and assign them to
specific tasks.
See Adding and Updating Users

Access Groups and User Profiles
Create new Access Groups and User Profiles based on the user’s custom settings. Your groups will be available when adding or changing a user and are included in all security reports.

Passwords
Passwords can help protect sensitive company data.
See Passwords for more information

Security Access Logs
The Security Access Log tracks every time Security or Audit Trails are enabled or disabled. If Security is enabled, the Security Access Log also tracks all logon attempts.
See Security Access Logs

Security Reports
1099 Pro offers numerous reports to track users and access groups. These security reports are available only to administrators or users with administrative rights.
See Security Reports

Turn On/Off Security
1099 Pro offers two levels of security; on and off. If security is enabled, access to 1099 Pro is limited to users with valid User ID/Password combinations. These users are restricted to specific tasks assigned by the Administrator. This provides a twofold method of protecting sensitive company data.
See How to Enable or Disable Security

Tax Form Audit Trail and Action Logging Options

View Audit Trail Records
The Master Audit Trail Browser is available only to administrators or users with administrative access rights. Use it to view all manual and cascading changes to all tax forms (the Record History screen allows the viewing of individual tax forms only).
See Master Audit Trail Browser.

Purging Audit Trail Logs
The Audit Trail Record Log is invaluable for tracking tax forms changes. If the log becomes so large that the performance of 1099 Pro is compromised, older records may be purged. For most users however, purging is not necessary and is generally not recommended as this valuable information is permanently deleted from the system.
See Purging Audit Trail Logs for more information.

Combining Tax Forms (Corporate Suite Only)

Aggregation / Rollup Options
The 1099 Pro Aggregation Feature was designed to allow users to consolidate more than one tax form of the same type, for one recipient under a given filer.
See Using Aggregation for more information.
Rules & Options

Preference, Update and Program options
Configure many of the software general settings such as date range warning, update checking and backup reminders.
See Preferences for more information.

Manage ASP Module PS/ACL Access (CS version only)
Control the Pressure Seal or Alternate Combined Layout print options for the 1099 Pro.NET (ASP) module.
See Manage PS/ACL Access Control for more information.

Tax Form Validation for Import and Entry
Adjust settings to configure the warning and error messages displayed when importing or manually entering forms.
See Custom Tax Form Validation Rules for more information.

Tax Form Print Codes & Custom Messages
Create custom messages to print on tax forms or to duplicate certain fields anywhere on the form.
See Tax Form Print Codes & Custom Messages for more information.

Form Specific Rules & Settings
Adjust Form W-2 SUTA settings. ASP users may select default Puerto Rico Form 1099-MISC envelopes.
See Tax Form Print Codes & Custom Messages for more information.

Reporting Thresholds (Corporate Suite Only)

Manage State CFS Limits and Settings
The State CFS Limits and Settings Manager is a 1099 Pro Corporate Suite/ASP feature that allows users to manage reporting thresholds for state and federal returns.
See State CFS Limits and Thresholds

User Fields and E-mail (Corporate Suite Only)

Optional Form 1099-MISC Amount Box
This feature allows for a custom MISC amount box and/or custom Oil & Gas fields on Form 1099-MISC.
See MISC Optional Fields for more information.

Lookup and Code Translations
This section allows users to manage custom codes and texts for tax forms.
See Manage Custom Codes and Texts for more information.

Scheduler Utility Email Settings
This section allows users to manage the e-mail address, recipients, and messages sent by the Scheduler Utility
See Scheduler for more information.
11.1 Security Overview

11.1.1 System Security Settings/Password Requirements: Step 1

Setting Password Requirements

**Step 1: Set Security Preferences/Password requirements**

The Security Preferences/Passwords requirements section allow Administrators to configure details regarding a user's password such as password length, lockout settings, expiration, and password format. Corporate Suite additionally allows Administrators to set the login type such as tying Corporate Suite security into Windows Active Directory security.

1. To configure password/login requirements click the “Set Password requirements”/“Set Security Preferences” (Corporate Suite) button.

2. At the “Modify System Security Settings” window, configure the following settings:
   
   a. **Login Type:** *(Corporate Suite Only)*
      
      i. **Default:** Requires the user to enter the username and password assigned to during user creation (Step 4).
      
      ii. **AutoFill:** Pre-fills the login dialogue with the Windows User Name. When creating users you must use the same login name they use for Windows for this to be useful.
      
      iii. **Active Directory:** Removes login prompts instead using the Windows Domain/Username/Login that the user logged into their computer with. The username in our software must match the username they log into Windows with.

   b. **Minimum Password Length:** Defines the minimum character length the password can be; range is from 5-15 characters

   c. **Lock a User ID after this many invalid login attempts:** Sets the maximum number of times a user can fail to log in before needing to have their account unlocked by an administrator.

   d. **Days before a password expires:** Sets the length of time a user’s password is valid before they must choose a new one.

   e. **Days to warn a user before their password expires:** Defines when the software will begin notifying when the user’s password is going to expire.

   f. **Times before a password can be used again:** Defines how many different passwords must be used before a user can use the same password again.

   g. **Ignore case when validating Passwords [‘e’ = ‘E’]:** Determines whether or not the case matters when a user is entering their password.

   h. **Require at least One (1) Uppercase Character:** Determines whether or not there must be at least one uppercase character in a User’s password.
i. **Require at least One (1) Lowercase Character**: Determines whether or not there must be at least one lowercase character in a User's password.

j. **Require at least One (1) Numeric Character**: Determines whether or not there must be at least one numeric character in a User's password.

k. **Require Special Characters in Password**: Determines whether or not special characters (i.e. !, @, #, $, %, ^, etc.) are required in a User’s password. *NOTE*: You must specify which special characters are allowed before enabling this option (see “l” below).

l. **Special Characters (Up to 15)**: Define special characters which may be used during password creation.

**11.1.2 Security - Access Groups: Step 2**

### Security - Access Groups

**Step 2: Creating and Managing Access Groups**

Access Groups allow an Administrator to define the Program Areas and Form types that a User will have access to, as well as their level of access. Users only have the rights specifically assigned to them; any rights not assigned are denied by default. The rights available within 1099 Pro are View/Access area, Create, Modify, Delete, Report, Correct, Print, and Reset/Void where applicable.

1. At the **menu bar** click File > Security & Administration > Security Groups.

2. At the Security Options screen click the "Create and Manage Access Groups" button to access the Access Groups screen.

3. Click “Add” to open the Update Access Groups screen and create a new access group.
   - Users may also select “Change” or “Delete” to modify any access groups you have already created or to view the contents of a built in Access Group.
   - **IMPORTANT**: 1099 Pro includes multiple built-in access groups (indicated by a TEAL color) that cannot be modified or deleted.

4. **Assign or Modify Access Rights** at the Update Access Groups screen by entering a Group Name and then "Tag" (or select) items in the Access Form or Program Area to configure. After tagging an item click the “Modify Highlighted Records” button.

5. The Modify Access Rights window opens and the Administrator may assign specific rights to a form or program area by clicking the check box to the left of the form to modify. *If the right is ghosted or grayed out then that right is unavailable for that particular area. You may also “Select All Rights” or “Clear All Rights”.*

6. Click “Save” when done to return to the Update Access Groups screen. Administrators may add Notes for the Access Group if desired. When done modifying Access rights click "Save Changes to Group" to exit and save changes.

7. At this point the Admin may "Add", "Change" or "Delete" other Access Groups as necessary; excluding 1099 Pro’s built-in access groups. When finished click “Close” to return to the Security Options screen.
   - **IMPORTANT**: If a Program Area or Form type is “Tagged” (or selected) and no rights are assigned
to it, you have created a “View only” access rule. This will allow assigned users to enter an area or form but they will NOT be able to enter or save any changes.

11.1.3 Security - Manage Profiles: Step 3

Security - Manage Profiles

Step 3: Create and Manage User Profiles

User Profiles allow Admin to apply Access Groups to specific Filers/Departments. When assigning a user to this profile (Step 4), the User will only have the specific rights granted by that Access Group on the specified Filers. 1099 Pro’s built-in User Profiles are applied to all filers. NOTE: In order to access the 1099 Pro system, a User must have rights to AT LEAST one Filer, in other words, they must be assigned to at least one User Profile.

The diagrams below illustrate the components comprising a User Profile. In step 4 you will assign users to these profiles.

1. To create or manage a User Profile click “Create and Manage User Profiles for Filers and Access Groups” from within the “Security Options” window. 1099 Pro has built-in User Profiles. Built-in groups are colored in teal and cannot be modified or edited. NOTE: By default, all built-in User Profiles have access to all current and Future Filers.
2. Click “Add” to create a new user profile. You may also select “Change” to modify any User Profiles. The “Quick Assign” button will walk you through these steps in a wizard. “Clone Profile” will allow you to clone a previously created profile and then edit the Filers and Access Groups assigned to it.

3. After clicking “Add”, “Change”, or “Clone Profile” you will be working in the “Update User Profile” screen. Here you will assign Access groups to Filers.

To create or update a user profile follow these instructions.
   a. Create a name for the User Profile.
   b. Tag the Filers that you wish to have access to. To tag a selection highlight the line and use the “Tag” button or click in the tag column next to Filer(s) this profile will have access to.
   c. Highlight the filer you wish to configure and click the “Assign Access Groups” button to attach Access Groups that were previously created to the profiles.
   d. The “Tag Access Group” screen opens and allows you to select profiles that have previously been created (Step2).
   e. After you are done selecting profiles click “Save” to exit. NOTE: You will need to repeat steps C, D, and E for each filer that is in this profile.

4. Upon exiting the “Update User Profile” screen you are returned to the “User Profiles” window. You can continue to add, change, or delete profiles here. Once you are done updating profiles click “Close” to be returned to the “Security Options” window.

11.1.4 Security - Add/Update Individual Users: Step 4

Security - Add/Update Individual Users

Step 4: Add/Update Individual Users
Generally you will have one user for each physical user of the software. This section will guide you through creating, updating, and deleting Users.

1. To configure Users, click on the “Add/Update Individual Users” from within the “Security Options” window.

2. The “Users” window opens displaying a list of all current users in the software. The “Add User” button allows you to add a new user. The “Change” button allows you to modify an existing user or view the profiles they are associated with. The “Delete” button will remove a user from the system.

3. Clicking the “Add User” button will open the “Adding a User” window. Here you will input the login information that will be used to access the software. (or “Change User” in the case of clicking “Change” button.

The information below will assist you in adding a new user or modifying an existing user:

a. User ID: Enter that will be used to login. Note: Corporate Suite users using the Active Directory Login Type must use the same username that the user logs into their network with.

b. Password: By default all new accounts start with “NEW” as their password and cannot be edited here. You may set the requirements users must meet for passwords by clicking “Set Security Preferences” on the “Security Options” window.
c. Lock Status: this field displays whether or not an account is locked due to login failures. Click “Change” to lock or unlock an account for use. Remember to reset the password if it is a case of the user forgetting their login information.

d. (Corporate Suite only) Pre-W2K Domain: This is only used when Active Directory Login type is selected by clicking “Set Security Preferences” on the “Security Options” screen.

e. Optional Information:
   i. User Name: Provide the end users full name and email address. This does not affect login.
   ii. Phone: Supply a contact phone number for the user.
   iii. Other info: This field can be used to store other info such as department, e-mail address, location etc.

f. User Profile Membership: This field displays all of the User Profiles that the user is currently associated with. Step 5: will cover adding users to profiles.

g. Click “Ok” to complete adding a user or “Cancel” to abandon any changes

*Note: built in accounts cannot be modified or deleted*

**11.1.5 Security - Add Users to a Profile: Step 5**

Security - Add Users to a Profile

**Step 5: Add Users to Profiles:**
This last step in configuring security will guide you through the process of assigning a user to a profile created during Step 3.

**To add a User to a User Profile**
1. Click on the “Add/Remove Users from Profiles” button located on the “Security Options” window.
2. At the “Security – Assign Users” (“Available User Profiles” in Corporate Suite) screen you will assign the users you have created to a profile.
3. Select the profile you wish to add users to by clicking the “Available User Profiles” dropdown.
4. Tag the users that you wish to have applied to the selected profile. **NOTE: You must click “Save” prior to adding users to another profile.**
5. To tag a user highlight the user and click “Tag” button or click in the column to the left of their UserID.

**Select which tax years users have access to under the profile.** (Corporate Suite Only)
1. Click “Save”, “Save my Changes to this Profile/Year”
2. Repeat the steps above to add users to additional profiles.

**11.1.6 Turn On/Off Security**

Turn On/Off Security
Section 1: Accessing Security

To access the 1099 Pro security control panel, select “File” from the program menu and then select “Security and Administration”.

From the “Global Administrative Options” window, click the “Security Groups” button on the left. Security status is displayed in the blue box toward the top of the window, next to the “Security is currently: (On/Off)” text. If security is not enabled, click on the “Activate Security” button to enable it. You will be prompted to restart the program to finalize this change.

1.1.7 Passwords

Passwords

Passwords can help protect sensitive company data.

See Setting Password Requirements

First Time Logon

If security is enabled during the Welcome Wizard, the Administrator must create a new password the first time they logon to 1099 Pro.

1. In the User ID field enter Administrator; in the Password field enter NEW.

2. Click "OK".

3. The Logon screen requires you to enter a new password.
   o Passwords must be at least 6 characters.
   o Passwords are case sensitive.
   o Password cannot be "NEW"

4. After successfully creating a password, Administrators are encouraged to create Users.

I Lost My Password!

If a User forgets their password the Administrator may reset it.

1. At the menu bar click on "File" and then on "Security & Administration".

2. At the Administration screen click "Security Groups", and then click on "Add/Update individual Users".

3. At the Browse & Update the List of Users screen select the User whose password needs to be reset and click "Change".

4. At the Changing a User screen click the "Reset" button. The password is automatically reset to "NEW". The next time the User logs into 1099 Pro they are required to change the password.

If the Administrator forgets their password they must contact Technical Support. The purchaser of 1099 Pro must send a request on company letterhead stating that the Administrator password is lost and an unlock code is required. Upon receipt of this request, Technical Support will provide an unlock code for that day only.
11.1.8 Security Reports

**Security Reports**

1099 Pro offers numerous reports to track Users, User Profiles, and Access Groups. These security reports are available only to administrators or users with administrative rights.

**To generate security reports**

1. At the menu bar go to File > Security and Administration.

2. At the Administration screen click the “View/Print Security Reports” button. Available reports include:
   - **Print Users by Name**: Lists all users sorted by User ID.
   - **Users and Attached Profiles**: Lists all access users and all of the User Profiles they are associated with.
   - **Profiles and Associated Access Groups**: Lists User Profiles and the Access Groups, Filers and Departments they are associated with.
   - **Access Group Detail**: Lists Access Groups and all of the permissions assigned to them.
   - **Detailed Security Report**: Summarizes the User Profiles and Access Groups selected Users are assigned to.
   - **Security Log**: Generates a report based on the security audit trail.

3. All reports offer a print preview option.

11.1.9 Security Access Log

**Security Access Log**

The Security Access Log tracks every time Security or Audit Trails are enabled or disabled. If Security is enabled, the Security Access Log also tracks all log-on attempts.

**Browse & Manage the Security Access Log**

1099 Pro includes predefined queries for sorting access log records including:

- **All Records**: Default selection that displays all records.
- **Access for One Date**: Select this query and then enter the date for which you want to show logs.
- **Access for One User**: Select this query and then click “Select User to Show” to pick a user, or click “Show Records with No Users” for any records with an unknown user.

**Export Log-on Records to an Excel spreadsheet**:
The Security Access Log tracks all attempts to open 1099 Pro. This log can be exported for review in an Excel document:

1. At the menu bar select File > Security and Administration.
2. At the Administration screen click “Manage Security Access Logs”.
3. Click on “Export to XML” located near the bottom left.
4. Select your destination folder and click "OK"

**Purge Log-on Records**
The Security Access Log tracks all attempts to open 1099 Pro. If the log becomes so big that the performance of 1099 Pro is compromised, older records may be purged. When purging records ONLY successful log-on's are deleted. To purge records:

1. At the menu bar select File > Security and Administration.
2. At the Administration screen click "Manage Security Access Logs".
3. At the Browse & Manage the Security Access Log screen click the "Purge Log-on Records" button.
4. The Purge Audit History screen allows the user to indicate the date PRIOR to which log-on records are purged. Modify this date as necessary.
5. Click "Begin" to start deleting records. A warning screen reminds that all deletions are permanent. Click "Start Deleting" to continue or "Cancel" to abort.
   - All purge attempts are permanently recorded in the log.

### 11.2 Data Maintenance

#### 11.2.1 Backup Data

**Backup Data**

1099 Pro backups can automatically copy all data files and compress them into a WinZip format. By default, the software prompts for a daily backup. **It is smart to backup your data on a regular basis.** If a problem occurs and data files need to be restored, a backup can save time, aggravation and expense!

See Restore Data (via a backup file)

**To Modify Backup**

1. At the menu bar select File > Security and Administration.
   - Users with restricted Security settings may not have access to this area; such users should consult with their software Administrator.

2. At the Global Administrative Options screen click the "Program Options" button and under Business Rules and Options click the "Preference, Update and Program Options" button.

3. At the Preferences screen, General tab, refer to the Backing Up Your Data Files subsection.
   - Change the frequency of the backup prompt; "0" or zero for every time the software is exited, "1" for once per day, "2" for every two days, etc.
   - Uncheck the box to disable backup prompts (not recommended).

**To Backup Data**

Access the Backup Wizard as prompted automatically by 1099 Pro (see Modify Backup above). The Backup Wizard application, **Backup16.exe**, may also be accessed directly through File Explorer. In a standard installation it is located at C:\1099 Pro\Pro99T17\Data Backups. All users must exit the
software prior to running the backup.

1. At the 1099 Pro Backup Wizard screen click "Next" to proceed.

2. Select Backup Location and File Name and click "Next" to continue:
   - Accept the default location for the backup file or use the ellipses button to select another location such as a network drive or flash drive.
   - The program automatically includes the date and time of the backup file in the default name. Accept the default name (recommended!) or manually enter a name. The extension of your backup file defaults to .ZIP. **Backup twice to the same file name and the existing backup file will be overwritten!**

3. Review your backup choices and click "Back" to revise or "Proceed with Backup" to continue. This screen details Total [data] Files, Total Size and Estimated Zip Size.

4. The Administrator indicates if backup was successful.
   - Use WinZip (a shareware utility) to access your backup data. Download it at www.winzip.com.

### 11.2.2 Restore Data

**Restore Data**

Users are strongly encouraged to backup data on a regular basis. If data is damaged or destroyed a backup file can quickly restore data. **Restoring a data file means losing ALL changes made since the last backup.** See [Backup Wizard](#).

- No backup file? If you used the Service Bureau to process your forms, we may be able to recover your data files for a fee. Contact the [Service Bureau](#) for more information.

#### To Restore Data

1. Re-install the software to its BASE version (run the Full Install only). Software downloads are available on the 1099 Pro Wiki. Download the appropriate Tax Year and Version (Professional or Enterprise). Consult Technical Support with questions.

2. Locate your .ZIP backup file (e.g., "1099 Pro Backup 9-AUG-2017 9-38AM.ZIP") which in a standard installation is located in the [Data Backups](#) folder (i.e., C:\1099 Pro\Pro99T17\Data Backups).

3. Double-click the .ZIP file to open the WinZip utility and then extract the contents of this backup file - .TPS (data) files - to your [Data](#) folder (i.e., C:\1099 Pro\Pro99T17\Data).
   - Learn more about [WinZip](#).

4. Open your software and run a [Form Counts by Filer](#) report to verify accuracy of restored data.

5. After successfully restoring your data, update your software to its most recent version.

### 11.3 Rules and Options

#### 11.3.1 1099 Module Preferences

**1099 Module Preferences**
The features contained within this section are available exclusively to users of the Corporate Suite edition.

- 1099 Pro Professional/Enterprise users see Preferences.

Corporate Suite preference items allow the customization of the software. Any user with access to Security and Administration may modify preferences. Changes made at the 1099 Module Preferences screen are universal to the program; not specific to the user. Administrators may opt to restrict user access to this area by setting permissions within Access Groups.

1099 Module Preferences Tabs
- **Global**: Includes options to capitalize recipient names and/or addresses, backup data, set date ranges, current tax year form options, deleted tax form options and other special features.
- **Local**: Includes recipient city options and local options specific to each user workstation.
- **Updates Checking**: Includes settings for software updates.
- **Limits**: Includes accounting date cutoff, open window cutoff date and earliest tax year to select in software.
- **Update Options**: Includes ASP only settings, Form 1099-LTC Box 5 options, processing restrictions and Transmitter/Submitter information protection.
- **Rcp Options**: Includes options to select recipients, force recipients as 'new', bypass recipient compare and cascade processes and error level checking.

### 11.3.1 Global

See Global Administrative Options

### 11.3.2 Local

**Local Tab**

**Recipient Address ZIP Code/City Options**
- **Convert City to UPPER case during manual entry ZIP lookups**: Selecting this check box causes the program to automatically convert the City to all uppercase characters when using the software's built-in zip code to city matching utility.

- **Always convert Recipient City to UPPER case during printing**: Selecting this checkbox causes the City name to always print in all uppercase characters, regardless of what is displayed at the Work With My Tax Forms screen.

**Local Options**
- Automatically reselect the last Filer at program start: (Default On) Turning on this option will automatically start the user viewing the filer information that they were viewing when they exited the software.

1. Show a reminder when using 'Add Recipient": Turning on this option will enable a warning that states:

   "Tip: In order to reduce typing and save time, recipients are normally added to 1099 Pro as part of the process of creating their 1099 forms. You do NOT need to add a recipient here before creating a tax form for them. Do you still want to add a new recipient/employee right now?"
2. Whenever you add a recipient in the "Recipient" section. Note: You will also be given the option to disable this message, at the time this message is displayed.

3. Show a reminder that First Name is discarded for EIN/Company: Note: These options can be set/changed by the user on each workstation. Your choices here will provide the default.

11.3.1.3 Updates Checking

See Software Updates

11.3.1.4 Limits

Limits Tab

This area will allow you to set the accounting day limit entries on records, so if you enter a specific date in these areas, users will receive a warning that they cannot save the record because it goes beyond that date.

There are two different areas where dates may be entered, the Transaction/Accounting Date Cutoff, and the Open Window Cutoff Date (WEB/ASP data entry only) which is extremely useful because representatives that are only allowed to interface with the program using the internet browser, can have different limits for record creation, allowing for a method of administration. Note: If the "Accounting Date Cutoff Date" or "Open Window Cutoff Date" are left blank, the accounting date will not be enforced, and no warning will be issued, regardless of the accounting date entered at the time of the records entry.

11.3.1.5 Update Options

Update Options

Change Recipient Address on Filed Forms (ASP Only)

- Create correction: Choosing this option will allow users to allow representatives using the ASP interface to adjust the address on forms after the form has been saved, and then filed.
- Update Address for Filed Forms without creating correction: Choosing this option will allow representatives using the ASP interface to alter a record's recipient information, that has been filed, without creating a correction.

Refile Forms already filed to a State:

- Forms can not be re-filed to a State: When a eFile has been generated for the State, it will not be sent to the State via the CFS (Combined Federal & State filing program) if that option is selected in the Federal eFile creation.
- Enable option to file form already filed to a State: If a record has been submitted using the State Subset eFile creation utility it will not then be submitted to the State again if the CFS (Combined Federal & State filing program) is checked during the Federal eFile file creation process.

Change of Status from Quick Print (ASP Only)

- Disallow status changes from Quick Print: Regardless of what copies are printed using the quick print tool, the status of the form will not change.
• Allow Quick Print status chances, option will not be checked:
• Allow Quick Print status changes, option will be checked:

Restrict Creation of Filed Wrong Form Corrections:
• No Restrictions: Anyone who has access to create corrections will have the ability to choose the filed wrong form option when a record will have its information manipulated.
• Restrict for ASP only: Representatives that use the ASP interface will not be able to choose the option "Filed Wrong Form" when manipulating a filed record.
• Restrict for ASP and CS: Users in general will not have the option to choose the "Filed Wrong Form" option when choosing to alter a filed form.
• Restrict Form 1099-LTC Box 5: This area will give you the option of what information is displayed when a 1099-LTC is printed out. Note: Box 5 indicates a Chronically Ill or Terminally Ill status.
• Use Box 5 information for printing/filing: Information entered in box 5 of the 1099-LTC will be printed for all copies and included in electronic filing.
• Suppress Box 5 for printing and filing: This option suppresses printing or reporting via electronic filing information entered in box 5 of the 1099-LTC

Options for allowing "Processing Restrictions" to be used with Tax Forms.
Note: These restrictive actions are allowed by default. Enabling them to disallow use.
• Restrict "Do Not Print" option: Checking this box will disable a representatives ability to check the "Do not print" box in the ASP interface and Corporate Suite software.
• Restrict "Do Not File" option: Checking this box will disable a representatives ability to check the "Do Not File" box in the ASP interface and Corporate Suite software.
• Restrict "Do Not Merge" option: Checking this box will disable a representatives ability to check the "Do Not Merge" box in the ASP interface and Corporate Suite software.
• Restrict "User Hold" option: Checking this box will disable a representatives ability to click the "Hold" button on a form in the ASP interface and Corporate Suite software.

Specify the max number of records that will be return by Search engine in ASP: In this area you can determine how many records will be returned when a search is initiated using the "Form lookup" utility within the ASP interface, limiting this number can significantly reduce the amount of time that is used to search the database when a search criteria that is vague is used. Note: If no number is set, it will default to returning 100 records.

11.3.1.6 RCP Options

RCP (Recipient) Options

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

This area will allow you what rules apply to recipient information as it is entered into the system manually, or if it is imported into the software via the import utility.

Recipient Select options:
The following list applies only if you have an existing list of recipients within the software.

- **Select from Recipient list**: (Default) Choosing this option will allow people who are manually entering a record to pull information from the recipient list into the form.

- **Select Recipients from forms (ASP Only)**: Choosing this option will only allow people using the ASP interface to pull information from the recipients list when manually entering a record.

- **Select Recipients from Forms (Corporate Suite and ASP only)**: Choosing this option will not allow people using the Corporate Suite software, or ASP interface to pull information from the already existing recipients database.

**Force Recipients as New**

- **Do not force Recipients as new**: Choosing this option will cause the software to ask the user who is entering recipient information if they would like to update users and forms already in the recipient database. *The above option applies on both manual entry and import.*

- **All Recipients on import or manual entry are forces as new/unique**: Choosing this option will create a new entry in the recipient database for every recipients information entered into the software. *The above option applies on both manual entry and import.*

- **Disable Recipient List**: Choosing this option will disable the storing of recipients information altogether, and information will not be available to users manually entering forms, or importing them into the software.

*The following applies to the 1099 Pro Corporate Suite/ASP interface only.*

If you have the recipients list disabled during an import, the records that were imported will not be combined with future transactional imports. This is because there is no record kept of the transaction being linked to a specific recipient when the "Recipient list" has been disabled.)

**Bypass Recipient Compare process**

- **Compare Tax Form date to Recipient record on entry and offer updates**: When importing or manually entering recipient information, the software will prompt if this is newer information than the information currently stored in the recipient database.

- **Bypass Recipient Compare process for ASP only**: When manually entering recipient information into the Corporate Suite software, the software will prompt if this is newer information than the information currently stored in the recipient database.

- **Bypass Recipient Compare process for ASP and CS**: You will not be prompted when entering recipient information if this is newer information than the information stored in the recipient database in either the Corporate Suite software or the ASP interface.

**Bypass Recipient cascade process**

Recipient Cascade process depends on Recipient Compare settings. If Bypass Recipient Compare is turned on then no cascades can take place regardless of the setting for Bypass Recipient Cascade.

- **Allow cascade**: (Default) This option will allow changed in recipient information to take place across
multiple filer, and different take forms, so that if there are multiple form types for one filer, you will not have to adjust them all. This does not effect forms that have a status other than "Pending".

- **Restrict to current Filer only**: This option will allow changes in a recipients information to adjust multiple form types at the same time, but will not allow adjustments across multiple Filers.

- **Disable Cascade**: This will disable the ability for adjusted recipient information to be spread across multiple form types, and filers, all together.

**Error Level if missing Address Line 1 and 2**

- **No Error**: (Default) Turning on this option will disable the warning message if there is a missing Address line 1 or 2 for recipient information entered manually or via import.

- **Warning**: Turning on this option will give a warning message with a status of "Warning" when entering recipient information that is missing a Address line 1 or 2 for recipient information either manually or via import. The error message of warning will not prevent the tax form from being save, or from being brought into the software without prompt.

- **Error**: Turning on this option will give a warning message with the status of "Error" when entering recipient information that is missing a Address line 1 or 2 for recipient information either manually or via import. The warning status of "Error" is more severe than the status of warning, but is still capable of being brought into the software.

- **Reject**: Turning on this option will give a warning message with the status of "Reject" when entering recipient information that is missing a Address line 1 or 2 for recipient information either manually or via import. The warning status of "Reject" is the most severe message, and records with the status of reject will not be allowed to be saved in the system.

**Error Level if for SWT (State Withholding Tax) for non-taxing states**

This is the error warning that a user will see if they enter information for State Withholding Tax for a non-taxing state, this will be via the Corporate Suite software or the ASP interface, weather entered manually or imported into the software.

- **No Error**: (Default) Choosing this option will not attribute an error message to forms that are entered with State Withholding Tax on non-taxing States.

- **Warning**: Choosing this option will attribute an error message of "Warning" to forms that are entered with State Withholding Tax on non-taxing States. The error message of warning will not prevent the tax form from being save, or from being brought into the software without prompt.

- **Error**: Choosing this option will attribute an error message of "Error" to forms that are entered with State Withholding Tax on non-taxing States. The warning status of "Error" is more severe than the status of warning, but is still capable of being brought into the software.

- **Reject**: Choosing this option will attribute an error message of "Reject" to forms that are entered with State Withholding Tax on non-taxing States. The warning status of "Reject" is the most severe message, and records with the status of reject will not be allowed to be saved in the system.
11.3.1.7 1099 Corporate Suite and Professional/Enterprise comparison

Corporate Suite and Professional/Enterprise Comparison

Compare modifiable Preference items in the 1099 Pro Corporate Suite and Professional/Enterprise editions below. For an overview of all 1099 Pro software products view our online comparison chart at https://www.1099pro.com/products.asp. For further information please contact us at (888) 776-1099 or support@1099pro.com.

- 1099 Pro Professional/Enterprise users see Preferences.
- Corporate Suite users see 1099 Module Preferences.

<table>
<thead>
<tr>
<th>1099/1098/5498/W-2G Preferences &amp; Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CORPORATE SUITE</strong></td>
</tr>
<tr>
<td>Global (Tab name)</td>
</tr>
<tr>
<td>Options that apply to all users</td>
</tr>
<tr>
<td>Require a full name and address before a form can be saved</td>
</tr>
<tr>
<td>Auto capitalize names, addresses &amp; localities during manual entry</td>
</tr>
<tr>
<td>Hide the optional form category field on data entry forms</td>
</tr>
<tr>
<td>Remind me not to print red copy A until February</td>
</tr>
<tr>
<td><strong>Backing up your data files</strong></td>
</tr>
<tr>
<td>Creating backup files of your data files should be performed by your network and/or database administrator on a daily basis.</td>
</tr>
<tr>
<td><strong>Global date range checking</strong></td>
</tr>
<tr>
<td>Warn if dates entered on forms are outside this date range</td>
</tr>
<tr>
<td>Date is before</td>
</tr>
<tr>
<td>Or after</td>
</tr>
<tr>
<td><strong>Options for MANUALLY deleted forms</strong></td>
</tr>
<tr>
<td>Allow previously deleted forms to be visible on tax form browses</td>
</tr>
<tr>
<td><strong>2018 form options</strong></td>
</tr>
<tr>
<td>Allow users to undelete previously deleted tax forms</td>
</tr>
<tr>
<td>Do not allow</td>
</tr>
<tr>
<td>Allow Now</td>
</tr>
<tr>
<td>Not until Jan 1st 2018</td>
</tr>
<tr>
<td>-----------------------</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Options for manually deleted tax forms</td>
</tr>
<tr>
<td>Allow previously deleted forms to be visible on tax form browses</td>
</tr>
<tr>
<td>Allow users to undelete previously deleted tax forms</td>
</tr>
<tr>
<td>Special features</td>
</tr>
<tr>
<td>Active extended casino W-2G/1042-S options</td>
</tr>
<tr>
<td>Suppress no TIN message</td>
</tr>
<tr>
<td>File the CSR list by Filer if Security is on (only applies if recipient table links are disabled)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Local (Tab Name)</th>
<th>Recipient address zip code/city options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert City to UPPER case during manual entry ZIP lookups</td>
<td></td>
</tr>
<tr>
<td>Always convert Recipient City to upper case during printing</td>
<td></td>
</tr>
<tr>
<td>Local options</td>
<td></td>
</tr>
<tr>
<td>Automatically reselect the last filer at program start</td>
<td></td>
</tr>
<tr>
<td>Show a reminder when using 'add recipient'</td>
<td></td>
</tr>
</tbody>
</table>

* These options can be set/changed by the user on each workstation. Your choices here will provide the default.

<table>
<thead>
<tr>
<th>Checking for updates (Tab Name)</th>
<th>Checking for updates (Tab Name)</th>
</tr>
</thead>
<tbody>
<tr>
<td>These options help ensure that you have the most up to date version, including any last minute changes to the IRS/SSA</td>
<td>These options help ensure that you have the most up to date version, including any changes to the IRS/SSA</td>
</tr>
<tr>
<td>Ask for confirmation every time before checking TIP: Uncheck this only if your Internet connection is 'Always on'</td>
<td>Ask for confirmation every time before checking TIP: Uncheck this only if your Internet connection is &quot;Always on&quot;</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>How often the program should check for updates?</th>
<th>How often the program should check for updates?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic Adjustment (recommended)</td>
<td>Automatic Adjustment (recommended)</td>
</tr>
</tbody>
</table>
The program will check for updates occasionally during the summer, more frequently as tax season approaches, and every day at the height of tax season.

Specified interval (1-45 days) throughout the year checks will occur at the interval you set here.

Manual checking only - you will need to use the menu options to check for all updates.

**Limits (Tab Name)**

**Transaction/accounting date cutoff**

The accounting date cutoff is used to prevent users from creating or importing transactions beyond the current tax year or accounting quarter. If left blank, the restriction will not be enforced.

**Accounting date cutoff date:**

Enter the last date that transaction can be created or imported for.

**Open window cutoff date (Web/ASP data entry only)**

The open window cutoff date sets the starting date on which the web/asp module will not allow changes to certain federal and state withholding fields. If left blank, this restriction will not be enforced.

**Open Window cutoff date:**

Changes are not allowed from the specified date forward.

**Update Options (Tab Name)**

**Change recipient address on filed forms (asp only)**

Create correction

Update address for filed forms without creating correction

**Re-file forms already filed to a state**

Forms can not be refilled to a state

Enable option to file form already filed to a state

**Change of status from quick print (ASP only)**

Disallow status change from quick print

Allow quick print status changes, option will not be checked

Allow quick print status changes, option will be checked

| The program will check for updates occasionally during the summer, more frequently as tax season approaches, and every day at the height of tax season. | The program will check for updates occasionally during the summer, more frequently as tax season approaches, and every day at the height of tax season. |
| Specified interval (1-45 days) throughout the year checks will occur at the interval you set here. | Specified interval (1-45 days) throughout the year checks will occur at the interval you set here. |
| Manual checking only - you will need to use the menu options to check for all updates. | Manual checking only - you will need to use the menu options to check for all updates. |
| **Limits (Tab Name)** |  |
| **Transaction/accounting date cutoff** |  |
| The accounting date cutoff is used to prevent users from creating or importing transactions beyond the current tax year or accounting quarter. If left blank, the restriction will not be enforced. |  |
| **Accounting date cutoff date:** |  |
| Enter the last date that transaction can be created or imported for. |  |
| **Open window cutoff date (Web/ASP data entry only)** |  |
| The open window cutoff date sets the starting date on which the web/asp module will not allow changes to certain federal and state withholding fields. If left blank, this restriction will not be enforced. |  |
| **Open Window cutoff date:** |  |
| Changes are not allowed from the specified date forward. |  |
| **Update Options (Tab Name)** |  |
| **Change recipient address on filed forms (asp only)** |  |
| Create correction |  |
| Update address for filed forms without creating correction |  |
| **Re-file forms already filed to a state** |  |
| Forms can not be refilled to a state |  |
| Enable option to file form already filed to a state |  |
| **Change of status from quick print (ASP only)** |  |
| Disallow status change from quick print |  |
| Allow quick print status changes, option will not be checked |  |
| Allow quick print status changes, option will be checked |  |
### Restrict Creation of Filed wrong form corrections

<table>
<thead>
<tr>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Restrictions</td>
</tr>
<tr>
<td>Restricted for ASP only</td>
</tr>
<tr>
<td>Restricted for ASP and CS</td>
</tr>
</tbody>
</table>

### Restrict form 1099LTC box 5

<table>
<thead>
<tr>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>No restrictions for entry or print</td>
</tr>
<tr>
<td>Suppress print of Box 5 for RCP copies</td>
</tr>
</tbody>
</table>

### Options for allowing "Processing Restrictions" to be used with tax forms

<table>
<thead>
<tr>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>These restrictive actions are allowed by default. Check a box to disallow use</td>
</tr>
<tr>
<td>Disable the &quot;do not print&quot; option</td>
</tr>
<tr>
<td>Disable the &quot;Do not file&quot; option</td>
</tr>
<tr>
<td>Disable the &quot;Do not merge&quot; option</td>
</tr>
<tr>
<td>Disable the &quot;User hold&quot; option</td>
</tr>
</tbody>
</table>

### Specify the maximum number of records that will be returned by the ASP search engine.

If this number is zero, search will return up to 100 records.

### RCP Options

#### Recipient Select Options

<table>
<thead>
<tr>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select from recipient list</td>
</tr>
<tr>
<td>Select Recipient from Forms (ASP only)</td>
</tr>
<tr>
<td>Select Recipient from Forms (ASP only and CS)</td>
</tr>
</tbody>
</table>

#### Force recipient as new

<table>
<thead>
<tr>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not force recipient as new</td>
</tr>
<tr>
<td>All recipients on import or entry are forced as new/unique</td>
</tr>
</tbody>
</table>

#### Bypass recipient compare process

<table>
<thead>
<tr>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compare tax form date to recipient record on entry and offer updates</td>
</tr>
<tr>
<td>Bypass recipient compare process for ASP only</td>
</tr>
<tr>
<td>Bypass recipient compare process for ASP and CS</td>
</tr>
</tbody>
</table>

#### Bypass recipient cascade process
recipient cascade process depends on recipient compare settings. If bypass recipient compare is turned on then no cascades can take place regardless of the setting for bypass recipient cascade.

<table>
<thead>
<tr>
<th>Allow cascade</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restrict to current filer only</td>
</tr>
<tr>
<td>Disable cascade</td>
</tr>
</tbody>
</table>

**Error level if missing address line 1 and 2**

| No error |
| Warning |
| Error |
| Reject |

**Error level if for SWT and non-taxing states**

| No error |
| Warning |
| Error |
| Reject |

11.3.2 **Tax Form Print Codes & Custom Messages**

**Tax Form Print Codes & Custom Messages**

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

Corporate Suite allows you to create custom print codes that will be applied to your forms at the time of printing. Print Codes allow for the insertion of a print message on the Blank Stock/Combined print out. The message can be the Duplication of a field of data on the record or it can be a static message of up to 39 characters. Up to 3 print codes can be imported or added manually at an individual tax form. Click on the "Select Codes" button to expose the codes that have been set up for use with any Filer/PTIN. Select print codes from the "Special Print Codes" box on the form entry screen. Please click here for further information on applying print codes.

To configure Tax Form Print Codes & Custom Messages, please use the following steps:

1. From the file menu, select "Security and Administration".
2. From the "Global Administrative Options" window, select "Business Rules".
3. Under the "Business Rules and Options" pane, click on the "Tax Form Print Codes & Custom Messages" button.
4. The “Browse Custom Print Codes” window displays all of your current print codes as well as a brief summary of a selected print code.
   - To add a print code, click on the "Add" button.
   - To change an existing print code, select it and click on the "Change" button.
   - To delete a print code, select it form the list and then click on the "Delete" button.
5. When adding or changing a print code, you will be required to define the following information:

- **Message Form type** - The form type that this print code will be used for.
- **A message description** - A short description of your print code. You will see this when tagging the rules that will apply to your print job.
- **The message to be printed or the field you wish to duplicate** - Define a custom message or replicate Account Number or Filer Department fields.
- **Define the position of your print code on the form** - This will define where your custom message will be printed on the tax form. Once you are done
- **The filers you wish to have access to the selected print code** - Define which Filers should have access to your print code.
  - There are two methods for selecting which filers have access to your print code. If you wish to grant all filers access to your print code, simply place a check in the "All Filers" check box on the bottom left corner.
  - You can also manually select which filers have access to your print code by clicking on the "Select (tag) Specific Filers" button. Clicking on this button will display the "Browse the Filers File" window which will display a complete list of all Filers currently in your system.
  - To select a filer, click on it (it will be highlighted afterward) and then click on the "Tag" button. You can also search for a specific PCode by typing it in the "Search PCode" box at the top left corner. To change the sort order of the Filers list click on the drop down menu labeled "Current View" at the top right corner. You can sort the Filers list by PTIN, Filer TIN or Company/Last Name.
  - When you have finished selecting your Filers click on the "Proceed to Next Step" button to
save your changes and return to the Code/Message Will Be Created window.

6. **Message will print on Copies**: This will allow you to input what forms will have your custom text printed on them, this will be determined by the alphanumeric character that you place within the box.  
   1: Placing a 1 in the text box will print your message on all "Copy 1 For the State Dept" forms.  
   2: Placing a 2 in the text box will print your message on all "Copy 2 For the Recipient to File with State Tax Return" forms.  
   B: Placing a B in the text box will print your message on all "Copy B for Recipient" forms.  
   C: Placing a C in the text box will print your message on all "Copy C for payer Forms" forms.  
   R: Placing a R in the text box will print your message on all "Combined for Recipient (B/Instructions/2)" forms

   **Note**: You can also combine the form type that this effects by placing multiple characters in the text box. I.E. 12C will place your message on all Copy 1 For the State Dept, Copy 2 For the Recipient to File with State Tax Returns and Copy C for payer Forms. Do not put spaces in-between the characters in order to have your custom message effect the maximum amount of forms.
7. Once you have completed creating your print code, click on the "Save" button to save any changes and exit the print code creation screen. You may also click on the "Cancel" button to discard any changes and exit the screen.
11.3.2.1 Using Print Codes (CS version only)

Using Print Codes

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

In order to apply your custom print codes/messages when printing your forms, you will need to select up to 3 codes/messages at the form entry screen. Print codes can be applied to forms either manually, on a per form basis or during an import.

To apply a print code manually, please use the following steps:

1. Enter the "Work With My Tax Forms" screen.
2. Select a form that is already in the system and click on the "Change" button or add a new form by clicking on the "Add" button.
3. Locate the Special Print Codes box at the bottom of the form entry window.
4. Enter the desired print code in one of the three boxes or click on the "Select Codes" button.
5. Clicking on the "Special Print Codes" button will display the Select Print Message Codes for this form window where you can select print codes to apply to your form. You can select a print code by clicking on it and then clicking on the "Tag" button. To disable a print code, click on the code and then click on the "Untag" button. You can also click on the "Untag/Remove All" button to disable all currently selected print codes. Once you have made your selections, click on the "Save" button to save your selections and return to your form.

6. You will now see that your selected print codes will be displayed in the three boxes underneath the Special Print Codes heading. These codes will now be applied when the form is printed.

11.3.3 Preferences

Preferences

Preference items allow the customization of 1099 Pro software. Any user with access to Security and Administration may modify preferences. Changes made at the Preferences screen are universal to the program; not specific to the user. In multi-user environments, Administrators may opt to restrict user access to this area by setting permissions within Access Groups.

☐ Corporate Suite Users: See 1099 Module Preferences

To Modify Preferences
1. At the menu bar select File > Security and Administration.

2. At the Global Administrative Options screen click the "Program Options" button and under Business Rules and Options click the "Preference, Update and Program Options" button.
   - Corporate Suite Users: At the Global Administrative Options screen click the "Rules &
Options" button and under Business Rules and Options click the form specific "Preferences / Options" button.

3. At the Preferences screen, tabs include; General, General (More) and Checking for Updates. Many items are checked "on" by default with the intention to help safeguard user data. Functions may be set "off" or "on" at the user's discretion by inserting or removing a check in the corresponding box.
   - Corporate Suite Users: Preferences screen tabs include; Global, Local, Updates Checking, Limits, Update Options and Recipient Option. The below listed Preference Options are included in Corporate Suite and many more as well. For information on these options please consult your Corporate Suite Account Manager.

4. Changes take place after clicking "OK" and then exiting and re-opening the software.

Preferences Options
Overall Options
Auto capitalize names, addresses and localities during manual entry.

Backing Up Data Files
Remind me to backup every X days. Users are strongly encouraged to backup data on a regular basis. To backup once per day enter "1", every two days enter "2", etc. Set to zero to backup every time the program is exited.

Global Date Range Checking*
Warn if dates entered on forms are outside of this range. Set dates are within the respective tax year. Dates may be modified by clicking the ellipses buttons.
   - Date is before 1/01/2017 (default entry)
   - Date is after 12/31/2017 (default entry)
* This feature is not available in 1042-S Pro.

Options for Manually DELETED Tax Forms
   - Allow previously deleted tax forms to be visible at the Work With My Tax Form screen.
   - Allow users to undelete previously deleted tax forms. Available in Corporate Suite only.

Other Global Options
   - Suppress/turn off the Report Wizard 'Custom Reports' option on Browses.
   - Suppress/hide all TINCheck functions and capabilities.

Recipient Address ZIP Code/City Options
   - Convert City to UPPER case during manual entry ZIP lookups
   - Always convert Recipient City to UPPER case during printing

Other Options
   - Automatically reselect the last Filer at program start
   - Show a reminder when using "Add Recipient"

Task Menu Display
   - Suppress the "Control Total Reports" option
   - Suppress the "Recipients List" option

Checking for Updates
   - Ask for confirmation every time before checking for updates. Only uncheck this box if your Internet connection is always on. When an update is available, users are always prompted prior to
download/installation, regardless of the status of this box.

- How often should program check for updates:
  - Automatic Adjustment (recommended) - The program will check for updates occasionally during summer, more frequently as tax season approaches and every day at the height of tax season.
  - Specified Interval (1 - 45 days) Throughout the Year - Checks will occur at the interval specified here.
  - Manual Checking Only
  - See Software Updates

### 11.3.4 ASP.net preferences

#### ASP.net Preferences

**Setting 1099Pro.NET Preferences**

Access ASP preference in the Corporate Suite Software via the menu bar > File > Security and Administration > “Rules & Option” button and then ”ASP Module Update Preferences/Options” button.

**ASP Module Preferences**

- Global Tab – various options like allowing deleted forms to be viewed, Allow/Disallow custom report creation.
- Local Tab – reselect the last Filer at program start.
- W-2/1042-S Tab – Skip over W-2 control number, W-2 Calc button.
- Updates Checking Tab – set how often to check for updates to .NET
- Limits Tab – Set the Accounting Date Cutoff Date and the earliest year to display.
- Update Options Tab – allow Quick Print to update the Print Status.
- Recipient Options Tab – select Recipient options.
- Group/ASP Tab – disable all Group Actions, set the Optional Custom Training Materials URL for ASP module under “Help & About”.

### 11.3.5 Custom Tax Form Validation Rules

**Custom Tax Form Validation Rules**

1099 Pro E/SQL software allows you to create and manage tax form validation rules. These rules are used for detecting errors and/or warnings on tax forms. Items such as invalid TINs, invalid zip codes, and the rules that govern how boxes should be filled out. The software does come with a basic set of rules built-in, but this new feature will allow you to create your own validation rules at any time.

1. To view, change or delete tax for validation rules, click on ”File” from the top menu and then select “Security and Administration”.
2. At the Global Administrative Options window, click on the ”Business Rules” button on the left pane.
3. Now click on the “Tax Form Validation for Import and Entry” button.
4. The Manage business Rules/Validation screen summarizes the rules for a particular form and indicates if the rule is active, where the rule is active and the severity.

5. The "DT.Imp/Web" column determines where the validation rule is applied. "DT" applies the rules to a manual data entry, "Imp" to imports and "Web" refers to users on the web/internet module. There are also three levels of error message severity. "W" is a warning, which is a non fatal problem with your form. "E" is an error which may be a fatal problem with the form and "R" is a reject which will not allow the form to be saved or imported at all. You can also define "OK" which will allow the form to be saved without warning or you can use the "Default" option, which will use the systems default rules to evaluate the form.

6. To deactivate a rule that you may want to reactivate later or customize a rule, see Business Rules/
Validation Changes for instructions.

11.3.6 Manage PS/ACL Access Control (CS version only)

Manage Pressure Seal and Alternate Layout for 1099 Pro.NET

This screen allows Corporate Suite users to manage the alternate print layout or pressure seal forms that are available to users of the 1099 Pro.NET (ASP) module. In order to make alternate layout's available simply select your tax year and form type then use the approve button to select the layouts you want available in the 1099 Pro .NET module. In the example below the N14EZ Blank Stock for 1099-Misc (Pressure Seal) layout is available to 1099 Pro.NET users.

11.4 Reporting Thresholds

11.4.1 State Reporting Thresholds

Reporting Thresholds and Options

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

Corporate Suite includes the ability to manage the built-in state reporting limits/thresholds that are applied when generating a State Subset eFile. Thresholds are used to determine which amounts should or should not be reported. Typically these thresholds are set by each individual state and may vary.

- See State Reporting Thresholds & Rules
- See Combined Federal State Filing Program
Configuring Reporting Thresholds
To configure State Reporting Thresholds please use the following steps:
1. From the menu bar select File > Security and Administration.
2. At the Global Administrative Options window click the "Reporting Thresholds" button.
3. From the Reporting Thresholds and Options window, click on the Manage State CFS Limits and Settings button.

4. At the View/Manage CFS Filing Thresholds window a list of all the current state thresholds for all states is displayed. Available options include:
   - **Select State:** Select All States or an individual state to view associated thresholds.
   - **Select Year:** Select All Tax Years or a specific year to view associated thresholds.
   - **Select Form:** Select All Form Types or an individual form to view associated thresholds.
   - **Add:** Create a new threshold rule.
   - **View:** View an existing threshold rule.
   - **Delete:** Delete a threshold rule.
   - **Customize Rule:** Edit an existing threshold rule (see Customizing a Standard Rule below).
   - **Report:** Generate a report of threshold rules based on view selections (i.e. Select State, Select Form, etc).
   - **Status to Display:** Select which rules are visible based on their status (i.e. active, inactive).
   - **Rules Type to Display:** Select which rules are visible based on the type of rule (i.e. display All rules, Standard rules, etc).

Customizing a Standard Rule
To customize a built-in state threshold rule follow these steps:
1. Select the threshold rule to customize from the View/Manage CFS Filing Thresholds window by highlighting it. Click the "Customize Rule" button.
2. At the Record Will Be Added window options include:
   - **Active:** When this box is checked, the rule is enabled (active), when it is unchecked the rule will be disabled.
- **Form Type**: The Form Type the rule is associated with.
- **Rule Year**: The Tax Year to which the rule applies.
- **Rule Type**: Defines the kind of rule that is being edited (i.e., Standard, Standard (Custom) etc.).
- **State**: The state that the rule is associated with.
- **State Rule**: This box contains the actual rules used when the thresholds are evaluated.

3. If customizing a *built-in* rule the Form Type, Rule Year, Rule Type and State boxes are grayed out; users can only make the rule "Active" or "Inactive" and/or customize the "State Rule" field.

### Editing the "State Rule" box

There are two ways to edit the contents of the "State Rule" box.

1. **Manual Keying in of rules**: Users familiar with the names of the fields and mathematical symbols used to evaluate the rules can modify any existing rules or enter new rules at anytime.
2. **Right Clicking in the "State Rule" box**: Users new to customizing threshold rules should use this method.

Upon right-clicking in the “State Rule” box a menu appears with two options:
- Select Form Fields: Click on this option to choose which amount field(s) to evaluate (e.g., Box Amount 1, Box Amount 2, etc.)
Select Operator: Click on this option for a list of all available operators that can be used to evaluate your rules.

Select an operator by highlighting it and clicking the "Select High-Lighted Value" button.

11.4.2 State Reporting - Manage State CFS Limits and Settings (CS Only)

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.
See Security & Administration, Reporting Thresholds, Manage State CFS Limits & Settings, 1099-R, state of AL to follow this example.

- If your Filer has the CFS checkbox checked then your form will be filed in CFS if all the following requirements are met:
  - The state participates in the CFS Program,
  - The form type is included in the CFS Program
  - The records meets the State Thresholds (discussed below)
  - There is not a CFS Exception rule that excludes the related records from being included in the CFS file.

**State Threshold Rule Types:**

- Standard Rules - Records meeting the criteria in these rules will be filed with the state - either directly or via the CFS program.
- Standard (Custom) - These rules override Standard Rules and can be created/edited by the user. Both Standard & Standard (Custom) rules can be active and the Standard (Custom) rule will trump the standard.
- CFS Exceptions - Records meeting the criteria in these rules will be excluded from the CFS program filing even though the state & form type participate in the CFS program. This is done to accommodate state reporting thresholds for instances when states require direct filing.

NOTE: Users can inactivate rules they do not want.

See Reporting Thresholds

**11.5 SUTA Information (CS Version only)**

**11.5.1 Browse Region Code/SUTA State Table**

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

Use Region Codes to link a business entity with a specific SUTA (State Unemployment Tax Act) state. In an import, Region Codes may be used to assign a recipient to a particular state for SUTA purposes when they differ from their residence or tax state. Region Codes must be unique.

**Browse Region Code/SUTA State Table**

1. At the menu bar select File > Security and Administration.
2. At the Global Administrative Options screen click the Rules & Options button.
3. Under Form Specific Rules and Settings click the "W-2 Region Code & SUTA State Table" button.
4. At the Browse the Region Code/SUTA State Table screen use the "Add" or "Change" button to access the Region Code Update & Maintenance screen.
   - See Region Code Update & Maintenance screen
5. Region Codes are accessible on Form W-2 in the Region Code field via the <F2> key or by double-clicking your mouse.

See Adjust SUTA and Secondary State Limits for information on editing state specific values and
secondary calculations.

11.5.2 Edit Region Code/SUTA State - CS

Region Code Update & Maintenance

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

See Adjust SUTA and Secondary State Limits

Region Update & Maintenance
Region/Area codes are identifiers used to link a business entity with a specific State Unemployment Tax (SUTA) state. Region Codes are accessible on Form W-2 in the Region Code field via the <F2> key or by double-clicking your mouse.

To Edit Region Codes
1. From the Browse the Region Code/SUTA State Table screen use the "Add" or "Change" button to access the Region Code Update & Maintenance screen.
2. At the Region Code Update & Maintenance screen enter a unique Region Code to link a business entity with a SUTA state.
3. Enter the business entity's Name and Address information.
4. Click "OK" to save entry. Changes made at this screen flow through to associated Form W-2 records with a Pending print status.

11.6 Create and Manage Custom Codes (CS Version only)

Create and Manage Custom Codes

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

All tax forms now contain a 'Custom Code 1' and 'Custom Code 2'. These fields can be imported and exporting containing a code of up to 5 characters. When printing certain PS/ACL layouts this code translates to a string of up to 120 characters for recipient/combined printouts only. The message that is printed can be assigned a custom font and size.

11.6.1 Update or Change Custom Code

Update or Change Custom Code

This screen is used to modify custom codes that are when printing certain PS/ACL layouts this code translates to a string of up to 120 characters for recipient/combined printouts only. The message that is printed can be assigned a custom font and size.
11.7 Hosted Solutions (CS version only)

Hosted Solutions

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

Hosted Solutions Both Full Service & Limited Service hosting is available for 1099 Pro software through Data Processing Solutions (DPS). All hosting solutions include the application running at DPS's secure facilities and your users access to the software via secure Internet connections. See the diagram below which shows the relationship in how data is shared between both your company and our hosting provider, DPS.
Full Service includes all aspects including Importing, error reports, Federal & State Filings, Corrections, etc. DPS is the premier hosting solution with extensive experience in the Insurance, Banking, Oil & Gas and Financial Industries.

For more information visit our site at [http://www.1099pro.com/serv_Hosting.asp](http://www.1099pro.com/serv_Hosting.asp) or contact:

1099 Pro, Inc.  
Hosting Services  
23901 Calabasas Road, Suite 2080  
Calabasas, CA 91302  
Tel: (866) 444-3559  
Fax: (818) 876-0202  
E-Mail: Hosting Department

11.8 Installing

Install Software

To download any 1099 Pro software product please visit: [http://host.1099pro.com](http://host.1099pro.com). All software installations are two-step, requiring both the Full Install and the Update.

- See Multi-User/Network Installations

**To Install Single-User* or Demo**

1. Insert the CD-ROM into your computer's CD-ROM drive.  
2. On your Windows desktop click the "Start" button and select "Run".  
3. In the Open field, type x:\setup.exe, where x is the name of the CD-ROM drive and setup.exe is the name of the 1099 Pro executable.  
4. Click "OK" to start the setup program.  
5. Follow the instructions provided by the setup program. If 1099 Pro prior year data is detected on your
system the Roll Forward Utility activates.

Virus Checkers
Disable virus checkers (e.g., Norton, McAfee, ViruScan, etc.) PRIOR to installation to avoid potential corruption. Random errors in 1099 Pro are typically due to installation of software while running a virus checker. After a successful installation, re-enable the virus checker.

11.9 Logging in as a Different User

If logged in with a user account in 1099 Pro, you may log off your existing user and log in as a different user without fully closing the software. Follow the steps below to log in as a different user. IMPORTANT! You must first close all screens in 1099 Pro using the close button at the bottom right. ”Logon as Different User” will only appear once you close all top level screens and you can see the following window in your 1099 Pro software.

Steps to change your current logon account.
1. Click on “File” on the toolbar at the top in 1099 Pro.
2. Select “Logon as Different User”
3. When you are prompted with the 1099 Pro logon screen, type in your User ID and then your password.
4. Click "OK".
Finally verify your login has changed by checking the user currently logged in in the bottom right corner of the screen.

11.10 Optional Field Filters

Optional Field Filters

The following features are available exclusively to users of the Corporate Suite edition of our software.

Optional Fields
Optional Grouping/Filtering Fields
Source
Batch ID
Category
Alternate Acct/Info - Specific to 1099-INT,

Codes & Flags
Special Print Codes
Select for Print/Export
Custom Codes
Processing Restrictions

Print/Export Checkbox
The print/export checkbox is an additional filter when exporting or creating custom queries. This checkbox allows users to tag (or select) individual records for a future print/export process without having to print each record individually. This allows companies the ability to consolidate print runs, standardize print processes, and to automate print processes through integration with the 1099 Pro Scheduler. See Print/Export Checkbox.

11.11 1099-MISC Optional Fields

MISC Optional Fields

Form 1099-MISC provides optional fields for custom recipient reporting.

See data entry specific Optional Field Filters (as highlighted in green in the below image).

Optional Text Line 1/Line 2 Fields
These fields allow users to enter a maximum of 30 alpha-numeric characters per line. This data prints on Combined Recipient copies only; it is not provided to the IRS. Users may import data to these fields or directly enter it at the 1099-MISC data entry screen. This field is available to users of both 1099 Pro and Corporate Suite software.
The following options are available exclusively to users of the Corporate Suite edition.

Optional Amount Box
1. On the Corporate Suite menu bar select File > Security and Administration.

2. At the Global Administrative Options screen click the "User Fields and Email" button.

3. Under Optional Fields, select the "Allow use of 1099-MISC extra amount box" checkbox.

4. Enter a title for the box and click the "Apply Now" button to save changes and close the screen.
   - The amount box and custom title display on the 1099-MISC data entry screen to the right of the Account Number field (see example, "MISC Optional Box" in below image).
   - The optional amount box and title print only on the Combined Recipient Copies; this information is not reported to the IRS.

5. Users may need to exit and re-enter CS for changes to take effect at the 1099-MISC data entry screen.

Oil & Gas Amount Fields
1. On the Corporate Suite menu bar select File > Security and Administration.

2. At the Global Administrative Options screen click the "User Fields and Email" button.

3. Under Optional Fields, click the "Manage 1099-MISC Oil & Gas Fields" button.

4. At the Update Custom Fields screen users may select the "Activate Optional Oil & Gas Amount" checkbox for a maximum of three fields.
   - Enter a Custom Name to display on reports (required).
   - Use the Update Form Prompt field to enter an optional field description to display at the 1099-MISC data entry screen (see example, "OIL & GAS 1" in below image).
   - The oil & gas amount boxes and titles print only on the Combined Recipient Copies; this information is not reported to the IRS.

5. Click the "Save" button to save changes and close the screen.

6. Users may need to close and restart CS for changes to take effect at the 1099-MISC data entry screen.
11.12 Set Aggregation Rules (CS Version only)

Setting Aggregation Rules

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

See Aggregation

Aggregation allows users to group similar records of the same PCode (PTIN) and Form Type together into one record.

To Turn On Aggregation
1. On the menu bar select File > Security & Administration.
2. At the Global Administrative Options screen select the "Combining Tax Form" button.
3. At the Aggregation/Roll-Up Options screen select the "Turn ON Aggregation" button.

To Turn Off Aggregation
1. To remove existing aggregation from a tax form uncheck the Enable Aggregation box.
2. When finished, click "Save/Apply Changes" to save your changes.
   o All forms currently aggregated will be de-aggregated and listed as individual tax forms again.
   Users may not turn off aggregation if any forms associated with the process have a protected status (e.g., Filed, etc.)
Select the tax form to aggregate on.
1. Select the tax form to enable Global Aggregation for and click the "Set/Change Matching Criteria button". *First time users must set aggregation rules which determine current rules for combining tax forms in a particular order. Tax forms which match all of the selected criteria for the Filer will be combined into a single aggregate form.*

Set Aggregation Rules
1. The list of available fields are TIN, Account Number, Tax State, Category, Form Source & Department.
2. From the list of Available Fields for Aggregation window on the left, click to highlight the field, then drag the field over to the left side window entitled, "Selected Fields for Aggregation".
3. To adjust the order of the fields, use the up and down arrow keys. When finished, click "OK" and "Save" to apply your changes.
4. The software aggregates the forms according to these rules.

Exceptions for Individual Filers
Aggregation can also be set for filers individually as an exception.
1. Click "Add" to add an aggregation exception for a filer. Select the filer from the list and then click "Select".
2. The list of available fields are TIN, Account Number, Tax State, Category, Form Source & Department.
3. From the list of "Available Fields for Aggregation" window on the left, click to highlight the field, then drag the field over to the left side window entitled, "Selected Fields for Aggregation".
4. To adjust the order of the fields, use the up and down arrow keys. When finished, click "OK" and "Save" to apply your changes.
5. The software aggregates (by/on) the chosen fields for this filer for the specified form type.

11.13 Un-Installing

Uninstall Routines

The Select Uninstall Method screen offers two options for removing 1099 Pro from your hard drive:
- "Custom" allows the user to select files individually (recommended).
- "Automatic" initiates a default uninstall routine.

Uninstall 1099 Pro (Custom)
1. Close all applications including 1099 Pro.
2. On your Windows desktop click the "Start" button.
3. Go to "Settings", "Control Panel" and select "Add/Remove Programs".
4. Select "1099 Pro 2017" and click the "Add/Remove" button.
5. At the Select Uninstall Method screen choose "Custom" and then click the "Next" button to start the uninstall program.
6. Files are categorized for deletion. Users may "Select All" (recommended), "Select None" or use their mouse to select specific files. Categories include:
   - System Files
   - Directories
7. After selecting appropriate files click "Finish" to complete the uninstall.

**Uninstall 1099 Pro (Automatic)**
The Automatic uninstall process retains your current data files under the main program directory in the folder named "Data", preserves the "Uploads" folder containing any uploads generated by the 1099 software for submission to the Service Bureau, and miscellaneous .DLL files are left in the Program root directory used by the software. In addition the .INI file is also preserved in the \Admin or \Windows directory.

1. Close all applications including 1099 Pro.
2. On your Windows desktop click the "Start" button.
3. Go to "Settings", "Control Panel" and select "Add/Remove Programs".
4. Select "1099 Pro" and click the "Add/Remove" button.
5. At the Select Uninstall Method screen choose "Automatic" and then click the "Next" button to start the uninstall program.
6. 1099 Pro prompts you through the remainder of the uninstall routine.

**NOTE:** Users who uninstall 1099 Pro and then reinstall it may get an "Invalid Record Declaration (47) Accessing TAXDATA.TPS [or FILERS.TPS]. Press OK to end this application" warning. This error occurs because some files were not deleted during the automatic uninstall. Users must perform a custom uninstall of 1099 Pro (and select all files for deletion) and then reinstall the software.

# 12 Audit Trails

**Audit Trails Overview**

Audit Trails DO NOT track the history of manual and cascading changes to a tax form including old and new values, date changed and the user responsible for changes. **NOTE:** If Audit Trail Records don't reflect a known change; Audit Trails are (or were) disabled.

**Master Audit Trail Browser**
The Master Audit Trail Browser is available only to administrators or users with administrative access rights. Use it to view all manual and cascading changes to all tax forms (the **Record History** screen allows the viewing of individual tax forms only).

See [Master Audit Trail Browser](#).

**About Record History**
The Record History screen displays audit trail information for the selected tax form and is available to all *Access Groups*. A limited version of the **Master Audit Trail Browser**, this screen tracks all manual changes made directly to a record. **Cascading updates** are not reflected.

See [Record History](#) for more information.

**Purging Audit Trail Logs**
The Audit Trail Record Log is invaluable should you need to track tax forms changes. If the log becomes so big that the performance of 1099 Pro is compromised, older records may be purged. For most users
however, purging is not necessary and is generally not recommended as this valuable information is
permanently deleted from the system.
See Purging Audit Trail Logs for more information.

Enabling/Disabling Audit Trails
Disable Audit Trails only if speed/performance is critical to the user. By disabling this feature tax form
changes are not tracked AND the Record History screen is automatically disabled.
See Enabling/Disabling Audit Trails

12.1 Audit Trails Activity Report

Audit Trails Activity Report

This tutorial will guide you through the process of printing a report of all audit trail activity related to one
or more areas in your 1099 Pro software.
1. The Audit Trail Activity Report is available by launching the software.
2. Click on “File” from the main menu.
3. Click on “Security and Administration”.
4. Click on the “Audit Trails & Logging” button.
5. Click the “View/Print Audit Changes Report” button.
6. Select the options you would like to have included in your Audit Trail Activity Report and then click the
   “OK” button.
7. You will now be brought to a screen that will ask, “Do you wish to PREVIEW this Report?”
   a. Click the “Yes” button to access the preview options
   b. Click the “No” button to send the Audit Trail Activity Report to the printer without
      previewing.
   c. Click the “Cancel” button to continue without generating the Audit Trail Activity Report.

Note: Once the report prints out, use the following legend to determine what changes have been made to
the records and filers on the report.

Definitions of the items on the “Audit Trail Activity Report” are as follows:
T = TIN (Tax ID Number)
N = Recipient Name
R = Recipient Name
A = Account (#)

Old values are on the left
New values are on the right

Subtitle: Audit report tool doesn't know what was done with the record.
TransType: Audit report tool doesn't know what was changed on any transactions.
12.2 **Deleted Record Detail**

**Deleted Record Detail**

From the Master Audit Trail Browser, click the "Deleted Record Details" button to display the contents of a deleted tax record. *NOTE: The Master Audit Trail Browser will not reflect records that were deleted while Audit Trails were disabled.*

See [Master Audit Trail Browser](#)

12.3 **Master Audit Trail Browser**

**Master Audit Trail Browser**

The Master Audit Trail Browser is available only to administrators or users with administrative access rights. Use it to view all manual and cascading changes to all tax forms (the Record History screen allows the viewing of individual tax forms only).

**To View Records**

1. On the menu bar select File > Security and Administration.
2. At the Administration screen click "Audit Trails & Logging", "View Audit Trail Records".
3. At the Master Audit Trail Browser screen refer to the Date, Time, User ID, Field Name, Old Value and New Value columns for invaluable information.

12.4 **Purge**

**Purge Audit Trail Log Records**

The Audit Trail Record Log is an invaluable tool for tracking tax forms changes. If the log becomes so big that the performance of 1099 Pro is compromised, older records may be purged. For most users however, purging is not necessary and is generally not recommended as this valuable information is permanently deleted from the system.

**To purge audit trail log**

1. On the menu bar select File > Security and Administration.
2. At the Administration screen click "Purge Audit Trail Records".
3. At the Purge Tax Data Audit Trail Record screen all records prior to the selected date are deleted. Modify this date as necessary.
4. Click "Begin" to start deleting records. A warning screen reminds that all deletions are permanent. Click "Start Deleting" to continue or "Cancel" to abort.

12.5 **Record History**

**Record History**

The Record History screen displays audit trail information for the selected tax form and is available to all Access Groups. A limited version of the Master Audit Trail Browser, this screen tracks all manual changes made directly to a record. Cascading updates are not reflected. *NOTE: If Record History does not reflect a known change to a tax form, Audit Trails are, or were, disabled.*

Copyright 1099 Pro® 2017
12.6 Turn Audit Trails On/Off

Turn Audit Trails On/Off

Disable Audit Trails only if speed/performance is critical to the user. By disabling this feature tax form changes are not tracked AND the Record History screen is automatically disabled.

To turn audit trails On/Off
1. On the menu bar click "File" and "Security and Administration".
2. The Administration screen indicates if Audit Trails are on or off.
   - Click "Activate Audit Trails" to turn on functionality.
   - Click "Turn OFF Audit Trails" to turn off functionality.

To view record history
At the "Work with My Tax Forms" screen highlight a record and click "Change".
   - Records with a pending print status display the Changing a Record screen. Click the "Audit Trail" button located in the upper right corner of the screen.
   - Records with any other print status display the Protected Form Update screen. Click the "Field Update History" button.

12.7 Audit Trail Report Filters

Audit Trail Report Filters

1. In this section you may print or view a report showing an audit trail using that are narrowed down by filters.
2. To begin this process click on the "File" button on the menu bar.
3. Then Click on the "Security and Administration" button, this will bring you to the "Global Administrative Options" window.
4. From here, click on the "Audit Trails and Logging" button, here you will be taken to the "Tax Form Audit Trail and Action Logging Options" window.
5. From here click on the "View/Print Audit Changes Report" button, you will be given the "Specify Audit Trail Report Filters" screen. From here you can choose what options to use to filter down what information will go into the Audit Trail report.
   o Limit Report to changes for one Form Type
     o All Forms: Choosing this option will list all available form types on your report.
     o One Form Type (select from list): This option will let you choose which forms will be used in the report from a list. You will be asked to TAG each form type you would like listed.
   o Limit Report to changes for one PCode
     o All Filers: Choosing this option will show all available PCodes on the report
     o One Filer (Select from list): Choosing this option will allow you select which PCodes will be included on your report.
   o Limit Report to changes from one User ID
     o All Users: Choosing this option will show all available UserID's on your report.
- **One User - enter User ID**: Choosing this option will allow you to choose which UserID will be used to filter down your report. (P3)

(P3)

Limit Report to changes from one User ID
- All Users
- One User - enter User ID:

- **Limit report to a Date Range**
- **None** - all dates will be shown:
  - **Today**: Choosing this option will show all changes made today.
  - **Last 7 days**: Choosing this option will show all changes made within the last 7 days.
  - **Last 14 days**: Choosing this option will show all changes made within the last 14 days.
  - **Last 30 days**: Choosing this option will show all changes made within the last 30 days.
- **Specify Other Range**: Choosing this option will allow you to choose the date range that will be used to display your Audit Trail Report. (P4)

(P4)

**Routine Query Value**

**Activity Log Report**


You can enter a date manually, use the popup calendar or select from the list of defaults (Both dates are required, and Through must be the same as or after the From date)

**Default Ranges (select an option to pre-fill the Accounting Dates)**

- Today
- Tax Year
- Q1
- Q2
- Q3
- Q4
- Jan
- Feb
- March
- Apr
- May
- June
- July
- Aug
- Sept
- Oct
- Nov
- Dec

[OK] [Cancel]

- **Deleted Record Options**
  - **All activity**: choosing this option will show you all deleted option.
  - **Skip deleted**: If you choose this option deleted records will not be displayed on your report.
  - **Only deleted**: Choosing this option will display only deleted records on your report.

6. Once you are done choosing the options you prefer, click on the "OK" button.
7. Now you will be given the option PREVIEW your report before it is printed. Click "Yes" if you would like to view the report before it actually prints out. Click "NO" to have the report begin printing or click "Cancel" to change your options before you begin printing your report.
13 Browse Records

Work With My Tax Forms

To access the Work with My Tax Forms screen go to the Preparing My Forms task panel and select the “Work With My Tax Forms” link. Use the Current Form drop menu to switch between form types.

Corporate Suite Users: In Corporate Suite the Work With My Tax Forms screen is referred to as the “Browse, Enter & Edit” screen and includes heightened functionality. To access the Browse, Enter & Edit screen go to the Forms & Printing task panel and select the “Browse, Enter & Edit” link. Use the Current Form drop menu to switch form types and Tax Year drop menu to select the appropriate year.

The Work With My Tax Forms screen allows users to view all forms - of the selected form type - which may be sorted in a designated order. From this screen users can Add, Change, Delete, Print, Total as well as perform Group Actions with their forms.

- **Current Sort/View Order** - Users may sort forms by Last Name/Company, TIN, Account or by creating a custom view. See Current Sort/View Order for further details. There are two ways to search for a form; one from the keyboard depending on your sort order and one by using your mouse.

- **Current Query/Filter** - By default all forms for the form type selected are displayed. Users can display a subset of the current form type by clicking on the “Current Query” drop down and use an alternate ready-made query, e.g. “Filed Corrections Only” or create their own custom query, e.g. “Tax State = CA, Corrected Forms Only”, etc. Note that the “Status” of a form can be used to create powerful queries to limit the records displayed. For example, if two batches of forms were imported - one with a Pending status and the other a Printed status - you could limit the forms displayed by their respective status.

ACA Custom Queries

Corporate Suite includes ACA (Forms 1095-B and 1095-C) specific queries to easily sort AIR records and search for dependent related information. At the Browse, Enter and Edit screen use the Current Query drop menu and select the desired query.

Queries Include:
- AIR Waiting – records that have been filed but the AIR ACK1095...XML acknowledgment file has not been imported.
- AIR Accepted – records that were accepted without errors by AIR
- AIR Error – records that AIR identified as having an error that should be corrected
- AIR Rejected – records that were submitted but AIR rejected the entire submission
- CI SSN Lookup – a way to find a form with a particular Covered Individual using the SSN (without dashes)
- Receipt ID Lookup – find an AIR Receipt ID e.g. 1095C-16-00012345
Add a Record
1099 Pro allows records to be added (either manually or via import) up to the user's current transaction limit. Transactions can range from 5,000 in a standard purchase up to an unlimited number of transactions.
See Adding a Record and Registration & Upgrades for more information.

Change a Record
Only records with a Pending status are available for modification.
Note: Cascading updates are changes made to a filer and/or recipient's information globally throughout all tax forms.
See Cascading Changes and Changing Records for more information.

Delete a Record
Only records with a Pending status are available for deletion. Delete records individually at this screen or in batch via Group Actions.
See Deleting Records and Group Actions for more information.
Print/View Report
This report is based on the currently selected query (if the default query, All Records, is chosen, then the report is identical to the Control Totals report).
See Print/View Reports

Group Actions Button
Group Actions allow users to tag (or select) a number of items and then perform a single action on them. In all cases, users are prompted to confirm their choice before the action is taken. For example, deleting a group of pending forms allows you to manually select any number of pending forms for removal. All associated notes for the forms are likewise deleted.
See Group Actions for more information

Browse by Form Button
The new "Browse by Form" button allows users to initiate browsing tax forms using the update form. This allows the user to quickly move from form to form while viewing all of the data for each form. When using Browse by Form, the current view and Query settings remain in effect, just as if you were using the standard browse. For example, if you are viewing the list of forms in Last Name/Company order, and have a Query to only show forms that have Notes, you will still see only forms that have notes, in Last Name/Company order, when you switch to Browse by Form mode.
See Browsing by Form for further instructions.

Quick-Print Form Button
To quickly print any tax form, regardless of print status, highlight the form and click on "Quick-Print Form".
See Quick-Print for further instructions

Email Tax Form Button
Use to e-mail tax forms to recipients. Requires a default mailing client for your computer.
See E-Mail Tax Forms for further instructions

13.1 Browse IRS Instructions

Browse IRS Instructions

The following instructions are available within your local 1099 Pro installation via the task panel under Help & Extras > IRS Pubs & Links OR may be viewed online (with an active Internet connection) by selecting the appropriate link. Corporate Suite Users: At the menu bar select Forms > IRS/SSA PDF Instructions and Blank Forms.

1099 Informational Return Instructions
General Instructions for Certain 1099 Informational Returns (rev. 1/2016)
1096 Transmittal
1098 Mortgage Interest Statement
1098-E Student Loan Interest Payments
1098-C Cancellation of Debt
1098-T Tuition Payments Statement
1099-A Acquisition or Abandonment of Secured Property
1099-B Proceeds From Broker & Barter Exchange Transactions
1099-C Cancellation of Debt
1099-CAP Changes in Corporate Control & Capital Structure
1099-DIV Dividends & Distribution
1099-G Certain Government & Qualified State Tuition Program Payments
1099-INT Interest Income
1099-K Payment Card and Third Party Network Transactions
1099-LTC Long Term Care & Accelerated Death Benefits
1099-MISC Miscellaneous Income
1099-OID Original Issue Discount
1099-PATR Taxable Distributions Received from Cooperatives
1099-Q Qualified Tuition Program Payments (Under Section 529)
1099-R Distributions From Pensions, Annuities, Retirement or Profit-Sharing Plans, IR's, Insurance Contracts, etc.
1099-S Proceeds From Real Estate Transactions
1099-SA Distributions From an SA or Medicare+Choice SA - (Formerly 1099-MSA)
3921 Exercise of an Incentive Stock Option Under Section 422(b)
3922 Transfer of Stock Acquired Through an Employee Stock Purchase Plan Under Section 423(c)
5498 IRA Contribution Information
5498-ESA Cover dell ESA Contribution Information
5498-SA or Medicare+Chose SA Information - (Formerly 5498-MSA)
W-2G Certain Gambling Winnings

ACA Compliance Instructions (CS Users Only)
1095-B Health Coverage
1095-C Employer-Provided Health Insurance Offer and Coverage

Miscellaneous Instructions*
Publication 3609 - Filing Information Returns Electronically
Form 4419 Application for Filing Information Returns Electronically/Magnetically
Form 592-B Resident and Nonresident Withholding Tax Statement
Form 8809 Request for Extension of Time to File Information Returns
Form SS-4 Application for Employer Identification Number
Form W-7 Application for IRS Individual Taxpayer Identification Number
Form W-8 Instructions for the Requester of Forms W-8BEN, W-8ECI, W-8EXP & W-8IMY
Form W-9 Request for Taxpayer Identification Number and Certification
Form W-9s Request for Student's or Borrower's Taxpayer Identification No. Certification
Puerto Rico Forms Informative Returns Electronic Filing Instructions (rev. 1/2016)

* Availability of forms and instructions is specific to softw are version installed.

IRS Telephone Assistance: Information Reporting Customer Service Site
For questions about reporting on Forms 1096, 1098, 1099, 5498, W-2, W-2G, and W-3 call toll-free (866) 455-7438 or (304) 263-8700 or E-mail mccirp@irs.gov. For TTY/TDD equipment, call 304-267-3367 (not toll free).

The hours of operation for the call site are Monday through Friday from 8:30a.m. to 4:30 p.m., Eastern time.

Other tax-related matters
For other tax information related to business returns or accounts, call (800) 829-4933.
Note: Users with an active internet connection can access many other files directly from the IRS/SSA websites. For details see Print Blank Forms & Instructions.

13.2 Entry Forms

Entry Forms

Entry forms are used to add, edit or view tax form information for a recipient. Recipients or payees are defined as the individual or entity receiving the informational return. All 1099 Pro software products allow up to 5,000 recipient records (or "transactions") in a standard installation; additional transactions may be purchased.

Navigating & Working with Entry Forms

Navigating / Filling In Forms
About Updates & Corrections
Saving & Canceling Changes
About Protected Forms
View List of Changes to a Form
Group Actions
Using Lookups

Navigating Fields / Filling In Boxes

Use the TAB key to move through fields on the tax form. To move backwards through fields use the SHIFT and TAB keys concurrently. To select/unselect a check box use the space bar and then TAB to the next field.

Updates and Corrections

Make necessary changes, additions or deletions to the form and click the "Save" button to exit and return to the Enter, Update & View screen. Any changed values or amounts turn blue to distinguish between original and corrected information.
- TINs - To change an SSN to an EIN or vice versa delete the entire number and then re-enter with appropriately placed hyphens.

If generating a correction, the IRS stipulates that the account number on the corrected form remain exactly as it was on the original form.

Saving and Canceling

Any changes made to a tax form may be saved immediately by clicking the "Save" button or abandoned via the "Cancel" button.
Changes to a Form
Group Actions
About Protected Forms
Using Lookups
Saving & Canceling

What Is a Protected Form?
A form with any status other than **Pending** is protected or locked to prevent any mismatch of data from the original record that has been mailed to a recipient and/or submitted to the IRS. This includes records with a status of Printed, Filed, SB Print-Mail, SB Filing, Filed 1096, etc. It is also possible that these forms were imported in a status other than pending in which case they would also be considered protected until they are Reset (VOIDED). Forms with a pending status may be changed or deleted.

**Use Lookups to Fill In Information**

1099 Pro allows users to select existing recipients from the Recipients Master List to add to or update a form. All recipient records are stored in a master database that is accessible on any tax form. To access this information at any data entry screen place your cursor in the Recipient TIN field and hit the <F2> key or right-click your mouse. The Select a Recipient screen appears with ALL recipients for ALL filers available for selection. Lookups are also available via the <F2> key in the Account Number, State ID Number and various Income Code fields.

**Adding a group of forms**

Group Actions let you tag/select any number of recipients, and then loop through the list creating new forms for them. The program will automatically fill in the recipient information on each new form, so all you have to do is fill in the specific box information for the form. For additional flexibility, you are also given the option to add the forms in any of four sort orders: by name, by TIN, by State or by ZIP. The Group Actions button can be found on the main Enter, Update & View screen at the bottom of the screen.

1. Click the "Group Actions" button
2. Select the Add tab, then click the "proceed with this action" button.
3. On the next screen, begin by selecting (tagging) all of the recipients you want to add to blank forms.
4. Next Select the "Sort" order in how these form will be placed.
5. Finish by filling out all information for each form and clicking "save".

**Viewing the list of prior changes to a form**

1099 lets you view a list of prior changes to a form. Records with a pending status display the Changing a Record screen. In the upper right corner of the form is an audit trails button. Click the "audit trails button". This screen tracks all manual changes made directly to a record.

**TIN Validation**

This feature checks your recipients information against the lists below

(***Note**: Please note that it is required that you have an account at TINCheck.com prior to using this feature.)

- **TIN Validation**: This verification process, for both EIN and SSN numbers, ensures that payers file accurate payee TIN/Name combinations reducing or eliminating yearly IRS TIN/Name discrepancy penalties (B-Notices, CP2100(A)s, 972CGs).
- **(DMF) Death Master File**: The DMF is a continually updated list of all known deceased individuals.
  - It is used by the financial industry as well as government agencies to prevent identity fraud.
- **(SDN/OFAC) Specially Designated Nationals (SDN/PLC) Office of Foreign Assets Control (OFAC)**: Unlike IRS penalties for TIN/Name discrepancy, payers neglecting to verify the Office of Foreign Assets Control (OFAC) lists open themselves up to civil as well as criminal penalties.
13.2.1 1099 Aggregation Feature (CS Version only)

**Tax Form Aggregation**

The features contained within this section are available exclusively to users of the Corporate Suite edition.

The Tax Form Aggregation Feature was designed to allow users to consolidate more than one tax form of the same type, for one recipient under a given filer.

For example, John Smith owns an automobile detail business and frequently comes by the movie studio to wax and wash the studio automobiles. You, the Filer, issuing the 1099-MISC form, pay John frequently on a bi-weekly basis. Instead of printing and issuing multiple 1099 forms for John you prefer to provide him with a single, combined form at year's end. This feature allows you, the Filer, to view/print the aggregated box amount totals in the tax form which is a reflection of all tax form dollar amounts for this recipient under this master tax form only.

**How Aggregation Works**

Users first set aggregation rules for the specific tax form type. Then when performing a transactional import data is automatically aggregated - based on the user's specified rules (e.g, by TIN, Name, etc.) - during each successive import. Users may view an individual record's aggregated amounts at the Changing a Form Record screen via the "Transactions" button.

The initial tax form may be manually entered and subsequent associated transactional imports are aggregated to it. However, future manually entered tax forms for the same recipient and form type are not aggregated as they are not linked to the original master tax form. **Tax forms must be imported via a Transactional Import for aggregation to occur.**

- See Setting Aggregation Rules
- See Transactional Imports
- See Name/Address Reconcile by TIN Tool

13.2.1.1 Viewing Transactions (CS Version only)

**Viewing Transactions**

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

To show the Aggregated Dollar Amounts list:
1. First, open a tax form a for recipient that contains more than one dollar amount for 1 tax form type.
2. Click the "Transactions" button on the right side of the tax form.
3. Click the "View" button to see a detail of the transaction.
13.2.1.1.1 Updating Transactions (CS Version only)

**Updating Transactions** *(This feature is only available in the Corporate Suite version of the 1099 Pro Software)*

This screen will allow you to edit transaction's that were previously entered. Currently disabled!

13.3 Browsing by Form

**Browsing By Form**

The Work With My Tax Forms screen now offer the ability to browse all tax forms (of the same form type, same filer) using the update form. This allows the user to quickly move from form-to-form and view data.
To Browse By Form
1. On the Preparing My Forms task panel click the "Work With My Tax Forms" link.
2. Select the type of tax form to browse.
3. At the Enter, Update and View screen select the individual form to start browsing at.
4. Click the "Browse By Form" button located at the bottom center of the screen.
   - Use the PageUp ("pgup") and PageDown ("pgdn") keys to move forwards/backwards through the forms.
   - If a form has a protected status (Printed, SB Filed, MagMedia, etc.) users may only VIEW the form.
   - Forms with a Pending status are available for EDITS. To continue browsing forms after making changes to a Pending form, simply press the PageUp/PageDown keys to continue.
5. To exit the Browse By Form feature use the Escape ("esc") key on your keyboard or click the "Cancel" button on the tax form.

NOTE: When using Browse by Form, the current View and Query settings remain in effect, just as when using the standard browse. For example, if viewing the list of forms in Last Name/Company order, and have a Query to only show forms that have Notes, you will still see only forms that have notes, in Last Name/Company order, when switching to Browse by Form mode.

13.3.1 State Status

State Status Legend

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

Note if the state is known then the status below will be preceded by the state abbreviation. For example, CA Orig/Pending

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orig/Pending</td>
<td>Record is to be filed as State Original</td>
</tr>
<tr>
<td>Orig/Filed</td>
<td>Record was filed with State as Original</td>
</tr>
<tr>
<td>Orig/Filed CFS</td>
<td>Record was filed CFS as Original</td>
</tr>
<tr>
<td>Orig/Filed ST corr/</td>
<td>Record is filed with State as Original and all State Correction(s) that exist for the record filed with the State(s)</td>
</tr>
<tr>
<td>Filed</td>
<td></td>
</tr>
<tr>
<td>Orig/Superceded</td>
<td>Record was IRS filed but not filed with the state. Then a correction was created which will be an Original to the state.</td>
</tr>
<tr>
<td>Orig/Pending but</td>
<td>Record was IRS filed but not filed with the state. Then a correction was filed with the IRS. And then a correction of a correction was created which will be an Correction to the state.</td>
</tr>
<tr>
<td>Superceded</td>
<td></td>
</tr>
<tr>
<td>Orig/Filed but</td>
<td>Record was IRS filed but not filed with the state. Then a correction was filed with the IRS &amp; with the state. And then a correction of a correction was created which will be an Correction to the state.</td>
</tr>
<tr>
<td>Superceded</td>
<td></td>
</tr>
<tr>
<td>Orig/n\a</td>
<td>Original State records for one of the non taxing states</td>
</tr>
<tr>
<td>Corr Active</td>
<td>Record was filed with State and at least one state correction for the records is pending</td>
</tr>
<tr>
<td>Corr/Pending</td>
<td>Record is to be filed as State Correction</td>
</tr>
<tr>
<td>Corr/Filed</td>
<td>Record is filed with State as Correction</td>
</tr>
<tr>
<td>Corr/Superceded</td>
<td>Record is created as state Correction but superceded by creating of new correction</td>
</tr>
<tr>
<td>Corr/Pending but</td>
<td>Record was IRS &amp; state filed. Then a correction was filed with the IRS. And then a correction of a correction was created which will be an Correction to the state.</td>
</tr>
<tr>
<td>Superceded</td>
<td></td>
</tr>
</tbody>
</table>
Corr/Filed but Supercended | Record was IRS & state filed. Then a correction was filed with the IRS and with the state. And then a correction of a correction was created which will be an Correction to the state.
---|---
Corr/n/a | Correction State records for one of the non taxing stated
n/a/n/a | No state information on the record

### 13.4 1042-S

**Browse, Enter & Edit Screen**

The 1042-S Browse, Enter & Edit screen (sometimes referred to as the Work With My Tax Forms screen) provides direct access to recipient forms. At this screen numerous options are available for records as discussed below.

**Access the Browse, Enter & Edit Screen**

1. At the [Forms & Printing task panel](#) select the Browse, Enter & Edit link.
   - Use the Tax Form drop menu to select the appropriate Tax Year.
   - Use the Current Form drop menu to select the appropriate Tax Form.

**Sort By Options**

**Current View:** Allows users to sort records by TIN, Last Name/Company or Account Number or to define their own Custom View. See [Current View](#) for specifics.

**Current Query / Custom Query:** By default all records for the selected form type are displayed. To display a subset of the current form type use the "Current Query" drop menu and select an alternate predefined query such as "Corrections (Filed)" or "Errors Only".

Savvy users may create custom queries (e.g., Tax State = CA, Date Imported = X/XX/XXXX, etc.). Furthermore, the [FormStatusCode](#) (Printed, Pending, or Filed) when used in conjunction with other fields can create powerful queries to limit the records displayed.

**Add a Record**

Manually add records at this screen or use the [Import Wizard](#) to quickly import records. If preparing more than 250 records of any one type for a filer, you must file those records electronically.

**Change a Record**

Only records with a pending status are available for modification. Users may reset or void a Print Session to revert records to a pending status.

**Delete a Record**

Only records with a pending status may be deleted. To delete all other records users must first reset their print status.

**1042-S Report**

This report is based on the currently selected query (if the default query, All Records, is chosen, then the report is identical to the Control Totals report).

**Custom Reports**

Users may create and save tax form specific, custom query reports.
Group Actions Button
Group Actions allow the users to tag (or select) a number of items and then perform a single action on them. In all cases, the user is prompted to confirm their choice before the action is taken. For example, deleting a group of pending forms allows for the manual tagging of any number of pending forms for removal. All associated notes for the forms are also deleted. See Group Actions for more information.

Browse by Form Button
All tax form browses now have a new button on them to initiate browsing tax forms using the update form. This lets you move from form to form while viewing all of the data for each form. When you use Browse by Form, your current View and Query settings will still be in effect, just as if you were using the standard browse. For example, if you are viewing the list of forms in Last Name/Company order, and have a Query to only show forms that have Notes, you will still see only forms that have notes, in Last Name/Company order, when you switch to Browse by Form mode. See Browsing by Form for further instructions.

Quick Print Form Button
To quickly print any record from the Browse, Enter & Edit screen, highlight the record and click the "Quick-Print Form" button. See Quick Print for further instructions.

13.5 Add a Record
Add a Record

A standard installation of 1099 Pro allows up to 5,000 records (or tax forms); bump codes may be purchased at any time. Please visit https://www.1099pro.com/videos.asp and select the "How to Add a Form" video for a brief tutorial on the process.

1. At the Preparing My Forms task panel click the "Work With My Tax Forms" link. Use the Current Form drop menu to select the form type to process.
   - Corporate Suite Users: At the Forms & Printing task panel click the "Browse, Enter & Edit" link. Use the Current Form drop menu to select the form type to process and Tax Year drop menu to select the year.
2. At the Work with My Tax Forms screen click "Add" to access the Adding a Form Record screen.
3. After completing all fields click "Save". The record is saved and a blank screen is presented for your next record. Click "Cancel" to exit the Adding a Form Record screen.

13.6 Void Records
Void Records

Records are Voided, instead of deleted, to retain data for possible future reference. Only records with a Printed status can be voided.

To Void a Record
1. At the "Work with My Tax Forms" screen highlight a record and click "Change" to access the Protected Form Update Options screen.
2. Click the "Void the Form" button.
3. 1099 Pro prompts, "Are you sure you want to do this?" Click "Yes" to void the record.

**Un-Void a Record**
A voided record may be un-voided (or reset) to a Pending status.

**To Un-Void a Record**
1. At the "Work with My Tax Forms" screen highlight a record and click "Change" to access the Protected Form Update Options screen.
2. Click the "Un-Void the Form" button.
3. 1099 Pro prompts, "Are you sure you want to do this?" Click "Yes" to un-void the record. The record automatically reverts to Pending status.

# 13.7 Browse Notes/Attachments

## Browse Notes

All tax forms, recipient forms and filer forms now have an icon/button to the left of the SAVE button that lets you create and update notes for that item.

When you are on a data entry form, the Notes button will change colors to help you know if there are existing notes or not.
- If the button background is BLUE, no notes have been entered for the item yet, or any existing notes have been deleted.
- If the button background is RED, there are currently notes for the item.

Each note can contain up to 512 characters, and you can have as many notes as you want for each item. Every time a note is created or updated, the note will show the date and time of the action and either the User ID of the person who made the change (if you have Security turned on) or the network name/ID of the machine where the change was made.

Depending on the type of note, you may be able to view and update them from multiple places within the program.

### Global Notes
These are visible everywhere within the program, and can be viewed and updated from every Notes browse. You can also enter Global Notes directly from the main File menu, using the ‘Global Notes’ option.

### Filer Notes
Filer notes are associated with a specific Filer, and are only available on the update form for that Filer. When entering notes for a Recipient, you can also view/update all Global notes.

### Recipient Notes
Recipient notes are associated with the individual recipient, and can be viewed and/or updated from both the recipient update form and from every tax form associated with that recipient. When entering notes for
a Recipient, you can also view/update all Global notes.

**Tax Form Notes**
This type of note is attached to one specific tax form for one recipient. When entering notes for a tax form, you can also view/update the notes for the recipient of the form, as well as view/update all Global notes.

**Attachments**
*(Corporate Suite/ASP Version Only)*
You may attach documents to Filer/Form/Recipient Notes. You will be able to View/Download these documents from the program.

### 13.7.1 Update Notes

**Update Notes**

This screen will allow you to add or modify note. Please see Browse Notes/Attachments for all available note types.

### 13.8 GIIN Validation

**GIIN Validation**

GIIN is a Global Intermediary Identification Number assigned to a PFFI or Registered Deemed Compliant FFI. A separate GIIN will be issued to the FI to identify each jurisdiction, including the FI’s jurisdiction of residence, in which the FI maintains a branch that is not treated as a Limited Branch. It is anticipated that the IRS FFI list will be updated on a monthly basis to add or remove FIs (or their branches). The GIIN may be used by an FI to identify itself to withholding agents and tax administrations for FATCA reporting. A GIIN will be issued to only those FIs that are not Limited FFIs, Limited Branches, or U.S. branches of an FFI, and will be issued after an FI’s FATCA Registration is submitted and approved.

The Internal Revenue Service (IRS) Automatically validates a Global Intermediary Identification Number (GIIN) against the most up to date IRS information. A GIIN is a 19 digit identification number that is instrumental in the United States’ new FATCA legislation. Any Foreign Financial Institution (FFI) will undoubtedly need to validate all GIIN information before reporting the upcoming FATCA Form 8966.

Below is some information on GIIN formatting.

**Format:** XXXXXXX.XXXXX.XX.XXX
The GIIN is a 19-character identification number that is a composite of several other identifiers. These identifiers include the following:
- Each registering FI will be given a FATCA ID that will be used for purposes of establishing and accessing the FIs online FATCA account. For all FIs other than Member FIs, the FATCA ID is a randomly generated six character alphanumeric string. These 6 characters are upper case letters excluding the letter O, or numbers, or a combination of both. For Member FIs, the FATCA ID will be comprised of 12 characters: the first 6 characters will be the Lead FIs FATCA ID, followed by a period, and the last 5 characters will be alphanumeric and assigned sequentially to each Member. The FATCA
ID is not the same as the GIIN.

- The Financial Institution Type can be Single, Lead of an Expanded Affiliated Group, Member (not Lead) of an Expanded Affiliated Group, or Sponsoring Entity. The Financial Institution type is provided by the Financial Institution when creating its FATCA account.

- The Category Code is a two-character abbreviation identifying either the Financial Institution Type as previously described or a branch of the Financial Institution.

- The Country Identifier will be the ISO 3166-1 numeric standard country code for the Financial Institution’s country of residence for tax purposes that the Financial Institution identified in question 3 on the registration form, or, if the GIIN is for a branch, the branch country identified in question 9A on the registration form.

### 13.9 GIIN Composition

#### GIIN Composition

Enter a filer's GIIN at the Add a Filer screen.

GIIN is a Global Intermediary Identification Number assigned to a PFFI or Registered Deemed Compliant FFI. A separate GIIN will be issued to the FI to identify each jurisdiction, including the FI’s jurisdiction of residence, in which the FI maintains a branch that is not treated as a Limited Branch. It is anticipated that the IRS FFI list will be updated on a monthly basis to add or remove FIs (or their branches). The GIIN may be used by an FI to identify itself to withholding agents and tax administrations for FATCA reporting. A GIIN will be issued to only those FIs that are not Limited FFIs, Limited Branches, or U.S. branches of an FFI, and will be issued after an FI's FATCA Registration is submitted and approved.

Format: XXXXXX.XXXXX.XX.XXX

The GIIN is a 19-character identification number that is a composite of several other identifiers. These identifiers include the following:

Each registering FI will be given a FATCA ID that will be used for purposes of establishing and accessing the FI’s online FATCA account. For all FIs other than Member FIs, the FATCA ID is a randomly generated six character alphanumeric string. These 6 characters are upper case letters excluding the letter O, or numbers, or a combination of both. For Member FIs, the FATCA ID will be comprised of 12 characters: the first 6 characters will be the Lead FI's FATCA ID, followed by a period, and the last 5 characters will be alphanumeric and assigned sequentially to each Member. The FATCA ID is not the same as the GIIN.

The Financial Institution Type can be Single, Lead of an Expanded Affiliated Group, Member (not Lead) of an Expanded Affiliated Group, or Sponsoring Entity. The Financial Institution type is provided by the Financial Institution when creating its FATCA account.

The Category Code is a two-character abbreviation identifying either the Financial Institution Type as previously described or a branch of the Financial Institution.

The Country Identifier will be the ISO 3166-1 numeric standard country code for the Financial Institution’s
country of residence for tax purposes that the Financial Institution identified in question 3 on the registration form, or, if the GIIN is for a branch, the branch country identified in question 9A on the registration form.

Global Intermediary Identification Number (GIIN) Composition Format:

```
XXXXXX.XXXXX.XX.XXX
```

<table>
<thead>
<tr>
<th>Character Representation</th>
<th>No. of char</th>
<th>Position</th>
<th>Description / Rules</th>
</tr>
</thead>
<tbody>
<tr>
<td>FATCA ID (first six characters)</td>
<td>6</td>
<td>1-6</td>
<td>Alphanumeric upper case only. For all Financial Institutions, this is the same as the first 6 characters of the FATCA ID. For leads and singles, this is your FATCA ID, for members; this is just the first six characters. (First 6 characters of any Financial Institution’s FATCA ID are randomly generated and will never use the letter “O”).</td>
</tr>
<tr>
<td>Separator 1</td>
<td>1</td>
<td>7</td>
<td>Period = .</td>
</tr>
<tr>
<td>Financial Institution Type</td>
<td>5</td>
<td>8-12</td>
<td>Alphanumeric upper case only. Lead = 00000. Sponsoring Entity = 00000. Single = 99999. Member = Same as the last 5 characters of the Member’s FATCA ID (sequential, starting from 00001 and going to 99998, then A0000 – ZZZZZ; will never use the letter “O”).</td>
</tr>
<tr>
<td>Separator 2</td>
<td>1</td>
<td>13</td>
<td>Period = .</td>
</tr>
<tr>
<td>Category Code</td>
<td>2</td>
<td>14-15</td>
<td>Alpha upper case only. Based on Financial Institution or Branch category. LE = Lead. SL = Single. ME = Member. BR = Branch (the first thirteen characters of a branch’s GIIN will match the first thirteen characters of the GIIN of the Financial Institution).</td>
</tr>
</tbody>
</table>
13.10 Capitalization

Capitalization

1099 Pro capitalizes the first letter of names, addresses and non-ID boxes (Form W-2G only) during manual data entry. This is a default Preference setting that may be modified.

Please note:
• Account number and free form text fields have no special formatting.
• State abbreviations are forced uppercase.

13.11 Cascading Changes

Cascading Changes

What are Cascading changes?
When making manual changes to the Filer and Recipient Master Lists in 1099 Pro, those changes are then cascaded or (updated) throughout all tax forms with a Pending status. Cascading updates help ensure that ALL filer and recipient information, regardless of the tax form, is quickly and uniformly synchronized.

When does the cascading of those changes take place?
After making changes to a filer or recipient, click the "Save" button. The Administrator prompts to “Update all Pending forms with the new information?” Click "Yes" to update all pending forms associated with the recipient or filer, or "No" to update only the selected recipient or filer.

To update filer information for tax forms with statuses other than Pending (i.e., Printed, Filed, Uploaded....etc.), the user must manually reset the form's status back to Pending. The cascading changes automatically and immediately take effect.

I made prior changes to a tax form and now I am being prompted with a window "Recipient Record may need updating" or "Possible Recipient Information Mismatch." What do I do now?
1099 Pro prompts the user to update or synchronize changes if it sees that the existing recipient information does not correspond with the master recipient database. It will continue to do this for all consecutive tax forms that require updating. Click "Yes" to apply the changes or "No" to not make any changes. The same applies to changes made to filer and contact information, as well as manual
changes made directly to the Recipient Master list.

13.12 Change a Record

Change a Record

Only records with a Pending status are available for modification.

To Change a Record
1. At the Preparing My Tax Forms task panel click the "Work With My Tax Forms" link.
   - Corporate Suite Users: At the Forms & Printing task panel click the "Browse, Enter & Update" link.
2. At the Enter, Update and View screen highlight the appropriate record and click "Change" (or double-click) to access the Changing a Form screen.
3. Make necessary changes and click "Save".

13.13 Delete a Record

Delete a Record

Only records with a pending print status can be deleted. Deleted tax records may be viewed at the Work With My Tax Form screen (see View Deleted Records below). Corporate Suite users only may un-delete previously deleted tax records.

To Delete a Record
1. At the "Work with My Tax Forms" screen highlight the record and click "Delete".
   - Corporate Suite Users: At the Browse, Enter and Edit screen highlight the record and click "Delete".
2. The Administrator prompts to confirm the deletion. Click "Yes" to delete the record or "No" to cancel.

To View Deleted Records

Deleted tax records are available for audit trail purposes and may be viewed or reprinted. By default, the recipient copies of any deleted tax records that are reprinted have the phrase, "* * * DELETED FORM * * * " imprinted in the upper right corner of the document. Do NOT file deleted tax records with the IRS/SSA or state.

1. At the menu bar select File > Security and Administration.
2. At the Global Administrative Options screen click "Program Options" and "Preference, Update and Program Options" buttons.
3. At the Preferences screen, General tab, under Options for Manually DELETED Tax Forms select the "Allow Previously Deleted Forms to Be Visible on Tax Form Browses" checkbox.
   - Corporate Suite Users: At the Preferences screen, Global tab, under Options for Manually DELETED Tax Forms select the "Allow Previously Deleted Forms to Be Visible on Tax Form Browses" checkbox.
4. Click "OK" to save changes.
5. Return to the Work With My Tax Forms screen to view deleted tax records.
   - Corporate Suite Users: Return to the Browse, Enter and Edit screen to view deleted tax records.
To Un-Delete Tax Records
This feature is only available in Corporate Suite.

1. At the menu bar select File > Security and Administration.
2. At the Global Administrative Options screen click "Rules & Options" and the appropriate form type "Preference/Options" button.
3. At the Preferences screen, Global tab, under Options for Manually DELETED Tax Forms select the "Allow Users to Un-Delete Previously Deleted Tax Forms" checkbox. The "Allow Previously Deleted Forms to Be Visible on Tax Form Browses" checkbox must also be selected.
4. Click "OK" to save changes.
5. Return to the Browse, Enter and Edit screen to view deleted tax records.
6. Highlight the record to un-delete and click the "Delete" button.
7. At the Protected Form Update Options screen click the "Un-Delete the Form" button.
8. The Administrator prompts "Are You Sure You Want To Do This?" Click "Yes" to un-delete the record or "No" to cancel.
9. The record is immediately un-deleted and reverts to Pending status at the Browse, Enter and Edit screen.
   - Use the Record History screen to view an audit trail of all changes to the selected record including Box Amount Changes, Views and Deleted and Un-Deleted statuses.

13.14 Department

Department

The "Select Department" feature allows users to quickly change the department phone number associated with the current filer contact. Click on the down arrow in the tax form to display the list of contacts. Choose the contact by highlighting it and then click on "Select". Return to the tax form and the current contact phone number and department ID are listed. The name of the department does not print out.

Contacts can be added by clicking on "File" from the main menu and then selecting Filers list, Change Filer, Add as described in Filer Record Details.

13.15 Options for Tax Form Data Entry

Options for Tax Form Data Entry

1099 Pro contains a list of data entry options accessible at the Tax Form screen. Inactive buttons in this list indicate the tax form is non-edit able and therefore not available for use. The image below displays how the button title changes after information has been entered.
• **Audit Trails** - This screen displays record history information for the selected tax form.

• **Notes** - Allows users to View, Add, Update and Delete Notes for this tax form. After entering in Notes the button changes to "Has Notes" with **BOLD** text to indicate that notes now exist for this form. For more help on Notes, [See Browse Notes](#).

• **Preferences** - Access the "Data Entry Preferences for Form" screen where you can change the position of the First Name and Last Name/Company orientation in how it is displayed on the tax form.

• **Tax State** - Tax State is used for State filing only. It is normally the same as the state withholding (if any) or address state unless there is an explicit need to override it.

• **Withholding State** - When a tax form or electronic file is generated within 1099 Pro the "Withholding State" is determined to be the state with dollar amounts withheld. For example, Form 1099-R Box 12 "State Tax Withheld" or Form 1099-MISC).

• **Tax State with no amounts withheld** - If there are no amounts withheld users can still designate a "Tax State" if the work or event took place in a specific state via the Tax State override button. Click the "State" button to set a "Tax State".

• **Residence State** - If there is no "Tax State" then the default state is the recipient's "State of Residence".

• **IRS Instructions** - Access the 2017 General Instructions and the specific "Current Tax Form" instructions.

• **Form Help** - Provides help for the current tax form.

### 13.16 Print/View Reports

**Print/View Reports**

**How to Print/View Reports**
1. At the "Work with My Tax Forms" screen click the "Print/View Report" button.

2. The Administrator prompts to use the current query if one is selected at the Work With My Tax
Forms screen. If a query is not selected, the Administrator asks "Which Forms To Include?"
Options include:
- (1) All - Generates a standard Control Totals report
- (2) Query - Allows the user to select a previously saved query or create a new query
- (3) Selected - Generates a report for the highlighted record at the Work With My Tax Forms screen
- Cancel - Cancel and exit the report

See Control Totals Report

13.17 Search

Search

Use the Search field to quickly locate a recipient or filer.

To Search (AKA Incremental Index)
1. Set the Current View to the correct sort order criteria (i.e. By TIN)
2. At the Browse the Recipients, Browse the Filers or Browse Forms screen of the software, place your cursor in the Search field.
3. Enter the first few characters of your search criteria and hit the TAB key.
   - The browse screen highlights the record matching your entry. If multiple records match your entry the screen highlights the first match. Use the ARROW keys to scroll through the matches.
   - The Search results are governed according to the column sort order. (i.e. If searching by Last Name/Company, and you search the last name of Charlie Tuna in ascending order by typing in the letters "T" then "U"... in the search field then hit the TAB key, the search results listed are displayed with Charlie Tuna's last name.) If searching by Recipient TIN and you're sort order is set in ascending order then your search results are going to be listed in numeric order from beginning to end for this column only. This same method and result applies to all respective columns.

Note: For a quick form lookup without using you mouse, type the 1st numbers of the TIN (when your sort order is by TIN) and you will drop down to that particular record. If your sort order is by another field (Last Name or Account ...) then type the first few characters you of the field to drop down to that record. To use the "Search …" box you must click in the box, type your characters and hit the Tab key.

13.18 Select a Form

Select a Form

Use the Select a Form Type screen to select the form type you want to process.

To Search for Forms
1. Place your cursor in the search field.
2. Enter the first few letters of the form type, for example "1099-M", and click TAB. The first record matching your entry is highlighted.
13.19 Select Form Type

Select Form Type

If a record was originally issued on an incorrect form type, select the correct form type. The user is presented with a new form that displays the original recipient TIN and address but no individual box amounts or values.

13.20 Tagging Records

Tagging Records

1099 Pro allows users to manually tag (or select) records for inclusion in a print session.

To Tag Records
1. On the Forms & Printing task panel select the "Print Tax Forms" link. Use the Selected Form drop menu to select the form type to process.
2. At the Printing Tax Forms screen choose the "Manually select forms..." option.
3. Click the "Begin Print Process" button.
4. At the Selecting Form Records screen click the "Tag" button to select records. A red check mark appears beside each tagged record. (See Tag Key Shortcuts below.)
   - To sort records prior to tagging, use the View or Query drop menus.
5. After tagging all records, click "Proceed to Next Step" to initiate the Print Wizard.

Tag Key Shortcuts
- **Tag**: Use this button (or ALT + T) to tag individual records.
- **Tag All**: Use this button (or ALT + A) to tag all records.
- **Untag**: Use this button (or ALT + U) to untag an individual record.
- **Untag All**: Use this button to untag all records.
- **Flip**: Use this button (or ALT + F) to reverse the tag status of an individual record.
- **Flip All**: Use this button (or ALT + L) to reverse the tag status of all records. For example, if there are three records and only one record is tagged, the Flip All button will tag the two previously untagged records and untag the original record.
- **Prev Tag**: Use this button (or ALT + P) to scroll backwards through tagged records.
- **Next Tag**: Use this button (or ALT + N) to scroll forwards through tagged records.

13.21 Zip Code Lookup

Zip Code Lookup

1099 Pro allows you to quickly find or verify zip codes, cities, and states within the USA

The Zip Code Lookup feature:
- Includes every 5 digit ZIP code in the USA.
- Includes FPO (Fleet Post Office) and APO (Army Post Office) ZIP codes.
- Allows you to search by city, state, or ZIP code.
- Contains current ZIP code data.

Zip Codes can be looked up from either the City field (shows all matching cities) or the zip field (more precise, shows matching zips.) If you type a partial city or zip and then invoke the pop up, the list will start at the closest approximation. This database includes all zip codes and cities accepted by the United States Postal Service. The USPS currently recognizes all United States ZIP codes by either their preferred or alternate city names.

**USPS Codes:**
P = Preferred City Name (Example: Philadelphia, 19101)
A = Alternate (Example: Phila, 19101)

**Tip**
You can right click on the City or Zip Code fields to pull up the list of cities in the U.S. You may also type in the name of the City or Zip code in the search field. As you type, the software will narrow down the closest match based on your entry. A third tab, By State, allows you to type in the abbreviation of the state to match the zip code your are searching for.

<table>
<thead>
<tr>
<th>Zipcode</th>
<th>City</th>
<th>State</th>
<th>USPS</th>
</tr>
</thead>
<tbody>
<tr>
<td>91302</td>
<td>Hidden Hills</td>
<td>CA</td>
<td>P</td>
</tr>
<tr>
<td>91302</td>
<td>Monte Nido</td>
<td>CA</td>
<td>A</td>
</tr>
<tr>
<td>91302</td>
<td>Woodland Hills</td>
<td>CA</td>
<td>A</td>
</tr>
<tr>
<td>91303</td>
<td>Canoga Park</td>
<td>CA</td>
<td>P</td>
</tr>
<tr>
<td>91303</td>
<td>Woodland Hills</td>
<td>CA</td>
<td>A</td>
</tr>
<tr>
<td>91304</td>
<td>Box Canyon</td>
<td>CA</td>
<td>A</td>
</tr>
<tr>
<td>91304</td>
<td>Canoga Park</td>
<td>CA</td>
<td>P</td>
</tr>
<tr>
<td>91304</td>
<td>West Hills</td>
<td>CA</td>
<td>A</td>
</tr>
<tr>
<td>91305</td>
<td>Canoga Park</td>
<td>CA</td>
<td>P</td>
</tr>
<tr>
<td>91306</td>
<td>Canoga Park</td>
<td>CA</td>
<td>A</td>
</tr>
<tr>
<td>91306</td>
<td>Winneka</td>
<td>CA</td>
<td>P</td>
</tr>
<tr>
<td>91307</td>
<td>Bell Canyon</td>
<td>CA</td>
<td>A</td>
</tr>
<tr>
<td>91307</td>
<td>Canoga Park</td>
<td>CA</td>
<td>A</td>
</tr>
<tr>
<td>91307</td>
<td>West Hills</td>
<td>CA</td>
<td>P</td>
</tr>
</tbody>
</table>

### 13.22 IRS Codes

**IRS Codes**

Please review the IRS Instructions for the form to find a current listing of codes.

These instructions are available via the menu bar and selecting "Forms" and "IRS/SSA Instructions &
13.23 Puerto Rico Control Numbers (CS Version only)

Puerto Rico Control Numbers

The features contained within this section are available exclusively to users of the Corporate Suite edition.

Control Numbers are required and assigned by the Hacienda, www.hacienda.pr.gov, for each Puerto Rico form type filed. Users receive a range of control numbers which the software can then assign to individual records. Control Numbers consists of 9 digits, where the first two digits to the left represent the last two digits of the tax year; for example "160000001" for tax year 2016. The remaining 7 digits start at 0000001 in ascending order.

Puerto Rico Control Numbers cannot be manually assigned at the Adding/Changing a Form screen.

Manage/Assign Control Numbers
Puerto Rico Control Numbers are Tax Year specific. Set the appropriate year via the "Tax Year" drop menu located on the Corporate Suite main screen.

1. On the menu bar go to File > Security and Administration.

2. At the Global Administrative Options screen click the "Puerto Rico Options" button to access the Puerto Rico Control Numbers screen (verify the tax year).

3. Manage Control Numbers - Enter the range of control numbers received from the Hacienda specific to a Filer's EIN and form types. Indicate if the range is for Original or Corrected/Amended forms. The range must be in a "160000001" format wherein the first two digits indicate the tax year and the last digits are assigned by the Hacienda.

4. Assign ORIGINAL Control Numbers - Use this button to assign Control Numbers to all PENDING forms without a Control Number. This utility matches control numbers against the previously indicated filer EIN and form type(s). The process starts at the next available number after the highest previously assigned number within the range. If one range runs out it automatically moves to the next range (assuming there is more than one range assigned to you by the Hacienda for that EIN/Form type.) The process can be run as many times as necessary. Forms with existing control numbers are not affected.

5. Assign AMENDED Control Numbers - Use this button to assign Control Numbers to all CORR/PENDING forms without a Control Number.

Control Number Report
Run the Control Number summary report at any point to see what ranges are in the system, how many forms don't have numbers, what the highest used number is, etc.

1. On the menu bar go to File > Security and Administration.

2. Global Administrative Options screen click the "Puerto Rico Options" button to access the Puerto
Rico Control Numbers screen (verify the tax year).

3. View/Print Control Number Report

**Manually adding/editing a Control # via SQL**

**Assigning a specific Control Number**
To assign a specific Control Number, it must be directly entered into your database using an update statement. For example:

```
Update Pro1099. Form480_7C
Set Control Number PR = 123456789
Where TaxRecID = 100
```

### 14 Current Sort/View

**Current Sort/View**

**Record Sorting:**
1099 Pro offers built-in views that are tied directly to the Search field. To search for records by TIN the view must be set to "By TIN". Likewise, to search for records by name the view must be set to "By Last Name/Company" or "By Filer Name" as appropriate. Failure to properly set the view will result in a failed search attempt.

Views are available at select browse screens.

### 14.1 Current Sort/View

**Custom View**

**Custom Sorting of Records & Column Display**
Sophisticated users can select Custom View from the Current View drop menu and design their own views.

**To Define a Custom View**

1. At the "Enter, Update and View" Screen", where you can browse your form, click the drop down arrow in the field located in the upper right labeled "Current Sort/View."
2. Select Custom View from the list. (The software displays the Define View Format Layout Screen.)
3. This screen allows you to select the available fields from the left column and organize them in the "show these fields in this order" column on the right.
4. You may move the position of these items in the order in which they will appear by highlighting them on by one and clicking the up or down arrow to adjust it's position accordingly.
5. To save these changes click, “Apply” or Click "Next" to define a sort order for the custom view. The software displays the "Select a sort order for the view" screen. At this point you may:
   - Use the default sort order (Which tells 1099 Pro to accept the current sort order)
   - Select a predefined sort order (fastest) which tells the software to use the built in predefined list (Example: Filer ID, Last Name/Company, First Names or by Filer ID, Recipient TIN, then
Define your own custom sort order (slowest) Allows you to indicate what custom sort order the software should follow based on your custom field selections.

14.2 Custom Sort Order

Custom Sort Order

Define Custom Sort Order
Users may define a custom sort order to view recipient records in addition to the default sort options of by Recipient TIN or by Recipient Last/Company Name.

1. At the Work With My Tax Forms screen, click the “Current Sort/View” drop menu and select “Custom View”.
2. At the Define View Format window use the “Next” button to move to the Select a Sort Order for the View window.
3. Select the "Define Your Own Custom Sort Order" radio button to access the Sort Designer window.
4. Make your selections to arrange records by up to four fields, in ascending or descending order. For example: Sort View by "Account", Then By "State", Then By "City".
5. Click "OK" to save changes and close window.
6. Click "Apply" at the Select a Sort Order for the View window. This window closes and changes take effect immediately at the Work With My Tax Forms screen.
7. To cancel the custom view use the Current/Sort View drop window to select the default view.

14.3 Dynamic Queries (CS Version Only)

Dynamic Queries

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

Basic Use
• All 'AskFor...' tokens are composed of a single word with no spaces or other punctuation. Tokens are not case sensitive, but users are strongly encouraged to enter them using the capitalization as shown in this document as it makes the queries easier to read and understand.
• Manual Query: Click on the 'Manual' button and use the "AskFor..." string where desired. Examples:

  o RcpTIN = AskForText
  o DateLastEdit > AskForDate
  o DateCreated BETWEEN AskForDateRange
  o TIP: Date and Time ranges must be entered manually as shown above.

• At the Query Wizard Value Entry screen the 'Expression' radio button must be selected, or else the 'AskFor...' token is treated as if it is the actual value to use. Thus, the query returns neither a result nor triggers an invalid query response/error from the database. If the 'Expression' option is disabled, the query must be manually created.
Once the query is created and saved it prompts the user, each time, for the value to use (substitute) where the ‘AskFor…’ expression was in the query. To resubmit the query with a different value, click on the ‘Redo’ button under the “Current Query:” prompt to enter a new value (or set of values). Users can likewise press “F5” on their keyboard to redo a query. This simplifies the process of creating a query with new values to browse, update or report.

Removing a Query
To view all records again, users can select ‘All records’ on the query list or click on the ‘Undo’ button to the left of the ‘Redo’ button.

Restrictions
Users can have multiple unique ‘AskFor…’ expressions in the same query, but not the same one multiple times. For example:

This expression is allowed.
DatePrinted = AskForDate AND RcpLName = AskForText

This expression is not allowed.
RcpLName = AskForText AND RcpFName = AskForText

1099 Pro, Inc. plans to lift these restrictions at a future date.

WORKAROUND: For text and numbers users can use the from/through variants of the same type as additional tokens. For example:

RcpLName = AskForText OR RcpLName = AskForFromTest OR RcpLName = AskForThruText

TIP: Each ‘AskFor…’ token creates its own pop-up window, so multiple tokens can result in a succession of pop-ups before the query is completed and applied.

Available "AskFor..." Tokens
AskForText | Requests any type of text/string value. For example, anything dealing with names, addresses, TIN, account numbers or alphanumeric codes. Basically, anything that is not explicitly a number or date. Prompt is "Text to use".

AskForFromText | Same as "AskForText" except the prompt is "1st/From value".

AskForThruText | Same as "AskForText" except the prompt is "2nd/Thru value".

AskForDate | Requests a single date, with the pop-up calendar option. Defaults to current date and presets options are available.

AskForFromDate | Same as "AskForDate" except the prompt is "1st/From date".

AskForThruDate | Same as "AskForDate" except the prompt is "2nd/Thru date".

AskForDateRange | Pops up the full date range query window, with calendars and quick-select options for all common ranges (this year, this month, a particular month, a quarter, etc.) or select any random range.

AskForNumber | Requests a single number and provides for decimals. Prompt is "Number/Amount".

AskForLowNumber | Same as "AskForNumber" except the prompt is "1st/Low number".

AskForHighNumber | Same as "AskForNumber" except the prompt is "2nd/High number". These two tokens can be combined to create a numeric range.

AskForTimeRange | Asks for starting and ending times within a single day. Offers a number of quick-select options including 'Last 30 minutes', 'Midnight to 6AM', 'Before Noon', etc.

1099 Pro is continuing to enhance the token process and add more tokens to make it more intuitive. Check the online help or ask 1099 Pro for an updated list when program updates are issued.

15 Error & Validation Checking

Error & Validation Checking

1099 Pro performs various validation checks on your data. This helps users find and fix potential tax form errors (see Disclaimer) prior to submission to recipients or the IRS. Error and validation checks occur whether data is manually entered or imported. It also occurs when printing a form, or when generating a 1096 transmittal, electronic or service bureau files. If a problem is found, the software flags the record with a Warning, Error or Reject Error. Users are encouraged - but not required - to fix warnings and errors prior to submitting their records to recipients or the IRS.

- Users can instantly scan all records in the software for errors and warnings via the menu bar > Utilities > Check/Update Error Status For All Forms.
- See Filing Problems

Warnings & Errors Defined

Whether importing or manually entering data, 1099 Pro indicates if any records have errors or warnings associated with them, or if they were rejected.

- **Warnings** are intended to flag a possible inconsistency or omission in the data that may result in the record being rejected by the IRS/SSA.
- **Errors** are serious flaws in the data that would most likely result in the record being rejected by the IRS/SSA.
- **Reject Errors** occur when the user has not entered correct data, resulting in an automatic rejection.
Find Problem Records
1099 Pro offers several methods to locate records containing warnings and/or errors including:
- **Form Counts Report** - View a concise listing of all filers and form types including number of warnings and/or errors per form type.
- **Control Totals Report** - View errors and/or warnings in detail by Recipient. Users must select the "Extended Version - Errors and Warnings Messages" to access this information.
- **Review Import Session** - Prior to posting import data into the software, users can edit or delete individual records during Step 2: Validate Data of the Import Wizard.
- **Error Queries** - Sort records with errors and/or warnings at the Work With My Tax Forms screen. See Error Queries below.

Error Queries
At the Enter, Update and View screen display records with errors and warnings or errors only.

**To Run Error Queries**
1. On the Preparing My Forms task panel select "Work With My Tax Forms".
   - **Corporate Suite Users:** On the Forms & Printing task panel select "Browse, Enter & Edit" to access the Add, Update and View screen.

2. At the Enter, Update and View screen use the Current Query drop menu to select "Errors and Warnings Only" or "Errors Only".

3. The Enter, Update and View screen immediately displays any records that match the query criteria.
   - If NO records display then there are no records for the selected filer and form type with errors or warnings.
   - Any record containing an error or warning may be fixed provided it has a pending status.
   - After fixing a problem record it will disappear from this list. After fixing all problem records reset the Current Query to "All Records".

Disclaimer
1099 Pro software identifies many, but not all, of the most common format errors in information compliance submissions. The likelihood of submission rejection, though not eliminated, is greatly reduced when utilizing this software. Even if no errors are identified by this software, your submission could be returned or you could be penalized because of other errors.

Feedback
Users who encounter a situation that should possibly generate an Error or Warning in the software are encouraged to discuss the situation with 1099 Pro, Inc. at compliance@1099pro.com. Please indicate the form type, data set and IRS regulations in your correspondence.

15.1 **Warnings and Errors Scan Screen**

Errors & Warnings Scan
Users may scan their records for errors and warnings prior to generating a electronic file or Service Bureau upload file. If errors or warnings are found in electronic files, users may choose whether or not to process those records. For uploads, all records are processed regardless of any errors or warnings; the scan is simply a final informational check.
Processing Records with Errors/Warnings
Errors and Warnings typically indicate missing or incorrect information. Missing TINs (SSN or EIN), and State Fields are typical warnings. An incorrect Zip Code, for example, would generate an error. Typically the IRS accepts uploads with errors and warnings but a high percentage of missing TIN's or other errors or warnings may cause the IRS to reject your file and/or result in penalties.

Users are encouraged to make every effort to fix missing or invalid data but if unable to do so; file the records anyway. A good way to identify errors and warnings is to run a Control Totals Report, Extended Version. See Finding & Fixing Records with Problems.

☐ Try to fix Errors and Warnings before filing with the IRS. Consider filing Form 8809 for a 30-day filing extension in order to submit more accurate data.

15.2 Filing Problems

Filing Problems

Users may scan their records for errors and warnings prior to generating an electronic file or Service Bureau upload file. If errors or warnings are found in electronic files, users may choose whether or not to process those records. For uploads, all records are processed irregardless of any errors or warnings; the scan is just a last chance informational check.

Processing Records with Errors/Warnings
Errors and Warnings typically indicate missing or incorrect information. Missing TINs - SSNs or EINs - and State Fields typically generate a warning. An incorrect Zip Code, for example, would generate an error. Typically the IRS accepts uploads with errors and warnings but a high percentage of missing TIN's or other errors or warnings can cause the IRS to reject your file and/or result in penalties.

Users are encouraged to make every effort to fix missing or invalid data but if they are unable to do so, file the records anyway. A good way to identify errors and warnings by recipient is to run a Control Totals Report with "Extended Version - Errors and Warnings Messages" selected. Try to fix any errors or warnings prior to filing with the IRS. Consider filing Form 8809 for a 30 day filing extension in order to submit more accurate data.

☐ See Error & Validation Checking

15.3 Penalties

Penalties

Penalties Increased Effective 2017
The following penalties generally apply to the person or entity required to file information returns. The penalties apply to both paper and electronic filers. Reference the IRS's 2017 General Instructions for Certain Information Returns, page 18.

☐ See Deadlines

Failure To File Correct Information Returns by the Due Date (Section 6721)
If you fail to file a correct information return by the due date and you cannot show reasonable cause, you may be subject to a penalty. The penalty applies if you fail to file timely, you fail to include all information required to be shown on a return, or you include incorrect information on a return. The penalty also applies if you file on paper when you were required to file electronically, you report an incorrect TIN or fail to report a TIN, or you fail to file paper forms that are machine readable. The amount of the penalty is based on when you file the correct information return. The penalty is as follows.

- $50 per information return if you correctly file within 30 days (by March 30 if the due date is February 28); maximum penalty $536,000 per year ($187,500 for small businesses, defined below).
- $100 per information return if you correctly file more than 30 days after the due date but by August 1; maximum penalty $1,609,000 per year ($536,000 for small businesses).
- $260 per information return if you file after August 1 or you do not file required information returns; maximum penalty $3,218,500 per year ($1,072,500 for small businesses).

If you do not file corrections and you do not meet any of the exceptions to the penalty described later, the penalty is $260 per information return. Please see the [IRS Help for Taxpayers](#) site for information and advice on late filings and penalties.

### 16 Exports

#### Export Overview

1099 Pro features a powerful and intuitive Export Wizard for the exporting of tax form data in a Mapped ASCII (Fixed/Delimited/Excel) format, IRS* (Pub 1220 Format), and [Moore Wallace 1099 Print Export](#).

* IRS format exports are only available in 1099 Pro Enterprise and Corporate Suite edition.

#### 16.1 Export ASCII Wizard

##### Export Wizard

The 1099 Pro Export Wizard simplifies the process of exporting tax form data to an ASCII file; accessible in spreadsheet applications such as Excel or Access. If using Notepad to view files, data will appear out of alignment as the export files are Tab delimited. All export files are "Map by Name" compatible and can be imported directly into another Filer.

- See [Import Wizard](#)
- See [IRS Bulk TIN Export Wizard](#)

#### To Export Data:

1. At the menu bar select Utilities > Export Tax Forms to ASCII File(s).

2. At the 1099 Pro Export Wizard click "Next" to proceed. Use the "Back" button at any time to go back a step.
3. At the "Select the type of data and format to use" screen use the drop menu to select the appropriate form type and click "Next".
   - Exporting Form 1099-MISC triggers the 1099-MISC Special Processing screen. The IRS filing deadline for 1099-MISC with Box 7 data is 1/31/2018. Users may opt to export all 1099-MISC records or only those with Box 7/NEC data. See Deadlines.
   - To customize the delimiters and data exported use an export map, accessed via the "Add or Update Export Map" button. See Export Mapping Wizard for important field descriptions.

4. Choose a method for selecting eligible tax forms. Options include:
   - Export tax forms for ALL Filers: This option automatically selects every eligible form for all filers.
   - Export tax forms for up to 25 selected filers: This option prompts to manually select (tag) the filers to include in the export file. All form types for the selected filers are processed.
   - Split export records into separate files for each filer?: Mark the check box to export filers’ records into individual files. Leave the check box unmarked for a single, larger file containing data for all filers and form types.

5. Select the destination folder. Default location is <%DEFAULTPATH%>\Exports and click "Next" to continue.

6. Review settings and click "Finish" to create your export file.

16.2 Export Map Wizard

Export Map Wizard

1099 Pro allows users to customize the delimiters and data exported by generating unique export maps. Export maps are form specific and are saved as .TPS files.

- See Import Map Reports
- To export data files into an ASCII format see Export Wizard.

To Create Export Maps

1. The Excel Import Map Wizard is accessed via the menu bar > Utilities > Export Tax Forms to ASCII Files.
   - This process is also available in the Import Wizard at the Select the Type of Data and Format screen via the "Add/Update Form Import Maps" button.

2. Review onscreen information and click "Next" to continue to the Select the Type of Data and Format screen. Then click the "Add or Update Export Maps" button.

3. At the Manage Export Maps screen highlight the map to edit and click the "Change" button. Default/built-in maps are not available for edits; however, they can be duplicated via the "Copy" button and the copied version can be edited. To add a new map click the "Add" button.
   - Export maps are defined by their Map Type, File Format (Delimited or Fixed), Status (Default or OK) and Description. The Description column gives details about the currently selected export map and the Notes windows provides additional details.

4. In the Export Map Wizard review onscreen information and click "Next" to continue.

5. At the Define File Format for Exported Information screen select the type of information to export:
6. Select the File Format, End of Record character, Field Delimiter and other options. Click "Next" to continue setting default field processing options—reference the below chart for useful information. Click on a checkbox or "radio button" to set options On or Off.

7. Select specific fields to include in the export process by double-clicking an available field from the left to automatically move it to the right. Alternately select a field and click the "Add Field" button. Repeat until all of the necessary fields have been added.
   o If the wrong field is accidentally assigned, highlight the incorrect field and click the "Remove" button.
   o Use the Up / Down arrows to change the order of a specific field in the list.
   o Customize the parameters of a mapped Field Header by double-clicking it.

8. At the Specify a Name and Usage Notes screen enter a brief title for the export map. Use the Map Usage Notes field to enter specific notes for future reference.

9. At the Set Options screen verify the default destination folder for the export file and change as necessary.

10. At the Ready to Generate Export File screen review settings and click "Finish" to generate export map. Return to the Manage Form Export Maps screen and close it. Now return to the Select the Type of Data and Format screen within the Export Wizard and select your newly created export map. Click "Continue" and complete the export process with the newly created export parameters.
<table>
<thead>
<tr>
<th>Category</th>
<th>Options Available</th>
<th>Additional Information and Details Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Characters</td>
<td>1. Convert to all UPPER case</td>
<td>Character values include Names, Address Fields,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Descriptions…etc</td>
</tr>
<tr>
<td>Amounts</td>
<td>1. Include Commas</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>2. Include Dollar Signs</td>
<td></td>
</tr>
<tr>
<td>Check Boxes</td>
<td>1. Blank for unchecked - &quot;X&quot; for checked</td>
<td>Check boxes are logical values: Yes/ No, True/False,</td>
</tr>
<tr>
<td></td>
<td>2. Use Y/N</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3. Use T/F</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4. Use 0/1</td>
<td></td>
</tr>
<tr>
<td>Dates</td>
<td>1. mm/dd/yy</td>
<td>Dates can be from a tax form box or for example when a</td>
</tr>
<tr>
<td></td>
<td>2. mm/dd/yyyy</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3. yymmdd</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4. yyyyymmd</td>
<td></td>
</tr>
<tr>
<td>Numeric</td>
<td>1. Round to the nearest whole number</td>
<td>Numeric values are numbers that are NOT dollar</td>
</tr>
<tr>
<td></td>
<td></td>
<td>amounts like percentages or total shares.</td>
</tr>
<tr>
<td>EIN / SSN</td>
<td>1. Formatted (TIN type not required)</td>
<td>EIN/SSN values are Tax ID numbers (TINs).</td>
</tr>
<tr>
<td></td>
<td>2. Unformatted (Must include the TIN type)</td>
<td></td>
</tr>
<tr>
<td>Text (Multi-line)</td>
<td>1. Convert to all UPPER case</td>
<td>Text values are multi-line box values such as a</td>
</tr>
<tr>
<td></td>
<td>2. Don't convert CR/LF, export as is</td>
<td>transaction description.</td>
</tr>
<tr>
<td></td>
<td>3. Convert CR/LF to a single space</td>
<td></td>
</tr>
</tbody>
</table>

### 16.3 Moore Wallace (CS Version only)

**Moore Wallace Print Export**

The features contained within this section are available exclusively to users of the Corporate Suite edition.

This wizard allows users to export records in the Moore Wallace print format. Supported form types include:

- 1099-C
- 1099-DIV
- 1099-G
- 1099-INT
- 1099-LTC*
- 1099-MISC
- 1099-R
- 5498
- W-2

* Form LTC Box 5 information is not passed to Moore Wallace as this information is optional per the IRS.

See Moore Wallace Important Notes

16.3.1 Important Note for MW Export (CS Version only)

**Important Note for Moore Wallace Export**

The features contained within this section are available exclusively to users of the Corporate Suite edition.

Please review your filer info prior to exporting forms in the Moore Wallace Print format. As Moore Wallace only accepts 4 print lines for the Filer Address address Line 2 will be omitted from the print file. You may review your filer info on the Browse Filer's screen.

You may also create a query by following these instructions:
1. On the Browse Filer's screen select "Custom Query" in the top right.
2. On the Field Selection screen of the Query Wizard select "Routing Address (Suite, department, etc)" then click "Next".
3. On the Operation Selection screen of the Query Wizard select "Is Greater Than" then click "Next".
4. On the Value Entry screen of the Query Wizard enter "0" into the field then click "Next".
5. Click "Finish" then save your query if you wish to do so.

This query will now display Filer's that have address information in the line that will not be carried over.

16.3.2 Tagging for Test Printing (ASP Version only)

Tagging record for Moore Wallace Test Printing

The features contained within this section are available exclusively to users of the 1099 Pro.net edition of our software.

From this screen in the ASP module users can tag records to be included in a test printing for Moore Wallace.

16.4 Bulk TIN Matching

IRS Bulk TIN Matching Overview

The features contained within this section are available exclusively to users of 1099 Pro Professional, Enterprise and Corporate Suite editions.

Name/TIN mismatches on 1099 Informational Returns can generate penalties of up to $260/record, up to a maximum penalty of $3,193,000 per company! The IRS offers an interactive TIN Matching and Bulk TIN Matching Program for Forms* 1099-B, DIV, INT, K, MISC, OID and PATR. Or consider using 1099 Pro’s Bulk TIN Matching Service; no IRS registration is required, it's easy to create an upload file within our software and results are available within one business day. Cost is $135 for a single upload file of up to 100,000 records.

See 1099 Pro’s Bulk TIN Matching Service

Steps To Participate In IRS TIN Matching Program:
1. Register for the IRS TIN Matching System; allow at least 4-6 weeks.
2. Perform a 1099 Pro Web Update to acquire the latest updates for your 2017 software.

IRS TIN Matching Program Registration
2. Click on the "Register" button. Registrants will be asked to provide personal data including their Adjusted Gross Income (AGI) from their most recent individual income tax return.
3. After completing the online registration, SAVE YOUR USERNAME AND PASSWORD for future reference. It takes approximately 10 business days to receive your IRS confirmation code by mail.
4. After receiving the confirmation code, return to the Registration Services page and select the “Confirm Registration” link.
5. Once your registration is officially confirmed, complete the application for the TIN Matching Programs.

Notes On System Use
• Registered users may verify Names and TIN's interactively. Manually enter up to 25 Name and TINs at one time. Registered users may also submit a .TXT file as generated by the IRS Bulk TIN Export Wizard.
• IRS responses are sent to a "secure object repository" and an E-Mail notification is sent to the registered user indicating a response is waiting. Users have 30 days to access and download the results file. Once accessed, the results are retained for 3 days before being purged. The same information sent in the .txt file is returned with one additional field containing the results indicator.
• BE SURE NOT TO SUBMIT THE SAME DATA WITHIN A 24 HOUR PERIOD OR THE SYSTEM WILL SUSPEND YOUR ACCOUNT FOR 96 HOURS!
• 1099 Pro, Inc. suggests verifying Name/TIN combinations prior to January.

How To Respond To System Results
1. Review your IRS Bulk TIN Results.
2. Verify your data against the original W-9 form on file for the Recipient.
3. Use the 1099 Pro software to issue and track additional W-9s, 1st B Notices or 2nd B Notices as applicable.
4. Lastly, mail corrected returns to recipients and file IRS corrections as necessary.

Protection From IRS Penalties
• Due Diligence: Using either 1099 Pro's Bulk TIN Matching Service or the IRS TIN Matching System allows users to verify the accuracy of TIN and Name information prior to submitting information to the IRS.
• IRS Code 6724 provides any penalties under Section 6721 may be waived if the Filer shows the failure to provide a correct TIN on an information return is due to Reasonable Cause and not Willful Neglect.
• Filers may prove Due Diligence and receive a waiver from proposed penalties if they prove the TIN and Name combination they submitted matched IRS records. Providing a copy of the "Print Screen" of your IRS System Responses will be considered proof of Due Diligence.

*Note: As of this writing, the IRS does not allow other form types to participate in this program under penalty of perjury and possible imprisonment.

16.4.1 Session Details and Options (CS Version only)

Session Details and Options

This screen allows users to review the options used when exporting data. Users can also View/Print a Report of the data contained in the export. Voiding a session is useful for denoting the data was not used.
16.4.2 IRS Incorrect TIN Flowchart

IRS Incorrect TIN Flowchart
16.4.3 IRS Missing TIN Flowchart

IRS Missing TIN Flowchart
16.4.4 IRS Bulk TIN Export Wizard

IRS Bulk TIN Export Wizard

The features contained within this section are available exclusively to users of the Enterprise and Corporate Suite editions.

Registered users of the IRS TIN Matching System can quickly generate .TXT files suitable for submission to their program.

- See IRS Bulk TIN Matching Overview
- See Service Bureau Bulk TIN Matching

To Create Export File
1. On the menu bar select Utilities > Export for IRS Bulk TIN Matching.
2. At the Bulk TIN Matching Export Wizard review important onscreen information. Click "Next" to proceed. Use the "Back" button at any time to go back a step.

3. Choose a method for selecting eligible records. **IMPORTANT:** The IRS does not allow submission of the form types displayed in red. Only check these form types if you have verified with the IRS or appropriate counsel that it is legal to submit recipients receiving these form types
   - **Selected Form Types for ALL Filers:** This default option prompts to select (tag) the form types to include in this upload file. All Filers will be processed.
   - **Selected Form Types for Selected Filers:** This option prompts to select (tag) the filer and the form types to include in this upload file.

4. Set options for your export.
   - **Specify where export files should be created:** The default location is C:\1099 Pro\Pro99T17 \Exports.
   - **Force TIN Type as Unknown for all records:** Select this check box to remove the SSN or EIN identifying hyphens. Users will be unable to import results back into the software if this box is checked.
   - **Split export records into separate files for each filer?** Check this box to split filer records into separate export files; otherwise all Filers and form types are combined in a single large file.

5. At the Ready to Generate Bulk TIN Matching Export File screen review settings and click "Finish" when satisfied. The system will process your file and the Administrator indicates when file is "Done".
   - In the \Exports directory two files are created; your primary Bulk TIN export file with a date and time stamp in the file name AND a secondary file with the word "DUPLICATE" appended to the file name. When submitting your export file to the IRS **send the primary file, not the duplicate file.** The duplicate file is for your records - the IRS will penalize any uploads containing duplicate records.

6. Go to the IRS E-Services website to login and post the .TXT export file.

**16.4.5 Bulk TIN Results**

**Bulk TIN Results**

Users receiving Bulk TIN results (after submitting a Service Bureau Bulk TIN Upload or via the IRS Bulk TIN Matching Program) are provided coded responses for all invalid Name/TIN combinations.

**Bulk TIN Results**

Bulk TIN results contain the following coded information from the IRS:

<table>
<thead>
<tr>
<th>Code</th>
<th>Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Name/TIN combination matches IRS records.</td>
</tr>
<tr>
<td>1</td>
<td>Missing TIN or TIN not 9 digit number.</td>
</tr>
<tr>
<td>2</td>
<td>TIN not currently issued.</td>
</tr>
<tr>
<td>3</td>
<td>Name/TIN combination does NOT match IRS records</td>
</tr>
<tr>
<td>4*</td>
<td>Invalid request (i.e., contains alphas, special characters)</td>
</tr>
<tr>
<td>5</td>
<td>Duplicate request.</td>
</tr>
<tr>
<td>6</td>
<td>(matched on SSN), when the TIN type is (3), unknown, and a Matching TIN and name control is found only on the NAP DM1 database.</td>
</tr>
<tr>
<td>7</td>
<td>(matched on EIN), when the TIN type is (3), unknown, and a matching TIN and name control is found only on the EIN/NC database.</td>
</tr>
</tbody>
</table>
Sample Bulk TIN Results
The following sample lines indicate the TIN provided by Matthew Mulberry is 2 - Not Currently Issued and the Name/TIN provided by Acme Incorporated is 0 - Matches IRS records.

1;183421111;Matthew Mulberry;89765;2
2;562611111;Acme Incorporated;89765;0

Invalid TIN Matching Requests
Any record submitted without the required fields (TIN Type, TIN, Name) automatically receives Indicator 4 - Invalid Request. For example, the following line from a Bulk TIN Matching file is missing the Name field:

2;562611111;;8976

The above line would generate a "4" in the results data file, indicating an Invalid Request, as follows:

2;562611111;;89765;4

* Any record submitted without the required fields (TIN Type, TIN, Name) automatically receives Indicator 4 - Invalid Request. If TIN Type is unknown, you may check the "Force TIN Type As Unknown" box during the Wizard and the IRS will check the TIN against both the SSN and EIN master files. However, you will be unable to import returned results for matching purposes if this option is chosen.

For More Information:
Direct questions regarding specific tax regulations or regulatory services to IRSCompliance.org at:
Phone: 877 TAX-REGS (877) 829-7342
Email: compliance@IRSCompliance.org

17 Electronic Filing

17.1 eFile Overview

Filing via eFile

See Electronic Filing Session Window

FIRE System
Use the Filing Information Returns Electronically (FIRE) System to electronically upload informational returns to the IRS. Electronic files created via the 1099 Pro eFile Wizard fully comply with required IRS record formats per Pub. 1220 including the Combined Federal State Filing Program format. Filers with 250 or more records must file electronically or face IRS Penalties. See IRS FIRE System for more information.
AIR System (Corporate Suite only)
Use the Affordable Care Act Informational Return (AIR) System to electronically file Forms 1095-B and 1095-C and their associated 1094 transmittals. The AIR system has different requirements than FIRE. Filers with 250 or more records must file electronically or face IRS Penalties. See ACA Filing - Mag Media for more information.

Service Bureau Upload Wizard
The Service Bureau is proud to offer a wide variety of services to registered users of 1099 Pro. Customers are encouraged to schedule their print/mail and electronic uploads appointments now! Rates and availability are not guaranteed until your appointment is booked. See Service Bureau Upload Process to begin.

Account Number Generation - Are Account Numbers Required?
1099 Pro offers a utility to generate account numbers for each form that does not have an account number. IRS Publication 1220, states on page 65 that account numbers are required. "Enter any number assigned by the payer to payee that can be used by the IRS to distinguish between information returns. This number must be unique for each information return ..." See How to Generate Account Numbers for more information.

Generate State Subset (Enterprise and Corporate Suite users only)
The "Create State Subset Files" wizard guides users through the file generation process. Users can select all filers or individual filers, all form types or selected form types and all states or selected states. All files are generated in the IRS format detailed in Publication 1220 with record types T, A, B, C, K & F. See How to Generate State Subset Files for more information.

State Identification Number
State ID numbers are assigned by the individual state. For example, in California the Employer Development Department (EDD) assigns a state ID number. Check with your accountant or attorney to determine your company’s state ID number. Many companies do NOT have one. See State ID Number for more information

File Format Illustration
The 750 Byte file structure may be either sequential or random. If a sequential file is created, the record delimiter - the combination of a CARRIAGE RETURN (CR) character and a LINE FEED (LF) character - must occur in that sequence (CR/LF) and only once following the end of each record. There must be no delimiter before the first record. Random files must have a record length of exactly 750 bytes. The CARRIAGE RETURN and LINE FEED should follow the record after position 750 in what would be positions 751 & 752. All data records must be a fixed length of 750 bytes. See File Format Illustration

eFile Viewer
See eFile Viewer for information on this optional utility.

17.1.1 Electronic Filing Session Window

eFile Session Window
The Electronic Filing Session window contains the electronic filing functions available in 1099 Pro. From this window users can generate the following electronic files:

- **Federal Electronic Files** - Click the "Create a New 1220 Format File for e-File" button (or in Corporate Suite "Create an IRS FIRE or AIR eFile" button)
- **State Subset Files** - Click the "Create State Subset Files" button
- **State Subset Forms** - Click the "Create State Subset Forms" button
- **State Quarterly Files** - In Corporate Suite only, click the "TY Quarterly State Reporting" button

### Completed eFile Session List

The eFile Session List contains logs detailing all electronic files generated via the eFile wizard. *Not all columns are included in all 1099 Pro, Inc. software products.*

**Columns Include:**

- **Log** - A specific number assigned to every individual file generated by the eFile Wizard.
- **Session** - A number assigned to any group of files generated together by the eFile Wizard. *Multiple sessions can be included in a single log.*
- **Filer TIN** - The associated filer's TIN number.
- **Form Type** - The form type of the generated records.
- **Copy Count** - The number of forms generated for the particular log.
- **Trans Type / Session Type** - The type of transaction or session that was processed and varies by software product.
  - 1099 Pro options include: "Originals", "VOID: Originals", "G - Corrections", etc.
  - 1042-S Pro options include "Originals", "Pro-Rate Originals", "VOID: Originals", etc.
  - W-2 Pro options include "Originals", "VOID: Originals", "Corrections", "State Subset File - STATE", etc.
  - 8966 Pro options include "Originals", "VOID: Amended", "Void", etc.
- **Info** - Indicates if the eFile was processed for Federal or State filing.
  - **FEDERAL FILES**
    - CFS - Denotes that the generated file had the Combined Federal State Filing flag set "on".
    - Std. - Denotes that the generated file had the Combined Federal State Filing flag set "off".
  - **STATE FILES**
    - The information field for the state files uses the following pattern: Letter + Letter, e.g., "U+A".
    - The first letter position denotes the primary process filter:
      - U: Unfiled records
      - A: All Records
    - The second position is a static "+" (plus).
    - The third letter position denotes the threshold setting used.
      - A: Indicates that no thresholds were applied (all eligible forms were selected).
      - S: Denotes that only state thresholds were applied.
      - F: Denotes that only federal thresholds were applied.
- **Session Date** - Displays the date the eFile session was created.
- **Time** - Displays the time the eFile session was created.
- **Receipt ID** - Corporate Suite only, use to track IRS confirmation for AIR filings specific to Forms 1095-B and 1095-C.
- **Reset/Voided** - Indicates the date a session was voided or reset.
- **File Name** - Details the file name and location saved.

### View/Print Log Report
Use to generate a totals report on the currently selected session.

**Reset/Void Magmedia**
Use to Void/Reset the currently selected filing session along with any log IDs associated with that session. See Reset E-File Session

### 17.1.2 The Advantage of Filing Electronically

#### Advantages of Filing Electronically

- Online notification within 1 - 2 work days as to the acceptability of the data transmitted for Forms 1098, 1099, 5498 and W-2G. It is the filer's responsibility to log back in to check results.
- Later due dates than paper for electronically filed Forms 1098, 1099 and W-2G.
- Allowing more attempts than electronic filing to correct bad files before imposing penalties for Forms 1098, 1099, 5498 and W-2G.
- Better customer service due to on-line availability of transmitter files for research purposes.

**FIRE System Specifics**
For detailed information on the FIRE System including; data compression, file preparation, file naming and electronic filing protocols please review Pub. 3609 Filing Information Returns Electronically (PDF). This very helpful publication answers 99% of all FIRE related questions and provides an IRS contact number for any remaining questions. See IRS Instructions

#### 10 Day Window for Electronic Filers
Per IRS Pub. 1220, part C, section 7:
"If the [electronic] file is good, it is released for mainline processing 10 calendar days from receipt. Contact [the IRS] at 304-263-8700 within this 10 day period if there is a reason the file should not be released for further processing. If the file is bad, normal replacement procedures are followed."

### 17.1.3 1099 Electronic Filing Wizard

#### 1099 eFile Wizard

The 1099 Electronic Filing Wizard simplifies the process of creating an electronic file per IRS Pub. 1220. This Wizard allows users to create Original, Corrections, Test and Replacement files. To create an electronic file users must have a Transmitter Control Code (TCC) assigned by the IRS and be registered with the IRS FIRE Site. Users without a TCC must apply for one no later than 30-days prior to the filing deadline or alternatively, consider using the 1099 Pro Service Bureau for their filing needs.

- **IMPORTANT**: The TY 2017 IRS filing deadline for Forms 1099-MISC with Box 7 amounts is 1/31/2018.
- **Corporate Suite Users**: For information on efiling Forms 1095-B /1095-C see ACA.
- **See** State Subset Wizard

**Electronic File .INI Edits**
Users can manually edit the [System] portion of their .INI file to allow for Sort by TIN formatting or Batch
Processing of their magnetic media (electronic) files. See Electronic File .INI Edits for information.

**Generate Electronic Files**

Prior to running the eFile Wizard users must enter their TCC information at the menu bar > File > Transmitter Information.

1. Go to the **Filing My Forms** task panel and click the "Electronic Filing" link.
   - **Corporate Suite Users:** Go to the Filing & Corrections task panel and click the "Electronic Filing" link.

2. At the Begin New 1220 Generation Session screen click the "Create a new 1220 format file for eFile" button.
   - **Corporate Suite Users:** Select the "Create an IRS FIRE or AIR e-file" button and then select "Create a New 1220 Format File for e-file". If generating ACA Forms 1095-B or 1095-C please see ACA - Mag Media Filing on the 1099 Pro Wiki Support Site.

3. At the eFile Wizard screen click "Next" to continue. Click "Back" at any time to go back a step.

4. Check for software updates and click "Next" to proceed. Although not required to continue with this process, it is always smart to update to the most recent version of the software.

5. If your records do **not** have account numbers associated with them, run the **Generate Account Numbers Wizard** and then click "Next" to proceed.
   - Per IRS Pub. 1220, account numbers are required if submitting more than one information return of the same type for the same payee.
   - The Generate Account Numbers Wizard will NOT overwrite any existing account numbers.

6. Choose a method for selecting eligible records. Eligible records (forms) include those with a status of Pending, Printed or SB Print+Mail; records that have been voided, deleted or previously filed are NOT included.
   - **ALL Forms for ALL Filers:** This default option automatically selects every eligible form for all filers.
   - **Selected Form Types for ALL Filers:** This option prompts you to manually select (tag) the form types to include in the electronic file. All filers are processed.
   - **Selected Form Types for Selected Filers:** This option prompts you to manually select (tag) both the filers and form types to include in the electronic file.

7. Select the type of file to generate:
   - **Original:** Select if submitting file for the first time to the IRS.
   - **Corrections:** Select if, after submitting file to the IRS, you need to correct data. For example; a TIN, Amount, Name or form type were incorrect.
   - **Test:** Select if creating a test file for submission to the Combined Federal/State Filing Program.
   - **Replacement of Original File:** Select if the IRS requests a replacement because the original file was damaged.
   - **Replacement of Corrections File:** Select if the IRS requests a replacement because the corrected file was damaged.
     - Replacement Files require a FIRE replacement file name or alpha character from a 9267 Tracking Slip.

8. At the 1099-MISC Special Processing screen indicate whether to process ALL 1099-MISC
records or only those reporting Box 7 Non-Employee Compensation amounts greater than zero. For 2016 the IRS filing deadline for Forms 1099-MISC with Box 7 amounts is 1/31/2017.

9. Select how you will submit the file to the IRS/MCC. Form 4804 is no longer required for electronic filing.
   • Electronic Filing

10. Check for possible Electronic File data problems. Users may opt to scan their files for any errors or warning that might cause their file to be rejected by the IRS. Should errors or warnings be determined, users may choose whether or not to include those records in this electronic file.
   • See Filing Problems and Error & Validation Checking

11. Select the destination folder. Default location is C:\1099 Pro\Pro99T17\MagFiles.

12. Verify Transmitter Information. Changes made here are temporary and apply to this session only. To make permanent changes exit the eFile Wizard and go to the Update eFile Transmitter Information screen.

13. Verify Contact and Company Information. Changes made here are temporary and apply to this session only. To make permanent changes exit the eFile Wizard and go to the Browse the Filers screen.

14. Select filers for submission to the Combined Federal/State Filing Program. You must have prior permission from the IRS to participate in this program.
   • Changes made to a filer's CFSF status are permanent. CFSF status may also be set at the Browse the Filers screen.

15. Confirm settings and if satisfied, click "Finish" to generate your electronic files.
   • Your electronic file is available, in a default file creation, at C:\1099 Pro\Pro99T17\MagFiles.
   • The file name (for example, IRSTAX-00005 (Orig) 2015 02-10-16 01-43-27PM.IRS) includes the date and time of creation and whether it is an Original, Test, Replacement or Corrections file. Do not rename electronic files.
   • Electronic files may be viewed in the optional eFileViewer or a text editor such as Notepad.

16. Post your file on the IRS FIRE site. See FIRE System.
   • Corporate Suite Users: ACA Forms 1095-B / 1095-C must be posted to the AIR System. Please see ACA - Mag Media Filing on the 1099 Pro Wiki Support Site for detailed information.
   • Also see XML Error Logs to review ACA records with fatal errors that fail validation.

☐ Check the status on an IRS FIRE upload at https://tools.1099pro.com/CheckStatus.aspx.

17.1.3.1 Affordable Care Act (ACA)

Affordable Care Act (ACA)

The features contained within this section are available exclusively to users of the Corporate Suite edition.

Under the Affordable Care Act (ACA) certain companies and businesses that provide health insurance to
their employees must submit information returns to the IRS reporting on individual’s health insurance coverage. ACA forms must be filed through the AIR System, which has different filing requirements than the FIRE System.

Anyone required to file 250 or more information returns must file them electronically or you may be subject to IRS Penalties. All filers are encouraged to electronically file even if they have less than 250 returns.

To Electronically File ACA Returns
1099 Pro Corporate Suite allows users to file ACA returns either:

1. Via the Service Bureau for a fee, OR
   - Please see Corporate Suite ACA - Service Bureau for detailed instructions on this process (requires active Internet connection).

2. Within 1099 Pro by creating an XML Magnetic Media file to post to the IRS AIR System.
   - Please see Corporate Suite ACA - Filing Magnetic Media for detailed instructions on this process (requires active Internet connection).
   - See TCC for AIR for important information on registering to use IRS e-Services, applying for a Transmitter Control Code (TCC) and submitting Test Files. The TCC for AIR is unique to the ACA program; the TCC for the IRS FIRE Site is different.

17.1.3.2 CA-592 Quarterly eFile Wizard (CS Edition)

CA-592 Quarterly eFile Wizard

The features contained within this section are available exclusively to users of the Corporate Suite edition.

☐ See Form CA-592 Overview
☐ See State Quarterly eFile Wizard

1. Verify the correct Tax Year is selected (use the “Tax Year” drop menu to change as necessary).

2. On the Filing & Corrections task panel select “Electronic Filing” and choose the “1099/1099/5498” radio button as the form type.

3. At the Begin a New IRS eFile Generation Session screen click the “Quarterly State Reporting” button and select “CA-592 Quarterly File”.

4. At the CA-592 State Quarterly Filing Wizard carefully review information specific to filing CA-592 per Pub. 1023 paying special attention to the handling of Standard vs. Transactional Filers. Click “Next” to proceed; use the “Back” button at any time.

5. At the Do You Have the Latest Version of 1099 Pro? screen it is recommended, although not required, to check for updates. Click “Next” to continue.

6. At the Choose How Forms Will Be Selected For the CA-592 State Quarterly Filing screen choose a
method for selecting eligible records. Voided records are not included in quarterly electronic files.

- **ALL CA-592 Forms for ALL Filers** - This option selects every eligible tax form for every Filer.
- **All CA-592 Forms for Selected Filers** - This option allows users to manually select the Filers to process.

7. At the Specify the File Type, Transmission Medium and Quarter To Process screen indicate files to include.

- **Type of Quarterly File(s) Being Created:**
  - Original (default) - 1099 Pro creates 592 electronic files for Original records only. **NOTE:** The Franchise Tax Board has specific requirements for filing Amended records via paper only; review the Instructions for Form 592.
  
- **Select the Quarter to Process:** See Filing Deadlines below
  - Quarter 1 – Jan. 1 to Mar. 31
  - Quarter 2 – Apr. 1 to May 31
  - Quarter 3 – Jun. 1 to Aug. 31
  - Quarter 4 – Sep. 1 to Dec. 31 (Standard - non-transactional - records are considered Quarter 4)

- **Select the Form Type to Process:**
  - Only Filed/Uploaded forms - This option generates a report showing completed reports, ensuring work is not duplicated.
  - Only Pending/Printed forms - This option generates a report for all records that are not yet filed with the IRS.
  - All forms - This option generates a report for all records, regardless of print status.

8. At the Select Destination Folder for your CA-592 State Quarterly Filing screen review the default file location. Users are encouraged to save files to a LOCAL drive and then move them as necessary. All files are automatically named by individual Filer and per SWIFT specifications. The naming convention is preset for the State abbreviation, filing quarter and year, TIN, today's date and time (hour-minute-second) and Filer Name; for example, **CA Q4TAX 2016 555335555 10-21-16 8-37-11AM 2 CA-592 Test Filer 2.CS**.

- **Archive a Copy of this File (recommended)**: Creates an original copy of this file as a BLOB retrievable should your original file become corrupted or lost.
- **Create a State Withholding Summary Report**
  - Detail Report: Includes Recipient Names and TINs with totals, by Filer.
  - Summary Report: Includes totals only, by Filer.

9. At the Ready to Generate CA-592 State Quarterly eFile(s) screen review settings and if satisfied click the "Finish" button to initiate the electronic file creation and report (if selected in Step 6). Use the "Back" button if necessary to make any changes.

- The file is saved to the default file location unless a different location was selected.
- If a State Withholding Summary Report was selected it automatically displays in PDF format.

**SWIFT System Code H Error**

**IMPORTANT - Part III Type of Income Subject to Withholding**

During 1099 Pro, Inc.'s testing via Swift1023xValidator.exe, the Code H “Allocations to Foreign (non-US) Nonresident Partners/Members” fails validation although it is a choice on Form 592-B. Accordingly, 1099 Pro Corporate Suite changes code H to code I resulting in “Independent Contractor” in your CA file(s).

**SWIFT System**

SWIFT (Secure Web Internet File Transfer) is the Franchise Tax Board's method for securely transmitting
files to and from FTB via the Internet. To use the SWIFT System transmitters must have FTB issued SWIFT login credentials; contact your FTB representative to request this information or refer to the State of California Franchise Tax Board website at https://www.ftb.ca.gov/

1099 Pro's CA-592 Quarterly E-File Wizard creates files in the required CSV format. Post files on the SWIFT login site at https://swift.ftb.ca.gov/.

592 Filing Deadlines

Filing deadlines are subject to change. 1099 Pro, Inc. strongly encourages users to verify all filing deadlines and addresses and assumes no liability for inaccuracies or changes contained herein.

Quarter 1 = April 15
Quarter 2 = June 15
Quarter 3 = September 15
Quarter 4 = January 15

If the due date is on a weekend or holiday, the deadline is extended to the next business day.

17.1.3.3 Electronic Filing Module

Electronic File Module

The Electronic File Module is available in the Enterprise and Corporate Suite editions only. Users may upgrade or use the Service Bureau to file electronically with the IRS on your behalf.

Filing Deadlines:
Paper filers must file returns by February 28, 2018. Electronic filers may file returns electronically through April 02, 2018 without a late filing penalty. Electronic Filing functionality is available to Enterprise Edition customers as a free "Web Update" every December. The IRS does not allow testing of the current year's Electronic File format until November. 1099 Pro sends test files to the IRS and awaits full verification of the Electronic File format before releasing the electronic filing module to our customer base. We employ this strategy to bring you a proven and tested product. No customer of 1099 Pro has ever been penalized by the IRS due to a software error on our part.

Transmitter Control Code (TCC):
A TCC is required if your company will be filing electronically via the 1099 Pro Enterprise Electronic File Module. If you don't already have one, we suggest you submit your request to the IRS at least 45 days prior to the April 02, 2018 filing date. To request a TCC number complete Form 4419, Application for Filing Information Returns Electronically. This form may be printed directly within the 1099 Pro software or obtained by calling the IRS at (866) 263-8700 or (304) 263-8700.

If your company doesn't have a TCC or you've missed the deadline to apply for one, our Service Bureau can file electronically on your behalf for a nominal fee.

Combined Federal / State Filing Program (CFS):
Participation in this program allows the IRS to forward certain 1099 information directly to participating states. The following information returns may be filed under this program; 1099-DIV, 1099-G, 1099-INT, 1099-MISC, 1099-OID, 1099-PATR, 1099-R and 5498. By checking the box "Combined Federal/State Filer" for each Filer, 1099 Pro will flag that electronic data going to the IRS to be formatted in the CFS.
program.
Some states, such as California, require reporting of other forms not in the CFS (e.g. 1098, ...). In this case you can create state specific files using 1099 Pro Enterprise or Corporate Suite or you can contact our Service Bureau for specialized filing on your behalf. Current Enterprise and Professional customers can reference http://www.1099 Pro.com/resourcecompliance.asp for more information.

Visit the 1099 Pro web site at www.1099 Pro.com for the latest information and updates.

17.1.4 Efile States Subset File Wizard
17.1.4.1 How do I Generate State Subset

State Subset Overview

The features contained within this section are available exclusively to users of the Enterprise and Corporate Suite editions of our software. For all others, contact the Service Bureau for CF/SF Program options.

Important Disclaimer - Please Read
- All files generated will be in the 750 byte format per Publication 1220 unless a separate format is required by the state. Even though many states follow the IRS Pub 1220 specifications, they often make unique modifications to the record layouts.
- While 1099 Pro makes every effort to keep these formats updated it is your responsibility to verify the state(s) receiving your files will accept both the format and the data generated prior to submission.
- The Enterprise version of the software does not apply state thresholds when filing. Enterprise will create a file for all non-zero forms and it is up to the end-user to decide which records/files to submit. The Corporate Suite software provides complimentary “State Filing Thresholds” rules, which can be edited by users to meet their exact state filing needs, that are used to filter out unwanted or unnecessary forms. See Reporting Thresholds.
- Please see Special Cases for State Filing for a detailed list of states’ formats that require modifications after the state direct eFiles are generated but before submittal to the states. These modifications are necessary because the related states require information that is not present on the tax form and thus not able to be generated by the Enterprise or Corporate Suite software.

What is State Direct Filing / State Subset Filing?
State direct filing is when a state requires that a tax form be sent directly to their tax department.

When is State Direct Filing Required?
1. If the State does not participate in the Combined Federal/State Filing Program (CFSF).
2. If the form type in question is not included in the CFSF program (e.g., 1099-S).
3. If the individual state has threshold rules that require direct filing. For example:
   a. If State Tax Withheld > 0
   b. If the state requires that all forms be filed directly, regardless of dollar amount (e.g., Oregon).

*It is each company’s responsibility to determine whether or not it has state direct filing obligations and what thresholds apply. The Corporate Suite software updates the State Reporting Thresholds every year and allows for users to modify the the thresholds, if desired.

How does the Software determine the Tax State?
1. Explicit State Withholding Boxes: If the state withholding box is completed on a tax form, for a specific tax state, then that state is the “tax state” regardless of the Tax State Override (#2) or the Recipient Address (#3) below. Forms with explicit state withholding boxes include: 1099-B, 1099-DIV, 1099-G, 1099-INT, 1099-K, 1099-MISC, 1099-OID, 1099-R, W-2G, & 1042-S.
2. Tax State Override: If you use the optional “Override default for State tax reporting” button, located on
the right hand pane of the form entry window, the selected state will override the recipient's state in their address.

3. Recipient Address: If there is no state withholding and a different state is not selected in the "Override default for State tax reporting" box as discussed above then the state in the recipient address will be used.

See [State Subset Wizard](#) to begin the process.

**TIP Number 1:** Be careful of potential duplicate filings where you may have already filed your data in the Combined Federal State Filing Program. If you have specific questions concerning state filing, please contact that state.

**TIP Number 2:** 1099 Pro is capable of combining multiple filers with the multiple form types in one file. If you want separate files for Filers A, B and C and multiple form types then consider processing one Filer and Form type at a time.

### 17.1.4.2 State ID Number

#### State ID Numbers

State ID numbers are assigned by the individual state and are generally used for state withholding purposes. For example, in California the Employer Development Department (EDD) assigns a state ID number. Check with your accountant, attorney, or the specific State Department of Revenue to determine your company's state ID number. Many companies do not have, or require, a State ID Number.

**To Add/Change/Delete State ID Number**

1. On the menu bar select File > Filers List.
   - Corporate Suite Users: On the General Options task panel select Filers List.

2. At the Filer Master List screen highlight the Filer with the State ID to edit, and click the "Change" button.

3. At the Changing a Filers Record screen select the “State I.D. Number(s)” tab.

4. Either “Add”, “Change”, or “Delete” State ID Numbers as necessary. If the “Add” or “Change” options are utilized, the user is prompted with a check box to “Update all PENDING tax forms with the new State information”:
   - If checked, this applies the new/updated State ID Number to any pending record, under the selected filing entity, that has the State already entered into one of the boxes listed below.
   - If unchecked, all records remain unchanged but any future records will utilize the new State ID Number.

**To Access the Select State ID database**

When adding or changing a record place your cursor in the state box, located:

- 1099-B: Box 14
- 1099-DIV: Box 12
- 1099-INT: Box 15
- 1099-G: Box 10a
- 1099-K: Box 6
- 1099-MISC: Box 17
- 1099-OID: Box 10
1099-R: Box 13  
W-2G: Box 13  
W-2: Box 15  
1042-S: Box 23

Use the <F2> key or right-click your mouse to access the Select State ID database.

17.1.4.3 What can I expect from the States Subset File Wizard

What To Expect From the State Subset

What Happens When Generating State Subset Files?
Files will be placed in the "MagFiles" directory unless a different directory was selected. State Files are labeled by State Abbreviation, Date & Time with a TXT extension; for example, "CA TAX 2-25-09 5-01PM.TXT".

The eFile Viewer™ can be used to view any files that follow that standard IRS Pub 1220 format exactly. States that employ different formats, or a modified 1220 format, are not accommodated by the eFile Viewer.

Where "Electronic Filing" option, from the left-hand toolbar, also doubles as the Completed eFile Session list to view the eFile creation history and to Reset (Void) Sessions. Users may identify individual state files from the Completed eFile Session List as the "Trans Type" column has the two letter state abbreviation followed by the type of file generated e.g. "CA:Original". Detailed listings of any electronic file generated can be obtained by highlighting the eFile session in question and then by clicking the "View/Print Log Report" button. These reports can be previewed to the screen or printed. Additionally, the IRS form 4804 may be printed in the same manner if desired for any electronic filing session.

Note: See IRS Publication 1220 for more details.

17.1.4.4 State File Generation Wizard

State Direct / State Subset Wizard

The features contained within this section are available exclusively to users of the Enterprise and Corporate Suite editions of our software. For all others, contact the Service Bureau for CF/SF Program options.

How to Generate State Direct / State Subset Files
Prior to starting this wizard please see State Subset Overview for important information and review the State Reporting Thresholds to see if any modifications are required.

1. Go to the Filing My Forms task panel and click the "Electronic Filing" link.

2. At the Preparing Tax Forms for Filing Electronically screen click the "Create State Subset Filing" button.
   • Corporate Suite Users: To generate Puerto Rico subset files select "Create Puerto Rico Files".
3. **Check for Updates** - It is recommended to routinely check for program updates. States have different reporting deadlines than the IRS and are constantly releasing their filing specifications in late into the reporting season. Users who are not on the latest version risk filing in incorrect formats and receiving related penalties.

4. **Choose How Filers & Forms Will Be Selected** - Select which tax forms will be included and then click "Next" to proceed.
   - **All Forms for ALL Filers Types**: This default selection includes all form types for the Filer(s) selected and includes all eligible records.
   - **Selected Form Types for ALL Filers**: Use to select form types for ALL filers.
   - **Selected Form Types for Selected Filers**: Use to select form types and filers.

5. **Select States to Generate Files For** - A separate report will be created for each state, but only if you have issued forms to recipients or withheld taxes for that state.
   - Tag (or select) states as appropriate then click "Next" to continue.

6. **Select the File Type & Transmission Medium (CS Only)** - Select which type of file to create & the types of records to include.
   - **File Types**: Original, Corrections, Replacement of Original File, Replacement of Corrections File, Test.
     - **NOTE**: 1099 Pro does not support individual states' corrections formats. The Corrections state file will be in the same format as the original (often this is what states require).
   - **Record Types**: Only include records that meet the criteria that you set below in the state direct file generation. This is subject to the File Type that you choose above.
     - **Filed/Uploaded Forms**: Only forms that are in a "Filed Mag", "Print/Mag", or "SB Filing" status will be included.
     - **Pending/Printed Forms**: Only forms in a "Pending", "Printed", or "SB Print/Mail" status will be included.
     - **All Forms**: All form statuses are included, subject to the "Original" or "Corrections" status chosen above.

7. **Account Numbers** - Some form types require recipients to have unique account numbers; the wizard will not overwrite existing account numbers. See Generate Account Wizard.

8. **Process Forms with All Zero Amounts (CS Only)** - Select whether you want to include forms with zero amounts or not.
   - **Filter (Skip) forms that do not have any dollar amounts**: All non-zero records, regardless of status, will be included in your state subset files except for Corrections.
   - **Process all forms including ones with all zero amounts (subject to threshold selections)**: All forms in the database are eligible for state filing, subject to the options chosen in the state direct filing wizard.

9. **1099-MISC Special Processing** - Certain states follow the IRS specifications that 1099-MISC forms, with Box 7 amounts, be filed at earlier deadlines (i.e January 31st) than other form types. This option only appears if you have selected All Forms / All Filers or included the 1099-MISC form type.
   - **Process all 1099-MISC Records**: All 1099-MISC records are eligible to be filed.
   - **Process only 1099-MISC records with Box 7 Non-Employee Compensation**: Only 1099-MISC forms that have Box 7 amounts are eligible to be filed.

10. **Group by EIN** - New as of Tax Year 2015, choose either:
11. **Threshold Options (CS Only)** - Choose whether or not to apply additional thresholds to filter out eligible records

- **NO - Do NOT apply State Thresholds (non-zero forms will be filed):** No additional thresholds are applied. The state thresholds & federal thresholds are ignored and any record meeting all of your previous selections is included.

- **YES - Apply State Thresholds (only forms that meet or exceed State thresholds will be filed):**
  - Process forms meeting each State threshold criteria - The state threshold rules from the Security & Administration Tab -> Reporting Thresholds -> Manage State CFS Limits and Settings are applied. If a state does not have a threshold rule (for that tax year & form type) then all the records for that state are excluded. Any records that are below the thresholds are also excluded.
    - State thresholds are used to file the minimum necessary records with each state. Each state has their own set of unique thresholds.
  - Use Standard/Standard Custom Thresholds any any form with explicit State Withholds > 0 - All records in the above option are included + any records that have explicit state withholding (regardless of whether or not there is a state threshold rule.
    - For instance, if a 1099-MISC record with a tax state of Alaska (AK) has state tax withheld, it would be excluded in the first option but included in this second option.

- **YES - Apply Federal Thresholds**
  - Use EIN in Threshold Grouping and Filtering - Thresholds are measured across all Payer Codes (PCodes) for a specific EIN.
  - Use Payer Code in Threshold Grouping and Filtering - Thresholds are measured only across the specific Payer Code for an EIN. Any other Payer Codes under the same EIN are not included when aggregating records to see if they meet the minimum threshold.
  - Apply Federal Threshold Rules to Each Form Individually - Only the individual record is used when measuring against the threshold.

12. **Select CA Surname** - California requires an additional indicator in your state file that specifies how your Recipient name information is ordered for those Recipients with an SSN (not EIN). Please select the "My last name field for SSN Recipients with an SSN has their names entered with first name first" check box IF:

- You place all Recipient Name data in the LAST NAME field. You do NOT use the FIRST NAME field. AND
- The LAST NAME field for your Recipients with an SSN has their names entered as first name first, e.g. "John Doe", rather than "Doe, John".

13. At the Initializing Wizard screen review Important information and then click "Next" to proceed:

- All non-zero records, regardless of status, will be included in your state subset files except for corrections. Corrections, if any, must be handled by paper filing.
- Do not file the same information twice. For example, do not file in the CF/SF Program and then submit the same data again, unless directed to do so by the state.
- State rules change frequently and it is YOUR responsibility to file and verify that your file was accepted by the state.
- Unlimited state subset files may be generated.

14. **Select Destination Folder** - The default location is C:\1099 Pro\Pro99T16\MagFiles.
15. **Verify Transmitter Information** - Auto populated from the Electronic Filing Transmitter information. Changes made during this process are temporary and only affect the eFiles being generated in this session.

16. **Verify Contact and Company Information** - Auto populated from the Electronic Filing Transmitter information. Changes made during this process are temporary and only affect the eFiles being generated in this session.

17. **Click “Finish” to generate state subset file(s).**
   - View [Special Cases for State Filing](#) to review states that require unique modifications before submittal. These states require the user to edit the information **before** submitting the files to their respective states.

### 17.1.4.5 Special Cases for State Filing

#### Special Cases for State Filing

The states contained within this section have unique filing formats that require certain user edits before submitting the state eFiles. The additional information required by these states is not available on the 1099/W-2 tax form and thus cannot be generated from the software during the eFile creation process. Only W-2 Pro, 1099 Pro Enterprise, and Corporate Suite can create state direct reporting eFiles.

**IMPORTANT:** 1099 Pro, Inc. suggests using a text editing program such as TextPad or Notepad to edit the state files. Please use caution when editing files - a single wrong space or character can cause files to be rejected by the states!

#### States Requiring Additional Information / Edits (1099 Reporting)

- **Alabama (AL):**
  - Alabama requires that 1099 and W-2 records be submitted together, within the same file. If your company is required to submit 1099 and W-2 information, directly to AL, please copy all of the entire line from your W-2 electronic file (generated from W-2 Pro or Corporate Suite) and paste it at the end of the last character in the 1099 file.

- **Idaho (ID):**
  - Idaho requires special information that mimics its Reconciliation Form 967 to be included in the C Record of its electronic file. This information is not present on any of the 1099 tax forms so it must be added manually if required or different from the default output.
    - **C Record(s):**
      - **Positions 561-571:** Withholding Payments Made During the Year – Payments made from 1/1 to 12/31.
      - **Positions 605:** Tax Due Sign – Enter negative sign (-) if there is a refund.
      - **Positions 606-616:** Penalty on Balance Due.
      - **Positions 617-627:** Interest on Balance Due.
      - **Positions 628-638:** Total Amount Due or Refund. Total amounts in positions 594-604 + positions 606-616.
      - **Positions 639:** Tax Due Sign – Enter negative sign (-) if there is a refund.
      - **Positions 662-672:** Penalty for Late Filing. 1099 Pro currently zero fills this field.
- Positions 673-683: Total Due or Refund. Total of positions 628-638 + positions 662-672.
- Positions 684: Total Due Sign – Enter negative sign (-) if there is a refund.
- **NOTE:** 1099 Pro currently zero fills all amount fields and blank fills all non-amount fields, shown above.

- **Iowa (IA):**
  - K Record(s), Positions 682-689: Enter the Payer BEN
    - Iowa requires the addition of a Business eFile Number (BEN) in the K Record of all file submissions. The Iowa Department of Revenue assigns a BEN to every registered business entity that may need to log into Iowa eFile & Pay such as an employer, payer, or bulk filer (payroll service provider or transmitter). A bulk filer must use its own BEN to log into eFile & Pay, not its client’s BEN. A bulk filer must report the respective client’s (employer/payer) BEN on RV and K records.

- **Massachusetts (MA):**
  - Massachusetts requires special information, pertaining to bonds & mutual funds, be included in the B Record when filing 1099-INT records with the state. Please use a text editor to open the eFile and add this information, if necessary.
    - For Interest from Bonds:
      - Use the 1099-INT format to record earnings on each state or local bond. Report the income as if it were taxable for federal purposes. Note: A return is due for each bond on which interest is paid.
      - Report payment amounts in positions 67-78 of the payee "B" record. Right-justify and zero-fill.
    - For Interest from Mutual Funds:
      - Use the 1099-INT format to record earnings from mutual funds, money market funds, and unit investment trusts. Report the income as if it were taxable for federal purposes.
      - Use positions 44-46 of the "A" record to report the percentage of mutual fund portfolio income distribution attributable to bonds issued by Massachusetts, Puerto Rico, Guam and the Virgin Islands, rounded to the nearest whole number - e.g. 25.4% would be reported as 025 and 25.5% would be reported as 026.
      - Report payment amounts in positions 67-78 of the payee "B" record. Right-justify and zero-fill.

**States Requiring Additional Information / Edits (W-2 Reporting)**

- **Alabama (AL):**
  - Alabama requires that 1099 and W-2 records be submitted together, within the same file. If your company is required to submit 1099 and W-2 information, directly to AL, please copy all of the entire line from your W-2 electronic file (generated from W-2 Pro or Corporate Suite) and paste it at the end of the last character in the 1099 file.

- **Iowa (IA):**
  - Iowa requires a special file naming schema that incorporates the Business eFile Number (BEN).
    - 1099 Pro currently zero-fills the BEN as that information is not present on the tax form.
      - Example 1: IAW2-000000000-201701201730.txt
      - Replace the "000000000" with your company’s BEN
  - RV Record(s), Positions 40-47: Enter the Employer’s BEN
    - Iowa requires the addition of a Business eFile Number (BEN) in the RV Record of all file submissions. The Iowa Department of Revenue assigns a BEN to every registered business entity that may need to log into Iowa eFile & Pay such as an employer, payer, or bulk filer (payroll service provider or transmitter). A bulk filer must use its own BEN to log into eFile & Pay, not its client’s BEN. A bulk filer must report the respective client’s (employer/payer) BEN on RV and K records.
- **Indiana (IN):**
  - RS Record(s), Position 308: Enter the Tax Type Code
    - Indiana requires additional information in each RS record to indicate the Tax Type Code - which is related locality income tax reporting. Please enter the code "C", "D", "E", or "F" in the "Custom Msg/Text:" box for the eFile to correctly populate the field (*CS ONLY*). If using W-2 Pro software, please generate the eFile and enter the proper code for your reporting.
    - C = City Income Tax
    - D = County Income Tax
    - E = School District Income Tax
    - F = Other Income Tax

- **Kansas (KS):**
  - RS Record(s), Positions 338-348: Employee Contribution to KPERS, KP, & F and Judges
    - Right justify & zero fill. 1099 Pro currently leaves this field blank.

- **Louisiana (LA):**
  - RV Record(s)
    - The RV record(s) are considered optional by Louisiana and are not included in the eFile created by 1099 Pro. If your company prefers to report with an RV Record for LA, please follow the specifications on the state website (https://esweb.revenue.louisiana.gov/LaWage/Instructions.aspx#federal).

- **Maine (ME):**
  - RS Record(s), Positions 298-307: Maine Public Employees Retirement System Contributions (MEPERS)
    - For public employers who participate in the MEPERS, enter the amount of pick-up contributions deducted from this employee’s salary and contributed to MEPERS on behalf of the employee. This amount is required to be added back to Maine income pursuant to 36 MRSA 5122(1)(G). Do not include the employer’s portion of the contributions. Right justify and zero fill. 1099 Pro currently zero fills this field.

- **Maryland (MD):**
  - Maryland attempts to include the information from the MW508 reconciliation form in its eFile. The information from the MW508 is not present on the W-2 tax form and thus requires heavy user edits to accommodate.
    - RS Record(s), Positions 368-369: Employee Withholding Allowance
      - Number of exemptions claimed on Form W-4 Employee's Withholding Allowance Certificate. Currently, 1099 Pro zero fills this field.
    - RV Record(s):
      - Positions 149-160: MW508 - Employer Total Amount of Taxes Reported from Line 2
      - Positions 173-184: MW508 - Enter Total Withholding Tax Paid This Year from Line 3c
      - Positions 185-196: MW508 - Employer Total Tax Exempt Credits (Form MW508CR) from Line 3d
      - Positions 197-208: MW508 - Employer Amount Tax Due from Line 4
      - Positions 209-220: MW508 - Employer Overpayment from Line 5
      - Positions 221-232: MW508 - Employer Amount of Overpayment to be Applied as Credit to Your Account from Line 6
      - Positions 233-234: MW508 - Employer Amount of Overpayment to be Refunded from Line 7
      - Positions 269-296: MW508 - Employer Representative Name
      - Positions 297-311: MW508 - Employer Representative Title
New Jersey (NJ):
- RS Record(s)
  - Position 299: Family Leave Insurance Plan Type Code - Enter “P” if the employer has a private Family Leave plan approved. Otherwise, leave blank. 1099 Pro currently leaves this field blank.
  - Positions 300-313: Private Family Leave Insurance Plan Number - Make an entry in this field only if “Family Leave Insurance Plan Type Code”, above, is a “P”. Left justify & blank fill. 1099 Pro currently leaves this field blank.
  - Position 338: Disability Plan Type Code - Enter “P” if the employer has a private disability plan approved.
  - Positions 339-352: Private Disability Plan Number - Make an entry in this field only if “Disability Plan Type Code”, above, is a “P”. Left justify & blank fill. 1099 Pro currently leaves this field blank.
  - Positions 353-357: Combined NJ Unemployment Insurance, Workforce Development Program, and Health Care Subsidy Withheld - Right justify & zero fill. 1099 Pro currently zero fills this field.
  - Positions 358-362: Disability Insurance Withheld - Right justify & zero fill. 1099 Pro currently zero fills this field.

Ohio (OH):
- RS Record(s):
  - Positions 308: Tax Type Code
    - Ohio requires additional information in each RS Record to indicate the Tax Type Code – which is related to income tax reporting. Please enter the code "C", "D", "E", or "F" in the "Custom Msg/Text:" box for the eFile to correctly populate the field ("CS ONLY"). If using W-2 Pro software, please generate the eFile and enter the proper code for your reporting.
      - C = City Income Tax
      - D = County Income Tax
      - E = School District Income Tax
      - F = Other Income Tax
  - Positions 309-319: Local Taxable Wages
    - This field should only be filled in if the Tax Type Code above is "E". 1099 Pro currently populates this data from Local Wages box on the W-2 form. Users should either not populate Local Wages, on the W-2 form, for Ohio if the Tax Type Code is not "E".
  - Positions 320-330: Local Income Tax Withheld
    - This field should only be filled in if the Tax Type Code above is "E". 1099 Pro currently populates this data from Local Income Tax box on the W-2 form. Users should not populate Local Income Tax, on the W-2 form, for Ohio if the Tax Type Code is not "E".
  - Positions 331-337: School District Number
    - Enter the four digit school district number (right justify and fill with blanks). Listing of the school district numbers can be found at tax.ohio.gov in the IT 1040 booklet or SD 100 booklet.

17.1.5 FIRE System

**FIRE System**

Use the Filing Information Returns Electronically (FIRE) System to electronically upload files to the IRS. Electronic files created via the 1099 Pro Electronic File Wizard fully comply with required IRS record formats per Pub. 1220. The FIRE System is available 24 hours a day, 7 days a week to any transmitter and can be reached by visiting [https://fire.irs.gov](https://fire.irs.gov). The FIRE System can be accessed by opening a web browser, accessing the Internet and typing in the address [https://fire.irs.gov](https://fire.irs.gov) in the address field.

To use the FIRE System users must have a valid Transmitter Control Code (TCC). Users may file on behalf of multiple Filers with a single TCC. Users must also have valid IRS FIRE Site logon credentials.
which includes a User ID, Password, and PIN.

For more information on the IRS Fire System select Forms from the main menu, then select "IRS instructions and blank forms" from the drop down menu, then double click on "Filing Information Returns Electronically" from the View or Print Blank Forms and Instructions (PDF Format) screen.

17.1.6 FIRE Upload Process

FIRE System Upload

This process applies to 1099 Informational Returns (including 1098, 1099s, 5498s and W-2Gs) and 1042-S Foreign Person’s U.S. Source Income Subject to Withholding. The purpose of this tutorial is to guide users through account creation for the IRS FIRE (Filing Information Returns Electronically) system and the uploading of files to the IRS.

☐ This process does not apply to Form W-2 Wage & Tax Statements.

Create an IRS FIRE system account (if you do not have one).
1. Visit http://FIRE.IRS.gov
2. Click on the link labeled Create New Account
3. Now you will be asked to enter your company specific information. Enter your information in the indicated fields. This is critical because if there is any problem with the file, this is the information the IRS will use to attempt to contact you.

4. Once you have completed filling the information in, click “Submit” to continue.
5. You will be taken to a screen where you can create a user name and a password for accessing the
IRS FIRE system. Read the directions carefully. The password that you create MUST be 8 characters in length, and have an upper case, a lower case and a numeral, but cannot contain your user id or personal name.

6. Once you have input your chosen user name and password, click the “Create” button.
7. You will be asked to create a pin number. This number will be used when you upload your file (which is created by the 1099 Pro software).
8. Once you are done with the PIN creation process click the “Submit” button.

Create FIRE System Account (continued)

Please complete the form below. You will need to supply the name you intend to use as your User ID, and a password. If you wish to use special characters in your User ID, the following are allowed: _, /, &, #, -, period, comma, and space.

Your password must be eight alpha/numeric, containing at least 1 uppercase, 1 lowercase, and 1 numeral but cannot contain your User ID or your personal name!

<table>
<thead>
<tr>
<th>User ID</th>
<th>1099Pro</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password</td>
<td>**********</td>
</tr>
<tr>
<td>Verify Password</td>
<td>**********</td>
</tr>
</tbody>
</table>

Create
9. Now you will be redirected to the FIRE system account page, where you can make modifications to your account, or you can upload the file that 1099 Pro has created.

10. To continue with the file upload process, click on the "Send Information Returns" link in the top left corner.

11. You will be asked to enter your TCC and EIN at this point. Once you have entered this information, click the "Submit" button.

*Note: If you do not have a TCC number you will need to complete form 4419 and submit the completed document to the IRS* [http://www.irs.gov/pub/irs-pdf/f4419.pdf]
12. Now you will be shown your contact information. You can make any adjustments that are necessary, and once you are done, click the "Accept" button.

13. Here you will be shown a list of links, and you will choose what type of file you are uploading.

**Original File**: An information return that has never been reported.
1. Once you have clicked on the “Original File” link, you will be asked to enter the PIN number that you created in step 7. Once you have done this, click “Submit”.
2. Now you will need to click on “browse” and locate the file that the 1099 Pro software created for you.
3. After locating the file, click the “Upload” button to send it to the IRS.

**Replacement File**: If an original or correction information return is bad, it must be sent as a replacement file after you fix the errors. Once you have clicked on the “Replacement file” link you will need to choose if you are replacing an Electronic file. The 1099 Pro software generates eFile.
1. Click on “Correction file”.
2. You will be prompted to enter the PIN you created in step 7 of this tutorial. Once you have done this click “Submit”.
3. You will now need to click on “Browse” and locate the file that you created using the 1099 Pro software. Once you have located the file, you will need to click on the “Upload” button.

**Amended/Correction File**: An information return which is submitted by the transmitter, in order to correct an information return that was previously submitted and processed by the IRS, but contained erroneous data. An amended/correction file will only contain the records in error, not the entire original submission. If you are sending a 1042-S file, you would click on Amended File. Otherwise, click on Correction File.
1. Click on “Correction file”.
2. You will be prompted to enter the PIN you created in step 7 of this tutorial. Once you have done this click “Submit”.
3. You will now need to click on “Browse” and locate the file that you created using the 1099 Pro software. Once you have located the file, you will need to click on the “Upload” button.
Test File: This option is used to test your files for the upcoming tax year.

1. Click on the “Test File” link.
2. Click on Browse and locate the test file that you created using the 1099 Pro software. Once you have done this, click on the “Upload” button.

Once you are done with uploading any electronic files to us, click on “Logout” to complete your upload session.

17.1.7 Electronic File INI Edits

Electronic File .INI Edits

Users can manually edit the [System] portion of their .INI file found in the Admin folder (default location is C:\1099 Pro\Pro99T17\Admin\Pro99T17.INI). Altering settings in this location could potentially damage the software, please contact Technical Support for assistance if necessary.

Sort Records by TIN Formatting
Modify entry to sort records by Recipient TIN. A value of 1 sorts by FilerID,RCPTIN which increases processing time. A value of 0 (default) sorts by FilerID.

[System]
EnableMagTinSort=1

ZIP Magnetic Media File After Creation
Modify entry to automatically ZIP the magnetic media (electronic) file after creation.

[System]
ZipAfterMag=1

Batch Forms in Magnetic Media File
Modify entry to limit the number of forms included in a magnetic media (electronic) file.
17.1.8 Combined Federal/State Filing Program

**Combined Federal/State Filing Program**

The Combined Federal/State Filing Program (CF/SF) is open to electronic filers of Informational Returns. It was established to simplify information returns filing for the taxpayer. IRS/MCC forwards this information to participating states free of charge for approved filers. Separate reporting to those states is not necessary.

Some participating states require separate notification that the payer is filing in this manner. Since IRS/MCC acts as a forwarding agent only, it is the payer's responsibility to contact the appropriate states for further information [emphasis added].

“All corrections properly coded for the Combined Federal/State Filing Program will be forwarded to the participating states.”

* See IRS Pub. 1220 for a complete description. Contact your state agency for individual State requirements.

**First Time Participants Must:**
1. Obtain a [Transmitter Control Code (TCC)]
2. Submit a test file to the IRS. Test files may be generated via the [1099 Pro Electronic Wizard].
   - Hard copy print tests are no longer acceptable.
   - Electronic test files may be submitted between 11/01/16 to 3/17/17 (TY 2016).
   - A test file should consist of at least 11 total records for recipients from any of the states participating in the Program.

**Participation as of Tax Year 2016***

**Participating States**
AL, AR, AZ, CA, CO, CT, DE, GA, HI, ID, IN, KS, LA, MA, MD, ME, MI, MN, MO, MS, MT, NC, ND, NE, NJ, NM, OH, SC, VT and WI.

**Forms INCLUDED in Program**

* As of May 3, 2017 Publication 1220 has not been updated for Tax Year 2017.

**Test Files**
1. Electronic test files coded for this program must be submitted between November 1, 2016, through March 17, 2017 (for Tax Year 2016).
   - The FIRE Test System is down from 6 p.m. (Eastern) December 9, 2016, through January 2, 2017, for yearly updates.
2. A test file is only required for the first year when you apply to participate in the Program. Each record, both in the test and the actual data file, must conform to this Revenue Procedure.
3. While a test file is only required for the first year when a filer applies to participate in the Program, it is highly recommended that a test be sent every year you participate in the Combined Federal/State
Filing program. Each record, both in the test and the actual data file, must conform to the current Revenue Procedure.

4. Electronic filers must log on to the FIRE System within two business days to check the acceptability of their test file. The new test file must be transmitted no later than 3/17/17.

1099 Pro Service Bureau
A test file is not required if the Service Bureau is filing your informational returns.

17.1.9 Federal Thresholds (CS Version only)

Federal Thresholds

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

The Federal Thresholds are values that represent the minimum amount that you are required to report the IRS and to the payee for each 1099 form. If you pay less then the threshold for that particular form you do not need to file a 1099 form for that payee.

17.1.10 IRS Name Control

IRS Name Control

For 1099's and W-2G's, The following overview provides an explanation on the taxpayer identification number matching process and the development of name controls. Understanding this process could help decrease the filing of incorrect information returns such as 1099 documents used to report various types of income and W-2G's used to report gambling winnings.

The information returns you file must include a correct name and taxpayer identification number (TIN) combination to allow the IRS to match the information reported against the income included on the payee's income tax return. They check whether a name/TIN combination is correct by matching it against a file containing all social security numbers (SSNs) issued by the Social Security Administration and against a file containing all employer identification numbers (EINs) issued by the IRS. Then, they compare the name control on the payee document (if provided) to the name control on file. If a name control is not provided or is provided incorrectly, they develop it from the name(s) provided on the first two name lines of the information return. If they can match a developed name control to the name control in our records, they consider it to be correct. If no match is found using this process, they consider your name/TIN combination to be incorrect.

Name Controls
A name control consists of up to four characters. To help ensure that the name/TIN combination for an account matches the name/TIN combination on SSA or IRS files, use the following information when you open an account for a payee.

Individuals
The IRS develops name control for an individual from the last name on the return. For example:
- Ralph Teak, Dorothy Willow Joe McCedar
For an individual that has a hyphenated last name, they develop the name control from the first of the two last names. For example: 
*Brandy Cedar-Hawthorn Victoria Windsor-Maple*

**For Joint Names**
Regardless of whether the payees use the same or different last names, they develop the name control from the primary payee's last name. For example: 
*Joseph Ash & Linda Birch Edward & Joan Maple*

**Sole Proprietors**
The IRSs generally develop the name control for a sole proprietor, who may have both a SSN and an EIN, from the individual's last name (not the business name) on the information return. For example: 
*Mark & Jane Hemlock Karen Birch*
*The Sunshine Café Ace Computer Co.*

- **NOTE:** Sole proprietors should enter their business, trade, or "doing business as" name on the second name line of the information return.

**Other Organizations**
They develop the name control for other organizations from the entity's name on the original Form SS-4 (which was used to apply for the EIN). For example: 
*St. Bernard's Methodist Church ABC Company*
*Building Fund Main Street Store*

Knowing how name controls are developed should be helpful in the filing of correct information returns.

- **NOTE:** If a payee has changed his or her last name, for instance, due to marriage, he or she SHOULD inform the Social Security Administration of the name change. On name line one of the Form 1099, a payor should enter the payee's first name and new last name (if the change has been made with SSA), or the payee's first name, former last name, and new last name (if the change has not been made with SSA).

### 17.1.11 Reset E-File Session

**Reset eFile Session**

To reset/void an electronic filing session automatically resets all records in that efile session to their pre-eFile status. For example, a record that prior to electronic filing had a Pending status will return to Pending status and is thus available for edits and/or inclusion in a new electronic file session.

**To Reset Session**
1. On the Filing My Forms task panel select the "Electronic Filing" link.
2. At the Completed File Generation Sessions List screen highlight a session and click the "Reset (Void) Session" button.
3. The Administrator prompts, "Are you sure that you want to RESET/VOID this MagMedia session?" Click "Yes" to proceed or "No" to cancel.
The “Trans Type” column indicates that the session has been voided.

The Reset/Voided column indicates the date the session was voided.

17.1.12 Rule-of-250

Rule-of-250 Overview

The Rule-of-250 states that any filer submitting 250 or more forms of any one type must submit those forms electronically. Failure to do so may result in fines of up to $260 per form effective Tax Year 2017*. For those filers not signed up for the IRS FIRE system, our SSAE 16 SOC I TYPE II Service Bureau offers electronic filing services. Please call us at (866) 444-3559 to schedule an appointment and obtain pricing.

*From the 2017 IRS General Instructions for Certain Information Returns, page 8.

2016 General Instructions for Certain Information Returns (Forms 1098, 1099, 3921, 3922, 5498, and W-2G)

1099 Informational Returns:
Electronic reporting may be required for filing all information returns discussed in these instructions (see Who must file electronically below). Different types of payments, such as interest, dividends, and rents, may be reported in the same submission.

Pub. 1220 provides the procedures for reporting electronically and is updated annually. Pub. 1220 is available on the IRS website at www.irs.gov. You can file electronically through the Filing Information Returns Electronically System (FIRE System); however, you must have software that can produce a file in the proper format according to Pub. 1220. The FIRE System does not provide a fill-in form option. The FIRE System operates 24 hours a day, 7 days a week. You may access the FIRE System via the Internet at http://fire.irs.gov. See Pub. 1220 for more information

See Deadlines

Who must file electronically:
If you are required to file 250 or more information returns, you must file electronically. The 250-or-more requirement applies separately to each type of form. For example, if you must file 500 Forms 1098 and 100 Forms 1099-A, you must file Forms 1098 electronically, but you are not required to file Forms 1099-A electronically.

The electronic filing requirement does not apply if you apply for and receive a hardship waiver. See How to request a waiver from filing electronically below.

The IRS encourages you to file electronically even though you are filing fewer than 250 returns.

Filing requirement applies separately to originals and corrections:
The electronic filing requirements apply separately to original returns and corrected returns. Originals and corrections are not aggregated to determine whether you are required to file electronically. For example, if you file 400 Forms 1098 electronically and you are making 75 corrections, your corrections can be filed on paper because the number of corrections for Form 1098 is less than the 250 filing requirement. However, if you were filing 250 or more Form 1098 corrections, they would have to be filed electronically.
How to get approval to file electronically:
File Form 4419, Application for Filing Information Returns Electronically, at least 30 days before the due date of the returns. File Form 4419 for all types of returns that will be filed electronically. See Form 4419 for more information. Once you have received approval, you need not reapply each year. The IRS will provide a written reply to the applicant and further instructions at the time of approval, usually within 30 days. Users filing electronically via the 1099 Pro Service Bureau do NOT need to file Form 4419.

How to request a waiver from filing electronically:
To receive a waiver from the required filing of information returns electronically, submit Form 8508 at least 45 days before the due date of the returns. You cannot apply for a waiver for more than 1 tax year at a time. If you need a waiver for more than 1 tax year, you must reapply at the appropriate time each year.

If a waiver for original returns is approved, any corrections for the same types of returns will be covered under the waiver. However, if you submit original returns electronically but you want to submit your corrections on paper, a waiver must be approved for the corrections if you must file 250 or more corrections.

If you receive an approved waiver, do not send a copy of it to the service center where you file your paper returns. Keep the waiver for your records only.

Penalty:
If you are required to file electronically but fail to do so, and you do not have an approved waiver, you may be subject to a penalty of up to $100 per return for failure to file electronically unless you establish reasonable cause. However, you can file up to 250 returns on paper; those returns will not be subject to a penalty for failure to file electronically. The penalty applies separately to original returns and corrected returns.

The penalty applies separately to original returns and corrected returns.

See Penalties

18 eFile Viewer Overview

The eFile Viewer is an add-on program that allows users to view Electronic Files generated via the eFile Wizard. This utility is sold and run separately from the 1099 Pro software.

Main Screen (with file open)
After opening an electronic file, the Record Type is displayed in the left window in a hierarchy of “T”, “A”, “B”, “C”, “K”, and “F” records. When a Record Type is selected, the right window displays corresponding data. For example, select an “A” record and view RECORD TYPE, PAYMENT YEAR, PAYERTIN, PAYERNAMELN1 and other Filer specific data. The top window pane contains an overall summary of the Transmitter Detail.

Navigation
Navigate up and down vertically with the cursor keys on the keyboard; use your mouse to select Record Types on left window to display corresponding data in the right window. Data can be displayed in Viewed as Field List or View as Text format. See Viewing Options for further details.

**Editing eFiles**

Use eFile Viewer to edit certain values within your Electronic File. To manipulate the values of an opened electronic file select the appropriate recipient record and in the right window scroll down to the items highlighted in green. Only the green items are available for editing.

### 18.1 Installation and Registration

#### 18.1.1 License Agreement

**eFileViewer - Tax Year 2017**

**END USER LICENSE AGREEMENT FOR eFileViewer SOFTWARE**

**IMPORTANT-READ CAREFULLY:** This End-User License Agreement ("EULA") applies to all versions of eFileViewer Software including but not limited to Demo, Demonstration, Free, Single, Client/Server, Network and Multiuser versions of eFileViewer Software.

This End-User License Agreement ("EULA") is a legal agreement between you (either an individual person or a single legal entity, who will be referred to in this EULA as "You") and the Licensor for the eFileViewer software technology that displays this EULA, including any associated media, printed materials and electronic documentation (the "Software"). The Software also includes any software updates, add-on components, web services and/or supplements that the Licensor may provide to You or make available to You after the date You obtain Your initial copy of the Software to the extent that such items are not accompanied by a separate license agreement or terms of use. By installing, copying, downloading, accessing or otherwise using the Software, You agree to be bound by the terms of this EULA. If You do not agree to the terms of this EULA, do not install, access or use the Software. For purposes of this EULA, the term "Licensor" refers to 1099 Pro, Inc. By installing, copying, downloading, accessing or otherwise using the Software, You agree to be bound by the terms of this EULA. If You do not agree to the terms of this EULA, Licensor is unwilling to license the Software. In such event, You may not install, copy, download or otherwise use the Software.

**SOFTWARE LICENSE**

The Software is protected by intellectual property laws and treaties. The Software is licensed, not sold.

1. **GRANT OF LICENSE.** This EULA grants You the following rights:
   - **Single User Version.** You may install and use one (1) copy of the Software. Only one user of the Software can use the Software. Multiple use of the software concurrently requires additional Single User Version(s).
   - **Tax year - you may process 2017 tax forms as well as some other prior years with this software.**

2. **DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS.**
   - **Limitations on Reverse Engineering, Decompilation, and Disassembly.** You may not reverse engineer, decompile, or disassemble the Software, except and only to the extent that such activity is expressly permitted by applicable law notwithstanding this limitation.
   - **Trademarks.** This EULA does not grant You any rights in connection with any trademarks or service marks of Licensor or its suppliers.
No rental, service bureau, leasing or commercial hosting. You may not rent, lease, lend, provide a service bureau environment for multiple clients or provide commercial hosting services to third parties with the Software. The definition of a “service bureau” is set forth below.

Support Services. Licensor may provide You with support services related to the Software (“Support Services”). Use of Support Services is governed by the policies and programs described in the user manual, in “online” documentation, or in other materials from the support services provider. Any supplemental software code provided to You as part of the Support Services are considered part of the Software and subject to the terms and conditions of this EULA. You acknowledge and agree that Licensor may use technical information You provide to Licensor as part of the Support Services for its business purposes, including for product support and development.

WINDOWS 3.XX and Windows 95 ARE NOT SUPPORTED.

All information created with this software must be verified by the User(s) for accuracy and completeness. No warranty, guaranty or representations are made with regard to accuracy or completeness of information from this product.

Termination. Without prejudice to any other rights, Licensor or its suppliers may terminate this EULA if You fail to comply with the terms and conditions of this EULA. In such event, You must destroy all copies of the Software and all of its component parts.

3. INTELLECTUAL PROPERTY RIGHTS. All title and intellectual property rights in and to the Software (including but not limited to any images, photographs, animations, video, audio, music, text, and “applets” incorporated into the Software), the accompanying printed materials, and any copies of the Software are owned by Licensor or its suppliers. All title and intellectual property rights in and to the content that is not contained in the Software, but may be accessed through use of the Software, is the property of the respective content owners and may be protected by applicable copyright or other intellectual property laws and treaties. This EULA grants You no rights to use such content. If this Software contains documentation that is provided only in electronic form, you may print one copy of such electronic documentation. You may not copy the printed materials accompanying the Software. All rights not specifically granted under this EULA are reserved by Licensor and its suppliers. A “service bureau” for the purposes of this agreement refers to a business that provides services to third parties which include preparation, printing and mailing of completed tax forms and information returns to the end recipients. If Your purchase of the Software includes the right to act as a service bureau and utilize the software of the Licensor for this purpose, Your written agreement with the Licensor will specifically contain language that will permit the additional use of the Software for that purpose.

4. U.S. GOVERNMENT LICENSE RIGHTS. All Software provided to the U.S. Government pursuant to solicitations issued on or after December 1, 1995 is provided with the commercial license rights and restrictions described elsewhere herein. All Software provided to the U.S. Government pursuant to solicitations issued prior to December 1, 1995 is provided with RESTRICTED RIGHTS as provided for in FAR, 48 CFR 52.227-14 (JUNE 1987) or DFAR, 48 CFR 252.227-7013 (OCT 1988), as applicable.

5. SOFTWARE MEDIA
You may receive the SOFTWARE from the Internet, on-line network connection, or in disk media or on a CD-ROM or installed on the hard disk drive or ROM of your computer, or in multiple forms of media. Regardless of the number or type(s) of media you receive, you may use only the media appropriate for your single computer. You may not use the other media on another computer or loan, rent, lease, or transfer them to another user for any purpose whatsoever.

6. APPLICABLE LAW.
This EULA is governed by the laws of the State of California. If this Software was acquired outside the United States, then local law may apply. The exclusive venue and jurisdiction for any dispute shall be Los Angeles County Court in the North Valley District.

7. LIMITED WARRANTY
LIMITED WARRANTY FOR SOFTWARE ACQUIRED IN THE US AND CANADA. eFileViewer warrants that the SOFTWARE will perform substantially in accordance with the accompanying materials for a period of ninety (90) days from the date of receipt.

If an implied warranty or condition is created by your state/jurisdiction and federal or state/provincial law prohibits disclaimer of it, you also have an implied warranty or condition, BUT ONLY AS TO DEFECTS DISCOVERED DURING THE PERIOD OF THIS LIMITED WARRANTY (NINETY DAYS). AS TO ANY DEFECTS DISCOVERED AFTER THE NINETY (90) DAY PERIOD, THERE IS NO WARRANTY OR CONDITION OF ANY KIND. Some states/jurisdictions do not allow limitations on how long an implied warranty or condition lasts, so the above limitation may not apply to you.

Any supplements or updates to the SOFTWARE, including without limitation, any (if any) web updates, service packs or hot fixes provided to you after the expiration of the ninety (90) day Limited Warranty period are not covered by any warranty or condition, express, implied or statutory.

LIMITATION ON REMEDIES; NO CONSEQUENTIAL OR OTHER DAMAGES. Your exclusive remedy for any breach of this Limited Warranty is as set forth below. Except for any refund elected by eFileViewer, YOU ARE NOT ENTITLED TO ANY DAMAGES, INCLUDING BUT NOT LIMITED TO CONSEQUENTIAL DAMAGES, if the SOFTWARE does not meet eFileViewer's Limited Warranty, and, to the maximum extent allowed by applicable law, even if any remedy fails its essential purpose. The terms of Section 9 below ("Exclusion of Incidental, Consequential and Certain Other Damages") are also incorporated into this Limited Warranty. Some states/jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above limitation or exclusion may not apply to you. This Limited Warranty gives you specific legal rights. You may have others which vary from state/jurisdiction to state/jurisdiction.

YOUR EXCLUSIVE REMEDY. eFileViewer's and its suppliers' entire liability and your exclusive remedy shall be, at eFileViewer's option from time to time exercised subject to applicable law, (a) return of the price paid (if any) for the Software, or (b) repair or replacement of the Software, that does not meet this Limited Warranty and that is returned to eFileViewer with a copy of your receipt. You will receive the remedy elected by eFileViewer without charge, except that you are responsible for any expenses you may incur (e.g. cost of shipping the Software to eFileViewer). This Limited Warranty is void if failure of the Software has resulted from accident, abuse, misapplication, abnormal use or a virus. Any replacement Software will be warranted for the remainder of the original warranty period or thirty (30) days, whichever is longer. Outside the United States or Canada, neither these remedies nor any product support services offered by eFileViewer are available without proof of purchase from an authorized international source. To exercise your remedy, contact: eFileViewer, Attn. eFileViewer Sales Information Center/23901 Calabasas Rd, Suite 2080/Calabasas, CA 91302, or the eFileViewer subsidiary serving you.

8. DISCLAIMER OF WARRANTIES. THE LIMITED WARRANTY THAT APPEARS ABOVE IS THE ONLY EXPRESS WARRANTY MADE TO YOU AND IS PROVIDED IN LIEU OF ANY OTHER EXPRESS WARRANTIES (IF ANY) CREATED BY ANY DOCUMENTATION OR PACKAGING. EXCEPT FOR THE LIMITED WARRANTY AND TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, eFileViewer AND ITS SUPPLIERS PROVIDE THE SOFTWARE AND SUPPORT SERVICES (IF ANY) AS IS AND WITH ALL FAULTS, AND HEREBY DISCLAIM ALL OTHER WARRANTIES AND CONDITIONS, EITHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING, BUT NOT LIMITED TO, ANY (IF ANY) IMPLIED WARRANTIES, DUTIES OR CONDITIONS OF MERCHANTABILITY, OF FITNESS FOR A PARTICULAR PURPOSE, OF ACCURACY OR COMPLETENESS OR RESPONSES, OF RESULTS, OF WORKMANLIKE EFFORT, OF LACK OF VIRUSES AND OF LACK OF NEGLIGENCE, ALL WITH REGARD TO THE SOFTWARE, AND THE PROVISION OF OR FAILURE TO PROVIDE SUPPORT SERVICES. ALSO, THERE IS NO WARRANTY OR CONDITION OF TITLE, QUIET ENJOYMENT, QUIET POSSESSION, CORRESPONDENCE TO DESCRIPTION OR NON-
INFRINGEMENT WITH REGARD TO THE SOFTWARE. THIS EULA IS THE ENTIRE AGREEMENT BETWEEN THE PARTIES WITH RESPECT TO THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PRIOR AND CONTEMPORANEOUS ORAL AND WRITTEN AGREEMENTS AND DISCUSSIONS. NO EMPLOYEE OF eFileViewer HAS THE POWER OR AUTHORITY TO MODIFY THIS AGREEMENT EXCEPT BY AN AGREEMENT IN WRITING WHICH BEARS THE SIGNATURE OF AN OFFICER OF THE CORPORATION.

9. EXCLUSION OF INCIDENTAL, CONSEQUENTIAL AND CERTAIN OTHER DAMAGES. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL eFileViewer OR ITS SUPPLIERS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, BUT NOT LIMITED TO, DAMAGES FOR LOSS OF PROFITS OR CONFIDENTIAL OR OTHER INFORMATION, FOR BUSINESS INTERRUPTION, FOR PERSONAL INJURY, FOR LOSS OF PRIVACY, FOR FAILURE TO MEET ANY DUTY INCLUDING OF GOOD FAITH OR OF REASONABLE CARE, FOR NEGLIGENCE, AND FOR ANY OTHER PECUNIARY OR OTHER LOSS WHATSOEVER) ARISING OUT OF OR IN ANY WAY RELATED TO THE USE OF OR INABILITY TO USE THE SOFTWARE, THE PROVISION OF OR FAILURE TO PROVIDE SUPPORT SERVICES, OR OTHERWISE UNDER OR IN CONNECTION WITH ANY PROVISION OF THIS EULA, EVEN IN THE EVENT OF THE FAULT, TORT (INCLUDING NEGLIGENCE), STRICT LIABILITY, BREACH OF CONTRACT OR BREACH OF WARRANTY OF eFileViewer OR ANY SUPPLIER, AND EVEN IF eFileViewer OR ANY SUPPLIER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

10. LIMITATION OF LIABILITY AND REMEDIES. NOTWITHSTANDING ANY DAMAGES THAT YOU MIGHT INCUR FOR ANY REASON WHATSOEVER (INCLUDING, WITHOUT LIMITATION, ALL DAMAGES REFERENCED ABOVE AND ALL DIRECT OR GENERAL DAMAGES), THE ENTIRE LIABILITY OF eFileViewer AND ANY OF ITS SUPPLIERS UNDER ANY PROVISION OF THIS EULA AND YOUR EXCLUSIVE REMEDY FOR ALL OF THE FOREGOING (EXCEPT FOR ANY REMEDY OF REPAIR OR REPLACEMENT ELECTED BY eFileViewer WITH RESPECT TO ANY BREACH OF THE LIMITED WARRANTY) SHALL BE LIMITED TO THE GREATER OF THE AMOUNT ACTUALLY PAID BY YOU FOR THE SOFTWARE OR U.S. $5.00. THE FOREGOING LIMITATIONS, EXCLUSIONS AND DISCLAIMERS (INCLUDING SECTIONS 7, 8, AND 9 ABOVE) SHALL APPLY TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, EVEN IF ANY REMEDY FAILS ITS ESSENTIAL PURPOSE.

11. ENTIRE AGREEMENT. This EULA (including any addendum or amendment to this EULA which is included with the Software) is the entire agreement between you and eFileViewer relating to the Software and the support services (if any) and they supersede all prior or contemporaneous oral or written communications, proposals and representations with respect to the Software or any other subject matter covered by this EULA. To the extent the terms of any eFileViewer policies or programs for support services conflict with the terms of this EULA, the terms of this EULA shall control.

12. This Agreement shall be binding upon and inure to the benefit of the respective successors, assigns, and personal representatives of the parties, except to the extent of any contrary provision in this agreement. If any term, provision, covenant, or condition of this EULA is held by a court of competent jurisdiction to be invalid, void, or unenforceable, the rest of the Agreement shall remain in full force and effect and shall in no way be affected, impaired, or invalidated. Section, paragraph, and other headings contained in this Agreement are for reference purposes only and are in no way intended to describe, interpret, define, amplify, or limit the scope, extent, or intent of this Agreement or any provision of it.

18.1.1.1 eFileViewer Main Screen

At the eFileViewer Screen, you will see the files you have opened. The column categories displaying the contents of the file information as follows:
File Type
Tax Year
Total Records
Date & Time the file was loaded into the viewer
Total Filers
Total Recipients
File Name

You will typically find the following general field descriptions embedded in a Electronic file:

Transmitter "T" Record
Payer "A" Record
Payee "B" Record
End of Payer "C" Record
State Totals "K" Record
End of Transmission "F" Record

The Main Screen of the eFileViewer (with file open)

After you open the Electronic File you will see the contents of the file. The upper left side of the window contains a listed hierarchy of "T", "A", "C", "K", and "F" records. The "B" record is displayed in the lower left when you have an "A" record highlighted. As you highlight each field, (i.e. The "T" record field for a Transmitter), the right side of the window displays to data in relation to the current field selected on the left. While navigating up and down in a vertically with the cursor keys on the keyboard, you will notice that you must click with your mouse in order to have the right pane to display the data. The top of the screen contains an overall summary of the Transmitter Detail. There are also two different viewing options: View as Field List and View as Text.

18.1.1.1 Viewing Options

eFile Viewer Viewing Options

View as Field List
View the data in a field-by-field format.
• From, Thru, Size - Denotes the physical location of the fields.
• Field Name - Displays the title of the field that contains the data.
• Field Value - Contains the data manually entered by the filer or imported from an ASCII text file.

**View as Text**
View the data as text (without fields). The cursor position allows you to locate specifically where your cursor is within a record

### 18.2 File Format

Transmitter "T" Record (all fields marked required must include transmitter information)

Payer "A" Record

Multiple Payee "B" Records (at least 11 "B" Records per each "A" Record)

End of Payer "C" Record

State Totals "K" Record, if participating in the Combined Federal/State Filing Program

End of Transmission "F" Record (See Part C for record formats.)

**Note:** When generating State files "K" records will be generated if you have checked the "Combined Federal State Filing Program" (CFS) for the Filer and if the form type is in the CFS program i.e. DIV, G, INT, MISC, OID, PATR, R, 5498. "K" records will only be generated for states that participate in the combined program. Use of the Category option can result in multiple K records if the Filer & Form Type are in the CFS program. Filers where you opt out of the CFS will not have "K" records. To change the variable for the CFS click on "File" then "Filers list" and double click on the Filer to change any parameters. If you have state withholding or if you use the category field you may generate multiple K records. To suppress K records consider opting out of the CFS before generating files for states that do not participate in the CFS program.
18.3 Loading and Viewing Files

Load a New File / View Files

1. Open eFileViewer in the root of the program directory (for example, C:\1099 Pro\Pro99T17 in a standard installation). Find the file eFileViewer.exe and double-click to open.

2. Click the "Load New File" button to load a file.

3. Browse your local drive or network drive location for the Electronic File, select it and click "Open".
   - The selected file is displayed in the eFileViewer window.

4. Highlight the selected file and click the "View Selected File" button.
   - Additionally you may delete a file by highlighting it and selecting "Delete Selected File" or close the eFileViewer Tool by Clicking the "Close" button.

When opening the eFileViewer and loading a new file, the file is copied to a temporary location on the local drive and is used as your temporary "working" file, leaving your original Electronic File untouched.

18.4 Exporting a File

Export a File - eFileViewer

1. Open eFileViewer in the root of the program directory (for example, C:\1099 Pro\Pro99T17 in a standard installation).

2. Highlight the file to export and click the "Export" button. Review and accept the Readme and License Agreement.

   - *Users are encouraged to leave the Output File Name field blank and allow eFileViewer to create a name based on the PTin and Form Type.

4. Select .TAB (default) or .TXT file extension for the output file.

5. Select how to handle custom data positions 663-772 of the IRS file. Options include "Ignore It" or "Extract using the Default Formula". This field is unavailable if the field is blank in the file.
   - Per Pub. 1220, TY 2016, Positions 663-772: "This portion of the “B” Record may be used to record information for state or local government reporting or for the filer’s own purposes. Payers should contact the state or local revenue departments for filing requirements. You may enter comments here. If this field is not used, enter blanks."

6. Click the "Process" button to convert the file.

18.4.1 Limitations of Export

Limitations of Export - eFileViewer
The eFileViewer utility creates files that can be imported into 1099 Pro. While the utility has been thoroughly tested, you - the user - must exercise precautions to verify the accuracy of your data.

All output files are given abbreviated names in the form of 'PTin' plus the PTin, Form Type, Orig or Corr, and a two-digit number to account for possible duplicates in Filer Name and Form Type, and a three-character extension which you may specify. A log of output file names, filers and form types is also created. This log file can be printed for reference.

Note: Running eFileViewer more than one time can result in files that are overwritten. Overwriting can occur if you direct eFileViewer to place the output in a directory with existing files from a previous eFileViewer session.

KNOWN LIMITATIONS
All exports are in the format for 2017 form layouts. If exporting data from a prior year format please verify that all boxes still exist in the 2017 format.

Caution! The information on your printed form(s) and the information contained in the file sent to the IRS can differ on some forms. Please pay special attention to the below conditions where your original form and the data imported may vary. The IRS file being processed may not contain the following fields hence they may not be present during import for all form types when using the standard export.

Missing General Fields
- Address Apt/Suite
- Country
- Form Category
- Form Source
- Tax State
- Text Description Boxes - Formatting will be lost and some boxes may be truncated.

Missing Form Specific Fields
The following Items boxes are not contained in the IRS 750 file and will therefore not be present when imported into 1099 Pro software.

- 1099-PATR - Box 10
- 1098 - Box 5
- 1099-B - CORPORATION'S name, street address, city, state, and ZIP code
- 1099-CAP - Box 5
- 1099-INT - Payer's RTN. This data is added at the Filer level in 1099 Pro.
- 1099-MISC - Optional Text Lines 1 and 2, boxes 17 and 18
- 1099-Q - FMV amount and Distribution code (1-6)
- 1099-R - Box 8 percentage, boxes 11, 12, 14 and 15. Box 2a is blank if Box 2b "Taxable Amount Not Determined" is checked.
- 5498 - Armed Forces Box
- W-2G - Box 13
- W-2 - Box 20

Missing State and Local Income Tax Fields
State and Local Income Tax Withheld pos.723-746 in IRS specifications do not have a location to display on some forms and therefore will not always import if present.

IF YOUR DATA CONTAINED ANY INFORMATION IN THE BOXES/FIELDS LISTED ABOVE YOU
WILL NEED TO EITHER MANUALLY KEY IN THE ADDITIONAL INFORMATION AFTER IMPORTING OR FIND SOME OTHER METHOD FOR CAPTURING THAT INFORMATION.

The 1099 Pro Service Bureau at (866) 444-3559 may be able to assist in capturing the additional fields listed above.

After running the eFileViewer utility and importing data we strongly encourage users to proof both their Control Totals report and individual data items.

19 Form Status Overview

Form Status Overview

Users must select an import status for their data in the first step of the import routine, Import Data. Selecting the correct status is important because aside from Pending, the status of the session can only be reset by voiding (deleting) the entire session.

Use the Import Session Report to review the status of records in an import session.

19.1 Printed

Printed

All records are assigned a print status that determines their position in the filing cycle. A record with a Printed status is available for inclusion in a 1096 transmittal, electronic filing or Service Bureau upload. To edit a Printed record, first reset its print status to Pending.

See Print Status

19.1.1 Electronic Sessions Summary Report

eFile Log Summary Report

The features contained within this section are available exclusively to users 1099 Pro Professional, Enterprise and Corporate Suite.

The Electronic File Log Summary report provides in-depth comparative information on selected Filers, Pcodes, Form Types, or Session IDs.

See eFile Session Summary Report

To Generate Report
1. On the menu bar select Reports > eFile Sessions/Logs Summary Report.

2. At the eFile Log Report Wizard review the overview and click "Next" to proceed.

3. At the Limit Log Records for this eFile Log Report screen select a report option. Choices include:
One or more Filers (by PCode) - Filter the report for only selected PCodes. A PCode or Payer Code is an alphanumeric shorthand used to identify a Payer/Filer in the system. See Filer Record Details for further information.

One or more Filers (by EIN) - Filter the report for only selected EIN(s).

One or more Form Types - Filter the report for only selected form type(s).

One or more Session IDs - Filter the report for only selected electronic log session ID(s).

4. At the same screen, users may opt to select the "Group and Generate Additional Subtotals by EIN" checkbox. This feature is useful for tallying up recipient information by filer. After making appropriate choices click "Next" to continue.

5. At the next screen users must tag (or select) the appropriate PCode(s), Filer(s), Form Type(s) or Session ID(s) as indicated in Step 3, then click "Next" to continue.

6. At the Select the Date Range screen the current tax year is set as the default; for example, 1/01/2017 to 12/31/2017 for 1099 Pro 2017. To modify the Log Summary Report setting click the "Date Range To Use" button to customize the date range value by Day/Month/Year or alternately by quarter or tax year. Click "OK" to save changes and then "Next" to continue.

7. At the Ready To Generate eFile Log Report screen review settings and click "Finish" to generate report, use the "Back" button to go back and make changes if necessary. After clicking the "Finish" button the Administrator automatically prompts to preview the report.

19.1.2 Print Sessions

Print Sessions

A print session is any batch of records with a Printed or Filed 1096 print status.

See Print Status topic.

19.1.3 Printed Status

Printed Status - Shortcut

1099 Pro assigns a print status to all records. To determine a record's status go to the "Work with My Tax Forms" screen and refer to the Status column.

See Print Status Overview

Shortcut

1099 Pro includes a shortcut to assign "pending" records a "printed" status without actually printing the records (also referred to as a false print session).

To update records to a printed status

1. Follow the Print Wizard instructions through steps 1-7.

2. At step 8 select Preprinted forms as your paper type and do NOT select any copies to print.

3. Use the "Next" button to continue through the Print Wizard.

4. At the Print Summary screen, the Print Wizard warns that no copies have been selected to print.
Click “OK” to proceed and click the “Print” button.

5. At the Are these forms ready to send to the IRS? screen select “I have printed and verified my red Copy A forms...”. These records are assigned a printed status.

19.2 Print Status Overview

Print Status Overview

A print status is assigned to all records which determines its eligibility to participate in various processes. To determine a record's status go to the Work with My Tax Forms screen and refer to the Status column. Alternately, use the Form Counts Report to see all forms, sorted by filer, and their respective statuses.

Pending
All records begin with a Pending status. Only PENDING records may be modified.

Printed
Records receive a Printed status after selecting "I have printed and verified my red Copy A forms..." at the last step of the Print Wizard. These records are available for inclusion in a 1096 transmittal, Service Bureau Electronic Upload or IRS Magnetic Media file. To modify a Printed record first reset its print status to Pending.
- To reset the status for an individual record go to the Work With My Tax Forms screen, highlight the record, and click the “Change” button. At the Protected Form Update Options screen select “Reset to Pending”.
- To reset the status for a print session, at the menu bar go to Reports > Tax Form Print Sessions > highlight the print session and click the “Reset (VOID) Session” button.

SB Print+Mail
Records receive SB Print+Mail status if included in a Service Bureau Printing and Mailing upload. These records are available for generating a 1096 transmittal, Service Bureau Electronic Upload or IRS Magnetic Media file. To modify a record with this status reset it to Pending status.
- To reset the status for an individual record go to the Work With My Tax Forms screen, highlight the record, and click the "Change" button. At the Protected Form Update Options screen select "Reset to Pending".
- To reset the status for a print session at the menu bar go to Reports > Service Bureau Upload Sessions > highlight the print session and click the "Reset (VOID) Session" button.

SB Filing
Records receive SB Filing status if included in a Service Bureau Electronic Upload file. To modify a record with this status reset the entire upload session to their original pre-upload status. Do NOT reset the upload session if you have already submitted the file to the 1099 Pro Service Bureau for processing (contact the Service Bureau for assistance).
- To reset the status at the menu bar go to IRS > File Electronically via 1099 Pro Service Bureau > highlight the upload session and click the "Reset (Void) Upload" button.

Filed Mag
Records receive Filed Mag status after inclusion in a magnetic media or electronic file.
- To reset the status go to menu bar go to IRS > Create IRS Electronic Files > highlight the magnetic media session and click the "Reset (Void) Session" button.

Filed 1096
Records receive *Filed 1096* status after inclusion in a 1096 Transmittal.

- To reset the status at the menu bar go to Reports > Form 1096 Filing Session > highlight the print session and click the "Reset (Void) 1096" button.

**Corr**

Records receive *Corr* (corrected) status after processing a correction. Corrected records are further identified by their position in the print cycle. For example, *Corr/Pending, Corr/Printed, Corr/1096, Corr/Mag,* etc.

- To reset a corrected record with a pending status (*Corr/Pending*) go to the Work With My Tax Forms screen, double-click the record and click "Delete" at the Corrected Options screen. The record reverts to its pre-correction status. IMPORTANT: If there are any other corrected records associated with the record, they too must have a *Pending* print status prior to attempting the reset.
- To reset a corrected record with any other status, first reset it to *Corr/Pending*. The process for resetting a printed correction or filed correction is identical to the various procedures described above. Once the record has a *Corr/Pending* status delete it as normal.

**Deleted**

Records with a *Pending* status may be deleted. Deleted records are only visible at the Work With My Tax Forms screen if that setting has been enabled at the Preferences screen. Deleted records may be un-deleted in Corporate Suite only. See *Delete a Record*.

**Void/Unvoid**

Records are *Voided*, instead of deleted, to retain data for possible future reference. Only records with a *Printed* status can be voided. See *Void Records*.

* (Asterisk)

An asterisk indicates the record has *errors and/or warnings* associated with it.

**Shortcut**

1099 Pro includes a shortcut to assign "pending" records a "printed" status without actually printing the records (also referred to as a *false* print session).

**To update records to a printed status**

1. Follow the *Print Wizard* instructions through steps 1-7.

2. At step 8 select Preprinted forms as your paper type and do NOT select any copies to print.

3. Use the "Next" button to continue through the Print Wizard.

4. At the Print Summary screen, the Print Wizard warns that no copies have been selected to print. Click "OK" to proceed and click the "Print" button.

5. At the Are these forms ready to send to the IRS? screen select "I have printed and verified my red Copy A forms...". These records are assigned a printed status.

**19.3 Forms Status Values**

**Form Status Values**

Database values are useful for generating Custom Queries in 1099 Pro or in an SQL database.
In the Query Wizard select **Form Status Code** = Optional, form statuses to return, accepts an array of integers. The default returns all printed status forms. If an original 1099 form has a correction, only the latest correction is returned. This includes both parts of a 2-part correction, the zero correction and the new part. The original or new corrected values can be requested and both parts are returned. Corrected W-2's return the latest correction (W-2C) plus any superseded corrections and the original.

**ORIGINAL RECORDS**

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Original Pending</td>
</tr>
<tr>
<td>1</td>
<td>Original Printed</td>
</tr>
<tr>
<td>2</td>
<td>Original Printed and Voided</td>
</tr>
<tr>
<td>3</td>
<td>Original Printed and Filed Paper</td>
</tr>
<tr>
<td>4</td>
<td>Original Printed and e-Filed</td>
</tr>
<tr>
<td>5</td>
<td>Original SB Printed</td>
</tr>
<tr>
<td>6</td>
<td>Original Not Printed and e-Filed</td>
</tr>
<tr>
<td>7</td>
<td>Original Not Printed and SB e-Filed</td>
</tr>
<tr>
<td>8</td>
<td>Original SB Printed and SB e-Filed</td>
</tr>
</tbody>
</table>

**CORRECTION ZERO FORM (2-PART)**

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Corrected Pending</td>
</tr>
<tr>
<td>11</td>
<td>Corrected Printed</td>
</tr>
<tr>
<td>12</td>
<td>Corrected Printed and Voided</td>
</tr>
<tr>
<td>13</td>
<td>Corrected Printed and Filed Paper</td>
</tr>
<tr>
<td>14</td>
<td>Corrected Printed and e-Filed</td>
</tr>
<tr>
<td>15</td>
<td>Corrected SB Printed</td>
</tr>
<tr>
<td>16</td>
<td>Corrected Not Printed and e-Filed</td>
</tr>
<tr>
<td>17</td>
<td>Corrected Not Printed and SB e-Filed</td>
</tr>
<tr>
<td>18</td>
<td>Corrected SB Printed and SB e-Filed</td>
</tr>
</tbody>
</table>

**Correction (1-Part) / New Form (2-Part)**

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>20</td>
<td>Correction Pending</td>
</tr>
<tr>
<td>21</td>
<td>Correction Printed</td>
</tr>
<tr>
<td>22</td>
<td>Correction Printed and Voided</td>
</tr>
<tr>
<td>23</td>
<td>Correction Printed and Filed Paper</td>
</tr>
<tr>
<td>24</td>
<td>Correction Printed and e-Filed</td>
</tr>
<tr>
<td>25</td>
<td>Correction SB Printed</td>
</tr>
<tr>
<td>26</td>
<td>Correction Not Printed and e-Filed</td>
</tr>
<tr>
<td>27</td>
<td>Correction Not Printed and SB e-Filed</td>
</tr>
<tr>
<td>28</td>
<td>Correction SB Printed and SB e-Filed</td>
</tr>
</tbody>
</table>


**Error Status Values**

In the Query Wizard select **Error Status** = Optional.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No Errors</td>
</tr>
<tr>
<td>1</td>
<td>Warnings</td>
</tr>
<tr>
<td>2</td>
<td>Errors</td>
</tr>
<tr>
<td>3</td>
<td>Warnings + Errors</td>
</tr>
<tr>
<td>4</td>
<td>Fatal / Major Errors</td>
</tr>
</tbody>
</table>

## 20 Imports Overview

### Import Overview

1099 Pro features a powerful, intuitive Import Wizard to simplify the process of importing your data. Generally, users who can access their data in Excel (or a similar product) can import it! Importing delimited data is easiest, however users may also import Fixed Length files such as those created for the IRS. The Microsoft applications Excel, Access and SQL allow data to be saved in a .TXT format (see Converting Excel Formats); whereas older applications allow data to be saved in a .CSV (comma separated values) format.

**All 1099 Pro software installations include sample import files.** Users who review the sample import files and include our Header Records have great success with their imports! See Sample Import Files and Import File Conventions.

**Error and Validation Checking** is automatically performed on all imports; thereby allowing users the...
opportunity to find and fix any problem records before importing into the software.

See Reset (Void) Session

Import Wizard Steps

Step 1: Importing Data - Begin the import process.

Step 2: Validating Data - Test data for errors and warnings.

Step 3: Post Results - Post imported data for access at the Work With My Tax Forms screen.

20.1 Import Data

Import Data

1099 Pro features a user-friendly Import Wizard to simplify the import routine. Many database and spreadsheet applications such as Microsoft Excel, Access and Lotus 1-2-3 provide for the exporting of data to an ASCII file. These files can be imported into 1099 Pro, thus relieving the burden of manually entering the information onto the tax form.

- Import Maps for a Delimited or Excel File Type
- Corporate Suite Users: Import Maps for Fixed Length Files

See Import Wizard

20.1.1 Import Wizard

Import Wizard

1099 Pro simplifies the import process with our Import Wizard. The Import Wizard consists of three simple steps that may be done at once or at different times. Nothing is actually imported into the software until all three steps are completed.

See Create An Import File - Please review PRIOR to using the Import Wizard.

See Import Session Summary Report

Import Wizard Steps:

Step 1: Importing Data - Begin the import process.

Step 2: Validating Data - Allows the opportunity to test data for errors and warnings.

Step 3: Post Results - Post imported data for access at Work With My Tax Forms screen.

For more information on importing Fixed Length File Types see Import Maps for Fixed Length Files.
20.1.1.1 Manage Import Maps

Manage Import Maps

The Browse Screen for Import Map files lists the type of mapping and the file format used for each map. Additional details including Map Notes and Formatting Details are displayed in the Notes section.

To Add a New Map
1. Within the 1099 Pro Import Wizard click the "Add/Update Import Maps" button.
2. To add a new map click the "Add" button, select Delimited or Fixed Length as the map type, and follow the steps in the Import Map Wizard.

Change Existing Maps
Users can highlight an existing map on this screen and click "Change". Follow the steps on the screen and the wizard guides the user through the process of changing an existing map. Any changes made overwrite the current mappings.

To Delete Existing Map
1. Highlight the existing map to delete. The user is prompted to confirm their choice, click "OK".
2. An existing mapping cannot be deleted if it is tied to a current import/in-process import session. Any such imports must be completed or abandoned first and then the map can be deleted. Once deleted a map cannot be recovered.

View/Print Map Reports

20.1.1.1 Import or Export an Import Map

Importing or Exporting Maps

Using this screen you may import or export maps for use on other 1099 Pro installations.

- Import Maps for a Delimited or Excel File Type
20.1.1.2 Custom Record Filter

Custom Record Filter

The features contained within this section are available exclusively to users of the Corporate Suite edition.

From the define import maps wizards, users can enter a value that will be used to filter records in the event that the user is importing a file containing multiple form types. Any form that does not have the matching value entered on this window will be skipped/ignored.

For example, a file might have rec types ‘9I’ for 1099-INT and ‘9M’ for 1099-MISC records. Adding the 'Filter: RecType' field to a map triggers filtering. Entering '9M' in the window will cause the map to ignore the ‘9I’ records, etc. Also, if you add the filter trigger field, you will not be able to save the map without entering a filter value.

20.1.1.3 Customize a Fixed Field

Customize a Fixed Field
The features contained within this section are available exclusively to users of the Corporate Suite edition.

During the Import of Fixed Length files, users have the option to customize the "field size" of a mapped field.

**To customize a field during Fixed Width Import.**
1. Select specific fields to be included in the import process and add them to your layout. Do this by clicking and highlighting a field from the available fields on the left and then click the "Add this field" button which carries the "Database Field" from the left column over to the "Field Value" screen on the right.
2. In the Field/Header list to the right, double-click on the field name until you see the "Customize a mapped field" screen pop up. The following chart explains the title of the field and its contents.

![Customize a Mapped Field](image)

**Field Number**: Field or Record Number (Equivalent to a column in an excel spreadsheet).

**Position From - Through**: Location of the field value expressed in numeric positions from the first location to the last location.

**Field Size**: Total Number of characters form the first position to the last position of the field value.

**Mapped To**: Tax Form field that the Field Value is mapped or linked to.

**Field Value**: Title of the specific field.

**Process**: Allows users to enable specialized processing rules for the imported field.
- **If the field is empty, fill it with this**: Specify what should be entered into a field that is empty.
- **Removing leading/trailing characters**: Trim both leading or trailing characters from the imported field by a specified amount.
- **Changing the case of the imported value**: Force all characters to be either all upper or lower case for the imported field.
- **Adding fixed characters to the imported value**: Add characters to both the beginning or end of an imported field.
20.1.1.4 Customize Fixed Filler (CS version only)

Add/Customize Fixed Filler (CS Only)

There may be occurrences where your fixed length file contains blank spaces or contains information
that cannot be used in this program. With the Add Filer button, the software allows users to add or “fill
in” unused space. Parameters that can be set for adding space are
- The size of the unused space
- The start and ending position for this space.

This option is available upon creating a new fixed length map in Corporate Suite.

For more information, see Fixed Length Import Map Wizard

20.1.1.5 Delimited or Excel Import Map Wizard

Delimited or Excel Import Map

The 1099 Pro Import Wizard simplifies the process of creating Import Maps so users can import their
data into the 1099 Pro software. The first step in creating an Import Map is to specify how the records to
import will be selected and where the records will be inserted into the tax form. Import files can be
imported in a variety of formats, including delimited .CSV, Tab-Delimited, Pipe-Delimited, Fixed Length,
and Excel (XLS or XLSX). Follow the steps below to create and/or define an Import map.

☐ Remember, your 1099 Pro installation includes sample import files for easy map-by-name imports!

Define Import Map Type
The Excel Import Wizard may be accessed during the Import Wizard process at the Select the Type of
Data and Format Screen.

1. At the Select the Type of Data Format screen click the “Add/Update Form Import Maps” button.
2. At the Manage Form Import Maps screen click the "Add" (or "Change") button to access the Import Map Wizard. The Administrator prompts, "Which Type of Import Would You Like To Create?": select "Delimited" or "Excel".
   - To delete an import map, highlight the map and click the "Delete" button.
   - If header records in an import file are changed, the user must either modify the existing map or create a new map that reflects those changes.
   - The following columns define an Import Map: Map Type, File Format, Status and Description. The description column gives details about the currently selected import map and the Map Notes window to the right provides additional information.

3. At the Manage Form Import Wizard review onscreen information and click "Next" to proceed.

4. At the Define Overall Specifications for the Import File screen, the Mapping Form is determined by the type of tax form previously selected in the Import Wizard at the Select the Type of Data and Format to Use screen. To change the form type users must exit this wizard and return to the Import Wizard.

5. Check the "Has a Header Row" check box if appropriate. The header row in the spreadsheet has unique descriptive field names instead of user data.

6. At the Select the Sample Form File To Use screen browse for your file and click "Next" to proceed. A sample of the user's data file will display in the below box.

7. At the Map the Import Fields/Columns to Your Form screen, users may:
   - **Map by Name** - use the "Map by Name" button to automatically map all fields with matching names. To cancel a Map by Name use the "Reset/Clear the Map" button.
   - **Drag & Drop Fields** - manually match each field from the input file on the left to the corresponding tax form field on the right by dragging and dropping. To cancel a match, drag from right to left or double-click on it.
   - **Assign Value** - assign a fixed value to the selected unmapped field. For example, for the Rcp TIN Type field enter EIN=1, SSN=2 or Unknown=3 (or blank) if all imported recipients have an identical recipient TIN type.

8. At the Default Field Size and Format Options screen select below options and click "Next" to continue:
   - Check if "Amounts Use Implied Decimal Formatting". An implied decimal means that the dollar amounts being imported do not have an explicit period between the dollars and cents portions of the amount. For example, "10000" = "100.00" in implied decimals. *The use of the implied decimal format in delimited file formats is rare.*
   - Define date field indicators.

9. At the Set Recipient Matching Options screen choose how the software matches imported records with existing Recipients and/or tax forms. Options include:
   - **Matching Recipients with a TIN**
     - TIN plus Account Number
     - TIN plus Last Name (use only if account numbers are unavailable or inconsistent)
   - **Matching Recipients When TIN is Missing/Blank**
     - Account and then Last Name (default option) - Looks for account numbers first, then matches for Last Name for the Account.
     - Account plus a blank/missing TIN - Use when TIN/Account Number are the only identifying fields in the field (no name information is provided).
     - Last Name and then Account - Looks for the Last Name first, then matches for Account Number for the recipients.
• Last and First Name (use if account numbers are unavailable or inconsistent) - Account numbers are NOT used to match for recipients.

10. At the Specify a Name and Usage Notes for the Import Map screen enter a title of description for this map. Users may also add usage notes for further clarification. Click “Next” to continue.

11. At the Set Options for Locating Your Import Files screen review options and click “Next” to continue.
   - Specify the default folder where this type of import file will be located. If left blank, the software prompts to locate the import file.
   - Users may optionally specify a default file name for the files that will be imported using this map.

12. CORPORATE SUITE ONLY: Processing Options for Tax Form Imports
   - Select the type of data processing to be applied when your import is performed and click “Next” to continue.
     • Standard: All forms are added as individual records regardless of whether other forms may exist in the system for the same recipient.
     • Transactional: If existing forms are found for a recipient that match the form matching rules configured at the time of import, the new information will update the existing record and be added as a transaction for that record. Non-matching forms are added as new.
     • Year To Date: Transactions are added to existing tax forms to reflect the new Year to Date (YTD) amounts and information. Existing forms that are not included in the YTD import will be flagged as zero-drop candidates if the zero-drop option is enabled.
     • Replacement: This feature is currently unavailable.

13. Lastly, review settings on the summary screen and if satisfied, click “Finish”. The Administrator indicates if the import map was successfully created. Users may opt to import the data used to create this map by clicking the “Yes” button. Users are automatically returned to the Import Wizard, Select the Type of Data and Format To Use screen and the newly created Import Map is available for selection.
Fixed Length Import Map Wizard

The features contained within this section are available exclusively to users of the Corporate Suite edition.

The 1099 Pro Import Wizard simplifies the process of creating Import Maps so you can then import your data into the 1099 Pro software. The first step in creating an Import Map is to specify how the records to import will be selected and where the records will be inserted into the tax form. Import files can be imported in a variety of formats, including delimited .CSV, Fixed Length, Excel (XLS or XLSX) and XML. Follow the steps below to create and/or define an Import map.

1. **Defining a Fixed Length Map Type** *(also See Defining a Tab Delimited File Map)*
   - From the main screen in 1099 Pro you can click on the "Import Forms" link in the navigation bar to the left, or as an alternative, click on Utilities on the main menu then click "Run the Import Wizard".
   - Click on the "Manage/Create Import Maps" button.
   - Next, Click "Add" to add a new "Import map to the list, when prompted with "Which type of import would you like to create?", click "Fixed Length".
   - To delete and import map, highlight it and then click the "Delete" button.
   - When clicking "Add" or "Change" you are prompted to go through the wizard for creating and/or modifying Import maps, click "Next".
   - Select your Import Data Type; either a Tax Form, Recipients or Filers. Next set your Field Delimiter and End of Record Options then choose your whether or not your import file contains one or more header records. Click "Next" to continue.

2. **Set the Field/Column Order or Fixed Position of your Tax Form**
   - Next, specify your dollar amount format options for and using implied "decimals", then set your date field format options and the order in which your date components will be displayed. Click "Next". The following list shows which formatting and processing options are available for applying to a Fixed Length File Type:
     - **Tax Forms**: Amount (dollar) format and size, TIN (EIN/SSN) format options, Date Field Format Options, Check Box Size
     - **Recipients**: TIN (EIN/SSN) format options, Date Field Format Options, Check Box Size
     - **Filbers**: TIN (EIN/SSN) format options, Date Field Format Options, Check Box Size
   - Select specific fields to be included in the import process and add them to your layout. You can do this by clicking and highlighting a field from the available fields on the left and then click the "Add this field" button which carries the "Database Field" from the left column over to the "Field Value" screen on the right. The screen on the right also shows the positions of the information in the file as well as the character size of that field. Optionally you may use the "Add Filler" button to add blank columns in between columns which have data.
   - Repeat this procedure until all of the necessary fields have been added to your layout. If the wrong field is accidentally assigned, click and highlight the incorrect field and then click the "Remove" button, Begin again by highlighting the correct field from left, then click "Add this field" until you are finished. You may also click the up and down arrows to change the order of a
specific field up or down in the list. You also have the ability to customize the parameters of a mapped field. See Carefully Customizing a Mapped Field Click "Next" to continue.

- Enter a title and description which will be displayed for users when they need to select an import map to use. You may also enter some optional notes which describe your custom map.

3. **Set options for locating your import files.**
- Specify the default folder where this type of import file will be located. If left blank, you will always be prompted to locate the import file.
- Next, you may optionally specify a default file name for the files that will be imported using this map.

4. **Processing Options for Tax Form Imports**
- Select the type of data processing that will be applied when your import is performed.
  - **Standard:** All forms are added as individual records regardless of whether other forms may exist in the system for the same recipient.
  - **Transactional:** If existing forms are found for a recipient that match the form matching rules configured at the time of import, the new information will update the existing record and be added as a transaction for that record. Non-matching forms are added as new.
  - **Year To Date:** Transactions are added to existing tax forms to reflect the new YTD amounts and information. Existing forms that are not included in the YTD import will be flagged as zero-drop candidates if the zero-drop option is enabled.
  - **Replacement:** This feature is currently unavailable.

5. Finally, confirm the settings on the summary screen before you click "Finish".

![1099 Pro Fixed Length Import Wizard](image)

**Specify how the Import will affect existing Tax Forms**
These options let you specify what new information will update existing forms or replace them.

- **Processing Options for Tax Form Imports**
  - **Standard:** All Tax Forms are added as individual records, independent of all other forms and regardless of whether other forms may exist in the system for the same recipient.
  - **Transactional:** If existing forms are found for a recipient according to the form matching rules currently in effect for the Filer, the new information will update the existing record and be added as a transaction for that record. Non-matching forms are added as new.
  - **Year To Date:** Transactions are added to existing tax forms to reflect the new YTD amounts and information. Existing forms that are not included in the YTD import will be flagged as zero-drop candidates if the zero-drop option is enabled.
  - **Replacement:** All existing Tax Form information for the Filer is deleted and replaced by the new forms.

![Wizard Step 4](image)

Copyright 1099 Pro® 2017
20.1.1.7 Optional Database Fields (CS version only)

Optional Database Fields

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

The following is a list of optional database fields that may be assigned for a fixed width import.
- AuxStr1/Rcp Life of Line: An informational field used to describe additional recipient information such as "Life of" etc...
- Alternate Account/PACE Key: This field can be used as an alternate account field which requires a custom print process by 1099 Pro, Inc.
- Name Line 3 and Name Line 4: This field can be used to store additional name and addressing information.

20.1.1.8 Modifying an Existing Import Map

Modify an Existing Import Map

Adding a header after import map creation for a custom import map with headers
1. Click on “Import New Tax Forms” from the left hand navigation menu.
2. Click on “Begin a new XXXX Import Process”.
3. Click "Next".
4. Click on “Add/Update XXXX Import Maps”.
5. Select the import map that you would like to add the new header to.
6. Click on “Change”.
7. Click “Next”.
8. Click “Next”.
9. Click “Add”.
10. You will see two fields, one labeled “Mapped to Field” and one labeled “Field Name/Column”.

![Adding a New Input Field Name/Column]

11. Enter the name of the header into “Field Name/Column”.
12. Drag the new header (Input Field Name/Column) to the “Mapped Import Field/Column Value” corresponding to the “Map to Field/Destination”. See the Map by Name section for more detail.
13. Once you are done, click “Next”.
14. Please review all subsequent screens and click “Next” if they meet with your approval.
15. Click on “Finish”.

Your import map will now be modified and the next time that you use this import map to bring in tax forms, it will also bring in the information located underneath the newly designated header.

Adding an import field after import map creation for a custom import map without headers.

(Fixed Position)

1. Click on “Import New Tax Forms” from the left hand navigation menu.
2. Click on “Begin a new XXXX Import Process”.
3. Click “Next”.
4. Click on “Add/Update XXXX Import Maps”.
5. Select the import map that you would like to add the new import field to.
6. Click on “Change”.
7. Click “Next”.
8. Click “Next”.
9. Select the Database(Form) Field on the left hand side that you wish to add. (Highlighted in yellow below)
10. Click “Add this Field” to move the Database Field over to your import map.
11. Use the Up and Down Arrows to move the Database(Form) field to match the column in your import file. Note: The column on the import map must match the column’s location on the spreadsheet. In the “Col”, you will see which column on the spreadsheet the import map will be referencing when it imports.

12. When you are done making changes/adding columns, click “Next”.
13. Please review all subsequent screens and click “Next” if they meet with your approval.
14. You will see your new entry in the “Drag (map) Fields from here…”, on the left side under the “Col” entry will be the column where the import map will be looking for the information to import on your spreadsheet.
15. It is very important that the column number that is listed in there matches the column number over from the left on your spreadsheet. For example, if it indicated that it will be the 6th column over on your new import map area, it must be the 6th column over on your spreadsheet.
16. Please review the information located in the right window that contains the “Map to Field/Destination”, “Mapped Import Field/Column/Value” and “Col” columns.
17. If your information is correct, click on “Next”.
Please review all subsequent screens and click "Next" if they meet with your approval.
Click on "Finish".

20.1.9 Running a SQL Script on Your Imported Data (CS version only)

Running a SQL Script on your Imported Data

The features contained within this section are available exclusively to users of the Corporate Suite edition.

Corporate Suite allows you to call up to 3 SQL Stored Procedures on the imported records utilizing custom SQL scripting at the end of an import post. You must have at least one custom script in the database for the form type you are importing, otherwise you will not see the changes in the import wizards.

Please note, these scripts are created and maintained by 1099 Pro only.

Uses of this procedure might be to populate or override various data fields using complex logic involving conditions and multiple data fields.

20.2 Step 1 - Import Filers, Recipients, or Data

Step 1 - Import Data, Filers or Recipients

Import of Recipients is available exclusively to users of the Corporate Suite edition.

Welcome to the first step of the Import Wizard. Users may import Data, Filers Only or Recipients Only (Corporate Suite feature) into the program; thereby eliminating the need to manually enter data and thus saving you time!

Prior to starting an import please consider:
- All programs include sample import files. In a standard installation they are located at C:\1099 Pro Pro99T17\Import. Users are strongly encouraged to review the sample files and incorporate the Header Records to ensure a smooth import.
- If your data file includes leading zeros in TINs or ZIP codes save the file in Text (Tab Delimited) (.txt) format in Excel to preserve formatting.
- For detailed information on import file conventions please reference the online 1099 Pro WIKI.

Import Wizard - Step 1: Importing Data

Please visit https://www.1099pro.com/videos.asp and click the "Importing Using Standard Maps" video to watch a brief tutorial of the import process.

1. Go to the Preparing My Forms task panel and click the "Import New Tax Forms" link.
   - Corporate Suite Users: At the menu bar select Utilities > Run the Import Wizard. User is prompted to select the type of form to import.

2. At the Start a New Import Process screen click the "Import Records From Excel or a Delimited Text File" button.
Corporate Suite Users: At the Begin a New Import Session screen click the "Begin a New TY Import Process" button.

3. At the Import LOAD Wizard screen click "Next" to proceed. Use the "Back" button at any time to go back a step.
   - Corporate Suite Users Only: Select the form series to import. For filer or recipient imports, make any selection.

4. Select the Type of Data and Format and then click "Next" to proceed. If working in a multi-user or network environment see Troubleshooting below.
   - Select the type of tax form or "FILERS" for a filer only import, "RECIPIENTS" for a recipient only import (available in Corporate Suite Edition only).
   - Indicate the Import File Format: Excel or Delimited
   - If your import file does NOT include Header Records, use the "Add/Update Import Maps" button to create a custom mapping. See Manage Import Maps and the Delimited Import Map Wizard.
   - Corporate Suite Users Only: If importing filers or recipients, select "FILERS" or "RECIPIENTS".

5. The Tax Forms Revisions Notice appears for any form type with new tax year changes. Checking the "I understand and agree" box will cancel the reminder for future imports to this form type. Click "Next" to continue.

6. At the Select the File To Import screen browse for your file and click "Next" to continue.
   - The selected file should appear in the display box; although the data may appear slightly askew.
   - Your data may NOT appear if 1) there is a blank row at the top of your import file, or 2) there is a blank row between the Header Row and the start of your data. Users should cancel the import and modify their import file accordingly.
   - If your data is based on our sample import files and you deleted any columns/fields, you may receive a WARNING at the next screen indicating some expected fields are missing. Please review the screen carefully for instructions.

7. Select the Filer for the Import. By default the forms will import to the currently selected Filer. Use the "Select a Filer" button to change as necessary.

8. At the View the Mapped Import Records screen scroll down to verify that data is correctly mapping. Use the "View Next" button to sort through actual records and see live data. Should your data contain any strange characters; see Import File Conventions. You can also verify the Data Type, File Format, and Process Type before proceeding. Click "Next" to continue.

9. Specify Import Status and click "Next" to continue. See Import statuses.
   - Pending - This default status allows you to edit, print and print records. Most users select Pending status.
   - Filed - To indicate forms have been filed on paper with the IRS/SSA, e.g., Copy A and associated 1096 / W-3 / 1042 transmittal.
   - Uploaded - To indicate forms have been sent to the 1099 Pro Service Bureau.
   - E-Filed - To indicate forms have been printed and filed with the IRS/SSA.

10. At the Confirm, Text and/or Begin Import Process screen users may test their import file for potential errors or warnings. If errors or warnings are determined, users are encouraged to cancel the import and edit their import file as necessary. Users may NOT edit errors and save
changes at this screen. Click "Finish" if you are satisfied with your import file and ready to proceed to Import Wizard - Step 2: Validating Data.

11. The Administrator prompts, "What do you want to do?"
   o 1 - Report: Select to review any warnings or errors in your import data and generate a report or correct them interactively.
   o 2 - Continue: Select to proceed directly to Import Wizard - Step 2: Validating Data.
   o 3 - STOP: Select to return to the Import Wizard at a later time.

Troubleshooting Import Issues
Note: When importing a text file from (i.e. Microsoft Excel): During the import, you may run into a problem where during the process of assigning fields in the "Specify Form Field Mapping Screen", the software generates "0" records on the left hand side in the Available Input Fields column. Typically this can be caused by the import file being "locked" in memory by the application Microsoft Excel or similar application across a network LAN or WAN. The idea is to have Microsoft Excel or similar application to release control over the text file to be imported. To solve this problem, follow the steps below:

If working locally (An individual computer not on a network) First, close all instances of (i.e. Microsoft Excel) or another program used to generate your text file for import. Rename the file to a different file name. (i.e. "import.tab" >>> import2.tab.) Begin the Import Data process again starting with Step 1 above.

If working on a network (Your import file resides on another computer such as a workstation or a server) Again, close all instances of (i.e. Microsoft Excel) or another program used to generate your text file for import. Copy the file from the server to a folder on your local hard drive. (For Example: C:\Imports) Rename the file to a different file name. (i.e. "import.tab" >>> import2.tab.) Begin the Import Data process again starting with Step 1 above. Be sure and check with your Administrator to ensure you have the proper rights to carry out this task.

20.1.2.1 Import Status Options
Import Status Options

Users must select a print status for data imported via the Import Wizard. The imported records are termed a ‘session’. Records in an import session with a Pending status are available for edits, printing, etc. Records in an import session with any other status can only be voided (deleted). Use the Import Session Report to review the status of records in an import session.

Pending Status
Forms in this import session can be changed, printed, reset or filed in any manner.

Filed = Filed 1096 Status
Forms in this import session have been printed and filed with the IRS/SSA on paper via 1096/W-3/1042 transmittal.

Uploaded = SB Filing Status
Forms in this import session have been uploaded to the Service Bureau for processing.

E-Filed = Filed Mag Status
Forms in this import session have been printed and electronically filed with the IRS/SSA.
20.1.2.2 Import Session Status

Import Session Status

All import sessions have a status to indicate its position in the import process (reference the Status column at the Completed and In-Process Import Sessions screen).

**Loaded**  The import file has been loaded, but not fully imported into the software. To complete the import process highlight the session and click the "Continue with Session" button.

**Updated**  This import file has been imported and at least one of the records has been opened and saved (edits to the form). Re-applying validation, etc., will also trigger this status.

**Partial**  Some records in the import file have been Imported and some are still in a Loaded status.

**Imp/Disc**  Some records in the import file have been Imported, others were deleted during the Post

**Abandoned**  All records for the log were abandoned, none imported.

**Reset/Void**  A completed import was reset, removing the posted records from the database. Records only removed if their status has not changed since they were posted. Records that have had their status upgraded (e.g., Pending to Printed or Filed) are NOT removed.

Users must select a print status for data imported via the Import Wizard. The imported records are termed a 'session'. Records in an import session with a Pending status are available for edits, printing, etc. Records in an import session with any other status can only be voided (deleted). Use the Import Session Report to review the status of records in an import session.

Users must select an import status for their data in the first step of the import routine, Import Data. Selecting the correct status is important because aside from Pending, the status of the session can only be reset by voiding (deleting) the entire session. Use the Import Session Report to review the status of records in an import session.

Import Session Status Overview

**Loaded:** Step 1 of the Nothing has been done to the entire import other than the initial load.

**In Process:** Something has happened to logs (edit, posted, abandon, etc.), but there are still more records left.

**Completed:** All logs either posted, abandoned or reset. Nothing left to do.

**Discarded:** All logs abandoned or reset.

**All Reset:** All logs were posted, then reset.

**Individual Logs (one per Filer) can have the following values:**

**Loaded:** Nothing has been done to the records other than the initial load.

**Updated:** At least one of the records in import hold has been opened and saved, e.g., changes were possibly made. Re-applying validation, etc., will also trigger this status.

**Partial:** Some records were posted, some are still left.
**Imported:** All records were posted, processing completed.

**Imp/Disc:** Some records were posted, the rest were abandoned, so processing still completed.

**Abandoned:** All records for the log were abandoned, none imported.

**Reset/Void:** A completed import was reset, removing the posted records from the database. Records only removed if their status has not changed since they were posted. Records that have had their status upgraded (e.g., Pending to Printed or Filed) are NOT removed.

---

### 20.1.3 Step 2 - Validate Data

Welcome to the second of three steps of the Import Wizard. At this screen users validate and check their data for any potential errors.

**Import Wizard - Step 2: Validating Data**

Please visit [https://www.1099pro.com/videos.asp](https://www.1099pro.com/videos.asp) and click the “Importing Using Standard Maps” video to watch a brief tutorial of the import process.

1. Click the "Test My Import for Problems" button to perform a test import on up to 250 records. The Test Import Result window displays any errors and warnings. Select any record and click "Change/ Fix selected record" to view data, however changes are not saved in test mode. This is an excellent opportunity to verify your data and go back and make any necessary changes to mappings, delimiters, etc. Click "Close" to exit this screen.

2. Decide how to proceed with the import:
   - If records need to be corrected or deleted click "Finish" and then "Report" to run a summary report detailing any errors or warnings. This report is not available once the import session is posted. Then proceed to the Edit, Post or Abandon Imported Records screen.
   - If NO records need to be corrected or deleted AND you want to proceed directly to the final step of the import routine, click "Finish" and then "Continue". At the Edit, Post or Abandon Imported Records screen click "Post Session". You immediately enter the Post Import Records wizard.
   - If NO records need to be corrected or deleted BUT you don't want to proceed to the final step of the import routine at this time, click "Finish" and then "Stop". Remember to return at some point to modify, delete or post this import session!

3. A standard installation of 1099 Pro allows up to 5,000 transactions. If the combined total of existing records in the database and imported records exceeds 5,000, the import may abort.
   - To handle more than 5,000 transactions contact Sales at (888) 776-1099.

Proceed to **Import Wizard - Step 3: Posting Results**.

---

### 20.1.4 Step 3 - Final Import - Post Results

Welcome to the final step the Import Wizard. At this screen users post their data into the software.

---

Copyright 1099 Pro® 2017
Users importing very large import files should consider optimizing the post process.

**Import Wizard - Step 3: Post Results**

**Posting Import Session**
1. Open the Post Import Wizard via:
   - Continuing directly from the Import Wizard [Step 2: Validate Data](#) and selecting "Post This Session", OR
   - At the Preparing My Forms task panel select the "Import New Tax Forms" link. At the Completed and In-Process Import Session screen select any import session with a Loaded or Partial status and click "Continue with Session" and then "Post This Session".

2. At the Post Import Wizard click "Next" to continue. At any time click "Back" to go back a step.

3. If any records in the session contain errors or warnings you must decide how to handle them. Options include:
   - **Do not post records with errors**: (Recommended!) Records without errors are posted and problem records are placed on "hold" so you can fix them at a later time.
   - **Post records with Warnings/Errors**: Post all records now. You'll need to review individual records and manually update these fields at a later time.

4. Specify how to deal with existing recipients in the 1099 Pro system. Options include:
   - Match forms with existing Recipients, but do not update addresses
   - Ignore existing TINs, add every Recipient as new
   - Update the incoming tax form with my current Recipient information
   - Update my Recipient information with new information from the tax forms (default selection)

5. Review settings and click "Finish" to post your import session. Your imported records are available to view and/or edit at the Work With My Tax Forms screen.
   - See Import Session Summary Report
   - See Print Wizard

---

### 20.1.5 Reset (Void) Import Session

**Reset/Void Import Session**

**What Happens When an Import Session Is Reset**
When an import session is reset (voided), all tax forms associated with the import session are deleted UNLESS their status has been changed since the original import. For example, if records are imported as Pending and then some are updated to Printed or Filed Mag status, only the Pending records are deleted.

If this was a partial import and records have a Loaded status, users must use the “Continue with Session” button and then "Abandon the Session" to remove the session.

**What Does NOT Happen When an Import Session Is Reset**
Recipient records added or changed during the import session are NOT deleted or rolled back. To remove those recipient records refer to the Recipient Master List screen.
**Reset/Void Import Session**

Once an import session is reset/void it cannot be reversed.

1. On the **Preparing My Forms** task panel select the "Import New Tax Forms" link.
   - **Corporate Suite Users:** On the **General Options** task panel select the "Import Forms" link and select the appropriate form type to delete.

2. At the Completed and In-Process Import Session screen highlight any session with a status of "Imported" or "Partial" and click the "Reset (Void) Session" button.

3. The Confirm Reset/Void screen prompts the user to Proceed with Reset/Void or Cancel.
   - The Completed and In-Process Import Session screen immediately updates the session status to "Reset/Void".

### 20.1.6 Country Codes Table

#### Country Codes Table

When adding or changing information in a tax form users have the option of setting the address type for the recipient address.

**Address Type Options:**
- USA
- Canada
- Other

If "Other" is selected the Select Country Code screen appears. The list of country codes are consistent with the list of codes on the IRS website at [https://www.irs.gov/tax-professionals/e-file-providers-partners/foreign-country-code-listing-for-modernized-e-file](https://www.irs.gov/tax-professionals/e-file-providers-partners/foreign-country-code-listing-for-modernized-e-file). Select the appropriate code from the list then click the "select" button or click "cancel" to go back to the tax form screen.
20.1.7 Country Alias

Country Alias and Validation Options

1099 Pro supports custom country name and validation options during the import process. This is useful in situations where the code you use for a particular country does not match the one used by the IRS. Such an example would be if you used "JPN" to represent Japan; this country code would not be recognized during import since the IRS country code for Japan is "JP". In order to correct this error, 1099 Pro allows you to create alias for any country in the IRS database.

Example:

Let's take the example above:

1. On the initial import attempt, 1099 Pro generates an "Invalid Country" warning.

2. On closer inspection we find that the country code "JPN" is invalid.
3. To correct this we can use the "County Alias/Validation Options".

4. Click on the "Update Country Alias File" button to add "JPN" as an alias country code for Japan.

5. At the "Browse Country Alias/Translations" window you will see a list of all of the current country alias, if any exist. To create a new alias, click on the "Add" button.
6. At the “Adding a Country Alias Record” window, type the alias that you are currently using (in this case JPN) in the first box (top). On the second box (bottom) enter the name of the country or click on the "..." (ellipsis) for a complete list of IRS country names and codes. With your alias and corresponding IRS country code selected, click on the “OK” button.

7. Now that you have your alias configured, click on the "Close" button on the Browse Country Alias/Translation window to return to the import wizard.

8. You can now click on the "Reapply Alias/Validation" button to allow 1099 Pro to use your new country code alias.

9. After clicking on the "Reapply Alias/Validation" button, 1099 Pro will ask how you would like to apply your alias/translations. You can apply them to all records or records with problems only.

10. Once your aliases/validations have been applied, 1099 Pro will be able to properly translate “JPN” to Japan or “JP” and the "Invalid Country” warning will be removed.
20.1.8 Transactional Imports (CS Version Only)

Transactional Imports

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

A transactional import is an import which will allows users to aggregate (combine) data for a given recipient. Aggregation is the process where a recipient with multiple forms of the same type can have the total(s) of certain tax form fields added together to create one overall form which will continually display the total of the specified tax form fields. This is useful in situations when users need to combine, print and report on a single form the totaled amounts from multiple forms for a given recipient.

An important aspect of aggregation to understand is the criteria in which data is aggregated by. Transactional imports are unique in that they require two steps. The first step involves creating a recipient to import data in to and the second step is the actual importing of data to be associated with the previously created recipient record.

Recipient data can be added in 1 of 2 ways:
- Manually add a recipient record: Enter the Master Employees List under the menu option General Options and manually create a new recipient record by pressing the Add button.
- Import recipient data: Enter the Import module by clicking on the "Utilities" tab on the main menu and then clicking on the "Run Import Wizard" option. Create a new map for importing recipient data and then use the map to import you recipient data.
Once you have created your recipient data, you can proceed to import the transactional data:

- Create a new map for your transactional data using the Import Wizard.
- Make sure that the correct TIN, Account Numbers and other associated data match the recipient information that you would like to import this data for.
- Import your transactional data using the map you created.

Important notes: Please see the following links to learn more about creating and using Delimited Import Maps and Fixed Width Import Maps. If you attempt to import transactional data without having added an associated recipient, the software will save the transactional data import until the recipient is added and the import can be posted. If you have the recipients list disabled during an import, the records that were imported will not be combined with future transactional imports. This is because there is no record kept of transaction being linked to a specific recipient when the recipient list has been disabled. To view a list of the current optional transactional items (criteria) to be used during aggregation, view transactional items. For help combining transactions with other versions of our program please see the Roll Up procedure.

20.1.9 Transactional Items (CS Version Only)

Transactional Items

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

Configurable criteria for combining forms

Form combining can be configured to use any single or combination of the following criteria to aggregate forms by:
- TIN
- Control Number
- Account
- Box 15 State
- Tax State
- Distribution Code
- Form Category
- Form Source
- Department
- Box 13 Retirement
- Box 13 Statutory
- Box 13 Sick Pay

These options can be reached by:
- clicking on "File" from the main menu, then "Security and Administration", "Combining Tax Forms" then "Set/Change Matching Criteria".
- Once in the Aggregation Options window, you will see two columns. The column on the left is a list of available matching criteria and the right side represents the items you have chosen to match by.
- Drag the items from the left side to the right side in order to select your aggregation fields.
- You can adjust the order by which the criteria are matched by using the Up and Down buttons to arrange them. The order reads from top to bottom, with the top coming first.
- Once finished, press the Save/Apply Rule NOW to save your settings or the Cancel button to remove and changes.

The software will now aggregate (combine) forms based on the fields you have selected.
20.1.10 Drag and Drop Import Method

Drag and Drop Methods

Drag & Drop Import Method
Use if your import file contains your own unique headers or no headers at all. Click on a field from the Available Input Fields and drag it across to the matching field in the Input Field list. Repeat this procedure until all of the necessary fields have been assigned. If the wrong field is accidentally assigned, double left click the mouse on the incorrect field on the Input Field and the information is removed. Then drag the correct field from the Available Input Field to the Input Field.

For more information see the Import Wizard and Delimited or Excel Import Map topics.

Eliminate the need to Drag & Drop by using our Sample Import Files.

20.1.11 Map by Name Import Method

Map by Name

To perform manual Map By Name
At the "Map the import Fields/Columns to your..." area of the Delimited Import Map Wizard use the Drag & Drop method to map fields.
- Drag the Combined City/St/Zip Available Input Field to the Combined City/St/Zip Input Field. Do not drag it to the individual City, State and Zip fields. Performed correctly, (Combined City/St/Zip) appears at each of the individual City, State and Zip fields. The parentheses indicate a successful mapping.
- Drag the Address Delivery/St available Input Field to the Address Delivery/St Input Field. Then
drag the Address Apt/Suite available Input Field to the Address Apt/Suite Input Field. Performed correctly, Address Delivery/St+ appears at the Address Delivery/St Input Field only. The plus sign indicates Address Lines 1 & 2 have merged for a successful mapping.

- Drag all other fields as normal.

Header Records
Sample import files utilize header records for an easy Map By Name import. Header records describe a field of data. For example, row 1 of the 1099MISC.TAB sample import file is composed entirely of header records (i.e., Recipient TIN, Last name/Company, First name and so on). Header records are not case sensitive.

Users are encouraged to incorporate header records from the sample import file into their own import file. This ensures an easy Map By Name import. If using your own header records or none use the Drag & Drop method.

20.1.12 States Code Table

States Code Table

When adding or changing information on a tax form, the Employees’ master list, or Employers’ master list, users have the option of selecting the State code via a list of state names and abbreviations. Users can right-click on an existing State field in a tax form or an entry screen and select from the list of states. The list that appears on the screen is determined by the Address Type you have selected. For Example: Choose an address type of USA and a list of states will appear. Select Canada to display a list of provinces. Other allows the user to select a country from the Country Codes Table.
Sample Import Files

All 1099 Pro software installations include sample import files (also referred to as XLS Data Shells). Users are strongly encouraged to review the sample import files included in our software and available, in a standard installation, at C:\1099 Pro\Pro99T17\Import\Sample_XLS Files. Users who review the sample import files and include our Header Records have great success with their imports!

- Please review Import File Conventions.
- For customers not interested in using our Header Records or for information on importing Delimited File Types, see Import Maps for a Delimited File Type, or Excel.

Instructions for an Easy Import

Users who review our sample import files PRIOR to creating theirs and include our exact Header Records (the respective field names) have great success with their imports. Follow these steps:

1. Access the Import folder, which in a standard installation is located at C:\1099 Pro\Pro99T17\Import.
2. In the Import folder, double-click on the Sample XLS Files folder to view all available sample import files. Select and open the appropriate sample file, for example, "1099-MISC.xls".
3. Review the sample data and notice the formatting of the TINs, First and Last Names, Foreign Addresses, etc. Review Import File Conventions completely before proceeding. All Excel files contain a second worksheet with form specific guidance on the various fields and data requirements.
4. Copy the Header Records (the first row of data containing the respective field names) onto a new Excel sheet. Then copy your relevant data into the appropriate fields.
   - Do not place a blank row between the Header Records and the start of your data.
   - Do not edit the Header Record descriptions.
   - It is acceptable to delete columns, however doing so will trigger a warning during the import process.
5. Save this excel sheet as a Text (Tab Delimited).TXT file to maintain formatting. This file is ready to be imported into the software.

See Import Wizard - Step 1: Importing Data

Import File Conventions

For a smooth import please thoroughly review these conventions PRIOR to creating your import file. We highly encourage our users to review the sample import files that are included in our software and available, in a standard installation, at C:\1099 Pro\Pro99T17\Import\Sample_XLS Files. Users who review the sample import files and include our Header Records have great success with their imports!

- For additional form specific import file conventions please refer to the 1099 Pro Wiki site.

The order of data fields is not important and it is acceptable to have extra fields that won't be included in
your import file (e.g., phone number, date of birth, etc.).

Fields in **RED** are required.

<table>
<thead>
<tr>
<th><strong>Field (Header Record)</strong></th>
<th><strong>Description</strong></th>
<th><strong>Maximum Characters</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Rcp TIN</td>
<td>Enter dashes in TINs to differentiate SSNs and EINS. Leave blank if TIN is missing or unknown.</td>
<td>11</td>
</tr>
<tr>
<td>Rcp TIN Type</td>
<td>This is a 1099 Pro internal code used to format TINs entered in the RCP TIN field without dashes. Definitions include: EIN=1, SSN=2, Unknown type=0 or blank</td>
<td>1</td>
</tr>
<tr>
<td>Rcp TIN Code</td>
<td><strong>Required for Form 1042-S only.</strong> This is an IRS required code to differentiate TIN types. Definitions include: 0=No TIN Required, 1=SSN/ITIN, 2=Standard EIN, 3=QI/WP/WT-EIN, 4=TIN Required, But Not Provided. Not filling in this box will result in a 1 if formatted as an SSN/ITIN.</td>
<td>1</td>
</tr>
<tr>
<td>Last Name / Company</td>
<td>Enter Company if Recipient TIN is an EIN. Enter Last Name if Recipient TIN is an SSN.</td>
<td>40</td>
</tr>
<tr>
<td>First Name</td>
<td>Enter First Name only if Recipient TIN is an SSN. If Recipient TIN is an EIN, leave this field blank.</td>
<td>40</td>
</tr>
<tr>
<td>Name Line 2</td>
<td>Name line 2.</td>
<td>40</td>
</tr>
<tr>
<td>Address Type</td>
<td>Leave blank for US addresses. Enter &quot;C&quot; for Canada or &quot;O&quot; (not zero) for Other foreign countries. See Country Codes Table for more information. Please see Address Type Error below.</td>
<td>1</td>
</tr>
<tr>
<td>Address Deliv / Street</td>
<td>Recipient address line 1</td>
<td>40</td>
</tr>
<tr>
<td>Address Apt / Suite</td>
<td>Recipient address line 2</td>
<td>40</td>
</tr>
<tr>
<td>City</td>
<td>US/Canada enter City. <strong>Foreign addresses ONLY enter City, Country and Postal Codes.</strong></td>
<td>40</td>
</tr>
<tr>
<td>State</td>
<td>US State or Canadian Province.</td>
<td>2</td>
</tr>
<tr>
<td>ZIP</td>
<td>US/Canada enter postal codes. *For Canada the required format is letter-number-letter, a space, then number-letter-number. For example, &quot;C3H 4W9&quot; is a valid Canadian postal code. <em>Foreign addresses enter postal codes in City field.</em></td>
<td>15</td>
</tr>
<tr>
<td>Country</td>
<td>Enter if Address Type is “O”. Please see Country Field below.</td>
<td>25</td>
</tr>
<tr>
<td>Rcp Account</td>
<td>Recipient Account Number. The <a href="#">Generate Account Wizard</a> can auto populate field if required.</td>
<td>20</td>
</tr>
<tr>
<td>Rcp Email</td>
<td>Useful if you want the ability to e-mail forms (individually) to your recipients. See <a href="#">E-Mail Tax Forms</a>.</td>
<td></td>
</tr>
</tbody>
</table>

**Additional Fields**

| **Checkboxes** | Use X / Y / T / 1 to mark a checkbox. Leave field blank or use | 1 |
N / F / 0 (zero) to NOT mark checkbox. Values are not case sensitive.

Dates
Use MM/DD/YYYY format only. Unacceptable formats include Jan 3, 2017 and January 3, 2017.

Dollar Amounts
Do not use commas or dollar signs, e.g., use 1250.00, not $1,250. Decimals are not assumed if none are contained in the amounts. For example, 1250 imports as $1,250.00. An import of 1250.0000 (Access or double precision databases) imports as $1,250.

COUNTRY FIELD - The following formats are acceptable to enter in this field:

- A Country Name: This is matched against the country file, and if a match is found, it assigns the proper country code to the form. (e.g., Japan)
- An Alias for a Country Name: If a match is found for an alias, it is converted to the proper country name. For example, setup "FR" as an alias for France. See Country Alias.

ADDRESS TYPE ERROR - Users may receive an error during import if there is a discrepancy between the Address Type and Country fields; for example, if an Address Type of "C" for Canada is entered with a Country Code of "JA" for Japan. Users should abandon their import and edit their data file to reflect the proper Address Type for the Country to resolve the error. There is also the option to manually correct the error upon importing and posting your data at the Enter, Update & View screen.

20.4 Import History

View History

The features contained within this section are available exclusively to users of the Corporate Suite edition.

The Import Summary/History screen allows users to view a summary of the selected import session including the form type, import map, tax year, date and time of import, total number of records imported as well as the number of errors and warnings associated with the import session.

To View History

1. On the General Options task panel select "Import Forms".
2. At the Completed and In-Process Import Sessions screen highlight an import session to view its' history.
3. Click the "History" button.
20.5 Converting From Excel Formats

Converting Excel Formats

Excel Spreadsheet Files
When saving data in Excel, use the 'Save As' method to save your file in .TXT (TAB delimited) format, not .XLS format. Sample import files in this format are included in your 1099 Pro installation and are very helpful. These files appear out of alignment when viewed from a text editor such as Notepad but look great when viewed from Excel. To import .TXT (TAB delimited) files select [TAB], [CR LF] and Double Quotes as your delimiters in the Import Wizard. .TAB files will not display at the "Open" screen in Excel unless "All Files (*.*)" is selected at the "Files of Type" field.

Comma Quote Delimited Files
In a database program such as Microsoft Access save your file in .CSV (Comma Separated Values) format. To import .CSV files select Double Quotes and Comma as your delimiters in the Import Wizard or the import will fail. Examples of acceptable .CSV file formats (note formatting of dollar amounts):

"Charlie","Tuna","100.00","555-55-5555","1525 Bruin Ave","Westwood","CA","90024"
"Charlie","Tuna",100.00,"555-55-5555","1525 Bruin Ave","Westwood","CA","90024"

Other Spreadsheet Files
In your program determine if files can be saved in .TXT (text) format. If difficulty is encountered, columns may be inserted between the existing columns and a "|" (pipe) may be entered as a delimiter. To import .TXT files select Pipe as your delimiter in the Import Wizard.
No Obvious Way to Create an Import File
If nothing else works, try printing your data to a file. A generic text driver that only prints text characters may be required. Import that file into a spreadsheet, parse the various columns and then import into 1099 Pro.

20.6 Delimited or Excel Import Map Wizard

Delimited or Excel Import Map

The 1099 Pro Import Wizard simplifies the process of creating Import Maps so users can import their data into the 1099 Pro software. The first step in creating an Import Map is to specify how the records to import will be selected and where the records will be inserted into the tax form. Import files can be imported in a variety of formats, including delimited .CSV, Tab-Delimited, Pipe-Delimited, Fixed Length, and Excel (XLS or XLSX). Follow the steps below to create and/or define an Import map.

Remember, your 1099 Pro installation includes sample import files for easy map-by-name imports!

Define Import Map Type
The Excel Import Wizard may be accessed during the Import Wizard process at the Select the Type of Data and Format Screen.

1. At the Select the Type of Data Format screen click the "Add/Update Form Import Maps" button.

2. At the Manage Form Import Maps screen click the "Add" (or "Change") button to access the Import Map Wizard. The Administrator prompts, "Which Type of Import Would You Like To Create?": select "Delimited" or "Excel".
   o To delete an import map, highlight the map and click the "Delete" button.
   o If header records in an import file are changed, the user must either modify the existing map or create a new map that reflects those changes.
   o The following columns define an Import Map: Map Type, File Format, Status and Description. The description column gives details about the currently selected import map and the Map Notes window to the right provides additional information.

3. At the Manage Form Import Wizard review onscreen information and click "Next" to proceed.

4. At the Define Overall Specifications for the Import File screen, the Mapping Form is determined by the type of tax form previously selected in the Import Wizard at the Select the Type of Data and Format to Use screen. To change the form type users must exit this wizard and return to the Import Wizard.

5. Check the "Has a Header Row" check box if appropriate. The header row in the spreadsheet has unique descriptive field names instead of user data.

6. At the Select the Sample Form File To Use screen browse for your file and click "Next" to proceed. A sample of the user's data file will display in the below box.

7. At the Map the Import Fields/Columns to Your Form screen, users may:
   o Map by Name - use the "Map by Name" button to automatically map all fields with matching names. To cancel a Map by Name use the "Reset/Clear the Map" button.
   o Drag & Drop Fields - manually match each field from the input file on the left to the corresponding tax form field on the right by dragging and dropping. To cancel a match, drag from right to left or double-click on it.
- **Assign Value** - assign a fixed value to the selected unmapped field. For example, for the Rcp TIN Type field enter EIN=1, SSN=2 or Unknown=3 (or blank) if all imported recipients have an identical recipient TIN type.

8. At the Default Field Size and Format Options screen select below options and click "Next" to continue:
- Check if "Amounts Use Implied Decimal Formatting". An implied decimal means that the dollar amounts being imported do not have an explicit period between the dollars and cents portions of the amount. For example, "10000" = "100.00" in implied decimals. *The use of the implied decimal format in delimited file formats is rare.*
- Define date field indicators.

9. At the Set Recipient Matching Options screen choose how the software matches imported records with existing Recipients and/or tax forms. Options include:
- **Matching Recipients with a TIN**
  - TIN plus Account Number
  - TIN plus Last Name (use only if account numbers are unavailable or inconsistent)
- **Matching Recipients When TIN is Missing/Blank**
  - Account and then Last Name (default option) - Looks for account numbers first, then matches for Last Name for the Account.
  - Account plus a blank/missing TIN - Use when TIN/Account Number are the only identifying fields in the field (no name information is provided).
  - Last Name and then Account - Looks for the Last Name first, then matches for Account Number for the recipients.
  - Last and First Name (use if account numbers are unavailable or inconsistent) - Account numbers are NOT used to match for recipients.

10. At the Specify a Name and Usage Notes for the Import Map screen enter a title of description for this map. Users may also add usage notes for further clarification. Click "Next" to continue.

11. At the Set Options for Locating Your Import Files screen review options and click "Next" to continue.
- Specify the default folder where this type of import file will be located. If left blank, the software prompts to locate the import file.
- Users may optionally specify a default file name for the files that will be imported using this map.

12. **CORPORATE SUITE ONLY:** Processing Options for Tax Form Imports
- Select the type of data processing to be applied when your import is performed and click "Next" to continue.
  - **Standard**: All forms are added as individual records regardless of whether other forms may exist in the system for the same recipient.
  - **Transactional**: If existing forms are found for a recipient that match the form matching rules configured at the time of import, the new information will update the existing record and be added as a transaction for that record. Non-matching forms are added as new.
  - **Year To Date**: Transactions are added to existing tax forms to reflect the new Year to Date (YTD) amounts and information. Existing forms that are not included in the YTD import will be flagged as zero-drop candidates if the zero-drop option is enabled.
  - **Replacement**: This feature is currently unavailable.
13. Lastly, review settings on the summary screen and if satisfied, click "Finish". The Administrator indicates if the import map was successfully created. Users may opt to import the data used to create this map by clicking the "Yes" button. Users are automatically returned to the Import Wizard, Select the Type of Data and Format To Use screen and the newly created Import Map is available for selection.

20.7 Delimiters

Delimiters

A Delimiter is defined as a character used to indicate the beginning and end of a data string. Delimiters can be commas, periods, tabs, spaces or quotes. Users must specify the delimiter for their import file. Upon correctly setting delimiters, each field of your header record should appear on a different line at the Import Data Delimiter screen. If your data displays in one long row or contains strange characters the wrong delimiter was used. Select the appropriate delimiter to correct this problem.

File Format Choices
- Standard Tab Delimited: Works with all .TAB sample import files and standard .TAB files.
- Standard Comma Delimited (CSV): Works with comma separated value (CSV) files.
- Pipe: Works with pipe delimited "|" values.

20.8 Import Session Report

Import Session Summary Report

The Import Session Summary details all records in the selected import session.

To Generate Report
1. At the Preparing My Forms task panel select the "Import New Tax Forms" link.
2. At the Completed and In-Process Import Sessions screen highlight an import session and click the "Amount/Totals Report" button.
   - The "Amount/Totals Report" button is ghosted for any session with a status of Abandoned or Reset/ Void.
3. The Report Options screen prompts to:
   - Select the Printer - consider printing to PDF to save paper
   - Select the Sort Order - by Last Name/First Name or by TIN
   - Preview before printing
   - Print Summary totals only
4. Click "OK" to generate the report or "Cancel" to exit the report.

- See Reset/Void Import Session

### 20.9 Reset/Void Import Session

**Reset/Void Import Session**

**What Happens When an Import Session Is Reset**
When an import session is reset (voided), all tax forms associated with the import session are deleted UNLESS their status has been changed since the original import. For example, if records are imported as *Pending* and then some are updated to *Printed* or *Filed Mag* status, only the *Pending* records are deleted.

If this was a partial import and records have a Loaded status, users must use the “Continue with Session” button and then “Abandon the Session” to remove the session.

**What Does NOT Happen When an Import Session Is Reset**
Recipient records added or changed during the import session are NOT deleted or rolled back. To remove those recipient records refer to the Recipient Master List screen.

**Reset/Void Import Session**
Once an import session is reset/void it cannot be reversed.

1. On the Preparing My Forms task panel select the "Import New Tax Forms" link.
   - Corporate Suite Users: On the General Options task panel select the "Import Forms" link and select the appropriate form type to delete.
2. At the Completed and In-Process Import Session screen highlight any session with a status of "Imported" or "Partial" and click the "Reset (Void) Session" button.
3. The Confirm Reset/Void screen prompts the user to Proceed with Reset/Void or Cancel.
   - The Completed and In-Process Import Session screen immediately updates the session status to "Reset/Void".

### 20.10 Reject Imports

**Reject Imports**
Records that contain certain errors are automatically rejected for import. Reject errors include:
- Missing Last Name and TIN
- Field contains non-allowed negative amounts

If the correct information is available, users should exit the Import Post Wizard and fix the record at the Edit, Post or Abandon Records screen. If the correct information is not available, users may proceed with the import. The rejected record is held at the Completed & In-Process Import Sessions screen and may be fixed at a later time.

For more information on Warnings, Errors and Reject Errors see Error & Validation Checking.

20.11 QuickBooks Import Wizard

QuickBooks™ Import Wizard

1099 Pro allows users to import Form 1099-MISC data directly from QuickBooks.

Please note:
- Any QuickBooks version from 2008 onward is supported for the US, Canada, Australia and United Kingdom.
- The QuickBooks Online Edition is NOT currently supported.
- 1099 Pro ONLY imports 1099-MISC data; no other form types may be imported via this wizard.
- See QuickBooks Troubleshooting below.

QuickBooks Import

1. Go to the Preparing My Forms task panel and click the "Import New Tax Forms" link.

2. At the Start a New Import Session screen click the "Import records directly from QuickBooks" button.

3. At the QuickBooks Import Wizard screen review important information and click the "Next" button to start the process.
   - QuickBooks must be properly installed, configured, open and running on this computer. Users must have Administrative credentials for QuickBooks.
   - The company you want to import data from must already be open in QuickBooks.
   - If there is a discrepancy between the QuickBooks Recipient information and existing Recipient information, the existing record will be updated or overwritten to reflect the imported QuickBooks data.

4. At the Connect to QuickBooks screen click the "Connect to QuickBooks" button.

5. Switch to the QuickBooks software.

6. Select the following options when prompted:
   - "Yes, whenever this QuickBooks company file is open."
   - "Allow this application to access personal data such as Social Security Numbers and customer credit card information."

7. Choose an account with Administrator privileges.
8. After selecting the previous options, switch back to the 1099 Pro software and click the "Next" button.

9. Click on “Continue…”.

10. Click on “Done”. 1099 Pro will open and inform you if the connection was successful. Click on “OK” and then “Next”.

11. Click on “Select Filer” and choose the Filer where the 1099-MISC information from QuickBooks will be imported.

12. Verify the Filer you want is selected and click “Select” and then “Next”.

13. Click “Load QuickBooks Data Now”. Users receive a message indicating that “QuickBooks data successfully loaded”. Click “OK” and then “Next”.

14. Users are presented with a preview of all the information that will be imported from QuickBooks into the 1099 Pro software. Options Include:
   - **Skip forms with errors?**: Select this option to skip any records with errors (Note: There is an errors column noting imported records with errors).
   - **Skip forms with Warnings?**: Select this option to skip any records with errors (Note: There is a warnings column noting imported records with warnings).
   - **Combine forms by TaxID**: Select this option to combine multiple tax forms with the same TaxID into one form.
   - **Use Company Name?**: Select this option to import the companies’ vendor name when creating the form. If this is not selected, the vendor’s first name and last name will be used.

15. If information is acceptable click “Finish”.

16. Users can view a report of the imported forms by clicking on “Report” or click “Exit” from the administration warning screen.

17. After reviewing all imported information to go to the Work with my Tax Forms screen to view imported records.

**QuickBooks Troubleshooting**

Users who receive an error stating that the 1099 Pro software could not establish a connection to QuickBooks should follow the below process:

1. Click on the start button.
2. Right click on “Computer”.
3. Click on “Manage”.
4. Expand “Services and Applications”.
5. Click on “Services”.
6. Scroll down to QuickbooksDB21 and right-click on it.
7. Click “Properties”.
8. On the start up type drop down change it to “Automatic” and click ok.
9. Try connecting via the 1099 Pro software again.
20.12 Microsoft Access 2007 Rollup Procedure

Microsoft Access Rollup Procedure for Microsoft Office 2007

This procedure assists users with the process of aggregating information for multiple tax forms located on one spreadsheet and combining them onto one sheet. This process is useful when exporting information from multiple databases and several of them contain information for the same recipient. 1099 Pro, Inc. does not supply customers with Microsoft Office 2007 or Microsoft Access 2007. Users must have their tax form information in an Excel spreadsheet prior to beginning this tutorial.

- Corporate Suite includes built-in Tax Form Aggregation.

To Aggregate Data


2. Click on “Blank Database” and name the file. If necessary select an alternate location to save your database file.

3. In Access select the “External Data” tab and choose “Excel”.

4. Click on “Browse” to locate the Excel file to import. Verify the option “Import the source data into a new table in the current database” is selected.

5. The user is presented with a screen displaying all data contained on the spreadsheet divided by columns. Users are STRONGLY encouraged to use Header Records for the columns in their Excel files. To do so, select the option “First Row Contains Column Headings”. Verify data and click the “Next” button to proceed.

6. As the user clicks "Next" through the Import Spreadsheet Wizard, they are prompted to choose which field will be used as a primary key; we recommend letting Access choose the primary key. Click “Next” to continue.

7. The user is prompted to name the table and click “Finish”.

8. Lastly, the user can save the import steps used to create this table. Mark the “Save Import Steps” checkbox, name the file file and click “Save Import”.

9. The user returns to the Access main screen. Select the "Table" and locate the newly created table in the left-hand pane. Double click the table to display its contents.

10. With the table open, right-click on the table name in the left-hand pane to display a drop down men and select "Design View".
11. The table displays three columns: Field Name, Data Type and Description. It is important to verify that
the data is imported as the correct data type. All boxes to be aggregated must have "Number" as
their Data Type; otherwise, errors will occur during aggregation.
- Field Name contains Header Records.
- Data Type indicates how Access stores the data. The Number field type stores only numerical
data. The Text field type can store text or numerical characters.
- Description (optional) is useful for internal notes and will not affect data in any way.

12. Click the “Create” tab and then the “Query Design” icon.

13. The Show Table window lists the newly created table. Highlight the table and click "Add" and then
"Close" the window.

14. Drag and drop the Header Records from the query window into the “Field” columns on the bottom of
the screen. Drag and drop each Header Record that should appear in the export.

15. Next, for every box area to be aggregated right-click your mouse and select the "Totals" area
underneath the desired box and select "Sum".

16. For all areas that should have their information combined, leave the "Totals" area at "Group by". This will combine their fields, and this is what should be used for things like TIN, Address types, etc.

17. Once you are done, click on the “Run” icon.

18. If everything was entered correctly, you will be presented with a combination of all your matching forms as well as the totals for all the boxes where the prior information matched identically. If “Sum” was chosen for an area that could not be “Summed” (I.E. Form Category), you will receive the following error message:

19. Once that is done, you will be presented with a new object that contains all the information that you chose to aggregate.

20. You can now click on the “External Data” tab, and over the “Export” area, click on “Text File”.

21. It is not recommended that you select any of the options on this page. You will be given further options once you have clicked “OK”.

22. You will now see all your information in the “Sample Export Format” window. In addition to this, you will be given the option to save your text file as a “Delimited” or “Fixed Width”. It is recommended that you choose “Delimited” file. Click “Next” to continue.

23. You will now be given the choice of what delimiter will be used. It is recommended that you use the “Tab” delimiter. Also select “Include Field Names on First Row” and change the “Text Quantifier” to “None”, and click “Next” to continue.

24. You will now be given the chance to name your file; it is suggested that you name the file that will easily identify it, and click “Finish”. If you plan on creating many of these types of files, it is recommended that you select the option to “Save Export Steps” and choose a name that will easily identify the delimited text file creation process.

21 Printing Overview

Printing Overview

Print Tax Forms
The 1099 Pro Print Wizard simplifies the printing routine; print to preprinted laser forms or blank stock. See Print Tax Forms Wizard for more information.

Quick-Print
1099 Pro makes it easy to quickly print an individual tax form using the Quick-Print feature at the Work With My Tax Forms screen. See Quick-Print for more information.

Print Status
1099 Pro assigns a print status to all records. To determine a record's status go to the "Work with My Tax Forms" screen and refer to the Status column. See Print Status for more information.
Margin Alignments
Alignment adjustments can be made when printing to blank stock (plain copy paper). After choosing blank stock select Advanced Print Options at the "Ready to Print" summary screen.

Pre-Printed Forms Address Alignment
The Print Wizard allows users to print a test alignment, and adjust margins accordingly, prior to printing forms. A test alignment to a blank sheet of paper is a smart way to minimize form waste. See Troubleshooting Margin Alignments.

PCL Printing
High-speed PCL printing is designed for printing thousands of forms. Please contact Technical Support for more information about this feature.

Reprint Records
1099 Pro makes it easy to reprint an individual record from a print session. See Quick-Print for more information.

Reprint Print Sessions
1099 Pro makes it easy to reprint an entire print session. See Reprinting Print Sessions for more information.

Reset Print Sessions
Only print sessions with a Printed status can be reset. Resetting a session automatically resets ALL records to Pending status. To reset an individual record see Print Status. See Reset Print Sessions for more information.

Printing IRS Instructions Sheets
Your 1099 Pro installation includes many useful IRS/SSA forms and instructions. Additionally, users with an active Internet connection can access current versions of these and other files directly from the IRS/SSA websites. See Printing Blank Forms for more information.

Troubleshooting Printer Issues
1099 Pro prints to most Windows compatible printers, subject to the printer's margin limitations. Printers with a bottom margin greater than 1/3-inch may be unable to print data at the bottom of the page or may require printing two forms to a page. Check your printer's manual and/or Maximum Printable Area for your BubbleJet, Deskjet, Inkjet or Laserjet for exact printer specifications. See Trouble-Shooting Printer Issues for more information.

Form Limits
1099 Pro allows Form Session Limits for additional filtering options when printing forms. See Form Limits for more information.

PDF File Generation
Creating PDF files is fast and easy! 1099 Pro allows users to e-mail or electronically transfer PDF files via the Internet. To protect sensitive data users may optionally password protect PDF files and save them to a location on their hard disk or network. See Initial PDF Options for more information.

Advanced Print Options
1099 Pro offers an Advanced Print Option to allow users to shift the position of the Filer and Recipient Addresses either vertically or horizontally on a printed recipient copy and also force an "X" into the
"Corrected" and VOID boxes on the form. These options are only available on copies for Recipients (not Federal, Local, State or Filer copies).
See Advanced Print Options for more information.

21.1 Advanced Print Options

Advanced Print Options

1099 Pro offers Advanced Print Options to allow users additional print functionality when printing recipient copies. Choices made at this screen are unique to the individual print run and must be reset for subsequent print runs.

Options Include:
- A brief, standardized message to be printed on all forms in this print run. Select from the available list or enter your own message of up to 30 characters.
- Force an "X" in the Corrected* box.
- Force an "X" in the Void* box (the Void box is available only on select forms).
- Print "0.00" instead of blanks for all zero amounts.
- TIN Masking On/Off
- Address/Envelope Offsets - Use to shift the position of the Filer and/or Recipient addresses up or down and left or right. Address adjustments are measured in hundredths of an inch from the DEFAULT placement. For example, a change of ".25" will shift address down or to the right 1/4-inch. Likewise, a change of "-.25" will shift address up or to the left 1/4-inch. As adjustments are made, the adjustment title turns RED if the value entered is too large. When finished click "OK" to save changes and return to the Print Wizard.

* Forcing an "X" in the Corrected or Void box does NOT constitute a valid correction or void a form. These boxes may only be checked on Recipient copies, not Federal, Local/State or Filer copies.

Related topics:
An Overview of Print Status
Print Wizard
Forcing An "X"
Using the Print Message Option

21.1.1 Inserting a Custom Print Message

Inserting a Custom Print Message

Why a Custom Message?
This is an optional feature allowing filers to provide a brief, custom message to recipients such as "Revised & Re-Issued" or "Corrected and Re-Issued" on the form. This provides additional information to the recipient as to what was done, for example a correction to an SSN or confirmation of an address change.

To Enter Custom Message / Force an "X"
1. "The Special Options for this run only" tab allows users to specify an optional message to be printed
on all Recipient copies for the print run. For convenience, 1099 Pro provides the following built-in messages:

- * Re-issued Form *
- * Revised and Re-Issued *
- * Corrected and Re-issued *
- * Replacement Copy *
- * Duplicate copy per request *

2. Users can also force an "X" to be printed in the corrected box for the form(s) by placing a check mark in this option. For the few recipient copies that have a VOID box on them (most forms don't), users can force an "X" to be printed in that box. Forcing an "X" in the either of these boxes does not create a valid correction.

21.1.2 Forcing an X

About Forcing an "X"

Why Force an 'X' in the Corrected Box?

Many users regard these revised, re-issued forms as a correction, and want to have that box checked to help indicate to the Recipient that the new form has updated information on it. The Advanced Options allows users to force an "X" and thus help avoid confusion for the recipient. What's important to understand is that the IRS does NOT consider this a valid correction. Since the information has not yet been filed with the IRS/SSA, they neither know nor care how many versions of a form have been issued and/or reissued before they get the final information.

Regarding formal IRS corrections (i.e., a correction to information AFTER it has been submitted to the IRS), the IRS has very strict rules about which forms should have the Corrected and/or Void boxes checked. That's why the Advanced Options are only available for forms that go to the Recipient—send the IRS an original form with the Corrected box checked and it will probably be rejected.

To Enter Custom Message / Force an "X"

1. "The Special Options for this run only" tab allows users to specify an optional message to be printed on all Recipient copies for the print run. For convenience, 1099 Pro provides the following built-in messages:

- * Re-issued Form *
- * Revised and Re-Issued *
- * Corrected and Re-issued *
- * Replacement Copy *
- * Duplicate Copy per Request *

2. Users can also force an "X" to be printed in the corrected box for the form(s) by placing a check mark in this option. For the few recipient copies that have a VOID box on them (most forms don't), users can force an "X" to be printed in that box. Forcing an "X" in the either of these boxes does not create a valid correction nor void a form and is purely visual. These special options apply to the current print run only. For each subsequent print run these options must be set again.

See Advanced Print Options
21.2 Form Limits Overview

Form Selection Limits Overview

1099 Pro offers Form Selection Limits to provide an extra filtering option when printing forms. For example, users may print a large batch of "Pending" forms and wish to further filter the forms to a specific geographic area. The Form Selection Limits Filter allows this.

To Use Form Selection Limits
1. On the Printing & Mailing task panel click the "Print/Mail Forms Myself" link.
2. At the Begin Printing IRS Approved Tax Forms Forms screen select as appropriate:
   - ALL Pending forms for the CURRENT filer
   - All Pending forms for ALL filers
   - Manually select forms for the CURRENT filer
   - ALL Pending forms for SELECTED filers
3. After making above selection check the "Show me the optional extra filters for limiting the number of records that will be selected" box and click the "Begin a New Print Process" button.
4. At the Form Selection Limits screen select:
   - General Filters including Address Type, States/Provinces and Zip Code ranges.
   - Amount Thresholds - check the box to skip any form(s) without dollar amounts.
   - Overall Maximum Record Limit - indicate the maximum number of records for this process.
5. Review settings and when satisfied, click the "Apply Filters" button to begin the Print Wizard.

21.3 PDF File Generation Overview

PDF File Generation Overview

What Is a PDF File?
PDF stands for Portable Document Format and is a distribution format developed by the Adobe Corporation to allow electronic information to be transferred between various types of computers. The software which allows this transfer is called Acrobat. In order to view and print a PDF file users must download and install a copy of the Adobe Acrobat Reader, available at Adobe. This utility may be installed as either:
- A browser plug-in wherein PDF documents can be viewed directly in the browser window.
- A stand-alone program wherein PDF files can be downloaded and viewed separately.

Why Generate a PDF Files?
PDF files are a fast and easy method to e-mail or electronically transfer data via the Internet. Adobe Acrobat Reader is the preferred method of generating PDF files as it allows users to password protect PDF files and save them locally or on a network.

PDF Security - Is It Safe to Email PDFs?
1099 Pro offers the ability to both encrypt and password protect PDFs for security according to the Acrobat 5.0 standard. Encryption is commonly used to prevent unauthorized viewing, printing, editing, copying text from the document and doing annotations. Users can then control how they are used. The "Standard Security" encryption feature of the PDF Library has been enhanced to provide 128-bit...
encryption support.

[Click here to see the options available for PDF printing]

21.3.1 Initial PDF Options

PDF Print Options

Generating PDF documents enables your organization to optimize the delivery of professional-looking, compliant documents. This feature allows users to print reports or tax forms to an encrypted PDF file which can be password protected.

☐ To password protect individual tax forms for recipients see E-Mail Tax Forms.

Generate Protected PDF Forms &/or Reports:
Use the following procedure to print any document in 1099 Pro to an encrypted and/or password protected PDF file. Your system must have an available Adobe PDF printer.

1. At any print screen, use the "Change Selected Printer" button to access the Select Printer screen.
2. Select Adobe PDF as the printer and click the "Properties" button.
3. At the Adobe PDF Document Properties screen change the Adobe PDF Security drop menu setting to "Reconfirm Security for Each Job" and click the "Edit" button.
4. At the Adobe PDF - Security screen select "Encrypt All Document Contents" and select the "Require a Password to Open the Document" checkbox. Enter a password in "Document Open Password" field.
5. Click "OK" to save settings. The system prompts to confirm password. Please make a note of password; this is your internal password and 1099 Pro technical support cannot retrieve it for you.
6. For all future print runs with Adobe PDF as the selected printer, 1099 Pro automatically encrypts the document and users may opt to check/uncheck the password protection as necessary.

21.4 Printing Blank Forms Overview

Printing Blank Forms Overview

Your 1099 Pro installation includes many useful IRS/SSA forms and instructions. Additionally, users with an active internet connection can access current versions of these and other files directly from the IRS/SSA websites. All documents are in PDF format and require Acrobat Reader to be viewed or printed. Download Acrobat Reader for free at www.adobe.com.

☐ See View & Print IRS Tax Forms & Instructions
21.4.1 Print IRS Form & Instructions

Print IRS Forms and Instructions

To View Local Files
1. On the Help & Extras task panel select "IRS Pubs & Links".
   o Corporate Suite Users: On the menu bar select Forms > IRS/SSA PDF Instructions and Blank Forms.
2. At the View or Print Blank Forms and Instructions screen set the Current View to "Local files installed on my machine".
3. Highlight a PDF document and click "View the Selected Form". The selected file opens automatically in Acrobat Reader.

To View Files on Internet
1. User must have an active Internet connection.
2. Follow the appropriate links provided at the Browse IRS Tax Forms help topic.

IMPORTANT: Copy A Forms and 1096 / W-3 Transmittals
The IRS requires most Copy A* forms and all 1096 and W-3 Transmittal sheets to be preprinted with a special red ink that is invisible to their scanners. Do NOT send a black and white printout of any of these forms as they will be rejected.

* Copy A for Forms W-2 and 1042-S can be printed directly to blank paper - the preprinted red ink form is not required for these forms.

21.5 Pressure Seal Forms

21.5.1 Pressure Seal and Alternate Printing Formats

Pressure Seal and Alternate Print Formats

See Pressure Seal and ACL Tutorial

1099 Pro, Inc. supports the following formats and printing methods:

<table>
<thead>
<tr>
<th>Form Type</th>
<th>Company</th>
<th>Print Style</th>
<th>Format</th>
<th>Form Desc</th>
</tr>
</thead>
<tbody>
<tr>
<td>1098</td>
<td>Moore Wallace</td>
<td>MW356 Pressure Seal</td>
<td>8 1/2&quot; x 11&quot;, Single Sided, Z fold</td>
<td>Instructions, Copy B</td>
</tr>
<tr>
<td>1098</td>
<td>TFP Data System</td>
<td>5116 Pressure Seal</td>
<td>8 1/2&quot; x 11&quot;, Single Sided, Z fold</td>
<td>Instructions, Copy B</td>
</tr>
<tr>
<td>1098</td>
<td>Relyco PSB11Z</td>
<td>8 1/2&quot; x 11&quot;, Single Sided, Z fold</td>
<td>Instructions, Copy B</td>
<td></td>
</tr>
<tr>
<td>1098</td>
<td>Relyco PS356</td>
<td>8 1/2&quot; x 11&quot;, Single Sided, Z fold</td>
<td>Instructions, Copy B</td>
<td></td>
</tr>
<tr>
<td>1098</td>
<td>Moore Wallace</td>
<td>N11EZ Pressure Seal</td>
<td>8 1/2&quot; x 11&quot;, Single Sided, EZ Fold</td>
<td>Instructions, Copy B</td>
</tr>
<tr>
<td>1098</td>
<td>Alternate Comb.</td>
<td>5145 Blank Stock</td>
<td>8 1/2&quot; x 11&quot;, Duplex, 3 panels on side 1, addresses on side 2</td>
<td>Copy B, Instructions, B, Address on Back</td>
</tr>
<tr>
<td>Code</td>
<td>Comb.</td>
<td>Supplier</td>
<td>Size</td>
<td>Fold Style</td>
</tr>
<tr>
<td>-------</td>
<td>-------</td>
<td>----------</td>
<td>------</td>
<td>------------</td>
</tr>
<tr>
<td>5498</td>
<td></td>
<td>Moore</td>
<td>8 1/2&quot; x 11&quot;, Single Sided, EZ Fold</td>
<td>Copy B, Instructions</td>
</tr>
<tr>
<td>5498</td>
<td>Alternate</td>
<td>Moore</td>
<td>8 1/2&quot; x 11&quot;, Duplex, 3 panels on side 1, addresses on side 2</td>
<td>Copy B, Instructions, B, Address on Back</td>
</tr>
<tr>
<td>1042-S</td>
<td></td>
<td>Moore</td>
<td>8 1/2&quot; x 14&quot;, Single Sided, Eccentric Z Fold</td>
<td>Copy B, C, D, Print Instructions Separately</td>
</tr>
<tr>
<td>1098-C</td>
<td></td>
<td>Moore</td>
<td>8 1/2&quot; x 11&quot;, Duplex, 2 Panels Per Side</td>
<td>Copy C, B, Instructions, Address on Back</td>
</tr>
<tr>
<td>1098-E</td>
<td></td>
<td>Moore</td>
<td>8 1/2&quot; x 11&quot;, Single Sided, EZ Fold</td>
<td>Copy B, Instructions</td>
</tr>
<tr>
<td>1098-E</td>
<td>Alternate</td>
<td>Moore</td>
<td>8 1/2&quot; x 11&quot;, Duplex, 3 panels on side 1, addresses on side 2</td>
<td>Copy B, Instructions, B, Address on Back</td>
</tr>
<tr>
<td>1099-B</td>
<td></td>
<td>Moore</td>
<td>8 1/2&quot; x 11&quot;, Single Sided, EZ Fold</td>
<td>Copy B, Instructions</td>
</tr>
<tr>
<td>1099-B</td>
<td>Alternate</td>
<td>Moore</td>
<td>8 1/2&quot; x 11&quot;, Duplex, 3 panels on side 1, addresses on side 2</td>
<td>Copy B, Instructions, B, Address on Back</td>
</tr>
<tr>
<td>1099-C</td>
<td></td>
<td>Moore</td>
<td>8 1/2&quot; x 11&quot;, Single Sided, EZ Fold</td>
<td>Copy B, Instructions</td>
</tr>
<tr>
<td>1099-C</td>
<td>Alternate</td>
<td>Moore</td>
<td>8 1/2&quot; x 11&quot;, Duplex, 3 panels on side 1, addresses on side 2</td>
<td>Copy B, Instructions, B, Address on Back</td>
</tr>
<tr>
<td>1099-CAP</td>
<td></td>
<td>Moore</td>
<td>8 1/2&quot; x 11&quot;, Single Sided, EZ Fold</td>
<td>Copy B, Instructions</td>
</tr>
<tr>
<td>1099-CAP</td>
<td>Alternate</td>
<td>Moore</td>
<td>8 1/2&quot; x 11&quot;, Duplex, 3 panels on side 1, addresses on side 2</td>
<td>Copy B, Instructions, B, Address on Back</td>
</tr>
<tr>
<td>1099-DIV</td>
<td></td>
<td>Moore</td>
<td>8 1/2&quot; x 11&quot;, Single Sided, EZ Fold</td>
<td>Copy B, Instructions</td>
</tr>
<tr>
<td>1099-DIV</td>
<td>Alternate</td>
<td>Moore</td>
<td>8 1/2&quot; x 11&quot;, Duplex, 3 panels on side 1, addresses on side 2</td>
<td>Copy B, Instructions, B, Address on Back</td>
</tr>
<tr>
<td>1099-DIV</td>
<td>Payer Combined</td>
<td>Moore</td>
<td>8 1/2&quot; x 11&quot;, Single Sided</td>
<td>Copy C Payer, Instructions</td>
</tr>
<tr>
<td>1099-G</td>
<td></td>
<td>Moore</td>
<td>8 1/2&quot; x 11&quot;, Single Sided, EZ Fold</td>
<td>Copy B, Instructions</td>
</tr>
<tr>
<td>1099-G</td>
<td>Alternate</td>
<td>Moore</td>
<td>8 1/2&quot; x 11&quot;, Duplex, 3 panels on side 1, addresses on side 2</td>
<td>Copy B, Instructions, B, Address on Back</td>
</tr>
<tr>
<td>1099-H</td>
<td></td>
<td>Moore</td>
<td>8 1/2&quot; x 11&quot;, Single Sided, EZ Fold</td>
<td>Copy B, Instructions</td>
</tr>
<tr>
<td>1099-H</td>
<td>Alternate</td>
<td>Moore</td>
<td>8 1/2&quot; x 11&quot;, Duplex, 3 panels on side 1, addresses on side 2</td>
<td>Copy B, Instructions, B, Address on Back</td>
</tr>
<tr>
<td>1099-INT</td>
<td></td>
<td>Moore</td>
<td>8 1/2&quot; x 11&quot;, Single Sided, EZ Fold</td>
<td>Copy B, Instructions</td>
</tr>
<tr>
<td>1099-INT</td>
<td>Alternate</td>
<td>Moore</td>
<td>8 1/2&quot; x 11&quot;, Duplex, 3 panels on side 1, addresses on side 2</td>
<td>Copy B, Instructions, B, Address on Back</td>
</tr>
<tr>
<td>1099-INT</td>
<td>Payer</td>
<td>Moore</td>
<td>8 1/2&quot; x 11&quot;, Single Sided, Z Fold</td>
<td>Instructions, Copy B</td>
</tr>
<tr>
<td>Code</td>
<td>Brand</td>
<td>Model/Type</td>
<td>Dimensions</td>
<td>Paper Handling</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
<td>------------</td>
<td>------------</td>
<td>----------------</td>
</tr>
<tr>
<td>1099-INT</td>
<td>Relyco</td>
<td>PSB11Z Pressure Seal</td>
<td>8 1/2&quot; x 11&quot;, Single Sided, Z Fold</td>
<td>Instructions, Copy B</td>
</tr>
<tr>
<td>1099-MISC</td>
<td>Moore-Wallace</td>
<td>N11C Pressure Seal</td>
<td>8 1/2&quot; x 11&quot;, Duplex, C Fold</td>
<td>Copies 2, B, Instructions</td>
</tr>
<tr>
<td>1099-MISC</td>
<td>Alternate</td>
<td>5145 Blank</td>
<td>8 1/2&quot; x 11&quot;, Duplex, 3 panels on side 1, addresses on side 2</td>
<td>Copy 2, B Instructions, Address on Back</td>
</tr>
<tr>
<td>1099-MISC</td>
<td>Moore</td>
<td>N112 Pressure Seal</td>
<td>8 1/2&quot; x 11&quot;, Single Sided, Z Fold</td>
<td>Copy B, Instructions</td>
</tr>
<tr>
<td>1099-MISC</td>
<td>Wallace</td>
<td>Std Register 775 Pressure Seal</td>
<td>8 1/2&quot; x 11&quot;, Single Sided, Max 4 Filer Lines</td>
<td>Copy 2, B, Instructions on Back Preprinted</td>
</tr>
<tr>
<td>1099-OID</td>
<td>Moore-Wallace</td>
<td>N11EZ Pressure Seal</td>
<td>8 1/2&quot; x 11&quot;, Single Sided, EZ Fold</td>
<td>Copy B, Instructions</td>
</tr>
<tr>
<td>1099-OID</td>
<td>Alternate</td>
<td>5145 Blank</td>
<td>8 1/2&quot; x 11&quot;, Duplex, 3 panels on side 1, addresses on side 2</td>
<td>Copy B, Instructions, Address on Back</td>
</tr>
<tr>
<td>1099-PATR</td>
<td>Moore-Wallace</td>
<td>N11EZ Pressure Seal</td>
<td>8 1/2&quot; x 11&quot;, Single Sided, EZ Fold</td>
<td>Copy B, Instructions</td>
</tr>
<tr>
<td>1099-PATR</td>
<td>Alternate</td>
<td>5145 Blank</td>
<td>8 1/2&quot; x 11&quot;, Duplex, 3 panels on side 1, addresses on side 2</td>
<td>Copy B, Instructions, Address on Back</td>
</tr>
<tr>
<td>1099-Q</td>
<td>Moore-Wallace</td>
<td>N11EZ Pressure Seal</td>
<td>8 1/2&quot; x 11&quot;, Single Sided, EZ Fold</td>
<td>Copy B, Instructions</td>
</tr>
<tr>
<td>1099-Q</td>
<td>Alternate</td>
<td>5145 Blank</td>
<td>8 1/2&quot; x 11&quot;, Duplex, 3 panels on side 1, addresses on side 2</td>
<td>Copy B, Instructions, Address on Back</td>
</tr>
<tr>
<td>1099-R</td>
<td>Moore-Wallace</td>
<td>MW1304 Pressure Seal</td>
<td>8 1/2&quot; x 14&quot;, Single Sided, EZ Fold</td>
<td>Copy B, 2, C</td>
</tr>
<tr>
<td>1099-R</td>
<td>Alternate</td>
<td>5145 Blank</td>
<td>8 1/2&quot; x 11&quot;, Duplex, 3 panels on side 1, addresses on side 2</td>
<td>Copy B, C, 2 - Print Instructions Separately</td>
</tr>
<tr>
<td>1099-S</td>
<td>Moore-Wallace</td>
<td>N11EZ Pressure Seal</td>
<td>8 1/2&quot; x 11&quot;, Single Sided EZ Fold</td>
<td>Copy B, Instructions</td>
</tr>
<tr>
<td>1099-S</td>
<td>Alternate</td>
<td>5145 Blank</td>
<td>8 1/2&quot; x 11&quot;, Duplex, 3 panels on side 1, addresses on side 2</td>
<td>Copy B, Instructions, Address on Back</td>
</tr>
<tr>
<td>1099-SA</td>
<td>Moore-Wallace</td>
<td>N11EZ Pressure Seal</td>
<td>8 1/2&quot; x 11&quot;, Single Sided EZ Fold</td>
<td>Copy B, Instructions</td>
</tr>
<tr>
<td>1099-SA</td>
<td>Alternate</td>
<td>5145 Blank</td>
<td>8 1/2&quot; x 11&quot;, Duplex, 3 panels on side 1, addresses on side 2</td>
<td>Copy B, Instructions, Address on Back</td>
</tr>
<tr>
<td>5498-ESA</td>
<td>Moore-Wallace</td>
<td>N11EZ Pressure Seal</td>
<td>8 1/2&quot; x 11&quot;, Single Sided, EZ Fold</td>
<td>Copy B, Instructions</td>
</tr>
<tr>
<td>5498-ESA</td>
<td>Alternate</td>
<td>5145 Blank</td>
<td>8 1/2&quot; x 11&quot;, Duplex, 3 panels on side 1, addresses on side 2</td>
<td>Copy B, Instructions, Address on Back</td>
</tr>
<tr>
<td>5498-SA</td>
<td>Moore-Wallace</td>
<td>N11EZ Pressure Seal</td>
<td>8 1/2&quot; x 11&quot;, Single Sided, EZ Fold</td>
<td>Copy B, Instructions</td>
</tr>
<tr>
<td>5498-SA</td>
<td>Alternate</td>
<td>5145 Blank</td>
<td>8 1/2&quot; x 11&quot;, Duplex, 3 panels on side 1, addresses on side 2</td>
<td>Copy B, Instructions, Address on Back</td>
</tr>
<tr>
<td>MISC</td>
<td>TFP Data System</td>
<td>5113 Pressure Seal</td>
<td>8 1/2&quot; x 11&quot;, Single Sided, Z fold</td>
<td>Copies 2, B with Preprinted Instructions</td>
</tr>
<tr>
<td>MISC</td>
<td>Moore-Wallace</td>
<td>MW 353 Pressure Seal</td>
<td>8 1/2&quot; x 11&quot;, Single Sided, Z fold</td>
<td>Copies 2, B with Preprinted Instructions</td>
</tr>
<tr>
<td>MISC</td>
<td>Nelco</td>
<td>LMISCPSB Press</td>
<td>8 1/2&quot; x 11&quot;, Single Sided, Z fold</td>
<td>Copies 2, B with Preprinted Instructions</td>
</tr>
<tr>
<td>MISC</td>
<td>Relyco</td>
<td>PS353 Pressure Seal</td>
<td>8 1/2&quot; x 11&quot;, Single Sided, Z fold</td>
<td>Copies 2, B with Preprinted Instructions</td>
</tr>
<tr>
<td>MISC</td>
<td>Moore-Wallace</td>
<td>N11EZ Pressure Seal</td>
<td>8 1/2&quot; x 11&quot;, Single Sided, EZ Fold</td>
<td>Copy B, Instructions</td>
</tr>
<tr>
<td>W-2</td>
<td>Relyco</td>
<td>PS1287 (TX814/ W4)</td>
<td>8 1/2&quot; x 14&quot;, Single Sided, Eccentric Z Box Quad, Copies B, C, 2, 2, w/ Instructions</td>
<td></td>
</tr>
<tr>
<td>W-2</td>
<td>Relyco</td>
<td>PS1289 (TX814/ W4B)</td>
<td>8 1/2&quot; x 14&quot;, Single Sided, Eccentric Z Box Quad, Copies B, C, 2, 2, w/ Instructions</td>
<td></td>
</tr>
<tr>
<td>W-2</td>
<td>TFP</td>
<td>5224</td>
<td>8 1/2&quot; x 14&quot;, Single Sided, Eccentric Z Box Quad, Copies B, C, 2, 2, w/ Instructions</td>
<td></td>
</tr>
</tbody>
</table>
21.5.2 Pressure Seal and Alternate Printing Tutorial

Pressure Seal and ACL Tutorial

The Pressure Seal and the Alternate Combined Layout (or ACL) print option is designed for those customers printing a very high volume of forms or requiring specialized recipient copy layouts.

- 1099 Pro, Inc. can create a customized ACL for a fee. Please contact the Service Bureau for details.
- See Pressure Seal and Alternate Print Formats

To Use Pressure Seal and ACL Printing

These instructions assume the user has entered their data and is ready to print. The Pressure Seal and ACL Print options are available at all print screens including Quick-Print and the Print Wizard.

1. In the Print Wizard follow the prompts to the Select Printer and Paper Type screen, OR in Quick-Print select "Pressure Seal/ACL" as the Paper Type.

2. Select "Pressure Seal/Alternate Combined Layouts for recipient copies" as the paper type. Click "Next" to continue.

3. Review the form specific pressure seal formats. A brief overview of each form type is displayed. Press the "Select" button to continue.

4. The Pressure Seal Format screen is auto-populated with the selected form type. Click "Next" to continue through the Print Wizard as you normally would.
   - If selecting a format requiring preprinted forms, the user is prompted to load them into the printer at the appropriate time.
   - If using preprinted forms it is highly recommended to run a test print alignment and adjust print margins as needed to avoid wasting forms.
21.6 Email: Email Tax Forms

E-Mail Tax Forms

1099 Pro software allows users to email a password protected, PDF version of a "Combined for Recipient" or "Pressure Seal/Alternate Combined Layout" version of the tax form.

- 1099 Pro software uses the default mailing client for your computer. Users without a default mailing client setup will be unable to send encrypted PDF documents to recipients through the 1099 Pro software. See No E-Mail Client Detected.
- Corporate Suite users must use ASP to e-mail tax forms to recipients. Please contact your Account Manager for assistance.

E-Mail Tax Forms
Tax forms are e-mailed individually to recipients.

1. At the Preparing My Forms task panel click the "Work With My Tax Forms" link.

2. At the Work With My Tax Forms screen highlight the recipient to e-mail a tax form to and click the "Email Tax Form" button.

3. At the E-Mail an Encrypted Tax Form screen complete all fields.
   - **Step 1: Set the E-Mail Address** - This field is auto-populated if the recipient's e-mail address was included in your import file (using the Rcp Email column header). Otherwise the field is blank and the e-mail address must be manually entered.
   - **Step 2: Encryption and Password Settings**
     - Encryption is by default set at AES 128-bit; a more secure setting requiring Adobe Acrobat 7 or higher. The encryption is how complex a file is transformed using an algorithm (called a cipher) to make it unreadable to anyone except those possessing special knowledge, usually referred to as a key. The higher the level of encryption used, the more difficult it will be for the wrong person to open should they attain the document. However, high levels of encryption also require more sophisticated software to open. Choosing too high a level of encryption may prevent your recipient from being able to open the document.
     - **The default password is based on the first five digits of the recipient's TIN, a hyphen and the first five digits of their ZIP code.** For example, 12322-99999. The recipient must enter this password before the tax form can be viewed. The following is automatically included in the body of the recipient's e-mail, "The password is the first 5 digits of your Taxpayer Identification Number (SSN or EIN), followed by a dash, followed by the first 5 digits of your mailing address zip code." Users may alternately enter a password of their own choosing.
   - **Step 3: Choose PDF Format**
     - Standard Combined (default)
     - Select a PS/ACL Layout - allows for the selection of an Alternate Combined Layout or Pressure Seal formats.
   - **Step 4: Advanced Print Options**
     - Force an X in the "Corrected" checkbox.
     - Force an X in the "Void" box (not available on all forms).
     - Print 0.00 instead of blanks for all zero amount fields.
     - Mask TINs
     - Enter optional message to print on all forms in this print run.
4. Extra Options (for advanced users only)
   - **Print Driver**: Use to select a different printer/driver.
   - **File Folder**: By default the encrypted PDF is placed in a PDF directory in the installation folder for the software. To choose an alternate location use this button.
   - **Preview PDF**: Check to preview the encrypted PDF before it is sent. *The user password is required.*

5. **Create PDF and email message**: Click button to generate the encrypted PDF and attach it to an email using your default email client.

### 21.7 Email: No Email Client

**Email: No E-Mail Client Detected**

Those users without a default email client setup, e.g., Microsoft Outlook, Mozilla Thunderbird, gmail, will receive the below notice indicating where the PDF file will be saved, the email address it was going to, the subject line for the aforementioned email and the text.
21.8 Assigning a Printed Status

Assigning a Printed Status

Select this option after printing and approving all copies of these records (including Copy A). These records are assigned a **printed** status and are now ready to generate a 1096 transmittal or electronic file.

21.9 Batch Reprint

Adding Reprint Scheduler Job

1. Choose “Reprint Tax Forms”

   Select One Type of Process to Schedule
   - Import into Database
   - Export out of Database
   - Electronic File Creation for Filing
   - Reports
   - **Reprint Tax Forms**

2. Enter the name of Job, Initial Start date and Time as well as any dependencies (jobs that must be completed prior to this one).
3. Select Job Frequency. Here you will be able to select how often the jobs are run. Please see [Job Frequency Detail](#) for more in-depth information.
Scheduled Job Wizard

Define the frequency of this Process

Note: different frequencies will bring up different options

Set the Job Frequency

Frequency of this process:

- Daily
- Weekly
- Monthly
- One Time Only

4. Add input/output location for processing.
5. After defining Parameters the job is ready to run.

File Format

1. The following naming convention is required for each tab delimited text file: Reprint_MMDDYYYY_Seq#.TXT, e.g., Reprint_03072016_Seq123456.TXT. To submit a text file without any records to be reprinted, use the wording "NO DUPLICATE [Form Type] TAX FORM REQUESTS". This returns a failed file containing "No Duplicate Tax Form Requests".

2. Text File Format is TAB delimited with the following columns: (Header row optional)
   - Col 1 - Tax Year (e.g., 2015, 2016, or 2017)
   - Col 2 - Form Type (e.g., 1099-R, 1099-DIV, or W-2)
   - Col 3 - Filer PCode (e.g., ABC123)
   - Col 4 - Recipient TIN (e.g., 324-23-2354 or 324232354)
   - Col 5 - Recipient Account Number
   - Col 6 - TIN Masking [Default = 0, No Mask]
     - 0 = No Mask
     - 1 = Mask
     - 2 = PCode Filer Preference

21.10 Field Sizes

Field Sizes
Listed below are the maximum number of characters that will print in the respective field. In some fields, 1099 Pro may allow the entry of more characters than will actually print. The maximum printable characters is assumed numeric unless otherwise stated. Some field sizes are dependent on the selected address type; USA, Canada or Other (foreign, not Canada).

For form specific data fields please see Import Field Definitions and Data Types.

**Filer Data**
Location Code/Establishment No. = 4
Filer Name = 36
Filer Name 2 = 36
Address 1 = 36
Address 2 = 36
City = 21
State = 2
ZIP = 9
Department = 6
Contact Name = 24
Phone Number = 10
Extension = 5
RTN = 9
Fax Number = 10
E-Mail = 40

**Recipient Data**
If using an SSN:
First Name = 40
Last Name = 40
Name Line 2 = 40

If using an EIN:
Company = 40
Name Line 2 = 40

**State ID Numbers**
State Abbreviation = 2
State ID Number = 14
Recipient Data

If using an SSN:
First Name = 40*
Last Name = 40*
Name Line 2 = 40*

If using an EIN:
First name = 40
Company = 40
Name Line 2 = 40

USA Address Type
Address = 40
Address 2 = 40
City = 21
State = 2
ZIP = 9

Canadian Address Type
Address = 40
Address 2 = 40
City = 21**
Province = 2
Postal = 6 (plus 1 space)

Other Address Type
Delivery/St. = 40
Other/loc. = 40
City/Postal = 40
E-Mail = 40
Account Number = 20

Optional Grouping Fields for Querying
Form Source = 12
Category = 6

Note: *The First & Last Name fields print a combined maximum of 37 characters (plus one space) UNLESS the Last Name field contains 24 or more characters AND the First Name field contains 14 or more characters; then the First Name field prints only 1 character regardless of actual characters in that field. If there are 20 or more characters in the City field, "Canada" is automatically truncated to "Can".

21.11 Margin Alignments

Margin Alignments

Alignment Adjustments when printing to Blank Stock
Alignment adjustments can be made when printing to blank stock. After choosing blank stock you can select [Advanced Print Options] at the “Ready to Print” summary screen.
Pre-Printed Forms Address Alignment
The Print Wizard offers the opportunity to print a test alignment, and adjust margins accordingly, prior to printing your forms. A test alignment to a blank sheet of paper is a smart way to minimize form waste. Test alignments print the characters "X" and "9" instead of your actual data. Your data will print (assuming the software is registered) at the last step of the Print Wizard.

To Test Alignment
Initiate the Print Wizard; it automatically prompts to print a test alignment prior to printing your forms*. 
- When selecting preprinted laser as the paper type, the user is prompted to test alignment after selecting the copies to print. For the first test print do not modify the default Top and Left margin settings. Print the test to blank paper and then hold it and a preprinted form to the light to determine if data fits into the appropriate boxes. If data does not align refer to "Alignment Adjustments" below.

Alignment Adjustments
Alignment adjustments are measured in hundredths of an inch from the default margin. For example, "0.25" would effect an adjustment of ¼-inch. Once a margin is adjusted, it becomes a default setting for that form type until the margin is adjusted again.

Top Margin
Positive numbers (e.g., "0.25") move the data lower on the page. Negative numbers (e.g., "+0.25") raise the data higher on the page.

Left Margin
Positive numbers (e.g., "0.25") move the data to the right. Negative numbers (e.g., "-0.25") move the data to the left.

Review Margin Limitations

21.12 PCL Printing

PCL Printing

Please contact Technical Support for more information about this feature.

High-speed PCL printing is designed for printing thousands of forms. In order to provide an efficient and effective way to control printer features across many different printing devices, HP created PCL. PCL was originally conceived and devised for HP's dot matrix and Inkjet printers. The first printer in HP's LaserJet series, the HP LaserJet was released in 1984 with the PCL 3 version of the language.

PCL commands are compact escape sequence codes that are embedded in the print job before being sent to the printer. Issuance of the sequence was relatively easy from any high level language or form assembler. HP PCL formatters and fonts were designed to quickly translate application output into high-quality, device-specific, raster print images. The PCL printer language is common to virtually all HP printers, but not universal and not always backward compatible. This conceptual thinking enabled HP to minimize printer support problems and protect HP printer investment in applications and printer driver software. It is why the HP laser printers quickly became the industry standard.
The PCL printer language is successful because the following points remain consistent across all levels:

1. All HP LaserJet series printers implement PCL printer language features consistently.
2. HP printers implement the PCL feature in very cost-effective formatters.
3. HP printers have the ability to ignore most unsupported commands without causing the printer or issuing device to crash.

There are six major levels of PCL. The creation of these levels was driven by the combination of printer technology developments, changing user needs and application software improvements. The first versions of PCL (PCL 1 and 2) were used in HP impact and Inkjet printers in the early 1980s. The major phases of the PCL printer language are as follows:

**PCL 1** This version is supported by all HP LaserJet series printers (except the HP LaserJet 3100 and 3150 series products). It provided very basic printing and spacing functionality, but was limited to only text printing and ASCII characters. PCL 1 is the foundational base set of functions provided for simple, single-user workstation output. It was created in the late 1970s and introduced in the late 70s and early 80s.

**PCL 2** As was PCL 1, this version is supported by all HP LaserJet series printers (except the HP LaserJet 3100 and 3150 series products). Hence it covered all PCL functionality and provided Electronic Data Processing/Transaction functionality. Functions were added for general purpose, multi-user system printing, but still in ASCII printing only. It was introduced in the early part of 1982.

**PCL 3** This was the first of the intelligent series of efforts by HP to incorporate graphics, crude as they were back then. It was the embedded code for the original HP LaserJet series printer, and the HP LaserJet Plus series printer. This version provided the commands and features required for simple high quality word processing and data printing. Allowed for the use of a limited number of bitmapped fonts and graphics. It quickly rost to the position of industry standard and PCL 3 was widely imitated by other printer manufacturers, commonly referred to as "LaserJet Plus Emulation" when used by other companies. It came out in 1984.

**PCL 4** This industry standard release was the embedded code for the HP LaserJet Series II, commonly referred to as the workhorse laser, the HP LaserJet IID, HP LaserJet IIP, and HP LaserJet IIP Plus. It had a host of new page printing capabilities, including support for macros, larger bitmapped fonts and graphics. Introduced in 1985, it was the most radical of version improvements and would be more than sufficient for users for several years.

**PCL 5** As the foundation of the HP LaserJet III, HP LaserJet IIIID, HP LaserJet IIIIP, and HP LaserJet IIIISI, PCL 5 provided ultimate office publishing functionality. It was released to allow compatibility for industry acceptance for font scaling, outline fonts and HP-GL/2 (vector) graphics. PCL 5 was designed for more complex desktop publishing, graphic design, and presentation applications. Introduced in mid-1990 with the HP LaserJet III, this is the most widely used version of PCL compatibility in use by customers.

**PCL 5C** (Color) This was also an enhancement to PCL 5 to add functional color support for HP Color LaserJet, HP Color LaserJet 5, HP Color LaserJet 5M, HP Color LaserJet 2500 series, HP Color LaserJet 4500 series, HP Color LaserJet 4550 series, HP Color LaserJet 4600 series, HP Color LaserJet 5500 series, HP Color LaserJet 8500 series and HP Color LaserJet 8550 series printers. It offered no other changes except the commands needed to support color printing.

**PCL 6** This version offered significant changes in the backward compatibility issue for HP. PCL6 is very different from PCL5 and previous PCL versions. One significant difference is the manner in which the commands are sent to the printer. The target was performance and reliability; the jury is still out on the question of better. Prior to PCL 6, each new version of the language included commands not found in older versions as well as the older PCL commands. As a result, printers with more recent versions of PCL are backwards compatible with software that supports older versions of the language. PCL 6 was released with the HP LaserJet 4000 series, HP LaserJet 4100 series, HP LaserJet 2100 series, HP LaserJet 2200 series, HP LaserJet 1200, HP LaserJet 3200, HP LaserJet 3300, HP LaserJet 4200 series, HP LaserJet 4300 series, HP LaserJet 5000 series, HP LaserJet 5100 series, HP LaserJet 8000 series and HP LaserJet 9000 series printers. PCL 6 features new modular architecture that can be easily modified for future HP printers. The efforts for faster, post printing return to application have made somewhat of a problem with older operating systems. Other performance efforts are faster printing of complex graphics, more efficient data streams for reduced network traffic, better WYSIWYG printing, improved print quality, truer document fidelity, and complete backward compatibility. The compatibility issues have caused many users to select PCL 5 as the language version.

The PCL printer commands activate the printer features. By design, HP provided four general types of HP printer language commands. Control codes, PCL commands, HP-GL/2 commands and PJL commands. A control code is a character that initiates a printer function (for example, Carriage Return (CR), Line Feed (LF), Form Feed (FF), etc.).

PCL commands provide access to the printer's PCL control structure. The PCL structure controls all of the printer's features except those used for vector graphics, which are controlled by the HP-GL/2 commands. PCL commands (other than single-character control codes) are also referred to as "escape sequences." That design provided very easy use from high level programming languages and in reality, made the PCL the industry standard. The terms are used interchangeably. Once a PCL command sets a feature of the printer that feature remains set until that PCL command is repeated with a new value, or the printer is reset to default. In other words you turn on the feature and then turn it off.

**HP-GL/2** (vector graphic) commands are two letter codes that represent the function of the command (such as IN for initialize). After the two-letter mnemonic, there may be one or more parameters that identify details of how to process the command.

HP made great efforts to yield an ease on selecting feature and capabilities in the PCL designs and procedures. That ease rewarded HP with the popularity that is second to none in the industry for laser printers. They have been active in creating other printer languages and utilities as well, such as PJL, a JCL type language and utility.

### 21.13 Print Session Report

#### Print Session Report

The Print Session report summarizes all records in a selected print session. Details include recipient name, TIN, address, account number, individual box amounts and the record's print status.
To Generate Report
1. On the Printing & Mailing task panel select "Print/Mail Forms Myself". Use the Current Form drop down menu to change the form type to process as needed.
2. At the Completed Print Session List highlight a print session and click the "View/Print Session Report" button. Click "Yes" to preview the report.

21.14 Printing Tax Forms Wizard

Print Wizard

Print Tax Forms Wizard
The Print Wizard simplifies the process of printing tax forms. Any form with a Pending print status (or Corr/Pending for corrected forms) is available for selection in this wizard. Forms with any other print status may be printed individually via Quick-Print or in batch via Group Actions.

See Printing and Mailing via the Service Bureau

Print Forms Via Print Wizard
1. At the Printing & Mailing task panel click the "Print/Mail Forms Myself" link.
   - Corporate Suite Users: At the Forms & Printing task panel click the "Print Tax Forms" link. Use the Tax Year and Current Form drop menus to select the appropriate year and form.
2. At the Print Forms for Recipients and the IRS screen refer to the Begin Printing IRS Approved Tax Forms section. Choose the method for selecting the pending forms to print.
   - All Pending forms for the CURRENT filer (default)
   - All Pending forms for ALL Filers
   - ALL Pending forms for SELECTED Filers
   - If printing Form 1099-MISC, selecting any of these three methods triggers the 1099-MISC Special Processing screen. For Tax Year 2017 the IRS filing deadline for 1099-MISC with Box 7 amounts is 1/31/2018. Users may opt to print all 1099-MISC records or only those with Box 7 data. See Deadlines.
     - Manually select forms for the CURRENT filer
3. Set Form Selection Limits: Check the "Show Me the Optional Extra Filters" box to limit the number of records that will be selected. Records may be filtered by Address Type for specific print runs.
4. Corrections: Check the "Process and Print Corrected Forms Instead of Originals" box. This box is only available if there are corrected forms for the currently selected form type. See About Corrections.
5. Click the "Begin a New Print Process" button to access the Print Wizard.
   - Corporate Suite Users: Click the "Begin Print Process" button to access the Print Wizard or the "Custom Print Process" button to generate customized print statements.
6. Confirm Processing: This screen is triggered only if any records in the print run have errors or warnings. Filing records with missing or invalid data may result in the record being rejected by the IRS. If your data contains no errors or warnings this screen will not appear. Users may choose to:
   - Yes - Print the Forms Anyway
7. The Print Wizard displays the number of recipients selected for printing. To verify recipients, amounts, or other information users are encouraged to first run a Control Totals report. To proceed with the Print Wizard click "Next". Use the "Back" button at any time to go back a step.

8. Select Printer and Paper Type and then click "Next" to continue.

9. Review the selected printer and change if necessary.
   - Choose your paper type -
     - **Preprinted** laser forms: Including IRS red Copy A forms
     - **Blank** stock forms: Select to use the Combined Print option (at the next screen) which prints all recipient copies and instructions directly to blank paper.
     - **Pressure Seal/Alternate Combined Layouts**: Some form types offer unique print layouts. For example, 1042-S has an alternate layout to allow additional characters in the recipient name fields.

10. Select copies to print. Multiple copies may be selected; user is prompted to load preprinted forms into the printer as required. Did you know that 1099 Pro offers a special 3-up recipient version of Form 1099-MISC? Select Blank stock and Combined Print to preview!
   - Review how to Safeguard TINs.

11. **Verify Print Alignment (preprinted forms only)**: Users are highly encourage to print a test alignment to BLANK paper prior to inserting preprinted forms to minimize waste. After printing a test alignment page to blank paper, hold it up to the light behind the preprinted form. Adjust margins as necessary. When satisfied, click "Next" to continue.
   - Adjustments: Are measured in hundredths of an inch, e.g. "0.25" will shift the margin 1/4-inch.
   - Top Margin: Positive numbers move the data down, negative numbers move data up.
   - Left Margin: Positive numbers move the data right, negative numbers move data left.

12. Select a sort order to print forms:
   - By Last Name/Company Name (default)
   - By TIN
   - By Zip Code (use to pre-sort mailings for the post office)
   - By State Abbreviation
   - By Account Number, then Last Name
   - Additionally, check the "Within Each Selected Copy, Keep All Forms For Each Filer Grouped" box as appropriate.


14. Indicate preview preference:
   - Ask me before processing each copy (default)
   - Yes, preview each selected copy type without asking me
   - No, send the forms directly to the printer without previewing them

15. Review print summary and **advanced print options**. When ready to proceed click "Print". The Print Wizard pauses before printing each copy and prompts the user to load the appropriate form into the printer.
   - **FALSE PRINT**: To change a record's print status from Pending to Printed WITHOUT printing any forms do NOT select any copies to print. The Administrator prompts to press the "Print" button.
16. Indicate if forms are ready to send to the IRS/SSA:
   - **NO - I haven't printed my finalized or red Copy A yet.** These forms continue to have a Pending status and are available for further edits at the Work With My Tax Forms screen.
   - **YES - I have verified and/or printed my finalized Copies or red Copy A forms.** These forms are assigned a Printed status and are no longer available for edits. These forms are ready to transmit to the IRS via electronic filing or on a 1096 transmittal.

17. Click "Finish" to exit the Print Wizard.

21.15 Puerto Rico Compliant Tax Forms (CS Version Only)

**Puerto Rico Compliant Tax Forms**

The features contained within this section are available exclusively to users of the Corporate Suite edition.

1099 Pro Corporate Suite (CS) software supports enhanced Puerto Rico form printing from both the desktop and ASP web interface. This section of the help file will assist you with printing tax forms that are acceptable in Puerto Rico. This feature is accessible in either the "Quick-Print" or "Print tax forms" sections of the software. Additionally, Puerto Rico compliant tax forms can also be printed from our ASP interface, specifically via the quick print function in the software. Please see the section of the help file entitled, “For Puerto Rico Printing via the ASP web interface”, for more information.

The following information is for Corporate Suite only. Please see below for instructions on printing Puerto Rico forms.

These steps are to be used when you are asked to select what type of paper to use in either the "Quick Print" or "Print tax forms screen". To Print 1099-R's on approved Puerto Rico forms in the CS software:

1. From either the "Quick Print" screen or the "Print Tax Forms" screen, select “Pressure Seal/ACL” when asked to "Select the type of paper you want to print on”.
2. Click on "Puerto Rico 480.7C".
3. Click the "Select" button.
4. Click the "Print Now" button.

Since there are multiple pages required for a Puerto Rico 1099-R compatible printout (6 pages per recipient), it is recommended that you put the printer in duplex mode before printing. Currently address information is spaced to fit into an 8888-1 envelope. If needed 1099 Pro can create a template for the address information to be displayed properly with other envelopes.
To Print 1099-Int’s on approved Puerto Rico forms:
1. Select “Pressure Seal/ACL” when asked to "Select the type of paper you want to print on".
2. Click “Puerto Rico 480.7A No PR Tax W/H” to print 1099-Int Puerto Rico forms without Tax withheld for Puerto Rico, or Select “Puerto Rico 480.7A PR Tax W/H” to print 1099-Int Puerto Rico forms with Tax withheld for Puerto Rico.
3. Click the "Print Now" button.

Since there are multiple pages required for a Puerto Rico printout (4 pages per recipient), it is recommended that you put the printer in duplex mode before printing. Currently address information is spaced to fit into an 8888-1 envelope. If needed 1099 Pro can create a template for the address information to be displayed properly with other envelopes.
To Print 1099-MISC’s on approved Puerto Rico forms:

1. From either the "Quick Print" screen or the "Print Tax Forms" screen, select “Pressure Seal/ACL” when asked to “Select the type of paper you want to print on”.
   - Select “Puerto Rico 480.6A Corp/Partners” to print 1099-Misc Copy A Puerto Rico forms for Corporations or Partnerships.
   - Select “Puerto Rico 480.6B Corp/Partners” to print 1099-Misc Copy B Puerto Rico forms for Corporations or Partnerships.
   - Select “Puerto Rico 480.6A Individuals” to print 1099-Misc Copy A Puerto Rico forms for Individuals.
   - Select “Puerto Rico 480.6B Individuals” to print 1099-Misc Copy B Puerto Rico forms for Individuals.
2. Click “Select”.
3. When you are done selecting the type of form you want to print, click “Print Now”.

Note: Since there are multiple pages required for a Puerto Rico printout (4 pages per recipient), it is recommended that you put the printer in duplex mode before printing. Currently address information is spaced to fit into an 8888-1 envelope. If needed 1099 Pro can create a template for the address information to be displayed properly with other envelopes.
To Print 5498's on approved Puerto Rico forms:
1. From either the "Quick Print" screen or the "Print Tax Forms" screen, select “Pressure Seal/ACL” when asked to "Select the type of paper you want to print on”.
2. Click "Puerto Rico 480.7".
3. Click "Print Now".

Since there are multiple pages required for a Puerto Rico printout (6 pages per recipient), it is recommended that you put the printer in duplex mode before printing. Currently address information is spaced to fit into an 8888-1 envelope. If needed 1099 Pro can setup a template for the address information to be displayed properly with other envelopes.
For Puerto Rico Printing via the ASP web interface.
The 1099-R, 1099-Misc, 1099-INT or 5498 Puerto Rico tax form can be printed using the "Quick Print" option in the ASP interface.
1. Click on the record that needs to be printed.
2. Click on the "Quick Print" button on the bottom left corner of your screen.
3. Make sure the box to the left of the "Use Puerto Rico 480.x format instead of US format" is checked.

The filing state on the record being printed must be Puerto Rico otherwise the following option will not appear:
- Click the printed form type that you would like and click "Print Now" button to begin the print process.

21.16 Quick-Print Individual Record

Quick-Print

1099 Pro makes it easy to quickly print an individual form using the Quick-Print feature. Please visit https://www.1099pro.com/videos.asp and watch the "Using Quick-Print" video for a brief tutorial on this process.

- To reprint a group of forms, regardless of print status, please see Group Actions.
- To reprint an entire print session, as opposed to an individual form, see Reprint Print Session.

To Quick-Print a Form
1. At the **Preparing My Forms** task panel select the "Work With My Tax Forms" link. Use the Current Form drop menu to select the form type to print.
   - **Corporate Suite Users:** At the **Forms & Printing** task panel select the Browse, Enter & Edit link. Use the Current Form drop menu to select the form type and Current Year to select the tax year.

2. Highlight an existing record and click the "Quick-Print Form" button to access the Print Options screen.

3. Select the printer to use.

4. Select the type of paper:
   - **Preprinted forms** - including IRS/SSA red copy A. Adjust margin alignment as necessary.
   - **Blank stock** - print the form and data directly to blank paper.
   - **Pressure Seal/Alternate Combined Layout (ACL)**

5. Select the copies to print. Available options are determined by type of paper selected in previous step.
   - Combined Recipient Copies is a smart choice to print all required recipient copies and instructions on a single page. Must select Blank Stock as paper type in previous step.

6. Indicate your preview preference:
   - Ask me before processing each copy (default)
   - Yes, preview each selected copy type without asking me
   - No, send the forms directly to the printer without previewing them

7. Select the sort order to print forms (this field is ghosted if the print session contains only one record):
   - By Last Name/Company Name (default)
   - By TIN/Name/Account
   - By Zip Code (use to pre-sort mailings for the post office)
   - By State Abbreviation
   - By Account/Name

8. Advanced Options are only available for Recipient copies. Settings apply to all forms in this print run only. Options include:
   - Include a brief, standardized message on all forms
   - Force an "X" in the Corrected box on all forms. **IMPORTANT:** Forcing an "X" does not create a valid correction.
   - Force an "X" in the Void box. Most forms do NOT have a Void box. **IMPORTANT:** Forcing an "X" does not void a form.
   - Force "0.00" instead of blanks for all zero amounts
   - Modify **TIN Masking** settings

9. Click the "Print Now" button to print or "Cancel" to exit the screen.

Also see **Recipient Lookup Feature**

### 21.17 Reprint Print Sessions

**Reprint Print Sessions**
1099 Pro makes it easy to reprint a print session.

To Reprint a Print Session
1. On the Printing & Mailing task panel select the "Print/Mail Forms Myself" link. Use the Current Form drop menu to select the form type to process.
2. At the Completed Print Sessions screen highlight a print session and click the "Reprint Session" button.
3. At the Print Options screen select the paper type: Preprinted forms, or Blank stock
   o If selecting pre-printed forms, adjust margin alignment as necessary.
4. Indicate your preview preference:
   o Ask me before processing each copy (default)
   o Yes, preview each selected copy type without asking me
   o No, send the forms directly to the printer without previewing them
5. Select the sort order to print forms (this field is unavailable if the print session contains only one record):
   o By Last Name/Company Name (default)
   o By TIN
   o By Zip Code (use to pre-sort mailings for the post office)
   o By State Abbreviation
6. Enter a brief, optional message to print in the upper right corner of the form(s).
7. When satisfied with all entries click the "Print Now" button. Click "Close" to exit this screen.

To reprint an individual record, as opposed to an entire print session, see Quick-Print.

21.18 Reset Print Session

Reset Print Session to Pending

Only print sessions with a printed* status may be reset. Resetting a session will reset ALL records in that session to pending status. This is usually for making a revision to a tax form. For Example: an incorrect address, a dollar amount, or a TIN number...etc. To reset an individual record see Print Status.

To Reset Session
1. On the Printing & Mailing task panel select the "Print/Mail Forms Myself" link. Use the Current Form drop down menu to select the form type to process.
2. At the Completed Print Session List highlight a print session and click the "Reset (VOID) Session" button.
3. The software prompts, "Are you sure you want to reset these records to pending status?" Click "Yes" to proceed or "No" to cancel.

* After a print session is filed, users must first void any associated transmittal (i.e., 1096, W-3 or 1042-T) and then the print session is available for reset.

21.19 Troubleshoot Printer Issues

Troubleshoot Printer Issues
Margin Limitations
1099 Pro prints to most Windows compatible printers, subject to the printer's margin limitations. If your bottom margin is greater than 1/3-inch you may not be able to print data at the bottom of the page or you may have to print 2 forms to a page. Check your printer's manual and/or Maximum Printable Area for your BubbleJet, Deskjet, Inkjet or Laserjet if you have questions.

- Preprinted forms accepting up to a 1/2-inch bottom margin: 1099-MISC, 1099-R
- Preprinted forms requiring 1/3-inch or less bottom margin: 1098, 1098-T, 1099-DIV, 1099-INT, 1099-PATR, 1099-S, 5498, 1099-B (Needs 1/36-inch additional room at the bottom margin.)

Data Truncation
1099 Pro recommends a 1/5-inch (0.20) bottom margin when printing to blank paper. Data truncation occurs if bottom margin is greater than 1/3-inch. Suggested work around is to print 2 forms to a page instead of 3 forms per page.

Postscript Drivers
1099 Pro prints to almost all printers. When opting to print to blank paper, the forms and/or fonts may print too large or otherwise print strangely. This is typically due to printing with a postscript driver. To resolve this situation try printing to a PCL 5, PCL 6, EMF or any other non-postscript driver.

Help File Print Problems
Some print drivers may have difficulty printing hot spot or jump items. For example, instead of printing a dotted or solid line underneath the hot spot/jump item, only a blank line prints. To resolve this issue install an HP 4L print driver and set it as the default printer.

Default Printer
1099 Pro may default to a specific printer. Always review the selected printer while choosing your paper type in the Print Wizard. To switch printers use the "Select a Different Printer or Port" button to access the "Print Setup" screen.

Random Errors
Occasionally a virus checker (e.g., Norton, McAfee) can corrupt the 1099 Pro installation and cause random, inexplicable errors. If this occurs, backup your data files, perform a custom uninstall and then reinstall the software with the virus checker disabled.

12 CPI (characters per inch)
1099 Pro prints at 12 CPI to allow the maximum number of characters per field (e.g., 36 characters in a name field). Accordingly, your printer must be set at 12 CPI. To set your printer either:

- Adjust the front panel of the printer manually by setting the CPI to 12 and selecting a font like Courier. Do not select a proportional font or the IRS may fine you $50 for each form!, or
- On your Windows desktop click "Start", "Settings", "Printers" and highlight the printer. Right click your mouse, select "Properties" and click the "Device Options" tab if available (may not be available). You must know what control code(s) will set your printer to 12 CPI. For example, in the case of many Epson printers hit the <ESC> key, type an uppercase M, and <ESC>M then displays in the box. This may differ for your printer.

Generic Print Driver
If 1099 Pro indicates your driver is obsolete then consider installing an additional print driver.

Go to the Windows Machine connected to the printer. Click "Start", "Settings", "Printers" and "Add Printer". In the left window select "Generic" and then "Next". Keep your existing driver, select LPT1 (if appropriate) and name the printer "Generic12CPI". Indicate this is NOT the default printer and if prompted, provide the computer with your Windows CD. After installing this new print driver verify paper size is 8½-inch x 11-inch and dip switches are off.
If you are on a Windows Network you must install this "Generic12CPI" driver on the computer connected to the printer and allow sharing. To allow sharing click "Start", "Settings", "Printers", right click on "Generic12CPI" and select "Sharing".

21.20 View Selected Records

View the Records Selected for this Process

This screen previews the records selected for this print process. This information is also available via log reports.

22 Queries

Queries

1099 Pro offers predefined queries to filter your data. The Current Query drop menu is available at the Work with My Tax Forms, Filer Master List and Recipient Master List screens.

See Custom Query (Corporate Suite Users only)

Pre-defined Queries include:
- Corrections (Filed)
- Corrections (Not Filed)
- Errors and Warnings
- Filed Original Forms
- Forms with Notes
- Pending Original Forms
- Printed Original Forms
- Voided Original Forms

Recipient:
- Has notes
- Only SSN
- Only EIN
- TIN nonstandard
- Foreign, Canada, US for various addresses
- Open W-9s
- Any W-9s

Filer:
- Has notes
- SSN
- EIN
- Combined Fed/State filing program
22.1 Custom Query using Manual Override

Custom Query using Manual Override

Sophisticated users can use the manual override feature in the Query Wizard to create custom queries via the Expression Builder which allows additional Date and Function Categories.

1. At the Query Wizard Field Selection screen, click the "Manual" button in the lower left of the window.

2. In the Query Wizard Manual Override screen, users may either choose from pre-selected fields from the Field List drop menu or click the ellipses [...] button to its immediate right.

3. At the Expression Builder screen options include:
   - **Data and function categories**: Select the category of the function to be applied in this column.
   - **Data and function names**: Contains a list of logical expressions to be applied to the query. A logical expression consists of a field, operator and value.
   - **Validate**: This button will compile and determine if the current expression has been constructed properly.
   - **Clear**: Removes the contents of the current expression from the expression builder main screen.
   - **Insert**: Inserts the currently highlighted "Data and function name" into the Expression Builder Window.
   - **OK**: Executes the "Validate" feature to check the validity of the expression and saves your expression.
   - **Cancel**: Closes the expression builder and returns you to the Query Wizard "Field Selection screen

4. After saving your custom expression it is available for selection at all Current Query drop menus.

![Expression Builder](image)
22.2 Custom Query Wizard

Custom Query Wizard

The Query Wizard allows custom access to data via an intuitive wizard driven interface. All users can quickly create and save customized queries and then re-use those queries.

1. Access the Current Query drop menu at the Work With My Tax Forms screen. At the Current Query drop menu select "Custom Query".

2. In the Query Wizard select a field to evaluate, e.g., "Box 1 Amount" or "Recipient State or Province", and click "Next".
   - See Form Status Values for specific information on the "Form Status", "Voided", "Correction Type" and "Error Status" fields.

3. At the Operation Selection screen, select the operator, e.g., "Is Equal To" or "Is Between", and click "Next".

4. At the Value Entry screen determine the value to be used to complete the expression. For example, "Recipient State or Province Is Equal to CA" where "CA" is the value. Optionally, users may process the query using "Compare Using Case Sensitive Matching" by placing a check in the box. Click "Next" to continue.

5. Click "Finish" to save your changes and run the query.
   - At the finish screen users may add any additional selection criteria as needed.
   - Use the "Change" button to change your current query or use the "Delete" button to delete the current query and start again.
   - After clicking "Finish" the user is prompted to save the query. Click "Yes" to save and enter a query name or click "No" to bypass saving a query name and display the results of the current query.

22.3 Select a User

Select a User

The Select a User screen displays all users. Use to select an individual user for querying or reporting purposes.

23 Reports

Reports

1099 Pro offers numerous reports including:

- Control Totals
- Form Counts
- Forms Issued by Filers
23.1 Form Control Totals

Form Control Totals

The Control Totals report is an invaluable tool for reviewing recipient records and pinpointing recipient errors and warnings. Information contained in this report includes:

- Form type
- Filer's Name and TIN
- Recipient's First Name, Last Name, TIN, Account Number and optionally, their Address
- Individual record print status and date of last update
- Box-by-box totals
- Errors and Warnings
- Number of missing TINs and more....

To Run Control Totals Report
1. Select the appropriate form type and filer.

2. On the menu bar select Reports > Control Totals for Current Filer & Form Type.

3. At the View/Print Control Totals Report screen select a printer.
   - Consider printing to PDF to save paper.

4. Report Filter and Form Selection Options - Choose a method for selecting records:
   - All Pending Originals for this filer
   - All Original Forms for this Filer
   - Use Query Wizard to choose or create a query
   - Manually select records (tagging)

3. Error and Warning Messages - Choose how to print warnings and/or errors. This option is only available if Extended Version is selected under Report Format Options, below.
   - Don't print error and warning details
   - Print error and warning details
   - Print ONLY forms with errors and warnings
   - Print ONLY forms with errors

4. Report Record Ordering Options - Choose how to sort the records:
   - By Last Name
   - By TIN
   - By Account Number, then Last Name

5. Report Format Options - Choose a report format:
   - Summary Version (amounts only, no address, text or error/warning detail)
   - Extended Version (all form details including address and errors/warnings)
6. Additional options include:
   - Add custom notes for this report run
   - Print totals only (suppress individual form details)
   - Print Preview

7. To generate report click "Print Now".

8. At the preview screen go to the last page to view box-by-box totals.

### 23.1.1 Troubleshooting Control Totals

**Troubleshooting Control Totals**

On occasion users may experience difficulty generating a Control Totals report due to setting incorrect parameters. To resolve this issue users should:

- Verify the correct form type, for example, 1099-MISC or 1099-INT, is selected from the Current Form drop menu.
- Verify the form selection method, e.g., "All Original Forms For This Filer" [Print Only Forms With Errors or Warnings] or "All Corrections for Filer" is accurate.

If no information matches the set parameters the Control Totals Report will not generate.

### 23.2 State Quarterly eFile Wizard (CS Edition)

**State Quarterly eFile Wizard**

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

- See CA-592 Quarterly eFile Wizard

1. On the Filing & Corrections task panel select “Electronic Filing”. Select the form type to file and verify the Tax Year (use the “Tax Year” drop menu to change as necessary).

2. At the Begin a New IRS eFile Generation Session screen click the "Quarterly State Reporting" button and select "Create Quarterly Files".

3. At the State Quarterly Filing Wizard carefully review special rules for state quarterly processing. Click "Next" to proceed; use the "Back" button at any time.
   - For example, for certain 1099 Informational Returns, Filers/Pcodes with the same EIN will be combined under one Filer in the electronic output files for NY, CA and ME.

4. At the Do You Have the Latest Version of 1099 Pro? screen it is recommended, although not required, to check for updates. Click "Next" to continue.

5. At the Choose How Forms Will Be Selected For the State Quarterly Filing screen choose a method for selecting eligible records. Voided records are not included in quarterly electronic files.
   - **ALL Forms for ALL Filers** - This option selects every eligible tax form for every Filer (and
consequently may generate a very large file)

- **Selected Form types for ALL Filers** - This option allows users to manually select form types for ALL Filers.
- **Selected Form types for selected Filers** - This option allows users to manually select both form types and Filers (recommended).

6. At the Select the States to Generate Files For screen tag (or select) the states to include in the electronic file. A separate file is created for each state, but only if forms have been issued to recipients and taxes withheld for that state. Click "Next to continue.

7. At the Specify the File Type and Transmission Medium screen all files are created for Original records.

   - **Select the Quarter to Process:** IMPORTANT: See Filing Deadlines and Important Quarterly Notes below.
     - Quarter 1
     - Quarter 2
     - Quarter 3
     - Quarter 4
     - Yearly - Jan. 1st to Dec 31 (Not applicable to CA)

   - **Select the Form Type to Process:**
     - Only Filed/Uploaded forms - This option generates a report showing completed reports, ensuring work is not duplicated.
     - Only Pending/Printed forms - This option generates a report for all records that are not yet filed with the IRS/SSA.
     - All forms - This option generates a report for all records, regardless of print status.

8. At the Select Destination Folder for your State Quarterly Filing screen review the default file location. Users are encouraged to save files to a LOCAL drive and then move them as necessary. All files are named automatically and individually for each state. The naming convention is preset for the State abbreviation, filing quarter, today's date and time; for example, CA Q3TAX 7-30-15 4-43PM.TXT. States may have their own unique naming requirements. Check with the individual state and rename the file as necessary.

   - **Archive a Copy of this File (recommended):** Creates an original copy of this file as a BLOB retrievable should your original file become corrupted or lost.

   - **Create a State Withholding Summary Report**
     - Detail Report: Includes Recipient Names and TINs with totals, by Filer.
     - Summary Report: Includes totals only, by Filer.

   - **Excel Exception File:** Check this box to filter out records from the XML output file and create an Excel exception file that identifies which records were filtered; for example, records that contain "Trust" or "Inc." in the First or Last Name fields will be filtered.

9. At the Verify Transmitter information for your State Quarterly Filing screen review Transmitter TCC, TIN and Name for accuracy and modify as necessary. Changes made at this screen are temporary and apply to this session only. To make Transmitter information changes permanent see Create a Transmitter. When satisfied with information click "Next" to continue.

10. At the Verify your Contact and Company Information screen verify information and update as necessary. This information is included in your quarterly report and may be used by a respective state should it have any questions regarding your file. Click "Next" to continue.

   - Required fields include Contact Name, Phone Number (in the XXX-XXXX format), Company Name and Company Address.

11. At the Ready to Generate State Quarterly eFile(s) screen review settings and if satisfied click the
"Finish" button to initiate the electronic file creation and report (if selected in Step 8). Use the "Back" button if necessary to make any changes.

- The file is saved to the default file location unless a different location was selected.
- If a State Withholding Summary Report was selected it automatically displays in PDF format.

**Filing Deadlines**
State quarterly filing deadlines vary by state; check with the respective state for specific information.

**Important Quarterly Notes**
Maine (ME) quarterly files require additional editing in order to properly complete and submit the files per the 941ME Withholding eFile format. This is because the 941ME Withholding eFile format requires data that is not present on the 1099 tax form (such as bi-weekly payment dates). Users should review the entire withholding file, which includes, but is not limited to, the below.

**T Record Positions:**
- 123-133 - Line 3a from Form 941ME
- 175-185 - Total Amount Due

**R Record:**
Users must create and insert the R Record(s) according to the specifications in the 941ME Withholding eFile format. See - [http://www.state.me.us/revenue/magmedia/magmedia.html](http://www.state.me.us/revenue/magmedia/magmedia.html) - "MEETRS File Formatting Specifications for Electronic Transmittal of Quarterly Income Tax Withholding".

### 23.3 CA-592 Quarterly eFile Wizard (CS Edition)

**CA-592 Quarterly eFile Wizard**

The features contained within this section are available exclusively to users of the Corporate Suite edition.

- See [Form CA-592 Overview](#)
- See State Quarterly eFile Wizard

1. Verify the correct Tax Year is selected (use the "Tax Year" drop menu to change as necessary).

2. On the Filing & Corrections task panel select "Electronic Filing" and choose the "1099/1099/5498" radio button as the form type.

3. At the Begin a New IRS eFile Generation Session screen click the "Quarterly State Reporting" button and select "CA-592 Quarterly File".

4. At the CA-592 State Quarterly Filing Wizard carefully review information specific to filing CA-592 per Pub. 1023 paying special attention to the handling of Standard vs. Transactional Filers. Click "Next" to proceed; use the "Back" button at any time.

5. At the Do You Have the Latest Version of 1099 Pro? screen it is recommended, although not required, to check for updates. Click "Next" to continue.
6. At the Choose How Forms Will Be Selected For the CA-592 State Quarterly Filing screen choose a method for selecting eligible records. Voided records are not included in quarterly electronic files.
   - **ALL CA-592 Forms for ALL Filers** - This option selects every eligible tax form for every Filer.
   - **All CA-592 Forms for Selected Filers** - This option allows users to manually select the Filers to process.

7. At the Specify the File Type, Transmission Medium and Quarter To Process screen indicate files to include.
   - **Type of Quarterly File(s) Being Created:**
     - Original (default) - 1099 Pro creates 592 electronic files for Original records only. **NOTE:** The Franchise Tax Board has specific requirements for filing Amended records via paper only; review the Instructions for Form 592.
   - **Select the Quarter to Process:** See Filing Deadlines below
     - Quarter 1 – Jan. 1 to Mar. 31
     - Quarter 2 – Apr. 1 to May 31
     - Quarter 3 – Jun. 1 to Aug. 31
     - Quarter 4 – Sep. 1 to Dec. 31 (Standard - non-transactional - records are considered Quarter 4)
   - **Select the Form Type to Process:**
     - Only Filed/Uploaded forms - This option generates a report showing completed reports, ensuring work is not duplicated.
     - Only Pending/Printed forms - This option generates a report for all records that are not yet filed with the IRS.
     - All forms - This option generates a report for all records, regardless of print status.

8. At the Select Destination Folder for your CA-592 State Quarterly Filing screen review the default file location. Users are encouraged to save files to a LOCAL drive and then move them as necessary. All files are automatically named by individual Filer and per SWIFT specifications. The naming convention is preset for the State abbreviation, filing quarter and year, TIN, today’s date and time (hour-minute-second) and Filer Name; for example, `CA Q4TAX 2016 555335555 10-21-16 8-37-11AM 2 CA-592 Test Filer 2CS`.
   - **Archive a Copy of this File (recommended):** Creates an original copy of this file as a BLOB retrievable should your original file become corrupted or lost.
   - **Create a State Withholding Summary Report**
     - Detail Report: Includes Recipient Names and TINs with totals, by Filer.
     - Summary Report: Includes totals only, by Filer.

9. At the Ready to Generate CA-592 State Quarterly eFile(s) screen review settings and if satisfied click the "Finish" button to initiate the electronic file creation and report (if selected in Step 6). Use the "Back" button if necessary to make any changes.
   - The file is saved to the default file location unless a different location was selected.
   - If a State Withholding Summary Report was selected it automatically displays in PDF format.

**SWIFT System Code H Error**

**IMPORTANT - Part III Type of Income Subject to Withholding**

During 1099 Pro, Inc.’s testing via Swift1023xValidator.exe, the Code H “Allocations to Foreign (non-US) Nonresident Partners/Members” fails validation although it is a choice on Form 592-B. Accordingly, 1099 Pro Corporate Suite changes code H to code I resulting in “Independent Contractor” in your CA file(s).
SWIFT System
SWIFT (Secure Web Internet File Transfer) is the Franchise Tax Board's method for securely transmitting files to and from FTB via the Internet. To use the SWIFT System transmitters must have FTB issued SWIFT login credentials; contact your FTB representative to request this information or refer to the State of California Franchise Tax Board website at https://www.ftb.ca.gov/

1099 Pro’s CA-592 Quarterly E-File Wizard creates files in the required CSV format. Post files on the SWIFT login site at https://swift.ftb.ca.gov/.

592 Filing Deadlines
Filing deadlines are subject to change. 1099 Pro, Inc. strongly encourages users to verify all filing deadlines and addresses and assumes no liability for inaccuracies or changes contained herein.

Quarter 1 = April 15
Quarter 2 = June 15
Quarter 3 = September 15
Quarter 4 = January 15

If the due date is on a weekend or holiday, the deadline is extended to the next business day.

23.4 945 Federal and State Balancing Report (CS Edition)

Federal and State Balancing Report

The features contained within this section are available exclusively to users of the Corporate Suite edition.

Corporate Suite offers two balancing reports:
- The Summary Balancing Report for totaling federal and state withholding boxes by filer including box-by-box totals, total number of records, etc.
- The Federal and State Balancing Report for totaling the amount of Federal and/or State tax for select form types and isolating records by Cutoff Date that may be subject to IRS/SSA penalties.

Federal and State Balancing Report
The 945 Federal and State Balancing Report (for Forms 1042-S and 1099-INT / 1099-K / 1099-MISC / 1099-R / W-2G) and 941 Federal and State Balancing Report (for Form W-2) allows users to create a PDF report and Excel spreadsheet detailing Federal and/or State Withholding Tax to-date and the Cutoff date allows users to adjust the breakdown between Originals and Late Originals.

To Run Report
1. On the menu bar select Reports > 1098/1099/5498/W-2G Reports or 1042-S Specific Reports > 945 Federal and State Balancing Report.

2. At the 945 Balancing Report Wizard review onscreen information. Click "Next" to proceed, click "Back" at any time.

3. At the Choose How Totals Will Be Calculated screen options include:
   o Cutoff Date -
Late Originals are on or after TODAY'S DATE (by default) or enter appropriate date. All Originals are BEFORE this date.

- Start a new page whenever the EIN changes by marking check box.
- Report Type -
  - DEFAULT - Includes all original transactions entered before cutoff date, NOT the accounting date. The default report returns the FWT and/or SWT on all INT, K, MISC, R & W-2G forms created prior to the cutoff date. The cutoff date defaults to the current date unless manually overridden.
  - COMPREHENSIVE - Includes default amount from above AND late adds (new transactions on or after the cutoff date AND net change of ALL corrections (detail of final non-corrected amount versus corrected amount)). This report details FWT and SWT on all Forms 1099-INT / 1099-K / 1099-MISC / 1099-R / W-2G in the following manner:
    - On or Prior to the cutoff date regardless of filed status.
    - Late Originals created after the cutoff date.
    - Originals entered on or before the cutoff date.
    - Originals filed on or before the cutoff date.

- Select 945 Federal or State Balancing Report
- Forms To File -
  - Filed Forms Only - Original defined as filed at the Federal level before the Cutoff Date, Late Originals filed on or after Cutoff Date
  - Filed AND Not Filed - Uses the Federal Filing Date forFiled Records. The date used with Not Filed Originals is the date last edited. If the form was not edited then the report uses the date created. Consequently, Late Originals are where the date above is on or after the Cutoff Date.

4. At the Select the Filer screen indicate:
   - ALL Filers - This option automatically selects every eligible Filer in the system.
   - Selected Filers - This option allows the user to choose Filers.

5. At the Generate a 945 Worksheet Export File screen select the Destination Folder to save the export file.

6. Confirm settings and if satisfied click "Finish" to generate the report.
   - The file name contains two dates and a time; the first date is the cutoff date, the second date is the date and time the report was created. (Example: "945 1099 Federal Balancing Report CD 12-21-201712-21-2017 14-14-29.XLS").
   - The spreadsheet is designed so that users can work with detailed totals by Department or with Filer totals by FEIN.

- View Form 945 on the IRS website.

23.5 Form Counts

Form Counts by Filer

The Form Counts by Filer reports generates a listing of all forms sorted by filer, detailed by print status. The last page of the report tallies forms with errors and/or warnings and indicates if original or corrected. This report is very useful for tracking the status of your forms and determining if records contain any errors or warnings.

To Run Form Counts by Filer
1. On the menu bar select Reports > Form Counts by Filer/Status (all Filers/all Form types).
2. Click “Yes” to preview the report.

23.6 Forms Issued By Filer

Forms Issued by Filer

The Summary of Forms Issued by Filer provides detailed recipient information for all forms issued by the selected filer(s).

To Run Report
1. On the menu bar select Reports > All Forms issued by Selected Filer.
2. Click “Yes” to preview the report.
3. At the Browse the Filers File screen click the “Tag” button to select filers. A red checkmark appears beside each tagged filer. To sort filers prior to tagging, use the View drop menu.
   o Review Tag Key Shortcuts
4. After tagging appropriate filers click “Proceed” to run the summary.

23.7 Import Map Reports

Import Map Reports

The Import Map report is an invaluable tool for reviewing import maps. Information contained in this report includes:
- Form type
- Creation Date and Time of the Import Map
- Recipient's First Name, Last Name, TIN, Account Number and optionally, their Address
- Individual record print status and date of last update
- Creation Date and Time of the Report including the Network Station ID
- Field Name, Field Type and Field Description...

To Run Report
1. On the menu bar select Utilities > Run the Import Wizard OR on the Preparing My Forms task panel select “Import New Tax Forms”.
2. Select the "Import Records from Excel or a Delimited Text File" button to initiate the Import Wizard.
3. At the Select the Type of Data screen in the Wizard, click the "Add/Update (form type) Import Maps" button.
4. Highlight the appropriate import map and click the "View/Print Map" button
5. The user is prompted to preview the report.

23.8 Corrections/Late Add Report

Corrections/Late Add Report

The features contained within this section are available exclusively to users of the Corporate Suite edition.
The Corrections/Late Add utility allows users to export an Excel report detailing any Corrections and/or Late Add records that need to be filed or have been filed since a specified date.

**To Generate Corrections/Late Add Report**
1. On the menu bar select Reports > 1098/1099/5498/W-2G Reports > Corrections/Late Add to access the 1099 Pro Corrections/Late Add Report Wizard.

2. In the Wizard review important onscreen information. Click "Next" to proceed, use the "Back" button at any time.

3. At the Select Form Status screen indicate:
   - **Type of Export/Report to Create** -
     - Federal Report
     - State Report
   - **Set the Cutoff Date and Level of Detail** -
     - Cutoff Date: Defaults to current day. The Cutoff Date affects the type of forms included in the report.
     - Export Details Records. The Federal/IRS Detail Report includes the Filer's TIN, Recipient’s TIN, Account Number and individual box amounts. The State Detail Report includes the Filer's TIN, Recipient's TIN, Account Number, State and individual box amounts. Both reports list total forms and box-by-box grand totals.
   - **Select the Type of Forms to Include in the Report** -
     - Only Filed/Uploaded forms (Filed at the Federal/State level). Only corrections and late adds filed ON OR AFTER the Cutoff date will be included in the output.
     - Only Pending/Printed forms (Not Filed at the Federal/State level). This option would be used to process records that have not been filed and were created on or BEFORE the Cutoff date.

4. At the Select the Filers & Forms Types screen choose a method for selecting eligible records.
   Options include:
   - ALL Forms for ALL Filers - Default option
   - Selected Form Types for ALL Filers
   - Selected Forms Types for Selected Filers

5. Select Destination Folder:
   - Specify the Export File Destination Folder. Mark the checkbox to overwrite the Destination File Name (not recommended).
   - Location Where Export File Will Be Created. The default location is C:\1099_Pro\Pro99CS\Exports; users may change the destination folder at their discretion.

6. Confirm settings and when satisfied click "Finish" to start the Export process. The Administrator indicates when process is complete.

7. Open the Excel file to view report(s). Each form type's report is located on a separate worksheet, accessed by the sheet tabs at the bottom of the document window.

### 23.9 Daily Totals Report by UserID

**Daily Totals Report by UserID**
The Daily Totals Report by UserID displays the total changes made via manual entry by UserID. The user must specify the date, Filer(s) and form(s) to include in this report. This report is useful for verifying changes made to records by an individual user.

24 Scheduler Overview (CS Version)

Scheduler Utility

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

The scheduler allows users to schedule unattended import, printing, posting of records, and reporting. This allows users to set long imports and so forth to run during off hours; thereby increasing productivity and decreasing load on your server during business hours.

Please review the help sections Administrative Configuration to set up the Scheduler prior to use and Using the Scheduler for details on creating and editing jobs.

24.1 Administrative Configuration

Scheduler Administrative Configuration

This section will walk you through configuring the scheduler's notification settings for the end users. To access these options click "File", select "Security and Administration" then choose the "User Fields and Email" option in the bottom left hand corner.
Once you are in the User Fields and Email screens you can configure the following areas:

- **Set Email Server And Account**
- **Manage Email Recipient Lists**
- **Manage Automated Email Messages/Text**

### 24.1.1 Set Email Server And Account

Setting Up the Scheduler Email Server and Account
Settings must be configured in order for the scheduler to e-mail notifications. If your e-mail server is set up for anonymous relay then all options with the exception of "Server" are optional.

**Server**: Specify the location of your server using the domain name or IP address.

**User Name**: Supply the user name set up for the scheduler on your e-mail server.

**User Password**: Supply the password for the account set up for the scheduler on your e-mail server.

**Send Account**: Specify the e-mail address you would like the e-mail to appear as coming from. If this address is not configured on your e-mail server any replies will be returned to the person replying.

### 24.1.2 Manage Email Recipient Lists

#### Managing Email Recipients

This screen displays the e-mail addresses you can select for notification when a scheduled job is complete. Here you may add, change, or delete recipients available for notification.

Please see the section titled [Add or Update Scheduler Email Recipients](#) for more information on adding or changing an e-mail address.
24.1.2.1 Add or Update Scheduler Email Recipients

Adding or Updating an Email Recipient

After clicking "Add or "Change" on the Manage Email Recipient Lists you can enter or update a user's Email Address and Display Name.

![Image of Contact Will Be Added window]

24.1.3 Manage Automated Email Messages/Text

Managing Automated Email Messages and Text

This option allows you to create, change and delete Email templates for scheduled jobs. By choosing options under "Status of Request" and "Process Type" you can select which type of Email template you wish to display. In addition to adding templates from this screen you can also do this during job creation.

![Image of Browse Email Templates]

Please see the section Add or Update Email Templates for further detail on adding or changing an Email template.
24.1.3.1 Add or Update Email Templates

**Add or Update Email Templates**

After clicking "Add or "Change" on the Manage Automated Email Messages/Text screen you can select the criteria for the Email as well as enter a custom text to be sent to the Email Recipient Upon job Completion, Failure, or Cancellation. You will need to create templates for every criteria you wish to notify a recipient of.

![Image of email template creation interface]

24.2 Using the Scheduler (Browse Jobs)

**Scheduling Jobs (Browse Jobs)**

Users with administrative rights can access Scheduler via the menu bar > Utilities > Scheduler. At the Manage Scheduled Jobs screen users can **Add, Change**, or Delete jobs and view associated reports.
24.2.1 Adding or Changing a Job

Adding or Changing a Job

By clicking "Add" or "Change" from the Browse Jobs screen you will enter into a wizard that will guide you through the process of creating or editing a job within the scheduler. For more detail on the job types select an option below:

- Import into Database
- Export Job
- Reprint Job
- Report Job
- Scheduler Archive
- Job Frequency Detail
- Browsing Reports

24.2.1.1 Import Job

Adding an Import Job

1. Choose "Import into Database".
2. Enter the name of Job, Initial Start date and Time as well as any dependencies (jobs that must be completed prior to this one).

3. Select Job Frequency. Here you will be able to select how often the jobs are run. Please see Job Frequency Detail for more in-depth information.
4. Import Load and Post Parameters: Here you will define Import Load Parameters and Post Parameters. This will allow you define the criteria for loading and posting a record. Please see the Import section if you need assistance creating an import map.
5. After defining your Load and Post Parameters your job is now ready to run!

24.2.1.2 Export Job

Adding an Export Job

1. Choose “Export out of Database”

2. Choose the type of Export to Schedule
3. Enter the name of the Job, Initial Start date and Time as well as any dependencies (jobs that must be completed prior to this one.)

4. Select Job Frequency. Here you will be able to select how often the jobs are run. Please see Job Frequency Detail for more in-depth information.
5. Export parameters: Here you will define Export parameters. Please see the Export section if you need assistance creating an export map.
24.2.1.2.1 Additional Email Contact Options For Import

Additional E-mail Contact Options

In addition to the notification e-mail set up during scheduled import jobs, administrators can send notifications to users based off file name. To utilize this feature the selected import file must contain an e-mail address(es) in the following formats.

- [email@1099 Pro.com]
- [email1@1099 Pro.com; email2@1099 Pro.com; email3@1099 Pro.com]
- 'email@1099 Pro.com'
- 'email1@1099 Pro.com; email2@1099 Pro.com; email3@1099 Pro.com'

Example file names:

- "1099-Misc Import 2017 [email@1099 Pro.com].tab"
- "1099-Misc Import 2017 'email@1099 Pro.com'.tab"

This option automatically notifies users of the status of their import job regardless of the notification options set up when creating the job. These status e-mails contain both the import file name and Import Session information.
24.2.1.3 Report Job

**Adding a Report Job**

1. Choose "**Reports**".

   Select One Type of Process to Schedule
   - Import into Database
   - Export out of Database
   - Electronic File Creation for Filing
   - **Reports**

2. Select the Type of Report to Schedule

   **Scheduled Job Wizard**
   **Select the Type of Report to Schedule**
   *Only one report can be set up at a time*

   - **1099/1099/6498/W-2G Tax Form Summary Balancing Report**
   - 1099/W-2G 945 Federal and State Balancing Report
   - 1042-S Tax Form Summary Balancing Report
   - 1042-S 945 Federal and State Balancing Report
   - W-2 Federal/State Summary Balancing Report
   - W-2 941 Federal and State Balancing Report
   - 1099 Daily Totals Report By User

3. Enter the name of Job, Initial Start date and Time as well as any dependencies (jobs that must be completed prior to this one).
4. Select Job Frequency. Here you will be able to select how often the jobs are run. Please see Job Frequency Detail for more in-depth information.

6. After defining Report Parameters your job is now ready to run!

24.2.1.3.1 Reprint Job

Adding Reprint Scheduler Job

1. Choose “Reprint Tax Forms”
2. Enter the name of Job, Initial Start date and Time as well as any dependencies (jobs that must be completed prior to this one).

3. Select Job Frequency. Here you will be able to select how often the jobs are run. Please see Job Frequency Detail for more in-depth information.
4. Add input/output location for processing.
5. After defining Parameters the job is ready to run.

File Format

1. The following naming convention is required for each tab delimited text file:
   *Reprint_MMDDYYYY_Seq#.TXT*, e.g., Reprint_03072016_Seq123456.TXT.
   - To submit a text file without any records to be reprinted, use the wording "NO DUPLICATE [Form Type] TAX FORM REQUESTS". This returns a failed file containing "No Duplicate Tax Form Requests".

2. Text File Format is TAB delimited with the following columns: *(Header row optional)*
   - Col 1 - Tax Year (e.g., 2015, 2016, or 2017)
   - Col 2 - Form Type (e.g., 1099-R, 1099-DIV, or W-2)
   - Col 3 - Filer PCode (e.g., ABC123)
   - Col 4 - Recipient TIN (e.g., 324-23-2354 or 324232354)
   - Col 5 - Recipient Account Number
   - Col 6 - TIN Masking [Default = 0, No Mask]
     - 0 = No Mask
     - 1 = Mask
     - 2 = PCode Filer Preference

24.2.1.3.2 W2 Balance Report Wizard

**W-2 Reports**
The features contained within this section are available exclusively to users of the Corporate Suite edition.

1099 Pro Corporate Suite offers various W-2 specific reports including:

- W-2 Federal/State Summary Balancing Report
- W-2 941 Federal and State Balancing Report
- W-2 State Control Totals
- W-2 SUTA Quarterly Balancing Report
- W-2 BLS Quarterly Report
- Non-Classified W-2 Transactions

24.2.1.4 Scheduler Archive

Scheduler Archive

Archiving is recommended for those users with 10,000 or more scheduler logs in the system. For example, a scheduled process that runs every 5 minutes of every day would create 1,051,200 Logs under the scheduled Job in one year.

Scheduling a periodic archival of your logs helps clean up old data. Things to consider:

- The Scheduler Archive only archives data found in the Scheduler’s logs. It will not archive data found outside of the Scheduler such as an import log showing the number of forms imported, Warnings, Errors, Rejects and form type.
- If you wish you can archive logs older than one or more months.
- If you wish you can archive all results or just some results e.g. Nothing to Do which indicates that the Job found no work to perform.
- Archived data is moved to another table where it can only be viewed via MS SQL
- For more information read the screens and look up the topic “Scheduler” in the Help file

How to Schedule an Archive

1. From the Corporate Suite menu bar go to Utilities > Scheduler.
2. At the Manage Scheduled Jobs screen click on "Add", "Next" and select "Archive Scheduler Logs" and "Next".
   - Enter a name for the scheduled job.
   - Enter a date and time for your scheduled job to begin
   - Select a dependency (optional). A job dependency is a job that must be completed prior to this process starting. Only one job can be selected but multiple jobs may be chained together.
3. Indicate a frequency for the scheduled job to run: Daily, Weekly, Monthly or One-Time Only. It is required to specify the criteria and job types for the archive job to process.
4. Enter email addresses for who should receive confirmation of completed and/or failed jobs.
5. Click "Next"
6. Click "Finish"

24.2.1.5 Job Frequency Detail

Job Frequency Detail
Daily
Set start date and time the job will be run then select recurrence options.

- **Every day** - Allows job to be run every day. By selecting this option you may also select options to have the job repeat at specified intervals throughout the day.
- **WeekDays** - Runs Monday through Friday.
- **Every "X" days** - Allows user to set a custom day interval for the job to run.

Weekly
Select how many weeks between each job.

- **Select the day(s) of the week to run this process on**: Choose which days this job should run on.

Monthly
Select the start Day or Select via the Day of Week

- **Select the months to run this process** - Tag the months this process will be run in.

One Time Only
This job runs on the time and date specified one time only. If a past date is selected the job runs immediately.

Return to Adding or Changing a Job

### 24.2.1.6 Browsing Reports

**Browsing Reports**

By highlighting a job from and clicking the "Browse Reports" button on the "Browse Jobs" screen users can review documentation related to the highlighted job by clicking "View Selected Report".

<table>
<thead>
<tr>
<th>View Selected Document</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Control Total All</td>
</tr>
<tr>
<td>Control Total Warnings</td>
</tr>
</tbody>
</table>
25 Service Bureau Overview

Service Bureau Overview

Why should I use the Service Bureau?
NO customer has EVER incurred an IRS penalty due to an error on the part of 1099 Pro for information filed late or in an incorrect format to the IRS/SSA! The 1099 Pro Service Bureau is proud to offer a wide variety of services to registered users of 1099 Pro, all performed in our secure SSAE 16 SOC I TYPE II environment. We provide Printing and Mailing, Electronic Delivery, Web Presentment, Bulk TIN Matching, and IRS Filing services to thousands of our users. Additionally, all domestic Service Bureau Print/Mail jobs include IMB tracing. IMB (Intelligent Mail Barcode) tracing reports the last time each document was scanned by the post office.

Our customers utilize the Service Bureau to save money, minimize administrative headaches, safeguard their sensitive data, and benefit from our extensive experience. Whether you have a large or small job, consider the cost savings and the value of a “job done right” during your busiest months of the year.

What forms does the Service Bureau process?
The 1099 Pro Service Bureau can print, mail and/or file the following forms* for a fee:
- Informational Returns including 1098, 1099-INT, 1099-MISC, 3921, 5498, W-2G and many more!
- 1095-B / 1095-C Affordable Care Act (ACA) Compliance (Corporate Suite)
- W-2 Wage and Tax Statements
- 1042-S Foreign Person's U.S. Source Income Subject to Withholding

The Service Bureau does not print, mail or eFile Form 8966 Foreign Account Tax Compliance Act (FATCA) at this time.

* Users must purchase the associated software product to use the Service Bureau.

We’ve made the process simple:
1. Purchase the appropriate 1099 Pro software package for the type of form you wish to file.
2. Call or E-Mail our Service Bureau to schedule an appointment date. We must have your data by the agreed upon appointment date to ensure that it is posted online, mailed or filed by the IRS deadline.
3. Enter your data into the software via the Import Wizard or manual entry.
4. Use the Service Bureau Wizard to quickly and easily create, approve and transfer your upload file.

Customers are encouraged to schedule their upload appointments now! Rates and availability are not guaranteed until your appointment is booked.

Contact the SSAE 16 SOC I TYPE II Service Bureau
Contact the 1099 Pro Service Bureau team to book your printing, mailing and/or electronic filing appointment and for all Service Bureau related inquiries.
- Phone: (866) 444-3559 (toll-free) or (818) 876-0200
- E-Mail: sb@1099 Pro.com
- Internet: http://www.1099 Pro.com

Instant price estimates are available online at http://www.1099 Pro.com/servPricing.asp
25.1 Service Bureau Packages

1099 Pro Service Bureau Packages

These services are only available to 1099 Pro registered users.

Standard Service Bureau Options
Contact the 1099 Pro SSAE 16 SOC I TYPE II Service Bureau – (866) 444-3559, direct (818) 876-0200, or via email sb@1099pro.com.

- **Print and Mail Only:** The 1099 Pro Service Bureau (SSAE 16 SOC I TYPE II certified) will print and mail recipient copies by the IRS due date (pricing includes first-class US postage).
- **Electronic Filing Only:** The 1099 Pro Service Bureau will file your data electronically with the IRS on your behalf.
- **The Complete Package:** The 1099 Pro Service Bureau will print and mail recipient copies and file your data electronically with the IRS (pricing includes first-class US postage).
- **Service Bureau Support for the IRS Bulk TIN Matching Program:** The SSAE 16 SOC I TYPE II Service Bureau as an authorized agent can submit TIN/Name combinations to the IRS on behalf of our users and results are available to our customers within 24 hours! We encourage our customers to use this service to correct serious errors like invalid TIN numbers that would likely result in a 972CG, CP2100 or CP2100A notice from the IRS and possible penalties of $100.00 per mismatch. Call to schedule a Bulk TIN appointment today – (866) 444-3559.
- **TRA97 Compliance (Educational Institutions) Form 1098-T:** This option is unique to form 1098-T and designed for colleges/universities. The SSAE 16 SOC I TYPE II 1099 Pro Service Bureau prepares and mails the form 1098-T tuition statements and also files the forms electronically with the IRS. Call for a quote (866) 444-3559.

Add-On Services
Additional fees apply for the following services and are subject to the availability of the 1099 Pro Support and Programming team. Contact the Service Bureau for more information toll free (866) 444-3559 or email sb@1099pro.com.

- Custom WMF Files: Our team will design a detailed custom layout for your specific printing needs including logo and/or statement design.
- Custom Programming
- Custom Reports
- File Translation/Data Manipulation
- Data Entry
- Remote Hosting via the Internet
- Full Service Provider
- Corporate Suite Installation and Support
- Filing to the States: Filing via the CFSF program is included free of charge in our Service Bureau Package listed above. If additional state filing is required our Compliance Team can assist you. Available to 1099 Pro software users only.
- Corrections: Upload your corrections to the 1099 Pro Service Bureau via a secure FTP site, to eliminate the tedious 1096 paper filing process. Electronic filing of corrections via the Service Bureau is a $45 flat fee.
25.2 Service Bureau Overview & Upload Process

Service Bureau Upload Sessions

The 1099 Pro Service Bureau is proud to offer a wide variety of services to registered users of 1099 Pro, all performed in our secure SSAE 16 SOC I TYPE II environment.

The Service Bureau Upload Sessions screen provides direct access to optional Service Bureau utilities including Printing & Mailing, Electronic Filing and Bulk TIN Matching. Additionally, users may view uploads, reset/void uploads, complete pending uploads and view reports.

- See Service Bureau Overview
- See Service Bureau Wizard and Bulk TIN Matching

To Access Service Bureau Upload Sessions
On the Filing My Forms task panel click the "Via the Service Bureau" link.
- Upload sessions are Filer specific. If you don't see an upload session, verify the correct filer is selected.
- One upload session may contain multiple logs.
- The "Upload Task Column" indicates the type of upload sent to the Service Bureau including; Bulk TIN, Print+Mail, Filing, etc.
- The “Status” column indicates if the upload has been "Completed", is "Pending" final upload or has been "Voided".

To Reset (Void) Session
Highlight the session to void. If there are multiple logs within the session, highlighting any one log will void the entire session. A void session may not be un-voided.

To Complete Pending Upload
Highlight the session to upload. If there are multiple logs within the session, highlighting any one log will upload the entire session. To complete a pending upload the user must certify their data (even if they've previously done so) via Step 2 – Submit Service Bureau Upload and then submit it at the same screen. After successfully uploading the file, the “Status” column indicates "Completed".

Upload Form Summary
This report generates a log specific detail of an upload file. The last page of this report includes Total Forms and Box-By-Box Totals.

To Run Report
1. Click the "View/Print Log Report" button.
2. User is prompted to select a printer; consider printing to PDF to save paper.
3. Select the Sort Order; by Last Name/First Name or By TIN
4. Other Report Options include:
   - Preview before printing
   - Print Summary totals only
   - Errors andWarnings only
Upload Session Summary
This report lists all Form Types, Counts and Filers included in an upload session and the date generated. Users may also reprint the associated Control Totals Report. If there are multiple logs within the session, then multiple Control Totals Reports are generated.

To Run Report
1. Click the "View/Print Session Summary" button.
2. User is prompted to check "Reprint Control Totals" as necessary. Click "OK" to continue.

25.2.1 Service Bureau Upload Wizard

Service Bureau Upload Wizard
The 1099 Pro Service Bureau has streamlined the process of Service Bureau uploads into two simple steps:

- [ ] Step 1 – Create an Upload File
- [ ] Step 2 – Submit Service Bureau Upload

25.2.2 Step 1 - Creating an Upload File for Print/Mail or E-File

Step 1 - Create an Upload File

Creating an upload file is the first of two steps to submit your files to the 1099 Pro Service Bureau.

Prior to starting this process please consider:
- There are fees to use the Service Bureau (see the Service Bureau Price Estimator) and an appointment is required.
- If using the Service Bureau's Complete Package (Printing, Mailing and eFiling) you will transmit to us a Printing and Mailing upload in January AND an Electronic Filing upload in March (see note). This allows users the opportunity to make any changes to their forms so only the most accurate data is filed with the IRS. **NOTE:** If reporting Form 1099-MISC Box 7 Non-Employee Compensation amounts submit a single upload file in January. See Deadlines.
- A record's print status determines its eligibility to be included in an upload file. See Print Status Overview.
- By default, all Filers are included in the Combined Federal/State Filing Program. Users may un-select this option when creating their upload file.
- All upload processes include the opportunity to run the Generate Accounts Wizard. Some form types require recipients to have unique account numbers; the wizard will not overwrite existing account numbers.
- Users are highly encouraged to run a software Web Update prior to starting an upload.
- See Service Bureau Upload Sessions

Printing and Mailing
Please visit [https://www.1099pro.com/videos.asp](https://www.1099pro.com/videos.asp) and watch the "How to Print and Mail Using the Service Bureau" video for a brief tutorial on printing and mailing using the Service Bureau.
1. To have the Service Bureau print and mail your forms go to the **Printing & Mailing** task panel and click the "Via the Service Bureau" link.
   - **Corporate Suite Users**: Go to the **Service Bureau** task panel and click the "Printing & Mailing" link. Select the type of tax form to process and click "OK".

2. At the Printing, Mailing, Filing and Bulk TiN Matching screen click the "Printing & Mailing or E-Delivery Upload" button. **NOTE**: Only records with a **Pending** print status (or **Corr/Pending** for corrected forms) are available for inclusion in this upload file.

3. At the Create Upload File Wizard screen click the "Begin" button to start the process. You also have the option to:
   - Check for software updates, and/or
   - "Start the Generate Accounts Wizard". Learn more about Account Numbers.

4. **STEP 1: Select Filers** - Specify which filers should be processed.
   - **All of my Filers**: This default selection includes ALL eligible records for ALL Filers in the software. When uploading to the Service Bureau bundle all records into a single file to avoid additional charges.
   - **Select (Tag) Filers**: This allows you to manually tag (or select) each Filer for inclusion in the Service Bureau Upload.
   - **Current**: This uses only the currently selected Filer for uploading Filer information to the Service Bureau.

5. **STEP 2: Form Types** - Select which tax forms will be included:
   - **All Form Types**: This default selection includes all form types for the Filer(s) selected and includes all eligible records. When uploading to the Service Bureau bundle all records into a single file to avoid additional charges.
   - **Select (Tag) Form Types**: This allows you to manually tag (or select) form types for inclusion in the Service Bureau Upload.
   - **Current**: This uses only the currently selected form type and its eligible records for inclusion in the Service Bureau upload.
   - **Additional Options**
     - **Upload/Print Original Forms**: Default selection to upload original issue forms.
     - **Upload/Print Corrections**: Use to select corrected forms (with a **Corr/Pending** status) for upload to the Service Bureau.

6. **STEP 3: Upload Action** - Select what the Service Bureau will do with the forms. **IMPORTANT**: To take advantage of Web Presentment or Electronic Delivery the recipient's email address must be included in your original import file. Both Web Presentment and Electronic Delivery have a $150 setup fee.
   - **Print and Mail the forms**: This default option includes the printing and mailing of your selected forms.
   - **Print and Mail with Web**: This option includes both the printing and mailing of your selected forms AND forms are available on our ViewMyForms.com website for easy recipient download and printing. Recipients must register online to access this service.
   - **Electronic Delivery**: This option includes the electronic delivery (email) of encrypted tax forms to recipients.
   - **Web Presentment Only**: This option includes email notification to your recipients that tax forms are available on our ViewMyForms.com website for easy recipient download and printing. Recipients must register online to access this service.
   - **Additional Options (New)**
     - **I request Immediate Filing with the IRS**: This option is designed for entities that may be
closing, submitting corrections or late uploads that require expediency. Most users will upload a file for print/mail in January and submit a second, revised file in March for filing with the IRS.

- **Use CFS:** This default option includes selected records in the Combined Federal/State Filing Program.

7. **STEP 4: Thresholds** - Filter tax forms based on dollar amounts.
   - Check the "Do not include forms with no dollar amounts" box as desired.

8. **STEP 5: Contact Information** - Who should be contacted if there are questions? Enter the individual the Service Bureau should contact if there are any issues with the information in your upload file. Click "Update Contact" to edit individual.

9. **STEP 6: Printer** - Several reports print at the end of the Service Bureau Upload Wizard from the selected printer.

10. **STEP 7: 1099-MISC Special Processing** - If reporting Box 7 NEC data, both Recipient mailings and IRS filings are due by 1/31/2018. See [Deadlines](#). Processing options include:
   - e-File 1099-MISC forms with Box 7 Non-Employee Compensation Data
   - e-File ALL 1099-MISC forms
   - Skip e-Filing, I will file my 1099-MISC forms by the deadline

11. **Extra Options**
    - **TIN Masking:** Choose an option to mask the recipient's SSN or EIN or leave with default Filer setting. Learn more about [TIN Masking](#).
    - **Extra Print Options:** Choose this for advanced printing options unique to this run only. Includes the option to force an "X" in the Corrected box and/or to include a brief standardized message on the tax form(s).
    - **Error Scan:** Use to check records for the chosen Filer(s) and Form type(s) for errors or warnings prior to their being uploaded to the Service Bureau. Review [Errors & Warnings](#) for information on reviewing and/or adjusting any such records.
    - **Folder:** The default location is C:\1099 Pro\Pro99T17\Uploads. Although not recommended, users may change the location where an upload file will be saved.

12. Click on "Create File" to proceed. Please be patient while the upload session is generated. Upon completion summary reports will print to the default printer.

13. Proceed to [Step 2 - Submit Service Bureau Upload](#).

**Electronic Filing**

Please visit [https://www.1099pro.com/videos.asp](https://www.1099pro.com/videos.asp) and watch the "Filing Electronically with the Service Bureau" video for a brief tutorial on the Service Bureau filing process.

1. To have the Service Bureau electronically file your forms go to the Filing My Forms task panel and click the "Via the Service Bureau" link.
   - **Corporate Suite Users:** Go to the Service Bureau task panel and click the "Filing with the IRS" link. Select the type of tax form to process and click "OK".

2. At the Printing, Mailing, Filing and Bulk TIN Matching screen click the "Filing With the IRS Upload" button. **NOTE:** Any record with a Pending, Printed and SB Print+Mail print status (or Corr/Pending and Corr/Printed for corrected forms) is available for inclusion in this upload file.
Corporate Suite Users: Click the "Create an IRS or AIR Upload" button and select "Filing with the IRS Upload" for all 1099 Informational Returns or "1095-B Filing With the IRS Upload" or "1095-C Filing With the IRS Upload" as appropriate.

3. At the Create Upload File Wizard screen click the "Begin" button to start the process. You also have the option to:
   - Check for software updates, and/or
   - "Start the Generate Accounts Wizard". Learn more about Account Numbers.

4. **STEP 1: Select Filers** - Specify which filers should be processed:
   - **All of my Filers:** This default selection includes ALL eligible records for ALL Filers in the software. When uploading to the Service Bureau bundle all records into a single file to avoid additional charges.
   - **Select (Tag) Filers:** This allows you to manually tag (or select) each Filer for inclusion in the Service Bureau Upload.
   - **Current:** This uses only the currently selected Filer for uploading Filer information to the Service Bureau.

5. **STEP 2: Form Types** - Select which tax forms will be included:
   - **All Form Types:** This default selection includes all form types for the Filer(s) selected and includes all eligible records. When uploading to the Service Bureau bundle all records into a single file to avoid additional charges.
   - **Select (Tag) Form Types:** This allows you to manually tag (or select) form types for inclusion in the Service Bureau Upload.
   - **Current:** This uses only the currently selected form type and its eligible records for inclusion in the Service Bureau upload.
   - **Additional Options**
     - **File Original Forms:** Default selection to upload original issue forms.
     - **File Corrections:** Use to select corrected forms (with a Corr/Pending and Corr/Printed status) for upload to the Service Bureau.

6. **STEP 3: Upload Action** - Select the file type:
   - **Original (first) upload for these forms:** This default option is for both original uploads and corrected uploads.
   - **Replacement:** Select this option only if notified by the IRS. *Replacement forms are different than corrected forms.*
   - **Additional Option**
     - **File the forms using CFS:** This default option includes selected records in the Combined Federal/State Filing Program.

7. **STEP 4: Contact Information** - Who should be contacted if there are questions? Enter the individual the Service Bureau should contact if there are any issues with the information in your upload file. Click "Update Contact" to edit individual.

8. **STEP 5: Printer** - Several reports print at the end of the Service Bureau Upload Wizard from the selected printer.

9. **1099-MISC Special Processing** - Check the box to only process 1099-MISC forms with Box 7 NEC amounts greater than zero. *If reporting Box 7 NEC data IRS filings are due by 1/31/2018.* See Deadlines.

10. **Extra Options**
o **Error Scan:** Use to check records for the chosen Filer(s) and Form type(s) for errors or warnings prior to their being uploaded to the Service Bureau. Review [Errors & Warnings](#) for information on reviewing and/or adjusting any such records.

- **Folder:** The default location is C:\1099 Pro\Pro99T17\Uploads. Although not recommended, users may change the location where an upload file will be saved.

11. Click on “Create File” to proceed. Please be patient while the upload session is generated. Upon completion summary reports will print to the default printer.

12. Proceed to [Step 2 - Submit Service Bureau Upload](#)

### 25.2.3 Step 2 - Submit Service Bureau Upload

**Step 2 - Submit Service Bureau Upload**

After successfully completing [Step 1 – Create an Upload File](#), users must certify their data by carefully reviewing associated reports and then submit it to the Service Bureau. The [Summary Report](#) details the Form Types, Form Counts and Filers included in the upload and contains important information including the name and location of your upload file. There is a unique [Control Totals Report](#) for every Filer and Form Type with box-by-box dollar totals and form counts.

See [Service Bureau Upload Sessions](#)

**Certify Your Data**

The Certify Your Data screen displays automatically after creating an upload file. To continue the upload process, users must certify their data by carefully reviewing the Summary and Control Totals reports.

- If in agreement with the reports please proceed to the below steps.
- If not in agreement with the reports, click the “Cancel” button and use the “Reset/Void Upload” button at the Service Bureau Upload Sessions screen. All of the forms associated with the session will reset to their original, pre-upload status. Correct any problems discovered while reviewing the Control Totals Reports, then start anew at [Step 1 - Create an Upload File](#).
- To continue this process at a later time, click the “Cancel” button and use the “Complete Pending Upload” button at the Service Bureau Upload Session screen to return when convenient.

1. **Step 1: Review Totals** – Click the View Control Totals Report button OR Save Control Totals Report button. View the reports (one per Filer and Form type) and verify that all Filer(s), Form(s) and dollar amounts are correct. See [Control Totals Report](#).

2. **Step 2: Confirm Totals** – Confirm the Total Number of Forms. Enter the total number of forms in the “Acknowledge the total by re-entering it here” field.

3. **Step 3: Transfer Method** - Choose between:
  - Built-in HTTPS secure transfer - This default/preferred method works well for most of our users; however, those with firewalls or very large files may experience issues. *An internet connection is required for this method.
  - Built-in FTP using the Internet - This is an alternate method of uploading to the Service Bureau. The Wizard will automatically upload the file using standard File Transfer Protocol. *An internet connection is required for this method.
  - Manual Transfer - This option requires you to manually upload your file to our FTP site, e-mail it or send it to our Service Bureau via postal service. See Manual Transfer Options below.
4. **Step 4: Select Printer** - Control Totals Report prints to selected printer.

5. **Step 5: Digital Signature** - The individual responsible for this upload must type their name to certify they have examined the information returns and control totals in this transmission and to the best of their knowledge and belief, are true, correct and complete.

6. Click “Upload My File” to immediately transmit your file to the 1099 Pro Service Bureau. The software indicates if upload was successful and if so you will receive an e-mail confirmation from the Service Bureau, usually the same business day.
   - If upload was not successful, repeat the above procedure using the Built-in FTP or Manual Transfer option as appropriate.
   - There is no need to fax any documentation or call the Service Bureau; your file and approval is submitted electronically.
   - Expect your Bulk TIN Results within 1-2 business days. If you haven't received your emailed results by then please contact the Service Bureau. It is possible your results were blocked by your internal firewall or went to your SPAM folder.

**Manual Transfer Options**

Transmitting your upload file to the Service Bureau via built-in HTTPS or FTP is preferred. Those with firewalls, very large files or no internet connection may need to use the manual transfer option.

**Method A:** Transmit your file to our secure SSAE 16 SOC I Type II Service Bureau via FTP:

1. In your web browser go to [https://uploads.1099pro.com/](https://uploads.1099pro.com/).
   - **Login ID:** 1099upload
   - **Password:** 2004

2. After Login, click the “Upload” link and browse for your upload file. Service Bureau Uploads are automatically pulled into our system from the FTP site. You will receive e-mail notification from the Service Bureau within 30 minutes of successfully posting your upload file.
   - There is no need to notify the Service Bureau that a file was posted.
   - Your digitally signed Control Totals Report is automatically bundled into your upload .ZIP file. There is no need to fax documentation to the Service Bureau.

**Method B:** Transmit your upload file via e-mail.

1. E-mail your upload file to uploads@1099pro.com. Do NOT change the name of the attached upload file—it contains identifying information. After emailing the file you will receive an automatic confirmation of receipt of your e-mail within 30 minutes.
   - There is no need to notify the Service Bureau that a file was e-mailed.
   - Your digitally signed Control Totals Report is automatically bundled into your upload .ZIP file. There is no need to fax documentation to the Service Bureau.

**Method C:** Transmit your file via postal service on a CD or flash drive. This method is not recommended as files may easily get damaged, delayed or lost in the mail. Please contact the Service Bureau at (866) 444-3559 for more information on proceeding with this method.

### 25.2.4 Reset/Void Service Bureau Upload

**Reset (Void) Service Bureau Upload**

Resetting an upload session voids (deletes) the entire upload session. All forms automatically revert to
their pre-upload status.

**To Reset Session**
1. On the Service Bureau task panel select "Printing & Mailing".
2. At the Completed Service Bureau Upload Session List screen highlight an upload session and click the "Reset (Void) Session" button.
3. The Administrator prompts to confirm the void. Click "Yes" to continue or "No" to abort. Session status immediately updates to Voided.

### 25.3 Using Bulk TIN Matching

#### Bulk TIN Matching

Avoid $100+ record mismatch penalties! Utilize 1099 Pro's Bulk TIN Matching Service!

- See the [Bulk TIN Matching Wizard](#)
- See [Bulk TIN Matching Results](#)

#### Offer Details
- $135 for a single upload of up to 100,000 records
- E-mail the Service Bureau at sb@1099pro.com if the file is greater than 100,000 records
- Approximately 24 hour turn-around time
- Access to a FREE trial of our individual TIN Matching service (details below)

Bulk TIN checks are an essential compliance and risk mitigation service that identify TIN/Name mismatches prior to filing with the IRS. Penalties can be assessed at up to $260/record at the IRS’s discretion.

#### Additional Services - TINCheck.com

Another great option to validate your TIN/Name combinations via individual checks or bulk! TINCheck.com is a straightforward, user-friendly resource; simply log in and instantly gain access to multiple verification sources in one place.

**Extra Options:**
- Complete list validation: OFAC, DMF, EPLS, LEIE, TIN/Name
- Integrate an API/web service into an existing AP system for seamless verification of new vendors.
- Prepaid plans or monthly subscription pricing plans based on volume.
- Bulk TIN Checks with complete list validations available.
- FREE trial account - Sign up online at [TINCheck.com](#) for 10 free TIN checks!

### 25.3.1 Bulk TIN Matching Upload
The 1099 Pro Service Bureau has simplified the process of validating Name/TIN combinations in bulk to help filers minimize penalties. Please review **Bulk TIN Matching** for pricing and other important information.

- **Step 1 – Create Bulk TIN Upload File**

- **Step 2 – Approve Control Totals**

### 25.3.2 Step 1 - Creating an Upload File for Bulk TIN Matching

#### Bulk TIN Matching Wizard

1099 Pro's Bulk TIN Matching is an essential compliance and risk mitigation service that identifies recipient Name and TIN mismatches prior to filing with the IRS. The Bulk TIN Matching Wizard allows users to run up to 100,000 Name/TIN combinations in a single upload file for only $135. Results are typically available the following business day.

#### Step 1 - Create an Upload File

To submit a Bulk TIN Upload first schedule a Service Bureau appointment *unless* you have already used the Service Bureau for the current tax season. Current Service Bureau customers are welcome to upload at any time.

**To Create Upload File**

1. On the **Printing and Mailing** task panel select the "Via the Service Bureau" link to access the Printing, Mailing, Filing and Bulk TIN Matching screen.
   - **Corporate Suite Users:** On the Service Bureau task panel select the "Bulk TIN Matching via SB" link.

2. Click the "Bulk TIN Matching Upload" button to access the Bulk TIN Matching Upload Wizard. Click "Next" to proceed. Use the "Back" button at any time to go back a step.

3. Review informational screens and click "Next" to continue.

4. Run Software Update as prompted. It is highly recommend to check for updates to this program before starting any printing or filing process. This ensures the most recent version of the software is running. See Web Updates for more information

5. Choose a method for selecting eligible records.
   - **Selected Form Types for ALL Filers:** This default option prompts to select (tag) the form types to include in this upload file. All filers will be processed.
   - **Selected Form Types for Selected Filers:** This option prompts to select (tag) the filer and the form types to include in this upload file.

6. Set options for your upload.
   - **Force TIN Type as Unknown for all records:** Selecting this check box removes the SSN or EIN identifying hyphens. You will not be able to import your results back into the software if this
box is checked.

- **Select the destination folder**: The default location is C:\1099 Pro\Pro99T17\Uploads.

7. Enter your Contact Information and User Password:
   - This information is critical to how we will contact you with issues and where we will email the encrypted results.
   - The password is used to encrypt your Bulk TIN matching results; **retain the password to access your results**. Your password must be 8 to 30 characters in length.

8. Select the Printer for your Bulk TIN Matching summary and instructions and change as necessary.

9. At the Ready to Generate Bulk TIN Upload File screen review settings and click "Finish" when satisfied. The system will process your file and the Administrator indicates when file is "Done".

10. Continue to **Step 2 - Submit Service Bureau Upload**.

### 25.3.3 Step 2 - Submit Service Bureau Upload

**Step 2 - Submit Service Bureau Upload**

After successfully completing **Step 1 – Create an Upload File**, users must certify their data by carefully reviewing associated reports and then submit it to the Service Bureau. The **Summary Report** details the Form Types, Form Counts and Filers included in the upload and contains important information including the name and location of your upload file. There is a unique **Control Totals Report** for every Filer and Form Type with box-by-box dollar totals and form counts.

See Service Bureau Upload Sessions

**Certify Your Data**

The Certify Your Data screen displays automatically after creating an upload file. To continue the upload process, users must certify their data by carefully reviewing the Summary and Control Totals reports.

- **If** in agreement with the reports please proceed to the below steps.
- **If not** in agreement with the reports, click the "Cancel" button and use the “Reset/Void Upload” button at the Service Bureau Upload Sessions screen. All of the forms associated with the session will reset to their original, pre-upload status. Correct any problems discovered while reviewing the Control Totals Reports, then start anew at **Step 1 - Create an Upload File**.

To continue this process at a later time, click the “Cancel” button and use the “Complete Pending Upload” button at the Service Bureau Upload Session screen to return when convenient.

1. **Step 1: Review Totals** – Click the View Control Totals Report button OR Save Control Totals Report button. View the reports (one per Filer and Form type) and verify that all Filer(s), Form(s) and dollar amounts are correct. See **Control Totals Report**.

2. **Step 2: Confirm Totals** – Confirm the Total Number of Forms. Enter the total number of forms in the “Acknowledge the total by re-entering it here” field.

3. **Step 3: Transfer Method** - Choose between:
   - Built-in HTTPS secure transfer - This default/preferred method works well for most of our users; however, those with firewalls or very large files may experience issues. *An internet connection
is required for this method.

- Built-in FTP using the Internet - This is an alternate method of uploading to the Service Bureau. The Wizard will automatically upload the file using standard File Transfer Protocol. *An internet connection is required for this method.

- Manual Transfer - This option requires you to manually upload your file to our FTP site, e-mail it or send it to our Service Bureau via postal service. See Manual Transfer Options below.

4. **Step 4: Select Printer** - Control Totals Report prints to selected printer.

5. **Step 5: Digital Signature** - The individual responsible for this upload must type their name to certify they have examined the information returns and control totals in this transmission and to the best of their knowledge and belief, are true, correct and complete.

6. Click “**Upload My File**” to immediately transmit your file to the 1099 Pro Service Bureau. The software indicates if upload was successful and if so you will receive an e-mail confirmation from the Service Bureau, usually the same business day.

   - If upload was not successful, repeat the above procedure using the Built-in FTP or Manual Transfer option as appropriate.
   - There is no need to fax any documentation or call the Service Bureau; your file and approval is submitted electronically.
   - Expect your Bulk TIN Results within 1-2 business days. If you haven’t received your emailed results by then please contact the Service Bureau. It is possible your results were blocked by your internal firewall or went to your SPAM folder.

**Manual Transfer Options**

Transmitting your upload file to the Service Bureau via built-in HTTPS or FTP is preferred. Those with firewalls, very large files or no internet connection may need to use the manual transfer option.

**Method A:** Transmit your file to our secure SSAE 16 SOC I Type II Service Bureau via FTP:

1. In your web browser go to [https://uploads.1099pro.com/](https://uploads.1099pro.com/).
   - **Login ID:** 1099upload
   - **Password:** 2004

2. After Login, click the “Upload” link and browse for your upload file. Service Bureau Uploads are automatically pulled into our system from the FTP site. You will receive e-mail notification from the Service Bureau within 30 minutes of successfully posting your upload file.

   - There is no need to notify the Service Bureau that a file was posted.
   - Your digitally signed Control Totals Report is automatically bundled into your upload .ZIP file. There is no need to fax documentation to the Service Bureau.

**Method B:** Transmit your upload file via e-mail.

1. E-mail your upload file to uploads@1099pro.com. Do NOT change the name of the attached upload file—it contains identifying information. After emailing the file you will receive an automatic confirmation of receipt of your e-mail within 30 minutes.

   - There is no need to notify the Service Bureau that a file was e-mailed.
   - Your digitally signed Control Totals Report is automatically bundled into your upload .ZIP file. There is no need to fax documentation to the Service Bureau.

**Method C:** Transmit your file via postal service on a CD or flash drive. This method is not recommended as files may easily get damaged, delayed or lost in the mail. Please contact the Service Bureau at (866) 444-3559 for more information on proceeding with this method.
25.3.4 Bulk TIN Matching Results

Bulk TIN Results

Users receiving Bulk TIN results (after submitting a Service Bureau Bulk TIN Upload or via the IRS Bulk TIN Matching Program) are provided coded responses for all invalid Name/TIN combinations.

Bulk TIN Results

Bulk TIN results contain the following coded information from the IRS:

<table>
<thead>
<tr>
<th>Code</th>
<th>Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Name/TIN combination matches IRS records.</td>
</tr>
<tr>
<td>1</td>
<td>Missing TIN or TIN not 9 digit number.</td>
</tr>
<tr>
<td>2</td>
<td>TIN not currently issued.</td>
</tr>
<tr>
<td>3</td>
<td>Name/TIN combination does NOT match IRS records</td>
</tr>
<tr>
<td>4*</td>
<td>Invalid request (i.e., contains alphas, special characters)</td>
</tr>
<tr>
<td>5</td>
<td>Duplicate request.</td>
</tr>
<tr>
<td>6</td>
<td>(matched on SSN), when the TIN type is (3), unknown, and a Matching TIN and name control is found only on the NAP DM1 database.</td>
</tr>
<tr>
<td>7</td>
<td>(matched on EIN), when the TIN type is (3), unknown, and a matching TIN and name control is found only on the EIN/NC database.</td>
</tr>
<tr>
<td>8</td>
<td>(matched on EIN and SSN), when the TIN type is (3), unknown, and matching TIN and name control is found only on both the EIN/NC and NAP DM1 databases.</td>
</tr>
</tbody>
</table>

Sample Bulk TIN Results

The following sample lines indicate the TIN provided by Matthew Mulberry is 2 - Not Currently Issued and the Name/TIN provided by Acme Incorporated is 0 - Matches IRS records.

1;183421111;Matthew Mulberry;89765;2
2;562611111;Acme Incorporated;89765;0

Invalid TIN Matching Requests

Any record submitted without the required fields (TIN Type, TIN, Name) automatically receives Indicator 4 - Invalid Request. For example, the following line from a Bulk TIN Matching file is missing the Name field:

2;562611111;;8976

The above line would generate a "4" in the results data file, indicating an Invalid Request, as follows:

2;562611111;;89765;4

* Any record submitted without the required fields (TIN Type, TIN, Name) automatically receives Indicator 4 - Invalid Request. If TIN Type is unknown, you may check the "Force TIN Type As Unknown" box during the Wizard and the IRS will check the TIN against both the SSN and EIN master files. However, you will be unable to import returned results for matching purposes if this option is chosen.

For More Information:

Direct questions regarding specific tax regulations or regulatory services to IRSCompliance.org at:
26 Tax Supplies

Tax Supplies

1099 Pro, Inc. sells all of the tax forms and supplies necessary for use with 1099 Pro* software at competitive rates.

- All forms and supplies offered by 1099 Pro, Inc. are IRS approved.
- All orders over $100 automatically receive a 10% discount.
- Order in advance; overnight shipping of forms can cost more than the actual forms!
- Returns are NOT accepted after November 30, 2017. Customer is responsible for all return shipping charges.

*All tax forms and supplies are subject to availability. Prices subject to change without notice.

Online Ordering
Customers may place orders online for laser forms and envelopes (current tax year only). In addition to placing orders, customers may view tax forms and a brief item description. Try it at www.1099pro.com; click on the "Products" button and the "Tax Forms" hyperlink.

Online Customer Account Access
Customers who’ve purchased items in the past year may go online to view prior orders and activation codes. Order tracking is also available to see if your order has shipped. Try it at www.1099pro.com; click on the "Login" button and follow the prompts.

Telephone Orders
Customers may place orders for all tax supplies (including laser for current and past tax years) by telephone with our Sales team at (888) 776-1099.

26.1 Blank Copier Paper

Blank Copier Paper

Blank Copier Paper: Print Copy B &/or C directly onto blank copier paper. Good in case of an emergency when Blank Laser paper is unavailable (might require special folding and/or cutting to fit in standard IRS approved envelopes). 1099 Pro, Inc. offers custom designed IRS regulation envelopes to fit copier paper.

Blank Laser Perf: Print Copy B &/or C directly onto blank laser perforated stock (1099 Pro prints the necessary graphics). Easier to fold than blank copy paper because of the perforations and since it is blank…it won’t go out of date! Also prints instructions. When using blank stock you must select the copies to print. The Print Wizard features a Combined option that prints all required copies for the recipient on one sheet (e.g., 1099-MISC Combined includes copies B, 2 and instructions). You may instead select the individual copies for the recipient, but you will need to manually collate the copies.

*Please visit https://www.1099pro.com/videos.asp and select the “Quick Tips: Print to Blank Paper”
video for a brief guide on printing on blank perforated paper.

When printing instructions to blank paper you may:
- Print them as part of the normal print run with one copy per recipient. Remember to collate instructions with the recipient copies, OR
- Print them on one sheet now and photocopy it as many times as needed. Then use the reverse side of the photocopied sheets to print your forms. If selecting this option do NOT print any copies at this time, first prepare the instructions and then print the copies, OR
- Print "X" pages at this time.

The IRS requires you to send both tax forms and instructions to recipients.

26.2 Preprinted Paper

Preprinted Paper

Preprinted Laser Perf: When using preprinted laser forms the user selects the copies to print; for example, Copies A, B, C and/or the 1096/W-3 Transmittal. Preprinted forms are perforated, with each required copy preprinted with the necessary information in an IRS/SSA approved ink (Copy A in red drop-out ink, Copy B in black, etc.). The Print Wizard pauses before printing each copy to prompt the user to load the appropriate form into the printer.

☐ Preprinted forms save toner and time - order your tax forms today at (888) 776-1099.

26.3 Pressure Seal Forms

Pressure Seal Forms

☐ See Pressure Seal and ACL Tutorial
☐ See Pressure Seal and Alternate Print Formats

Support
To meet the needs of customers who are printing high volumes of forms, 1099 Pro, Inc. offers the ability to print to pressure seal forms in all of our products. Numerous pressure seal forms are available for purchase from 1099 Pro Sales for use with our software products. If there is a pressure seal form you would like to use that is not listed as a printing option in our software, contact our Service Bureau and we may be able to customize the software to accommodate the form (fees may apply).

Troubleshooting
Customers may experience issues when attempting to print on the large 8.5" x 14" pressure seal forms. If the printer software is not configured correctly during the print process after selecting pressure seal forms (any 8.5 x 14" form either preprinted or blank) you will find that it appears that the printer is compressing the graphics and text. The reason: The default setting for most printers is 8.5" x 11" letter paper. In order for the text and graphics to appear properly on the 8.5 x 14" paper you should select legal for the paper format. If you are unsure about how to select legal paper during the print process you will
want to contact your printer manufacturer.

27 Transmitter/Submitter Information

Transmitter/Submitter Information

Transmitter and Submitter requirements are specific to the type of form electronically filed.

Please see Create Transmitter/Submitter

1099 Informational Returns / Forms 1042-S

A Transmitter Control Code number or (TCC) is required when filing electronically. A TCC is composed of five alpha-numeric characters. If filing electronically via the Service Bureau, a TCC is not required and this information need not be completed.

Request a TCC for IRS FIRE System

To obtain a TCC file Form 4419 to request authorization to file forms electronically. Form 4419 must be mailed at least 30 days prior to the filing deadline for the electronic file. Print Form 4419 via the Help & Extras task panel > IRS Pubs & Links. For more information on TCC's, contact the IRS-MCC at (304) 263-8700. A single TCC may be used to file on behalf of multiple filers.

Forms 1095-B & 1095-C

The TCC for AIR is unique to filing ACA returns. The TCC issued for filing 1099 Informational Returns is suitable for the IRS FIRE System, not the AIR Site. See TCC for AIR for important information on registering to use IRS e-Services, applying for a Transmitter Control Code (TCC) and submitting Test Files.

Forms W-2 / W-2c

Submitter information is required when filing W-2s electronically and consists of a unique Submitter EIN and PIN. If filing electronically via the Service Bureau, this information is not required and this screen need not be completed.

- The term Submitter is sometimes used interchangeably with the term Transmitter.
- A registered Submitter may file on behalf of multiple employers/payers/filers.

Request Submitter Information

To obtain a Submitter EIN and PIN register with the SSA Business Services Online (BSO). Every BSO user must register personally; users may not register on behalf of another person. To register, go to www.socialsecurity.gov/bso/bsowelcome.htm and click on the Register button.

Form 8966

Transmitter information is provided to the IRS for contact purposes. This basic information must be filled out prior to creating the XML file that is packaged and sent to the IRS.

8966 Pro requires transmitters to have either a GIIN or FIN to generate XML files; this information is
FIN Numbers
Certain entities including U.S. withholding agents (USWA), territory financial institutions (TFI), third party preparers, or commercial software vendors are not required to have GIINs. These non-GIIN filers are required to obtain a FIN (FATCA Identification Number) in place of a GIIN to access IDES. The FIN is the 19-character identifier entered in the metadata and FATCA XML message header.

27.1 Create Transmitter/Submitter

Create Transmitter/Submitter

Transmitter and Submitter information is required when generating electronic files and is specific to the form type. Please see Transmitter/Submitter Information. Transmitter/Submitter information is not needed if filing via the Service Bureau.

1099 Informational Returns / Forms 1042-S

To Create a Transmitter
1. On the menu bar select File > Transmitter Information.
2. At the Update eFile Transmitter Information screen:
   - Enter the IRS assigned TCC. A TCC is composed of five alpha-numeric characters. The first two numbers are always 22. Alpha characters must be upper case.
   - Enter the IRS assigned TIN (dashes MUST be inserted!).
   - Enter the name of the company (or individual) owning the TCC.
   - Enter a contact name and phone number.
   - Enter the TCC owner's address.
3. Click "Save" or "Cancel" to exit the screen.

The transmitter information is incorporated into the electronic file. The TCC displays on the "Computer Generated Substitute Form 4804/Form 4802" report which prints automatically after creating an Electronic File. If after creating electronic files it is discovered that the TCC was incorrectly entered, the Electronic File session must be voided. Changes made at the Update Electronic File Transmitter Information screen will NOT flow through to already created electronic files.

Forms W-2 / W-2c

To Create a Submitter
1. On the menu bar select File > Submitter Information
2. At the Update Electronic Filing Submitter screen:
   - Enter the Submitter EIN
   - Enter the SSA assigned PIN (per the SSA, the PIN may not exceed 8 characters)
   - Enter Submitter Name and Address
   - Enter Company Name and Address
   - Enter Contact Information
   - Enter Preferred Method of Problem Notification
   - Enter Preparer Code
3. Click "Save" or "Cancel" to exit the screen.
The Submitter information is incorporated into the electronic file. If after creating electronic files you discover that your Submitter information was entered incorrectly, the Electronic File session must be voided. Changes made at the Update Electronic Filing Submitter screen will NOT flow through to already created electronic files.

**Forms 8966**

**To Create a Transmitter**
1. On the menu bar select File > Transmitter Information.
2. At the Update Electronic Filing Transmitter Information screen enter the Company specific information:
   - Company Name
   - Address Formatting:
     - USA
     - CANADA
     - OTHER
   - Company Address
   - City, Locale, Postal, Country
   - Contact Name
   - Phone Number
   - Company Email
3. Enter the FIN if a third party preparer.
   - Certain entities including U.S. withholding agents (USWA), territory financial institutions (TFI), third party preparers, or commercial software vendors are not required to have GIINs. These non-GIIN filers are required to obtain a FIN (FATCA Identification Number) in place of a GIIN to access IDES.
   - The FIN is the 19-character identifier entered in the metadata and FATCA XML message header.
4. Click "OK" to save changes or "Cancel" to abort.

### 28 Year-to-Date Imports and Zero Drops

#### 28.1 Year-to-Date Import Zero Drop Overview

**Year-to-Date Import Zero Drop Overview**

The features contained within this section are available exclusively to users of the Corporate Suite edition.

Year-to-Date Import Zero Drops are only available for imports performed within the current YTD.

This utility allows users to update and remove any records which were not included in the most current import. A Year-to-Date import differs from a non-transactional or transactional import in the following manner:

When a transactional or non-transactional import is completed, all records are stored separately in the database. After a Year-to-Date Import Zero Drop process is completed, all records not included in the most recent import are removed and all included records are updated with the most recent dollar amounts. This process insures that your records contain the most current recipient records and dollar amounts.
28.2 Year-to-Date Import and Zero Drop Process

Year-to-Date Import and Zero Drop Process

The features contained within this section are available exclusively to users of the Corporate Suite edition.

To Run Process:
1. At the menu bar select Utilities > Manage Year-to-Date Import Zero Drops.

2. At the Beginning and Processing Zero Drops screen there are two options:
   - OPTION 1 - Begin a Drop by Import Session Process: Use to apply the Zero Drop process to records based on an Import Session ID.
     - Click the "Begin a Drop by Import Session Process" button to access the Select Import Session screen. Select (or highlight) an Import Session ID and click on the "Select" button.
     - Select the filers to apply the zero drop process to via the "Tag" button; multiple filers can be selected or tagged. Click the "Proceed to the next step" button.
     - The program prompts to confirm the "Zero Drop" process. Click the "OK" button to continue or the "Cancel" button to abort the "Zero Drop".
   - OPTION 2 - Begin a Drop by Date Range Process: Use to apply the Zero Drop process based on a specified date range.
     - Click the "Begin a Drop by Date Range Process" button to start.
     - At the Form Selection screen choose the form type to apply the Zero Drop process to by highlighting it and pressing the "Select" button.
     - Select the Filers to apply the Zero Drop process to via the "Tag" button; multiple filers can be selected or tagged. Use the "Save" button to save these selected Filers for later usage. These saved Filers can be loaded during future processes by clicking the "Load" button.
     - With Filers selected, click on the "Select Date Range to use" button.
     - Select your date range by either entering a date into the "Set Range From" and "Through" fields—use the calendar icon button to the right of the date range boxes to display a pop-up calendar for easy date selection—or choose from any of the predefined options in the "Default Ranges" box. Click in any radio box to the left of the date range and entered dates auto-fill the "Set Range From" and "Through" fields.
     - Click the "OK" button to save date ranges and continue.
     - Use the "Proceed to the next step" button load the Zero Drop.
     - The program prompts to confirm the "Zero Drop" process. Click the "OK" button to continue or the "Cancel" button to abort the "Zero Drop".

3. The Zero Drop Process is complete.

28.3 Drop by Date Range

Drop by Date Range

The features contained within this section are available exclusively to users of the Corporate Suite edition.

Topic Pending 5/2017
28.4 Void a Zero Drop Session

Void a Zero Drop Session

The features contained within this section are available exclusively to users of the Corporate Suite edition.

Zero drop sessions can only be voided if the status of the forms associated with the session have not changed.

To Void a Zero Drop Session
1. At the menu bar select Utilities > Manage Year-to-Date Import Zero Drops.
2. At the Completed and In-Process Zero Drop Sessions screen highlight the session to void.
3. Click the "Rest (Void) Session" button to remove any changes made by the Zero Drop process.

28.5 Drop by Import Session

Drop by Import Session

The features contained within this section are available exclusively to users of the Corporate Suite edition.

Zero Drop Process Drop by Import Session

To Run Process
1. At the menu bar select Utilities > Manage Year-to-Date Import Zero Drops.
2. At the Beginning and Processing Zero Drops screen click the "Begin a Drop by Import Session Process" button to access the Select Import Session screen.
3. Select (or highlight) an Import Session ID and click the "Select" button.
4. Select the filers to apply the zero drop process to via the "Tag" button; multiple filers can be selected or tagged. Click the "Proceed to the next step" button.
5. The program prompts to confirm the "Zero Drop" process. Click the "OK" button to continue or the "Cancel" button to abort the process.
3. The Zero Drop Process is complete.

28.5.1 Select Import Session

Zero Drop: Selecting an Import session

The features contained within this section are available exclusively to users of the Corporate Suite edition.

This screen displays a list of all Year-to-date Import sessions for the current tax year. Select the session to use for the process.

Please see Year-to-Date Import Zero Drop Overview for more information on this process.
28.6 **Zero Drop Process Confirmation**

**Confirming Zero Drop Process Selections**

The features contained within this section are available exclusively to users of the Corporate Suite edition.

After making selections for the Date Range or Import Session Zero Drop Process, users receive a confirmation screen that displays an overview of their Zero Drop selections. The information displayed at this screen varies depending on the type of Zero Drop Process running (i.e., by Date Range or by Import Session). The image below is an example of the Zero Drop Process by Date Range confirmation screen.

If all settings are accurate click the "OK" button to start the Zero Drop Process or click the "Cancel" button to abort and start again.

---

### 29 Information Requests / W-9s

#### 29.1 Information Request Overview

**Information Request Overview**

1099 Pro* offers a simple method to create and track Information Requests for the following forms:

- W-9 Request for Taxpayer Identification Number and Certification
- W-9S Request for Student’s or Borrower’s Taxpayer Identification Number and Certification
- W-8 Series (Corporate Suite Edition only)
- First and Second "B" Notices for Backup Withholding

* 1042-S Pro, W-2 Pro, 8966 Pro and CRS PRO software do not include Information Request functionality.
Purpose of Form W-9
An individual or entity who is required to file an information return with the IRS, must obtain the recipient's correct taxpayer identification number (TIN) to report, for example, income paid, real estate transactions, paid mortgage interest, acquisition or abandonment of secured property, cancellation of debt, or contributions made to an IRA. A TIN may be the recipient's social security number (SSN), individual taxpayer identification number (ITIN), or employer identification number (EIN). Use Form W-9 Request for Taxpayer Identification Number and Certification to request a recipient's TIN if the recipient is a U.S. person or U.S. resident alien. If the recipient is a foreign person use the appropriate Form W-8.

For more information see Instructions for the Requester of Form W-9 on the IRS website.

Purpose of Form W-9S
An eligible educational institution, such as a college or university, or a lender of a student loan must get the recipient's correct identifying number to file certain information returns with the IRS and to furnish a statement. For students, this is their social security number (SSN) or, for those unable to obtain an SSN, their individual taxpayer identification number (ITIN). Use Form W-9S Request for Student's or Borrower's Taxpayer Identification Number and Certification to request a student's correct SSN or ITIN.

Purpose of Form W-8 Series
Form W-8 series are generally issued to assist withholding agents and foreign financial institutions in validating the forms for chapter 3 and 4 purposes in addition to outlining the due diligence requirements applicable to withholding agents for establishing a beneficial owner's foreign status and claim for reduced withholding under an income tax treaty.

For more information see Instructions for the Requester of Forms the Requester of W–8BEN, W–8BEN–E, W–8ECI, W–8EXP, and W–8IMY on the IRS website.

Purpose of B Notices
A “B” Notice is a backup withholding notice. There are First and Second “B” Notices, each with different content. Filers must send the First “B” Notice and a Form W-9 to a recipient after receiving from the IRS a first CP2100/CP2100A Notice due to an incorrect Name/TIN combination. Filers send the second “B” Notice to a recipient after receiving from the IRS a second CP2100/CP2100A Notice within a 3 calendar year period.

For more information see the IRS's Pub. 1281 Backup Withholding For Missing And Incorrect Name/ TIN(s).

29.2 Manage Information Requests

Manage Information Requests

From the Manage Information Requests screen users can track, update, print and view/reprint all previously issued Information Requests including Forms W-9 and 1st / 2nd B Notices. This screen is accessed via the Help & Extras task panel via the "W-9/B Notices" link. Corporate Suite Users: See Manage Information Requests (CS).
Use the **Information Request Wizard** to issue new requests including Forms W-9, W-9S and B Notices.

**Sort By Options**
- **Current View/Sort** - Sort Information Requests by Recipient's Last Name or TIN (SSN or EIN).
- **Search for Name/TIN** - This feature is used in conjunction with the Current View/Sort drop menu.
- **BWH Date Filter** - Sort requests by their backup withholding date.
- **Additional Filters** - Place check marks in the below boxes and the software filters the list based on the selected criteria.
  - **Request Types To Show:**
    - **W-9** - Show all W-9 requests only.
    - **W-9S** - Show all W-9S Requests only.
    - **1st B-Notice** - Show only a list of first B-Notice requests.
    - **2nd B-Notice** - Show only a list of second B-Notice requests.
    - **Show All** - Click this button to automatically place a check mark in all boxes.
  - **Request Status Types To Show:**
    - **Open/Pending** - Show all currently open/pending requests.
    - **Close/Resolved** - Show all closed or resolved requests when corrected information has been received back from the recipient.
    - **Voided** - Show all VOIDED requests.
    - **Escalated** - Show only escalated requests.
    - **Show All** - Click this button to automatically place a check mark in all boxes.

**View/Print Report**
The Information Request Summary Report includes the selected recipients' TIN/Name/Address When Issued, Current TIN/Name/Address and the Requester/Form Type/Status. The report details the date the information request was originally Created, Closed, any associated B Notices and the Withholding percentage, if applicable.

Run **Information Request Summary Report**

**Issue New Requests**
Use to access the Print Information Requests Screen and the **Information Request Wizard**. View previously issued Information Requests in batch and reprint as necessary.

**View/Reprint Selected**
Reprint individual requests by highlighting the record and selecting the "View/Reprint Selected" button.

**Update Selected Request**
Users can update any record's Request Type (e.g., W-9, 1st B Notice, etc.) with an Open/Pending status. Requests with a Closed or Escalated status cannot be updated.

To Update Status of an Information Request
1. At the Manage Information Requests screen highlight the appropriate record and select the "Update Selected Request" button.
2. At the Changing a Recipient's Record screen users can edit:
o Current Information - Update Recipient's SSN/EIN, First and/or Last Name.

- Status of the Information Request - Options include:
  - Leave the Request as Open/Pending
  - Close the Request - Updated information was received.
  - Void the Request - It should not have been issued. Once a request is voided it is deemed closed and is no longer available for updates.
  - Close and Escalate to 1st B Notice/2nd B Notice (never responded) - If this option is chosen, upon clicking the "Save" button the existing request is closed and the user is taken directly to the Information Request Wizard to create a 1st B Notice or 2nd B Notice request. **Closed, Escalated and Voided Requests are not available for updates.**

3. Click "Save" to apply changes to all pending records for this recipient or "Cancel" to exit this screen.

### 29.3 Information Request Summary Report

#### Information Request Summary Report

The Information Request Summary Report includes the selected recipients' TIN/Name/Address When Issued, Current TIN/Name/Address and the Requester/Form Type/Status. The report details the date the information request was originally Created, Closed, any associated B Notices and the Withholding percentage, if applicable. Corporate Suite Users can generate this report to an Excel output file.

#### To Run Information Request Summary Report

1. On the Help & Extras task panel select "W-9/B Notices".
   - Corporate Suite Users: At the TIN Management task panel select the "Browse All Requests" link.

2. At the Manage Information Requests screen select the "View/Print Report" button.

3. At the Information Request Report Options screen select the printer, sort order and to preview report. Additional options include:
   - Forms To Include In This Report - Check both the request types and status to include in this report.
   - Date Issued/Date Closed Range - If left blank includes all requests that match the type and status previously selected.
   - Filers To Include - Check to include all Filers in the software in the report. If unchecked, only the currently selected Filer is included in report.
   - BWH Report/Date - Filter records by a specific backup withholding date.
   - Corporate Suite Users:
     - Batch ID(s) Filter - Sort records by Batch ID, separated by commas. Batch IDs are generated automatically in numerical sequence of date created. Information Request Batch IDs are listed at the Create/Print Information Request screen (accessed via the TIN Management task panel and selecting the "Browse Batches" link).
     - Include Excel Output File - Check to generate report in .XLS format and save to indicated destination folder.

4. Click "OK" to initiate report or "Cancel" to exit this screen.
   - Specified parameters are listed at the bottom of each page of this report.
   - The last page of this report indicates total forms listed.
29.4 Browse Information Requests

Browse Information Requests

The Print Information Requests screen allows users to issue new Information Requests - including Forms W-9, W-9s, W-8 series and B Notices - individually or in batches and run batch reports. This screen is accessed via the Help & Extras task panel, selecting the "W-9/B Notices" link and clicking the "Issue New Requests" button. **Corporate Suite Users:** This screen is accessed via the TIN Management task panel and selecting the "Browse Batches" link.

**Issue Forms In Batch**
Use either option to access the Information Request Wizard.

- **Option 1:** On the Help & Extras task panel select the "W-9/B Notices" link. At the Manage Information Requests screen click the "Issue New Requests" button.
- **Option 2:** On the menu bar select Utilities > Issue W-9 and B Notice Forms.

**Issue Forms Individually**
Use either option to access the Information Request Wizard for a specified individual.

- **Option 1:** On the menu bar select File > Recipients List. At the Recipient Master List screen highlight a recipient and click the "Issue W-9/B Notice" button.
- **Option 2:** On the menu bar select File > Recipients List. At the Recipient Master List screen highlight a recipient and click "Change" to access the Changing a Recipient Record screen. Select the W-9/B Notices tab and use the "Issue an Information Request" button.

**Current Query**
The Current Query field on this screen allows records to be sorted by "All batches for this Filer" (default setting) or "All batches for ALL Filers."

**View/Print Batch Report**
The Batch Report is specific to the Information Requests contained within the selected Batch ID (Batch IDs are generated automatically in numerical sequence of date created). This report contains the selected recipients' Current TIN/Name/Address, TIN/Name/Address When Issued and the Requester/Form Type/Status. It further details the date the information request was originally Created, Closed, any associated B Notices and the Withholding percentage, if applicable.

- To run a multi-batch or multi-filer Information Request report see Information Request Summary Report.

**Reprint Forms/Batch**
Use to reprint all forms in a selected batch. The Report Options screen allows users to select Print All Forms or Print Open Forms and preview.

**Reset (Void) Batch**
Corporate Suite users only can use void outstanding requests within a batch. Requests within the batch that have been completed - and thus considered closed - cannot be voided.
29.5 Information Request Wizard

Information Requests, including Forms W-9, W-9s, Form W-8 Series (Corporate Suite Edition only) and First and Second B Notices, are important tools in maintaining current recipient Name and TIN information. The Information Request Wizard simplifies the process of issuing these forms to recipients individually or in batch. The status of these forms can then be tracked and updated as necessary. This utility is available in 1099 Pro Professional, Enterprise and Corporate Suite software only; W-2 Pro, 1042-S Pro, 8966 Pro and CRS PRO software do not offer it.

To Issue Information Requests
1. At the Help & Extras task panel select the "W-9/B Notices" link.
   - Corporate Suite Users: At the TIN Management task panel select the "Browse Batches" link. At the Create/Print Information Request screen click the "Create a New Batch of Information Requests" button and proceed to Step 4.

2. At the Manage Information Requests screen click the “Issue New Requests” button.

3. At the Print Information Requests screen click the “Print a New Batch of Information Request Forms” button.

4. At the 1099 Pro Information Request Wizard click “Next” to continue.
   - Review the IRS Instructions for the Requester of Form W-9.

5. Select the Specific Type of Information Request to print and click “Next” to continue:
   - W-9 Request for Taxpayer Identification Number and Certification
   - First B Notice
   - Second B Notice
   - W-9S Request for Student/Borrower’s Taxpayer ID Number and Certification
   - W-8 Series (Corporate Suite Edition only) - Includes Forms W-8 BEN, W-8ECI, W-8EXP, W-8IMY, W-8BEN-E and W-8 Combined.

6. Specify the Requester Filer issuing these forms (this information appears on the printed forms). Any changes made at this screen are temporary and will not permanently affect your Filer record, or alternately use the “Select a Different Filer to use as the Requester” button.

7. If issuing B Notices, additional information is required including:
   - B Notice 'Must Respond By' date
   - Backup Withholding Rate (default is 28%)

8. Select how Recipients will be selected for this batch and click “Next”.
   - Manual selection: Tag (or select) recipients.
   - Automatic selection: Select one or both options -
     - Pre-select all recipients that do not have a TIN, or
     - Pre-select all recipients who have an invalid TIN.

9. Set Print Options screen. The program remembers the user choices and automatically restores them each time this wizard is run. Click "Next" to continue.
   - Select the order to print forms (by Company/Last Name, TIN (SSN or EIN), ZIP/Postal Code or State)
Select whether to preview forms
- Select WHEN forms should print:
  - Now, as soon as I click Finish.
  - Not yet, I have more batches to create. Selecting this option automatically returns you to the Information Request Wizard after clicking Finish.

10. Confirm settings and verify printer. Click "Finish" to print or return to the Wizard to select more forms (as determined in the previous step).
- See Duplex Printing

29.6 B Notices - An Overview

"B" Notices—An Overview

The IRS sends Filers a CP2100/CP2100A Notice if recipient mismatches, i.e., Name/TIN combinations not matching the IRS database, are determined after filing. The Filer must then issue a Form W-9 and a "B" Notice to the recipient in question unless the Filer determines the error was on their part, e.g., a misspelled name, transposed TIN, etc. Please note:

- The recipient has 15 business days to respond to the notice and the Filer has 30 business days to reply to the IRS with their findings.
- The Filer need only issue a "B" notice 2 times in 3 calendar years to the same account.

1099 Pro simplifies the process of issuing B Notices via the Information Request Wizard.

What is a CP2100/CP2100A Notice?
A CP2100/CP2100A notice informs a Filer that they may be required to backup withhold. The notice includes a listing of any recipients with incorrect Name/TIN combinations. Filers with 250+ incorrect Name/TINs receive a DVD file CP2100, Filers with 50-249 incorrect Name/TINs receive a paper CP2100 and Filers with <50 incorrect Name/TINs receive a paper CP2100A. Upon receipt of a CP2100/CP2100A Notice, compare the information with your records. If the TIN is missing, the Filer may have to immediately start backup withholding. For incorrect TINs, the Filer must attempt to obtain the recipient's Name/TIN combination via a "B" Notice. Failure to comply often results in Filer penalties.

What is a Backup Withholding "B" Notice?
A "B" Notice is a notice to backup withhold. There are First and Second "B" Notices with different requirements for each, as outlined below. For more information see the IRS's Pub. 1281 Backup Withholding For Missing And Incorrect Name/TIN(s).

First "B" Notice
1. Send the First "B" Notice, Form W-9, and an optional reply envelope to the payee within 15 business days from the date of the CP2100 Notice or the date you received it (whichever is later). Date the "B" Notice no later than 30 business days after the date of the CP2100/CP2100A Notice or the date you received it (whichever is later). The outer envelope must be clearly marked "IMPORTANT TAX INFORMATION ENCLOSED" or "IMPORTANT TAX RETURN DOCUMENT ENCLOSED."
2. Make sure that necessary information such as the date, account number, and Backup Withholding (BWH) rate are on the "B" Notice before mailing it to the payee. If you do not include the optional reply envelope be sure to provide return address information in your mailing.

3. Update your records with the corrected information received from the payee and include it on any future information returns you file. Do not send the signed Form W-9 to the IRS.

4. Begin backup withholding on payments made to payees who do not return a signed Form W-9, response to the First "B" Notice no later than 30 business days after the date of the CP2100/CP2100A Notice or the date you received it (whichever is later). However, you may begin backup withholding the day after the date you receive the CP2100 Notice. Stop backup withholding no later than 30 calendar days after you receive the signed Form W-9 from the payee. You may stop any time within that 30 calendar day period.

**NOTE:** Do not file a correction unless you are also making a change to the dollar amount reported. It is your responsibility to send the appropriate "B" Notice to the payee, when required, to obtain the correct Name/TIN. This information may not be solicited by telephone. You need a TIN that the payee certifies as correct on Form W-9 in order to stop current backup withholding or prevent backup withholding from starting.

**Second "B" Notice**

1. Send the Second "B" Notice and an optional reply envelope to the payee within 15 business days after the date of the CP2100 Notice or the date you received it whichever is later). Date the "B" notice no later than 30 business days after the date of the CP2100 Notice or the date you received it (whichever is later). Do not send a Form W-9. The outer envelope must be clearly marked "IMPORTANT TAX INFORMATION ENCLOSED" or "IMPORTANT TAX RETURN DOCUMENT ENCLOSED."

2. The payee must contact the SSA to have his or her social security number validated (on Form SSA-7028, Notice to Third Party of Social Security Number Assignment) or the IRS to get his or her employer identification number validated (on IRS Letter 147C).

3. Allow 30 business days after the date of the Second "B" Notice to receive SSA Form 7028 from the SSA or Letter 147C from the payee. Begin backup withholding on payments made to the payee if you don't receive Form SSA-7028 or Letter 147C by the 30th business day. You may at your option begin backup withholding during the 30 business day period. You must continue to backup withhold until you receive the validation. Stop backup withholding no later than 30 days after you receive the required verification. You may stop backup withholding anytime within that 30 calendar day period after receiving verification.

**NOTE:** You are not required to file a correction unless you are also making a change to the dollar amount reported. It is your responsibility to send the appropriate "B" notice to the payee, when required, to obtain the correct Name/TIN. This information may not be solicited by telephone. You need a TIN validation (IRS Letter 147C or Form SSA-7028 as appropriate) in order to stop current backup withholding or prevent backup withholding from starting.

**Third and Subsequent Notices**

**Is a Third B-Notice Required?**

Generally, you may ignore a third or subsequent notice of missing or incorrect TIN(s) if you completed the actions for the First and Second "B" Notices and the incorrect payee name and TIN combination and
account number remain the same. However, if the CP2100/CP2100A Notice and listing(s) relate to the same payee, but with a different Name/TIN combination than on the "first" and "second" notice, you must treat the notice as a "first" notice.

29.7 Web Presentment

The 1099 Pro Corporate Suite software now includes a comprehensive API “Application Programing Interface” that offers users the ability to give recipient’s real-time access to their tax forms. The API makes it possible to deliver tax forms through your company’s online web portals, existing applications, or any programmable system. The API is available as a .Net DLL or Web Service to provide developers with the most flexibility when integrating it into your applications.

- Recipients get real-time access to the most up-to-date tax form data in the 1099 Pro system. Corrections are instantly available to recipients online.
- Electronic delivery management. Track and update recipient’s electronic delivery consent status.
- Comprehensive filtering and selection options: Tax Year, Filer TIN, Payer Code, Department, Recipient TIN, Account, Email, Form Type, Status, Source, Category, etc. Recipients only see the forms you want them to.
- Customizable link expiration. For added security, links to forms can be set to expire after a given period of time.
- On demand PDF generation and streaming from memory. No form data or images are saved on the local computer.
- Integrated PDF encryption. Each PDF can be password encrypted with a dynamically supplied password.

29.8 IRS Batch Processing (CS Version)

The features contained within this section are available exclusively to users of the Corporate Suite edition.

Filers receiving CP2100/CP2100A, 972CG and Bulk TIN notices from the IRS can enter this information into Corporate Suite to streamline responses and tracking. The IRS may provide these notices in a CD data file or on paper; Corporate Suite allows users the flexibility to import or manually enter this data into batches.

After these notices or "batches" are entered into 1099 Pro, users may track their Status / Batch Type / Notice Date and export data, approve for printing and more at the Previously Imported/Created Batches screen.

See Create/Import Batch Wizard
See Browse Information Requests to issue Information Requests (i.e., Forms W-9, W-9S, W-8 series and B Notices).

Previously Imported/Created Batches Screen
Corporate Suite users can access this screen via the TIN Management task panel and selecting the
"IRS Batch Processing" link. The following options are available for batches containing records—if a batch contains "0" (zero) records these options are ghosted and unavailable.

**Auto-Match Process**
Links recipient information in the imported file to existing recipients in the Corporate Suite database. Thus for purposes of a Bulk TIN Import users can automatically generate W-9’s for the recipients whose TIN’s did not match.

**Create/Link Recipients**
Link recipients from the IRS Batch Processing with EXSTING recipients in the Recipient Master List.

**View/Print Batch Report**
The Batch Report is specific to the Information Requests contained within the selected Batch ID (Batch IDs are generated automatically in numerical sequence of date created). This report contains the selected recipients’ Current TIN/Name/Address, TIN/Name/Address When Issued and the Requester/Form Type/Status. It further details the date the information request was originally Created, Closed, any associated B Notices and the Withholding percentage, if applicable.

☐ To run a multi-batch or multi-filer Information Request report see Information Request Summary Report.

**Export Batch to Excel**
Generate a batch specific report to Excel in a user specified destination folder. Report contains detailed information including; Request Type, Batch Type, Status (e.g., Open/Pending, In Progress, etc.), Linked Recipient, Match Status, Recipient Name/Address, Date Created and more. Filter options for this report include All Records, Approved Only or Not Approved Only.

**Delete Batch**
A batch with a Pending or In Process status can be deleted. A batch with a Printed or Approved status cannot be deleted unless the batch is first Reset/Void at the Browse Batches screen.

**Abatement Report**
Prior to generating this report, an Auto-Match Process must be completed on the batch.

**Browse Batch**
Access the Manage Information Requests screen for the selected batch where users may Add / Update / Delete selected Information Requests and attach relevant documents. This area is also accessible by double-clicking a batch record.

**Approve Batch**
Once a batch is approved, it is available at the Information Request Print Batches screen for printing. See Browse Information Requests

**29.8.1 Create / Import Batch Wizard**

**Create/Import Batch Wizard**

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.
Filers receiving CP2100/CP2100A, 972CG and Bulk TIN notices from the IRS can use the Create/Import Batch Wizard to quickly import this data into Corporate Suite. After entering the notices or “batches” use the the IRS Batch Processing screen to track their status, auto-match and/or link recipients and run various reports.

**To Create IRS Batch Requests**
1. At the TIN Management task panel select the "IRS Batch Processing" link.

2. At the Import/Create CP2100A/CP2100/972CG screen click the "Create/Import New Batch" button.

3. At the 1099 Pro Create/Import Batch Wizard review onscreen information and click “Next” to continue.

4. At the Select Process and Batch Type screen select the batch type and process type:
   - **Key-In IRS Data** - Use this option if you received a CP2100A, CP2100, 972CG or Bulk TIN Results on paper and it must be manually entered as a batch. After selecting “Finish” in Step 6, the user is returned to the Import/Create CP2100A/CP2100/972CG screen where they must highlight the newly created batch and use the "Browse Batches" button to access the Manage Information Requests screen. At this batch specific screen use the "Add New Request button to manually add IRS data.
   - **Import IRS File** - Use this option if you received a CP2100, 972CG or Bulk TIN results in a file and the batch can be automatically imported. Users must select the IRS electronic files and continue through prompts.

5. At the Select Requester Information for this Batch of Requests screen review the default information (the currently selected filer), select a different filer and manually enter requester information. The "Notice Date" is the date the notice was received from the IRS or the date printed in the upper right-hand corner of the notice, whichever is more recent. Click "Next" to continue.

6. Verify settings and click "Finish" to create batch.

### 30 Error Messages

**Error Messages**

Error messages appear as pop-ups within your software due to user error or a software bug. Many of these errors have simple solutions that can be easily applied by the user, the user's IT department or 1099 Pro's technical support team. Prior to applying any solution backup data to avoid any possible data loss.

Most error messages result from one or more of the following issues:
- Incorrectly mapped data file.
- Inadequate user rights to read/write/edit data file.
- Third party anti-virus software removing critical software files.
- Incomplete software updates.

**Authorization Code Error**
If an Authorization Code does not work it is almost always because an incorrect version of the software was installed. For example, a 1099 Pro Enterprise Authorization Code is incompatible with a 1099 Pro Professional installation; likewise a W-2 Pro 2016 Authorization Code is incompatible with a W-2 Pro 2017 installation. Users should verify that the version installed matches the version purchased.
Common Error Messages & Solutions

- **Invalid Record Declaration Error 47**
- **Unable to Open Required File (ProTips): 2 – File Not Found**
- **Unable to Open Required File (ProTips): 3 – Path Not Found**
- **Unable to Open SystemID: 2 – File Not Found**
- **Unable to Open SystemID: 3 – Path Not Found**
- **Unable to Open SystemID: 5 – Access Denied**
- **Unable to Open SystemID File 53 – Invalid Clarion File**
- **Clarion Trappable Runtime Errors**
- **EC002 – Unable to Open Files!**
- **Error Code #0008 – Can’t Find Stub Loader**
- **Could Not Load DLL Library \USER32.DLL**
- **Single User Version Error**
- **File Not Found: Information Request**

Antivirus Exceptions

1099 Pro software requires full rights to certain folders and subfolders plus a carve-out from any antivirus programs (e.g., Norton, McAfee, Sophos, Kaspersky, Webroot, etc.). This includes full rights and permissions to where the software is installed is required, which is typically C:\1099Pro and all subfolders. In the case that your data folder is on a network, users will also need full rights to the Data folder where the .TPS files reside.

Antivirus (AV) programs often prevent installations, software updates and corrupt .TPS data files. The following assumes that the software is installed in the default installation locations. Be sure to create exceptions which correspond to where the software is launched from and where your data (.TPS) files reside.

For detailed instructions on setting up a carve-out for 1099 Pro software products please refer to the 1099 Pro WIKI at https://wiki.1099pro.com/display/PDWA/Antivirus+Exceptions.

30.1 Invalid Record Declaration (47)

File Access Error: Invalid Record Declaration (47)

![File Access Error Image]

**Solution:**

This error can occur when either system latency or anti-virus software interrupts the record-numbering process. Please contact 1099 Pro Technical Support to further assist in renumbering records.
30.2 Unable to Open Required File (ProTips): 2 – File Not Found

Unable to Open Required File (ProTips): 2 – File Not Found

**Solution:**
This error most often occurs if there was an error during installation or an error when mapping the file path to your data folder. First, verify the software is not running from a network location; the software must be run locally, or from a client installation linked to a hosted data file.

The software may be redirected to the correct data file by editing the .INI file:

- Navigate to C:\1099 Pro\Pro99Txx\Admin.
- Open the file called Pro99Txx.INI.
- Edit the file path associated with “SAV:GlobalDataPath” to point to your data file.
- Save and run the software.

Please note that the default location for a single-user install saves the data file in C:\1099 Pro\Pro99Txx\Data. If setting up a multi-user workstation, the data folder is most likely in a custom location specified during the server installation.

30.3 Unable to Open Required File (ProTips): 3 - Path Not Found

Unable to Open Required File (ProTips): 3 – Path Not Found

**Solution:**
This error most often occurs when the software is not linked to the correct data file. This can be fixed by reinstalling and directing the workstation to the proper data folder. Alternatively, the software may be redirected to the correct data file by editing the .INI file:
1099 Pro® 2017

- Navigate to C:\1099 Pro\Pro99Txx\Admin.
- Open the file Pro99Txx.INI.
- Edit the file path associated with "SAV:GlobalDataPath" to point to your data file.
- Save and run the software.

Please note that the default location for a single-user install saves the data file in C:\1099 Pro\Pro99Txx\Data. If setting up a multi-user workstation, the data folder is most likely in a custom location specified during the server installation.

30.4 Unable to Open SystemID: 2 - File Not Found

Unable to Open SystemID: 2 – File Not Found

Solution:
This error most often occurs if there was an error during installation, or if a third party virus protection software removed 1099 Pro program files. Verify the file "Systemid.TPS" exists; located in file path C:\1099 Pro\Pro99Txx\Resource. If this file has been removed, or was blocked from installation, you may need to backup your data, then uninstall and reinstall the software. Be sure to list 1099 Pro as trusted software in your anti-virus software to avoid having files removed.

If "Systemid.TPS" is present, it's possible that the file path to your data contains unacceptable characters. This can be changed by editing your .INI file:

- Navigate to C:\1099 Pro\Pro99Txx\Admin.
- Open the file called Pro99Txx.INI.
- Locate the file path associated with "SAV:GlobalDataPath".
- Make sure the data file path does not contain a backslash at the end of the path, or any periods if using a UNC. For example: \stationx.1099pro.com\c\xxxx\.
- Save and run the software again.

Please note that the default location for a single-user install saves the data file in C:\1099 Pro\Pro99Txx\Data. If setting up a multi-user workstation, the data folder is most likely in a custom location specified during the server installation.

Please contact 1099 Pro Technical Support to further assist in renumbering your records.

30.5 Unable to Open SystemID: 3 - Path Not Found

Unable to Open SystemID: 3 – Path Not Found
Solution:
This error most often occurs when the software is not linked to the correct data file. This can be fixed by reinstalling and directing the workstation to the proper data folder. Alternatively, the software may be redirected to the correct data file by editing the .INI file:

- Navigate to C:\1099 Pro\Pro99Txx\Admin.
- Open the file called Pro99Txx.INI.
- Edit the file path associated with "SAV:GlobalDataPath" to point to your data file.
- Save and run the software.

Please note that the default location for a single-user install saves the data file in C:\1099 Pro\Pro99Txx\Data. If setting up a multi-user workstation, the data folder is most likely in a custom location specified during the server installation.

30.6 Unable to Open SystemID: 5 - Access Denied

Unable to Open SystemID: 5 – Access Denied

Solution:
This error occurs when a user does not have full read/write/edit privileges to the location where the data folder is hosted. Contact your IT department to verify the rights are proper in both the shared location and the folder's security settings. If your IT department has confirmed that your security settings are set properly, contact 1099 Pro Technical Support for additional assistance.

30.7 Unable to Open SystemID File: 53 - Invalid Clarion File

Unable to Open SystemID: 53 – Invalid Clarion File

Solution:
This error most often occurs when the software is not linked to the correct data file. This can be fixed by reinstalling and directing the workstation to the proper data folder. Alternatively, the software may be redirected to the correct data file by editing the .INI file:

- Navigate to C:\1099 Pro\Pro99Txx\Admin.
- Open the file Pro99Txx.INI.
- Edit the file path associated with "SAV:GlobalDataPath" to point to your data file.
- Save and run the software.
Please note that the default location for a single-user install saves the data file in C:\1099 Pro\Pro99Tx\Data. If setting up a multi-user workstation, the data folder is most likely in a custom location specified during the server installation.

30.8 EC002 – Unable to Open Files!

EC002 – Unable to Open Files!

Solution:
This error most often occurs when attempting to restore data from the wrong year (e.g., data from 2016 into 1099 Pro for 2017). Users cannot restore data into a different year’s software. This is a security measure to ensure that users do not accidentally file the wrong data.

Recipient and filer information may be rolled forward during or immediately after installing. For more information, see Roll Forward Data.

30.9 File Not Found - Information Request

File Not Found: Information Request

Solution:
This error may occur when performing a Roll Forward procedure if some some of the user selected items such as "Prior Year Security Settings" or "Prior Year Import Maps" do not contain data. For example, in the 2016 software security was not used or custom import maps were not created.

The user should click "OK" and continue with the installation.
30.10 Could Not Load DLL Library \USER32.DLL

Could not load the DLL library C:\Windows\USER32.DLL. The specified module could not be found.

Solution:
This error occurs when a user does not have full read/write/edit privileges to the location where the data folder is hosted. Contact your IT department to verify the rights are proper in both the shared location and the folder's security settings. If your IT department has confirmed that your security settings are set properly, contact 1099 Pro Technical Support for additional assistance.

30.11 Clarion Trappable Runtime Errors

Clarion Trappable Runtime Errors

The following errors can be trapped in code with the ERRORCODE and ERROR procedures. Each error has a code number (returned by the ERRORCODE procedure) and an associated text message (returned by the ERROR procedure) indicating what the problem is.

2 File Not Found
The requested file does not exist in the specified directory.

3 Path Not Found
The directory name specified as part of the path does not exist.

4 Too Many Open Files
The total number of file handles available has been used. Check the FILES= setting in the CONFIG.SYS file, or the user's or network's simultaneous open files setting in a network environment.

5 Access Denied
The file has already been opened by another user for exclusive access, has been left in a locked state, or you do not have network rights to open the file. This error can also occur when no disk space is available.
7 **Memory Corrupted**
Some unknown memory corruption has occurred.

8 **Insufficient Memory**
There is not enough unallocated memory left to perform the operation. Closing other applications may free up enough memory.

15 **Invalid Drive**
An attempt to read a non-existent disk drive has failed.

27 **Invalid Table Declaration**
An attempt to open a table that has an invalid table structure has failed. This is normally found when a Dynamic File has been created incorrectly. Also seen in IP Driver based applications.

30 **Entry Not Found**
A GET to QUEUE has failed. For GET(Q,key), the matching key value was not found, and for GET(Q,pointer), the pointer is out of range.

32 **File Is Already Locked**
An attempt to LOCK a file has failed because another user has already locked it.

33 **Record Not Available**
Usually an attempt to read past the end or beginning of file with NEXT or PREVIOUS. May also be posted by PUT or DELETE when no record was read before the attempted PUT or DELETE.

35 **Record Not Found**
For a GET(File,key), the matching key field value was not found.

36 **Invalid Data File**
Some unknown data file corruption has occurred, or the OWNER attribute does not match the password used to encrypt the file.

37 **File Not Open**
An attempt to perform some operation that requires the file be already open has failed because the file is not open.
38 Invalid Key File
Some unknown key file corruption has occurred.

40 Creates Duplicate Key
An attempt to ADD or PUT a record with key field values that duplicate another existing record in the file has been made to a file with a key that does not allow duplicate entries.

43 Record Is Already Held
An attempt to HOLD a record has failed because another user has already held it.

45 Invalid Filename
The filename does not meet the definition of a valid DOS filename.

46 Key File Must Be Rebuilt
Some unknown key corruption has occurred that requires the BUILD statement to re-build the key.

47 Invalid Record Declaration
The data file on disk does not match the file's declaration in the .EXE, usually because you have changed the file's definition in the Data Dictionary and have not yet converted the existing data file to the new format. See How do I handle an Error 47

48 Unable To Log Transaction
A transaction logout or pre-image file cannot be written to disk. This usually occurs because no disk space is available, or the user does not have the proper network rights.

52 File Already Open
An attempt to OPEN a file that has already been opened by this user.

54 No Create Attribute
An attempt to execute the CREATE procedure on a file whose declaration does not include the CREATE attribute.

55 File Must Be Shared
An attempt to open a file for exclusive access that must be shared. (Legacy error, no longer used)

56 LOGOUT Already Active
An attempt to issue a second LOGOUT statement while a transaction is already in progress.
57 Invalid Memo File
Some unknown memo file corruption has occurred. For Clarion data files, this could come from a corrupt .MEM file "signature" or pointers to the memo file in the data file that are “out of sync” (usually due to copying files from one location to another and copying the wrong .MEM file).

63 Exclusive Access Required
An attempt to perform a BUILD(file), BUILD(key), EMPTY(file) or PACK(file) was made when the file had not been opened with exclusive access.

64 Sharing Violation
An attempt to perform some action on a file which requires that the file be opened for shared access.

65 Unable To ROLLBACK Transaction
An attempt to ROLLBACK a transaction has failed for some unknown reason.

73 Memo File Missing
An attempt to OPEN a file that has been declared with a MEMO field and the file containing that memo data does not exist.

75 Invalid Field Type Descriptor
Either the type descriptor is corrupt, you have used a name that does not exist in GET(Q,name), or the file definition is not valid for the file driver. For example, trying to define a LONG field in an xBase file without a matching MEMO field.

76 Invalid Index String
The index string passed to BUILD(DynIndex,string) was invalid.

77 Unable To Access Index
An attempt to retrieve records using a dynamic index failed because the dynamic index could not be found.

78 Invalid Number Of Parameters
You did not pass the correct number of parameters to a procedure called in an EVALUATE statement. Note: As of Clarion Version 6.2 (9047), the SQL Drivers now add more information to the trace log file, explaining why the ERRORCODE 78 was generated.
79  Unsupported Data Type In File
The file driver has detected a field in the file declared with a data type that is not supported by the file system the driver is designed to access.

80  Unsupported File Driver Function
The file driver has detected a file access statement that is not supported. This is frequently an unsupported form (different parameters) of a statement that is supported.

81  Unknown Error Posted
The file driver has detected some error from the backend file system that it cannot get further information about.

88  Invalid Key Length
An attempt to CREATE a Clarion file driver KEY or INDEX with more than 245 characters. Other file drivers can also return this error when their file system key length limits are exceeded.

89  Record Changed By Another Station
The WATCH statement has detected a record on disk that does not match the original version of the record about to be updated in a network situation.

90  File Driver Error
The file driver has detected some other error reported by the file system. You can use the FILEERRORCODE and FILEERROR procedures to determine exactly what native error the file system is reporting.

91  No Logout Active
The COMMIT or ROLLBACK statement has been issued outside of a transaction frame (no LOGOUT statement has been executed).

92  BUILD in Progress
A BUILD statement has been issued and PROP:ProgressEvents has been set to generate events. The statement generating this error is not appropriate to execute during a BUILD process.

93  BUILD Cancelled
The user cancelled the BUILD. This error is set when EVENT:BuildDone is posted.

94  Record Limit Exceeded
The target file has exceeded the record limit. This value is file driver dependant, and can be returned
during any attempt to modify a file where the record limit is exceeded.

97 Stream Error
Used during RTF processing.

100 Trigger Error
This error is set whenever a registered file callback method returns FALSE. See CALLBACK

1010 Illegal Expression
The EVALUATE procedure has detected an error in the syntax of the expression it is attempting to evaluate.

1011 Variable Not Found
The EVALUATE procedure has not found a variable used in the expression it is attempting to evaluate. You must first BIND all variables used in the expression for them to be visible to EVALUATE.

30.12 Single User Version Error

Single User Version Error

Solution:
This error occurs when a user does not have full read/write/edit privileges to the location where the software is installed. Contact your IT department to verify the rights are proper in both the shared location and the folder’s security settings. If your IT department has confirmed that your security settings are set properly, contact 1099 Pro Technical Support for additional assistance.

31 Additional Services

31.1 TINCheck

TINCheck: TIN/Name Verification

The IRS penalty for TIN/Name mismatches is now $100 per mismatch. The TINCheck service is an essential tool in identifying mismatch errors through an interactive and user friendly website prior to filing information returns. Simply log in with a username and password, and instantly gain access to multiple verification sources in one place. Users also have the option of integrating the API/web service into an existing accounts payable system, allowing your company to seamlessly verify information while entering new vendor information into your database.

IRS TIN/NAME MATCHING (IRS TIN MATCHING) Internal Revenue Service (IRS)
Internal Revenue Service (IRS) This verification process, for both EIN and SSN numbers, ensures that payers file accurate payee TIN/Name combinations reducing or eliminating yearly IRS TIN/Name
discrepancy penalties (B-Notices, CP2100(A)s, 972CGs). The IRS can assess penalties of up to $1,500,000 ($500,000 for small business) for non-compliance. In the event of intentional disregard, there is no limit.

**EIN/NAME LOOKUP SYSTEM (ELS)** Internal Revenue Service (IRS) issued EINs

Internal Revenue Service (IRS) issued EINs. This lookup process will retrieve the company name that is associated with a given EIN number. This lookup is only for public knowledge company EIN numbers, it does not return individual names from Social Security Numbers (SSNs). This lookup is very useful for getting the correct company name that was identified as a mismatch by the IRS TIN Matching process.

**SPECIALLY DESIGNATED NATIONALS (SDN/PLC)** Office of Foreign Assets Control (OFAC)

Office of Foreign Assets Control (OFAC) Unlike IRS penalties for TIN/Name discrepancy, payers neglecting to verify the Office of Foreign Assets Control (OFAC) lists open themselves up to civil as well as criminal penalties. OFAC non-compliance carries civil penalties of up to $1,000,000 per violation plus criminal fines of up to $10,000,000 and imprisonment ranging from 10 to 30 years.

**DEATH MASTER FILE (DMF)** Social Security Administration (SSA)

Social Security Administration (SSA) The DMF is a continually updated list of all known deceased individuals. It is used by the financial industry as well as government agencies to prevent identity fraud. IRS TIN/Name Matching does not discern whether or not a payee is deceased. For some payers, knowing whether they are paying a deceased individual is prudent. Checking payees against the Death Master File gives the payer community the ability identify and prevent fraud.

**DENIED PERSONS LIST (DPL)** Department of Commerce (DOC)

Department of Commerce (DOC) The DPL is a list created by the U.S. Department of Commerce of individuals and entities that have been denied export privileges. Any dealings with a party on this list that would violate the terms of its denial order is strictly prohibited. Violation can result in a civil penalty amounting to the greater of $250,000 or twice the value of the transaction for each violation. For criminal violations, violators may be fined up to $1,000,000 and/or face up to 20 years of imprisonment.

**EXCLUDED PARTIES LIST SYSTEM (EPLS)** General Services Administration (GSA)

General Services Administration (GSA) The Excluded Parties List System includes companies that have been debarred, suspended, excluded, or disqualified from receiving Federal contracts, subcontracts, assistance, and benefits. Government agencies and contractors are required to check this list to validate vendors and/or payees are in good standing with the federal government.

**EXCLUDED INDIVIDUALS AND ENTITIES (LEIE)** Office of Inspector General (OIG), Health & Human Services (HHS)

Office of Inspector General (OIG), Health & Human Services (HHS) In the health care industry, anyone who hires an individual, entity, or contractor on the LEIE may be subject to civil monetary penalties (CMP) by the OIG ranging into the millions of dollars. To avoid CMP liability, health care entities need to routinely check the LEIE to ensure that new hires, current employees, or contractors are not on the excluded list.

**DESIGNATED FOREIGN TERRORIST ORGANIZATIONS (FTO)** Department of State (DOS)

Department of State (DOS) Foreign Terrorist Organizations (FTOs) are foreign organizations that are designated by the Secretary of State in accordance with section 219 of the Immigration and Nationality
Act (INA).

POLITICALLY EXPOSED PEOPLE (PEP) Central Intelligence Agency (CIA)
Central Intelligence Agency (CIA) A quarterly updated list compiled by the CIA of Chiefs of State and Cabinet Members of Foreign Governments.

FBI Wanted Lists (FBL) Federal Bureau of Investigation (FBI), Department of Justice (DOJ)
Federal Bureau of Investigation (FBI), Department of Justice (DOJ) Criminal Enterprises, Cyber Crimes, White Collar Crimes, Violent Crimes, Crime Alerts, Crimes Against Children, Domestic Terrorism, Seeking Information, Seeking Terror Information, Top Ten Fugitives, Most Wanted Terrorists, etc.

ADDRESS VALIDATION (AV) United States Postal Service (USPS)
United States Postal Service (USPS) Automatically validate a address (if provided) using the USPS Address Validation and Normalization Database to insure the most accurate and up-to-date address information.

ADDITIONAL VERIFICATIONS State Banned Lists Including state and local banned patron lists for casinos and other various lists.

For more information on TINCheck products and services, contact us!

The TINCheck Sales and Support team is available Monday through Friday, 8am to 5pm PST.

Contact Sales
Email: sales@tincheck.com
Phone: 1-866-452-3467

Contact Support
Email: support@tincheck.com
Phone: 1-866-452-3467

31.1.1 Manage my TINCheck account

TINCheck: Managing your TINCheck account

Note: Before you can begin to use the TINCheck service an account needs to be created.
To review different plans please visit: https://www.tincheck.com/plans

*Please visit https://www.1099pro.com/videos.asp and select the "How to Use Integrated TIN/Name validation" to watch a brief tutorial on the TINCheck integration process.

In order to order to enter your tincheck account information into the software so that you can utilize real time tin verification please complete the following steps.

Click on "File"
Click on "Security and administration"
Click on "Program Options"
Click on "Set TINCheck Account"
In the TINCheck User (login) ID field please enter your TINCheck user ID (Note: This is normally an email address)
In the TINCheck Password field please enter your TINCheck password.
After completing the preceding two steps it is recommended that you click the "Test my TINCheck connection now!" button to make sure that your account information has been entered correctly before proceeding.
Note: If in the future you would like to disable the software’s ability to verify TIN's then click the "Turn off (Disable) all TINCheck functionality) checkbox.
If you would like to enter any notations or descriptions regarding the TINCheck service please enter them in the Account description or Account notes fields; please note that neither of these areas will have any impact on the processing of TIN's.
Once you are done click on "Save" or, if you would like to discard of the changes made to this screen click on "Cancel".

If you attempt to verify a TIN prior to entering a TINCheck account you'll see the below screen, click the "Configure TINCheck account" button to enter TINCheck account information, or click the "Sign up now!" button to open the www.TINCheck.com website in your default internet browser.
31.1.2 Manage my results

TINCheck: Managing your results

In order to check the validity of a TIN that you're using on a tax record:
When editing an existing tax form or adding a new one click the "Tax Validation" button.
Click "Check TIN/Name"

Please note that when checking TIN's the TINCheck service also provides you with information on the following lists:

**IRS TIN/Name Matching (TIN Matching):** Internal Revenue Service; This verification process, for both EIN and SSN numbers, ensures that payers file accurate payee TIN/Name combinations reducing or eliminating yearly IRS TIN/Name discrepancy penalties (B-Notices, CP2100(A)s, 972CGs). The IRS can assess penalties of up to $1,500,000 ($500,000 for small business) for non-compliance. In the event of intentional disregard, there is no limit.

**Specially Designated Nationals (OFAC/SDN/PLC):** Office of Foreign Assets Control, Department of Treasury; Unlike IRS penalties for TIN/Name discrepancy, payers neglecting to verify the Office of Foreign Assets Control (OFAC) lists open themselves up to civil as well as criminal penalties. OFAC non-compliance carries civil penalties of up to $1,000,000 per violation plus criminal fines of up to $10,000,000 and imprisonment ranging from 10 to 30 years.

**Death Master File (DMF):** Social Security Administration; The DMF is a continually updated list of all known deceased individuals. It is used by the financial industry as well as government agencies to prevent identity fraud. IRS TIN/Name Matching does not discern whether or not a payee is deceased. For some payers, knowing whether they are paying a deceased individual is prudent. Checking payees against the Death Master File gives the payer community the ability identify and prevent fraud.
31.1.3 History Requests

**TINCheck: History of Requests**

The TINCheck History screen allows you to see all instances of the TIN associated with the record that you're viewing having been checked; in this way it also serves as an audit trail allowing you to see the information associated with that TIN at the time it was checked, and who performed that check (If you have multiple login ID's configured)

If you would like to print/view a report of the audit trail quite simply press the "Print/View" button.
31.1.4 TINCheck Integration

There are 2 ways you can give a user access to TINCheck integrated features. If the end user is part of a “built-in” access group, the admin can create. If the user is part of a custom access group, you can simply modify the user profile under the access group. Users belong to access group that are highlighted in green are using Built-in Groups. If using built-in groups, a new access group will have to be created to allow access to TINCheck.
Users already using custom access groups and profiles will need to update the access group to allow TINCheck integration. Highlight the group and click the Change button. Tag the Program Area named “Allow access to TINCheck” and the click the Modify button.
Click Select All Rights then Save.
Click Save Changes to Group. For users using Built-In Groups, you will need to create an Access Group first and then update your User Profile(s). Click the Add button at the bottom.
Give your new access group a name and tag Allow access to TINCheck and click the Modify button.
Click Select All Rights then Save.
Click Save Changes to Group. Go to your User Profiles and update them to include the new access group we created for TINCheck access. Tag the access group and click Save Changes to Group.
31.1.5 Status Icons

TINCheck Status Icons

These status symbols can be found when adding/editing an individual record; you'll find them to the right of the TIN being checked.
Clicking on the symbol will give you more information about it and allow you to validate the TIN once more by clicking on the “Go to Validation” button.
31.2 Managed Services

Managed Services

The 1099 Pro Managed Services team, IRSCompliance, can maintain your payee and payment database in our secure SSAE 16 SOC I Type II environment, or on your secure servers. Managed Services can support current and prior years of tax data for forms 1098, 1099, 5498, W-2G, W-2, 1042-S, 3921, 3922, as well as Puerto Rico payment information. This service includes regulatory support, compliance training, and year-end recipient statements. Users can access the 1099 Pro Corporate Suite software to securely view and print their payee and payment information and perform data queries, either online or through a secure network.

With more than 25 years of experience, IRSCompliance members have real world experience in a variety of industries, and as a result, are experts in federal law, state tax, local tax, and payment types that are subject to reporting. IRSCompliance’s expertise and efficiency will improve your compliance and minimize financial risk to your company.

CUSTOM AND SCALABLE FEATURES
Federal & state filing for originals and corrections
Quarterly wage reporting
Independent Contractor Reporting
TIN Compliance Management: B-Notices, TIN matching, W-8 and W-9 processing
Balancing and reconciliation
Transaction detail history and audit trails
Penalty abatement
Form 1099-K processing and reporting

OPTIONAL SERVICES
Withholding & deposit services
Policy and procedure development
Regulatory publications, webinars, and events
Standard and custom printing services
Consulting, risk assessment services, and curing
Penalty appeals
Electronic filing services
Electronic payee statement presentment
Electronic solicitation and validation of W-8s & W-9s

1099 Sales and Technical Support
(888) 776-1099
sales@1099pro.com

31.3 Form CA-592 New

Form CA-592 Overview

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.
New for Tax Year 2016 - 1099 Pro prepares Form CA-592 Resident and Nonresident Withholding Statements for payees who received California source income but are not residents of California. Users may print year-end composite statements and generate electronic files either 1) quarterly if using transactional imports with an accounting date, or 2) fourth quarter only if doing a standard year-end (non-transactional) import.

There is no Service Bureau support for printing, mailing or filing Form CA-592.

☐ See CA-592 Quarterly E-File Wizard

32 Glossary

Glossary

10 Day
Per IRS Pub. 1220, part C, section 7:
"If the [electronic] file is good, it is released for mainline processing 10 calendar days from receipt. Contact [the IRS] at 304-263-8700 within this 10 day period if there is a reason the file should not be released for further processing. If the file is bad, normal replacement procedures are followed."

1096 Transmittal
Use this preprinted red ink form to transmit paper Forms 1099, 1098, 5498, 39XX and W-2G to the Internal Revenue Service. Do not use a 1096 Transmittal to file electronically. For electronic submissions, see Pub. 1220, Specifications for Filing Forms 1098, 1099, 5498 and W-2G Electronically.

250 Rule
The Rule-of-250 states that any filer submitting 250 or more forms of any one type must submit those forms electronically. Failure to do so may result in significant per form penalties.

See Rule-of-250 for detailed information.

4419
To obtain a TCC number, file Form 4419 to request authorization to file forms electronically. Form 4419 must be mailed at least 30 days prior to the filing deadline for the electronic file. Form 4419 may be printed at the Print Blank Forms screen.

8809
Purpose of form. Use this form to request an extension of time to file 1098 series, 1099 series, W-2 series, W-2G, 5498 series, 8027, 1099-INT/OID for REMIC and 1042-S forms.
- A -

"A" Record
Identifies the person making payments

Access Groups
Access Groups determine which Filers and tax form types a user can access and which tasks they can perform upon those tax forms. By default, all users can access ALL forms and All Filers unless you create your own Access Groups. Built in Groups are groups that cannot be deleted or changed other than just adding or removing members.
Available built groups consist of "All Forms/All Filers". The key to restricting forms and Filers to a user is to minimize the number of Filers and/or forms you make available to them.

Account Generation Wizard
1099 Pro offers a feature that will generate account numbers for each form that does not have an account number. IRS Publication 1220, states on page 77 that the IRS requires account numbers "Enter any number assigned by the payer to payee that can be used by the IRS to distinguish between information returns. This number must be unique for each information return ..." The IRS has indicated that they will not reject files if they do not have account numbers but by having account numbers the IRS will be able to process any corrections that they encounter.

Activation Code
A registration code (aka activation code or product ID) is provided upon proof of payment. The algorithm of your registration code indicates the edition, user license and number of record transactions purchased.

Aggregation
The 1099 Aggregation Feature was designed to allow users to consolidate more than one tax form of the same type, for one recipient under a given filer.

For example, John Smith owns an automobile detail business and frequently comes by the movie studio to wax and wash the studios automobiles. You, (the Filer) issuing the 1099-MISC form, pay John frequently on a bi-weekly basis so instead of printing and issuing multiple 1099 forms for John you only want to view/print it as one combined form. This feature will allow you to view the aggregated box amount totals highlighted in green in the tax form which is a reflection of all tax form dollar amounts for this recipient under this master tax form only.

Audit Trails
Audit Trails do NOT track the history of all manual and cascading changes to a Master Recipient & Filer List. Only direct changes to a tax form are stored in the record history screen.

- B -

"B" Record
Contains the payment information from the information returns.

B-Notice
If after submitting files to the IRS, a mismatch is determined, (e.g., a recipient's name and TIN do not match the IRS records), the IRS sends the Filer a CP2100 or CP2100A Notice. The Filer must then issue a Form W-9 and a B Notice to the recipient in question unless the Filer determines the error was
on their part (e.g., a typo).

**Backup Data**
The 1099 Pro Backup Wizard automatically copies all data files and compresses them into a WinZip format. By default, 1099 Pro prompts for a daily backup.

**Blank Paper**
Print Copy B &/or C directly onto blank copier paper. This is good in case of an emergency when Blank Laser Perforated paper is unavailable (might require special folding and/or cutting to fit in standard IRS approved envelopes). 1099 Pro, Inc. offers custom designed IRS regulation envelopes to fit copier paper.

**Blank Laser Perforated**
Print Copy B &/or C directly onto blank laser perforated stock (1099 Pro prints the necessary graphics). Easier to fold than blank copy paper because of the perforations, and since it is blank, it won't go out of date!

**Bulk TIN Matching**
TIN Matching is a pre-filing service offered to payers and/or authorized agents who submit any of six information returns subject to backup withholding (Forms 1099-B, INT, DIV, OID, PATR, and MISC). With **Interactive TIN Matching** authorized payers can match up to 25 payee TIN and name combinations against IRS records prior to submitting an information return. **Bulk TIN Matching** allows payers and/or authorized agents filing any of the six information returns to match up to 100,000 TIN and name combinations. In order to participate in TIN Matching, payers must be listed in the IRS Payer Account File (PAF) database. If your firm has not filed information returns with the IRS in one of the past two tax years, the application will not be available to you at this time.

*Click here to learn how to use Bulk TIN Matching*

**Business Rules**
Business Rules are formulated in conjunction with the compliance experts from IRS Compliance to check that data being processed in 1099 Pro’s software does not contain common formatting errors, form specific errors, is valid for State and Federal filing, and can be used to separate records with different levels of issues for processing.

- **C** -

**"C" Record**
Contains the total number of payees and the totals of the payment amount fields filed for each payer and/or particular type of return.

**CFSF / CFSFP - Combined Federal State Filing Program**
The Combined Federal/State Filing Program was established to simplify information return filings for taxpayers. The CF/SF Program allows the IRS to forward electronically-filed information returns to participating states free-of-charge for approved filers, thus eliminating separate reporting to those states.

**Control Totals**
The Control Totals report is an invaluable tool for reviewing recipient records. Information contained in this report includes:

- Form type

- Filer's Name and TIN
- **Recipent's First Name, Last Name, TIN, Account Number and optionally, their Address**

- **Individual record print status and date of last update**

- **Box by box totals**

- **Number of missing TINs and more....**

**Corrections**

If you filed a return with the IRS and later discover you made an error on it, you must correct it as soon as possible. For some corrections, you must file two returns with Form 1096 and for some only one return with Form 1096. In addition, you must provide statements to recipients showing the corrections as soon as possible. If you fail to file correct information returns or furnish a correct payee statement, you may be subject to a penalty.

---

**Electronic Filing**

*See IRS FIRE System*

**EIN (Employer Identification Number)**

An Employer Identification Number (EIN) is also known as a federal tax identification number, and is used to identify a business entity. Generally, businesses need an EIN.

**Excel Spreadsheet Files**

When saving data in Excel, use the ‘Save As’ method to save your file in .TXT (TAB delimited) format, not .XLS format. Sample import files in this format are included in your 1099 Pro installation and are very helpful. These files appear out of alignment when viewed from a text editor such as Notepad but look great when viewed from Excel. To import .TXT (TAB delimited) files select TAB, CR LF and Double Quotes as your delimiters in the Import Wizard.

**Export Database**

The 1099 Pro Export Wizard simplifies the process of creating export files. Export files are written in ASCII format, delimited with a TAB character, and may be easily opened in Microsoft Excel, Access or Notepad.

---

**"F" Record**

End of Transmission

**Filer**

The individual or organization filing the 1099.

**FIRE System**

Use the Filing Information Returns Electronically (FIRE) System to electronically upload informational returns to the IRS. Electronic files created via the 1099 Pro Electronic File Wizard fully comply with required IRS record formats per Pub. 1220. The FIRE System is available 24 hours a day, 7 days a week to any transmitter and can be reached by visiting [https://fire.irs.gov](https://fire.irs.gov). The FIRE System can be accessed by opening a web browser, accessing the Internet and typing in the address [https://fire.irs.gov](https://fire.irs.gov).
Form Status
Users must select an import status for their data in the first step of the import routine, Import Data. Selecting the correct status is important because aside from Pending, the status of the session can only be reset by voiding (deleting) the entire session.

Forms
Fill-in forms allow you to enter information while the form is displayed 1099 Pro in the Enter, Update & view Screen. You can then print the completed form for your records and for filing with the IRS.

Forms Status Values
See topic on "Forms Status Values"

- G -

Generating Account Numbers
See Account Number Generation

Group Actions
Group Actions let you tag/select a number of items and then perform a single action on them. In all cases, you will be asked to confirm your choice before the action is taken.

- H -

History
1099 Pro lets you view a list of prior changes to a form. Records with a pending status display the Changing a Record screen. In the upper right corner of the form is a audit trails button. Click the "audit trails" button. This screen tracks all manual changes made directly to a record.

- I -

Import
Many database and spreadsheet applications such as Microsoft Excel, Access and Lotus 1-2-3 provide for the exporting of data to an ASCII file. These files can be imported into 1099 Pro, thus relieving the burden of manually entering the information onto the tax form. If your data has already been entered once, why type it again?

INI Files
The "Pro99T17.INI" file contains information specific to your installation and is located at <\%DEFAULTPATH%>\Admin. If installing to a directory such as Program Files it may be placed in C:\Windows. The INI file may or may not be deleted during a custom uninstall. This file can be manually deleted if you want to totally remove 1099 Pro from your system or if you want to perform a clean re-installation. This file can remain if you want to reinstall the software but retain your settings.

Install
See Instructions on Installing 1099 Pro.

IRS/MCC
The Internal Revenue Service, a division of the U.S. Treasury Dept. that is responsible for the assessment and collection of most federal taxes, except those relating to alcohol, tobacco, firearms, and explosives. Established in 1862, the IRS derives most of its revenues from the collection of corporate
and individual income tax.

- K -

"K" Records
Contains the summary for a given payer and a given state in the Combined Federal/State Filing Program, used only when state-reporting approval has been granted.

Keyboard Shortcuts
Keyboard shortcuts allow you to quickly enter or carry out functions by applying a combination of ALT [SHIFT] or Ctrl + key Commands on your keyboard.

- L -

Laser Forms
When using preprinted laser forms you must select the copies to print. The Print Wizard pauses before printing each copy to prompt you to load the appropriate form into the printer. For use with Copy A, B, C &/or 1096. Forms are perforated, with each required copy preprinted with the necessary information (Copy A in red drop-out ink, Copy B in black, etc.). Saves toner and time!

-M-

Master Tax Form
In terms of Aggregating data in a tax form, the master tax form is considered to be the first tax form entered at the top of the list.

- O -

Online Help Tutorials
Flash enabled tutorials walk you through various tasks including importing, exporting, printing, Electronic File, queries, etc. Tutorials simplify the 1099 Pro learning curve - try one at http://www.1099 Pro.com

Online Knowledge Base

- P -

Passwords
The Logon screen requires you to enter a new password. Passwords must be 3-8 characters, should not be case sensitive, and you cannot use the word "new."

Payer Codes
A Payer Code or PCode is an alphanumeric shorthand used to identify a Payer/Filer in the system. You might set up several Filers with the same TIN in the system and the Payer Code is an easy way to identify the business area you are dealing with. For example a Payer Code of ‘BOD’ where reporting for the Board of Directors takes place. Typically security and/or the return address would be different for each Payer Code.
Additionally, in an import file with recipient / tax form data for more than one Payer/Filer, Payer codes can be used to define which Payers / Filers the recipient / tax form data should be posted to. **Corporate Suite Only:** Payer Codes are automatically assigned as necessary.

**Penalties**  
Penalties can be assessed by the IRS/SSA for various reasons including filing after a deadline, invalid Recipient Name/TIN combinations, etc. See **Errors & Warnings** and **Penalties** for more information.

**Pending**  
These forms were inputted or imported. Forms with a *Pending* status can be changed or deleted

**Preferences**  
At the menu bar select File > Security and Administration > Program Options > Preference, Update and Program Options to access the Preferences screen. Preference items allow users to modify general settings which affect global software functions.

**Queries**  
The Query Wizard allows custom access to user data via an intuitive wizard driven interface. Users can quickly create and save customized queries.

**Recipients**  
The receiver of a 1098/1099/3921/3922/5498/W-2G tax form.

**Reports**  
Reports are useful for tracking the status of forms and determining if records contain any errors or warnings. 1099 Pro offers three main reports including the Control Totals Report, Forms Issued by Filer, and Form Counts by Filer.

**Restore**  
The 1099 Pro Backup Wizard automatically copies all data files and compresses them into a WinZip format. Use the shareware program WinZip to restore data to a location on your hard drive.

**Rights Groups**  
Activity Groups are used to allow or deny users from performing various activities within the system. Examples may be rights to View tax forms or rights to Import/Export tax form data. Activity Groups assigned to users cause these users to inherit the rights assigned to the Group. Activity Groups consist of two types; a built-in group (denoted by the **BLUE** color) and custom groups created by Admin. Built-in groups cannot be deleted or modified except to add or remove users.

**Roll Forward**  
During installation the wizard automatically looks for prior year data files. If files are located the wizard prompts to “Copy 2016 Filers to 1099 Pro 2017”. This is the only opportunity to roll forward prior year data into 1099 Pro 2017.

**Rule-of-250**  
See [Rule-of-250](#)
Search
Access any recipient or filer via the Search Name field.

Security
1099 Pro offers two levels of security: On and Off.
- If security is enabled, access to 1099 Pro is limited to users with valid User ID/Password combinations. These users are restricted to specific tasks assigned by the Administrator. This performs a twofold method of protecting sensitive company data.

Service Bureau
1099 Pro has a proven track record of printing, mailing and electronic filing. For a fee, our 1099 Service Bureau relieves users of the burden of ordering supplies and arranging for the printing, stuffing and mailing of tax forms with sensitive data. Simply input your data into our software, schedule an appointment with the Service Bureau, and on your assigned data transmit an encrypted file via the Internet to a secured site where we:
- Print and mail all recipient copies
- File required Federal copies
- File State copies (if necessary)
- Print, Mail & File Corrections

SSN (Social Security Number)
The nine-digit Social Security number is divided into three parts:
- The first three digits are the area number. If your Social Security number was assigned before 1972 when Social Security cards were issued by local offices, the area number reflects the State where you applied for your number. If your number was assigned in 1972 or later when we began issuing Social Security cards centrally, the area number reflects the State as determined by the ZIP code in the mailing address on your application for the number.
- The middle two digits are the group number. They have no special geographic or data significance but merely serve to break the number into conveniently sized blocks for orderly issuance.
- The last four digits are serial numbers. They represent a straight numerical sequence of digits from 0001-9999 within the group

Spreadsheets
When saving data in Excel, use the 'Save As' method to save your file in .TXT (TAB delimited) format, not .XLS format. Sample import files in this format are included in your 1099 Pro installation and are very helpful. These files may appear out of alignment when viewed from a text editor such as Notepad but maintain formatting of data. To import .TXT (TAB delimited) files select TAB, CR LF and Double Quotes as your delimiters in the Import Wizard.

State ID Number
State ID numbers are assigned by the individual state. For example, in California the Employer Development Department (EDD) assigns a state ID number. Check with your accountant or attorney to determine your company’s state ID number. Many companies do NOT have one.

Transmitter "T" Record
Identifies the Transmitter of Electronic file information contained on Form 4419.
Tag
The act of selecting a Filer, Recipient or State.

TCC - Transmitter Control Code
A Transmitter Control Code number or (TCC) is required when filing electronically. A TCC is composed of five alpha-numeric characters. If filing electronically via the Service Bureau, a TCC is not required and this information need not be completed.

Technical Support
See Technical Support

TIN - Taxpayer Identification Number. **NOTE:** All Forms 1099 must include payee tax identification numbers (TINs). A TIN is a social security number issued by the Social Security Administration, an Employer Identification Number issued by the IRS, or an Individual Tax Identification Number issued by the IRS. Individual Tax Identification Numbers are generally restricted to certain foreign vendors who are not eligible for social security numbers.

TIN Matching
See Bulk TIN Matching

Transmitter Information
The Individual or Organization responsible for filing the tax forms electronically to the IRS. To obtain a TCC, file Form 4419 to request authorization to file forms electronically. Form 4419 must be mailed at least 30 days prior to the filing deadline for the electronic file. Form 4419 may be printed at the Print Blank Forms screen. For more information on TCC's, contact the IRS-MCC at (304) 263-8700.

- U -

Un-Installing
The Select Uninstall Method screen offers two options for removing 1099 Pro from your hard drive:
- "Custom" allows the user to select files individually (recommended).
- "Automatic" initiates a default uninstall routine. This option retains your current data files under the main program directory in the Data folder, any Service Bureau uploads in the Uploads folder, the .INI file in the Admin folder and any miscellaneous .DLL files used by the software.

User(s) / UserID
A user is an individual who has access to the software. Rights and permissions which delegate what this user can and cannot do are assigned to the user and then the user freely uses the software either with or without restrictions.

User Group(s)
User Groups are created by attaching one or more Access Groups and one Activity Group to them. A user's rights are determined based on which User Groups they are a member of:
- Administrator/ALL Rights
- Tax Forms (Edit/Pending)
- Tax Forms (Full Rights)
- Tax Forms (View Only)
- Import Tax Form Data
- Export Tax Form Data
- All Tasks Except Security
- File Tax Forms with IRS
• Service Bureau Upload
• W-9 Tracking

- V -

Virus Checkers
Disable virus checkers (e.g., Norton, McAfee, ViruScan, etc.) PRIOR to installation to avoid potential corruption. Random errors in 1099 Pro are typically due to installation of software while running a virus checker. After a successful installation, re-enable the virus checker.

- W -

W-9
Use Form W-9 Request for Taxpayer Identification Number and Certification to request a recipient's TIN if the recipient is a U.S. person or U.S. resident alien. If the recipient is a foreign person use the appropriate Form W-8. See How to Create a W-9 Request

Warnings
See Errors and Warnings

Web Updates
The Check for Updates feature uses the Internet to check the 1099 Pro, Inc. update servers for a newer version of this program. Instead of running the full Web Update procedure from your Windows Start- >Programs menu, you can now quickly check for updates from within 1099 Pro, or even have the program automatically check for you. If there is a new version, a message will pop up to display the new version and a one line summary of what is included in the update.

32.1 Alignment

Alignment
Alignment adjustments are measured in hundredths of an inch from the default margin. For example, "0.25" would shift the top margin down 1/4-inch and "-0.25" would shift the top margin up 1/4-inch.

32.2 Business Rules

Business Rules
Business Rules are formulated in conjunction with the compliance experts from IRS Compliance to check that data being processed in 1099 Pro's software does not contain common formatting errors, form specific errors, is valid for State and Federal filing, and can be used to separate records with different levels of issues for processing.

32.3 ASCII

ASCII
A simple text file where fields are delimited (or separated) with certain characters such as a tab, space or pipe. 1099 Pro's import capability allows for most any ASCII file. These files can be exported out of most database and spreadsheet applications as an ASCII file, comma separated value (CSV) or tab

**Phone**: (888) PRO-1099, Select Option 2

**Email**: Click [here](#) to E-Mail Support

**Technical support is available**: Monday thru Friday from 7am to 5pm (PST), Excluding Holidays

### 32.4 Cascading updates

Cascading updates

Cascading updates are changes made to a recipient's name or address at the Browse Recipients screen.

### 32.5 Corrected options

Corrected Options

The Corrected Options screen is accessed whenever a corrected form (or original form associated with a correction) is selected at the "Work with My Tax Forms" screen.

### 32.6 End of Payer "C" Record

End of Payer "C" Record

End of Payer "C" Record - Contains the total number of payees and the totals of the payment amount fields filed for each payer and/or particular type of return.

### 32.7 End of Transmission "F" Record

End of Transmission "F" Record

End of Transmission "F" Record - Contains a summary of the number of payers in the entire file.

### 32.8 Filer

Filer

The term Filer is used by the IRS for the person or organization filing the 1096 transmittal. The terms filer, employer and payer are sometimes used interchangeably.

### 32.9 Hotspot

Hotspot

Hotspot (or popup) items are indicated by a dotted line underneath a word or phrase. Click the hot spot to view a popup information box.

Jump items are indicated by a solid line underneath a word or phrase. Click the jump to link to a related help topic.
32.10 Import Map

Import Map

Import Maps describe the format and contents of external data files so that the information they contain can be imported into the program.

32.11 Location code

Location Code

Use to set up multiple filers with the same TIN; allows different return addresses for different forms.

32.12 Payee "B" Record

Payee "B" Record

Payee "B" Record - Contains the payment information from the information returns

32.13 Payer "A" Record

Payer "A" Record

Payer "A" Record - Identifies the person making payments

32.14 Pending Status

Pending Status

All records are assigned a print status that determines their position in the filing cycle.

Select this option to continue printing copies of these records. These records maintain their Pending print status and are available for edits and/or further printing. The terms "pending" and "not printed" are sometimes used interchangeably.

See Print Status Overview

32.15 Recipient Employee

Recipient Employee

A recipient is an individual or business that receives a 1099 or a 1042-S. An employee receives a W-2. The terms recipient and employee are sometimes used interchangeably.

32.16 Roll Forward Utility

Roll Forward

1099 Pro software allows users to roll forward 2016 Filer and/or Recipient information (including name,
TIN and address) and optionally Transmitter and Security settings and customized Import Maps. Rolled 
forward Recipient data is available at the Recipient Master List screen for viewing or changes; Filer data 
is likewise available at the Filer Master List screen.

How to Select Filers/Recipients AFTER Roll Forward
- **Select Filers:** Use the "Select Another Filer" button, located at the top of the task panel, to switch 
between Filers.
- **Select Recipients:** At any tax form data entry screen, users can place their cursor in the Recipient 
TIN field and right-click their mouse or use the <F2> key to select a Recipient and auto-populate the 
tax form with the Recipient's name, TIN and address.

**IMPORTANT:** To roll forward data does NOT mean to copy 2016 tax form specific information such as 
dollar amounts into the new 2017 installation. For example, a 2016 Form 1099-MISC is only available in 1099 Pro 2016. The exception is Corporate Suite — a multi-year software product.

How To Roll Forward Data
Users can roll forward their prior year data during the Installation Wizard (Image 1) or from the Windows 
Start Menu > 1099 Pro > Roll 2016 Data to 2017 Software. The roll forward utility is unavailable if any 
Filer and/or Recipient data has been added into the 2017 software; perform the roll forward PRIOR to 
entering or importing any data into the software. To perform a roll forward AFTER adding data, users 
must uninstall the 2017 software and then perform a fresh installation.

*(Image 1 - Roll Forward data option available through initial Installation Wizard.)*

- See File Not Found: Information Request Error
32.17 Rule-of-250

Rule-of-250

The Rule-of-250 states that any filer submitting 250 or more forms of any one type must submit those forms electronically. Failure to do so may result in fines of up to $100 per form. If you are not signed up for the IRS FIRE system or do not wish to do so our SSAE 16 SOC I TYPE II Service Bureau offers electronic filing services. Please call us at (866) 444-3559 to schedule an appointment and obtain pricing.

Rule-of-250 Overview

32.18 SSAE 16 SOC I Type II

SSAE 16 SOC I TYPE II

Definitions

- SSAE 16 - Statement on Standards for Attestation Engagements No. 16.
- SOC I - Service Organization Control Report No. 1
- Type I - Audit of a system on a specified date
- Type II - Audit of a system throughout a specified time period

Overview

The SSAE 16 is an attestation standard put forth by the Auditing Standards Board (ASB) of the American Institute of Certified Public Accountants (AICPA).

SSAE 16 SOC I Type II is a high-level security certification requiring a stringent audit process. 1099 Pro's hosting and data facilities have passed this difficult audit without exception, ensuring that your data is secure when using any of our software or services. The SSAE 16 effectively replaces the SAS 70 for reporting periods ending on or after June 15, 2011.

This standard applies to engagements undertaken by a Service Auditor for reporting on controls at organizations like 1099 Pro which provide services to their customers. The controls in place at service organizations are likely to be relevant to a customer's internal control over financial reporting (ICFR).

Details

The SSAE 16 requires certain enhancements from the SAS 70 report - such as the service organization provide a description of its system. The description should include the services provided, control objectives, supporting processes, policies, procedures, personnel and operational activities that constitute the organization's core activities relevant to its customers.

Additionally, the SSAE 16 requires a Written Assertion by management be provided to the Service Auditor. In this document, management must assert that the system description and control objectives included therein are a fair presentation for the time period specified in the SOC 1 report.

SOC 1 reports are performed and issued under the Statement on Standards for Attestation Engagements No. 16 (SSAE 16) as explained above. The controls addressed in a SOC 1 report are those that a service organization like 1099 Pro implements to prevent, detect and correct errors or omissions in the information it provides to customers.

Type II indicates that the service organization's system was suitably designed to achieve stated control objectives and to operate effectively throughout a specified time period. Type I refers to a system designed for implementation on a specific date, rather than throughout a specified time period.
For further information, or report details, please contact the 1099 Pro Service Bureau.

The Service Bureau
Phone: 866-444-3559
Email: sb@1099pro.com

32.19 SSN

Social Security Numbers

Social security numbers (SSNs) should be formatted as ###-##-####. Dashes are required to differentiate EINs from SSNs. There are approximately 100,000 numbers that are identical except for the placement of the dash!

32.20 State Totals "K" Records

State Totals "K" Records

State Totals "K" Records - Contains the summary for a given payer and a given state in the Combined Federal/State Filing Program, used only when state-reporting approval has been granted.

32.21 Tag

Tag

Individually tag (select) a record, print session or filer. A tagged item is marked by a red checkmark.

32.22 Task Panel

Task Panel

The task panel is the blue bar on the left side of the 1099 Pro screen and provides quick access to common tasks. Click on the links for details on the options contained within each task panel area.

Select Filer
Preparing My Forms
Printing & Mailing
Filing My Forms
Help & Extras

32.23 TCC

TCC

TCC for IRS FIRE System
Transmitter Control Code. Assigned to a filer when they have filled out Form 4419 at least 30 days prior to the filing deadline for the electronic file. Print Form 4419 via the Help & Extras task panel > IRS Pubs & Links.

**TCC for AIR (ACA)**
The TCC for AIR is unique to filing ACA returns. The TCC issued for filing 1099 Informational Returns is suitable for the IRS FIRE System, not the AIR Site. See TCC for AIR for important information on registering to use IRS e-Services, applying for a Transmitter Control Code (TCC) and submitting Test Files.

### 32.24 TIN

**TIN**

Taxpayer identification number. An SSN (Social Security Number) has 9 digits divided by 2 hyphens, i.e. 333-22-4444. An EIN (Employer Identification Number) has 9 digits divided by 1 hyphen, i.e. 22-7777777. The placement of the dash is critical!

### 32.25 TIN (SSN) Masking

**TIN Masking**

**What Is TIN Masking?**
Internal Revenue Bulletin 2014-31 allows for the truncation of recipient identification numbers on statements. The goal of these regulations is to reduce the risk of identity theft that may arise from placing a taxpayer’s entire identifying number on a recipient statement. The regulations allow for the replacement of the first five digits of the nine digit number with Xs.

**1099 Pro TIN Masking**
As allowed, all 1099 Pro software products provide optional TIN Masking. Use of this option allows you to print recipient copies of forms with the TIN masked, for example "444-12-1234" prints as "XXX-XX-1234", for added security when mailing to the recipient. By default, all Filers have TIN Masking enabled. To disable TIN masking see Changing a Filer. TIN masking may also be temporarily set "On/Off" at the Advanced Print Options screen.

**IRS Rules and Restrictions for use of TIN Masking***:
- A masked TIN has an 'X' for the first 5 digits. Example: XXX-XX-1234 or XX-XXX1234.
- Masking is only available for Recipient copies. **If masking is enabled, all recipient copies will have the TIN masked.** For example, if the recipient receives both a recipient and a state copy the TIN will be masked on both.
- Masking is allowed on Forms 1098 series (except 1098-C), 1099 series, 5498 series and 1095-C as per IRS Bulletin 2014-31. **Masking is not allowed on Form W-2.** Masking is available for Calendar years 2009 onwards.
- Masking is NOT allowed on IRS Copy A.
- Filers may not mask their own TIN.

*This software automatically applies these rules as needed when TIN masking is selected.
32.26 Transmitter "T" Record

Transmitter "T" Record

Transmitter "T" Record - Identifies the Transmitter of Electronic file information contained on 4419.
# Index

## - . -

.INI File Edits 192

## - 1 -

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 Day Window</td>
<td>173</td>
</tr>
<tr>
<td>1042-S Alternate Combined Layout</td>
<td>258</td>
</tr>
<tr>
<td>1042-S Pressure Seal</td>
<td>270</td>
</tr>
<tr>
<td>1095-B</td>
<td>175</td>
</tr>
<tr>
<td>1095-B Queries</td>
<td>130</td>
</tr>
<tr>
<td>1095-C</td>
<td>175</td>
</tr>
<tr>
<td>1095-C Queries</td>
<td>130</td>
</tr>
<tr>
<td>1096 Not Filed</td>
<td>59</td>
</tr>
<tr>
<td>1096 Overview</td>
<td>57</td>
</tr>
<tr>
<td>1096 Print Wizard</td>
<td>58</td>
</tr>
<tr>
<td>1096 Session Report</td>
<td>68</td>
</tr>
<tr>
<td>1096 Transmittal</td>
<td>69</td>
</tr>
<tr>
<td>1097-B</td>
<td>16</td>
</tr>
<tr>
<td>1099 Aggregation Feature (CS Version only)</td>
<td>136</td>
</tr>
<tr>
<td>1099 Compliance Seminars</td>
<td>52</td>
</tr>
<tr>
<td>1099 Module Preferences</td>
<td>92</td>
</tr>
<tr>
<td>1099 Pro Central</td>
<td>25</td>
</tr>
<tr>
<td>1099 Seminars</td>
<td>52</td>
</tr>
<tr>
<td>1099-MISC Box 7 Filing Deadline</td>
<td>23</td>
</tr>
<tr>
<td>1099-MISC IRS Deadline</td>
<td>23</td>
</tr>
<tr>
<td>1099-MISC Optional Fields (CS)</td>
<td>121</td>
</tr>
<tr>
<td>1220</td>
<td>173, 193, 203</td>
</tr>
</tbody>
</table>

## - 2 -

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>250 Forms - Rule of 250</td>
<td>196</td>
</tr>
</tbody>
</table>

## - 4 -

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4419</td>
<td>328</td>
</tr>
<tr>
<td>480.6B PR</td>
<td>272</td>
</tr>
<tr>
<td>480.7</td>
<td>272</td>
</tr>
<tr>
<td>480.7c</td>
<td>272</td>
</tr>
</tbody>
</table>

## - 5 -

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5113 Pressure Seal</td>
<td>272</td>
</tr>
<tr>
<td>592 CA Quarterly eFile Wizard</td>
<td>176, 286</td>
</tr>
<tr>
<td>592 CA Resident and Nonresident Withholding</td>
<td>369</td>
</tr>
</tbody>
</table>

## - 8 -

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.5 X 14 Paper</td>
<td>327</td>
</tr>
<tr>
<td>8966 IDES Reporting</td>
<td>143</td>
</tr>
</tbody>
</table>

## - 9 -

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>945 Federal and State Balancing Report - CS</td>
<td>288</td>
</tr>
<tr>
<td>96 DPI Setting</td>
<td>67</td>
</tr>
<tr>
<td>972CG Penalty Notice (CS)</td>
<td>341</td>
</tr>
<tr>
<td>9872CG</td>
<td>339</td>
</tr>
</tbody>
</table>

## - A -

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Record</td>
<td>203</td>
</tr>
<tr>
<td>Abandon Import Session</td>
<td>228, 244</td>
</tr>
<tr>
<td>About 1099 Pro, Inc.</td>
<td>16</td>
</tr>
<tr>
<td>About Corrections</td>
<td>70</td>
</tr>
<tr>
<td>ACA Compliance</td>
<td>16</td>
</tr>
<tr>
<td>ACA Filing</td>
<td>175</td>
</tr>
<tr>
<td>Access Denied</td>
<td>349</td>
</tr>
<tr>
<td>access group</td>
<td>85, 360</td>
</tr>
<tr>
<td>account</td>
<td>356</td>
</tr>
<tr>
<td>Account Generation Wizard</td>
<td>80</td>
</tr>
<tr>
<td>Account Number Generation</td>
<td>81</td>
</tr>
<tr>
<td>ACL</td>
<td>117</td>
</tr>
<tr>
<td>ACL Print</td>
<td>258</td>
</tr>
<tr>
<td>Acrobat</td>
<td>51</td>
</tr>
<tr>
<td>Activation</td>
<td>20</td>
</tr>
<tr>
<td>Activation Code</td>
<td>20</td>
</tr>
<tr>
<td>Activity Report</td>
<td>126</td>
</tr>
<tr>
<td>Add a Filer</td>
<td>36</td>
</tr>
<tr>
<td>Add a Record</td>
<td>140</td>
</tr>
<tr>
<td>Add a Transmitter</td>
<td>329</td>
</tr>
<tr>
<td>Add a User</td>
<td>87</td>
</tr>
<tr>
<td>Add or Create Records</td>
<td>130</td>
</tr>
<tr>
<td>Add Recipients</td>
<td>47</td>
</tr>
<tr>
<td>Adding a Filer</td>
<td>36</td>
</tr>
<tr>
<td>Additional Services</td>
<td>118, 313</td>
</tr>
<tr>
<td>Additional Transactions</td>
<td>136, 137</td>
</tr>
<tr>
<td>Index</td>
<td>389</td>
</tr>
<tr>
<td>-------</td>
<td>-----</td>
</tr>
<tr>
<td>BWH Filter</td>
<td>334</td>
</tr>
</tbody>
</table>

### - C -

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>C Record</td>
<td>203</td>
</tr>
<tr>
<td>CA Surname</td>
<td>181</td>
</tr>
<tr>
<td>CA-592 Overview</td>
<td>369</td>
</tr>
<tr>
<td>CA-592 Quarterly Electronic Filing Wizard</td>
<td>176, 286</td>
</tr>
<tr>
<td>Canada</td>
<td>51</td>
</tr>
<tr>
<td>Canadian postal code rules</td>
<td>51</td>
</tr>
<tr>
<td>Capitalization</td>
<td>145</td>
</tr>
<tr>
<td>Carve-Out</td>
<td>343</td>
</tr>
<tr>
<td>Cascading Changes</td>
<td>145</td>
</tr>
<tr>
<td>Category</td>
<td>264</td>
</tr>
<tr>
<td>Certify Data</td>
<td>319, 323</td>
</tr>
<tr>
<td>CFS Exception Rules</td>
<td>115</td>
</tr>
<tr>
<td>CFS Exceptions</td>
<td>115</td>
</tr>
<tr>
<td>CFS Filing Thresholds (CS)</td>
<td>112</td>
</tr>
<tr>
<td>CFS Threshold Rules</td>
<td>115</td>
</tr>
<tr>
<td>CFS vs Std</td>
<td>171</td>
</tr>
<tr>
<td>CFSF</td>
<td>193</td>
</tr>
<tr>
<td>Change a Filer</td>
<td>37</td>
</tr>
<tr>
<td>Change a Recipient</td>
<td>49</td>
</tr>
<tr>
<td>Change a Record</td>
<td>130, 146</td>
</tr>
<tr>
<td>Change TIN Type</td>
<td>134</td>
</tr>
<tr>
<td>Changes: Revisions to a Tax Form</td>
<td>278</td>
</tr>
<tr>
<td>Character Spaces</td>
<td>264</td>
</tr>
<tr>
<td>Characters</td>
<td>264</td>
</tr>
<tr>
<td>Checking for Updates</td>
<td>21</td>
</tr>
<tr>
<td>City Names</td>
<td>150</td>
</tr>
<tr>
<td>Clarion File Error</td>
<td>347</td>
</tr>
<tr>
<td>Clarion Trappable Runtime Errors</td>
<td>349</td>
</tr>
<tr>
<td>codes</td>
<td>367</td>
</tr>
<tr>
<td>Codes - Form Status Error Status</td>
<td>53, 209</td>
</tr>
<tr>
<td>Combine</td>
<td>247</td>
</tr>
<tr>
<td>Combined Federal State Filing</td>
<td>179</td>
</tr>
<tr>
<td>Combined Federal/State Filing Program</td>
<td>193</td>
</tr>
<tr>
<td>Combining Tax Forms</td>
<td>136, 137</td>
</tr>
<tr>
<td>Commit Rate</td>
<td>65</td>
</tr>
<tr>
<td>Common Error Messages &amp; Solutions</td>
<td>343</td>
</tr>
<tr>
<td>Comparison chart</td>
<td>98</td>
</tr>
<tr>
<td>Completed Electronic Filing Session List</td>
<td>171</td>
</tr>
<tr>
<td>Compliance</td>
<td>52</td>
</tr>
<tr>
<td>Compliance Seminars</td>
<td>52</td>
</tr>
<tr>
<td>Composition</td>
<td>143</td>
</tr>
<tr>
<td>Contact</td>
<td>59</td>
</tr>
<tr>
<td>Contact Information</td>
<td>37, 38</td>
</tr>
<tr>
<td>Control Numbers - Puerto Rico</td>
<td>152</td>
</tr>
<tr>
<td>Control Totals Report</td>
<td>283</td>
</tr>
<tr>
<td>Corporate Suite Dynamic Query</td>
<td>154</td>
</tr>
<tr>
<td>Corr Status</td>
<td>208</td>
</tr>
<tr>
<td>Correct a correction</td>
<td>71</td>
</tr>
<tr>
<td>Corrected Box - Force an X</td>
<td>251</td>
</tr>
<tr>
<td>Corrected Options</td>
<td>74</td>
</tr>
<tr>
<td>Correction of a Correction</td>
<td>75</td>
</tr>
<tr>
<td>Correction of a Correction (CS Version only)</td>
<td>71</td>
</tr>
<tr>
<td>Correction Types</td>
<td>79</td>
</tr>
<tr>
<td>Corrections</td>
<td>70, 75</td>
</tr>
<tr>
<td>Corrections Box</td>
<td>252</td>
</tr>
<tr>
<td>Corrections Status</td>
<td>208</td>
</tr>
<tr>
<td>Corrections/Late Add Report - CS</td>
<td>290</td>
</tr>
<tr>
<td>Could not load the DLL library</td>
<td>349</td>
</tr>
<tr>
<td>Country</td>
<td>230</td>
</tr>
<tr>
<td>Country Codes Table</td>
<td>229</td>
</tr>
<tr>
<td>CP2100</td>
<td>333, 339</td>
</tr>
<tr>
<td>CP2100/CP2100A Notice (CS)</td>
<td>341</td>
</tr>
<tr>
<td>CP2100A</td>
<td>333, 339</td>
</tr>
<tr>
<td>CPE Units</td>
<td>52</td>
</tr>
<tr>
<td>Create a Correction</td>
<td>75</td>
</tr>
<tr>
<td>Create Information Request Batch Wizard</td>
<td>342</td>
</tr>
<tr>
<td>CREATE SB UPLOAD FILE</td>
<td>315</td>
</tr>
<tr>
<td>Create Submitter</td>
<td>329</td>
</tr>
<tr>
<td>Create Transmitter</td>
<td>329</td>
</tr>
<tr>
<td>Creates Duplicate Key</td>
<td>349</td>
</tr>
<tr>
<td>Current View</td>
<td>153</td>
</tr>
<tr>
<td>Custom Codes</td>
<td>117</td>
</tr>
<tr>
<td>Custom Column Views</td>
<td>34</td>
</tr>
<tr>
<td>Custom Dynamic Query</td>
<td>154</td>
</tr>
<tr>
<td>Custom Messages</td>
<td>102</td>
</tr>
<tr>
<td>Custom Print Message</td>
<td>251</td>
</tr>
<tr>
<td>Custom Queries (CS)</td>
<td>32</td>
</tr>
<tr>
<td>Custom Query</td>
<td>130, 280</td>
</tr>
<tr>
<td>Custom Query Values</td>
<td>53, 209</td>
</tr>
<tr>
<td>Custom Query Wizard</td>
<td>282</td>
</tr>
<tr>
<td>Custom Rules</td>
<td>115</td>
</tr>
<tr>
<td>Custom Sort Order</td>
<td>154</td>
</tr>
<tr>
<td>Custom Tax Form Validation Rules</td>
<td>110</td>
</tr>
<tr>
<td>Custom Threshold Rules</td>
<td>115</td>
</tr>
<tr>
<td>Custom View</td>
<td>153</td>
</tr>
<tr>
<td>Customize a Fixed Field</td>
<td>213</td>
</tr>
<tr>
<td>Customize Fixed Filler</td>
<td>215</td>
</tr>
</tbody>
</table>

### - D -

Daily | 291
Daily totals | 291
Data 110
Data Aggregation 136, 137
Data Backup 91
Data Entry 147
Data Files 64
Data Restore 92
Data Security 383
Dates 23
De Minimis Corrections 2016 75
DEADLINES 23
dead master file 354, 358
Dedicated Servers 118
Define View 154
Delete a Filer 38
Delete a Record 130, 146
Delete audit trails 127
Delete Corrected Forms 76
Delete Corrections 76
Delete Recipients 49
Deleted Record Detail 127
Deleting software 124
Delimited 159
Delimited Import Map Wizard 215, 241
Delimited Import Mapping 215, 241
Delimiters 243
Demo 20
DENIED PERSONS LIST (DPL) 354
Department 147
Department Indicator 147
Different User 120
Disclaimer 16
Display 68
Display DELETED Records 108
Display issues 67
Distribution Codes 151
DMF 358
Donnelley, RR Donnelley 162
Duplex Printing 28, 255
eFile Log Summary Report 206
efile reset 195
eFile Retrieve 56
E-File Sort Order 192
Efile States Subset File Wizard 181
eFile Viewer Viewing Options 202
eFile Wizard 173
eFileViewer - Export Files 204
eFileViewer Overview 197
EFiling 170, 173
electronic 192, 315
Electronic Filing 170, 173, 181
Electronic Filing Deadline 23
Electronic Filing Deadlines 23
Electronic Filing Module 178
Electronic Filing Session Reset/Void 195
Electronic Filing Session Window 171
Email 38
Email Forms 259
Email Server Settings - CS 293
E-Mail tax Forms 259
Email Templates - CS 296
Emails, Automated - CS 295
Employee Listing Report 50
Encrypted PDF Option 254
Encrypted PDF Tax Forms 259
Entry Forms 134
Entry Not Found 349
Envelope / Address Print Offsets 251
Envelopes 326
Error & Validation Checking 156
Error Messages 343
Error Status Values 53, 209
Error Type 1 79
Error Type 2 79
Error: Invalid Record Declaration (47) 344
Errors 349
Errors - Import Checking 156
Errors and Warnings by Recipient 283
Excel Spreadsheet Files 240
EXCLUDED PARTIES LIST (EPLS) VALIDATION 354
Exclusive Access Required 349
Expanding or Contracting Views 202
Expiration and Reuse Options 84
Export ASCII Files 159
Export Database 159
Export Import Maps 160
Export Job 300
Export Wizard 159
Expression Builder Queries 281

- F -

F Record 203
False Print 208
FAQs 59
Fax 38
Federal and State Balancing Report - CS 288
Federal Income Tax Withholding Report - CS 288
Federal Thresholds 194
FFI 143
Field Sizes 264
file 315
File Access Error. 344
File Already Open 349
File Driver Error 349
File Format 203
File Is Already Locked 349
File Must Be Shared 349
File Not Found 343, 349
File Not Found Information Request 348
File Not Open 349
Filed 1096 Status 208
Filed Mag Status 208
Filer 36
Filer Master List Screen 35
Filer Name / Name Line 2 38
Filer Notes 141
Filer Record Details 38
Filer Reports 40
Filers List Report 40
Files already in use 354
Filing 1096 57
Filing Addresses 23
Filing CA-592 369
Filing Deadlines 23
Filing Forms Task Panel 27
Filing Forms Toolbar 30
Filing My Forms 27
Filing Problems 158
Filing via MagMedia 170
Filing with the IRS 315
filter 42
FIN Number 8966 328
FIN Numbers - 8966 329
Finding & Fixing Problem Records 156
FIRE System 187
FIRE upload process 188
First B Notice 339
Fixed Field Customizing 213
Fixed Length 159
Fixed Length Import Map Wizard 218
Fixed Length Mapping 218
Flat File 159
Force “X” 251
Forcing an X in the Corrected Box 252
Foreign Address - Filer 38
Form Control Totals Report 283
Form Counts by Filer Report 289
Form Counts Report 289
Form Limits 253
Form Status 206
Form Status Values 53, 209
Forms 326
Forms & Printing Task Panel (CS) 30
Forms Issued By Filer Report 290
Forms Issued for Recipients 49
Forms Issued Report 49
Franchise Tax Board 176, 286
Frequently Asked Questions 59
FWT 94

- G -

Gas & Oil Fields 121
General Options Toolbar 28, 29
Generating Account Numbers 80, 81
Getting Started 15
GIIN 142
GIIN Composition 143
Global Administrative Options 81
Global Intermediary Identification Number 143
Global Notes 141
Glossary 370
Group 85
Group - Deleting Pending Tax Forms 50
Group - Printing Pending Tax Forms 50
Group - Reprinting Printed or Filed Tax Forms 50
Group - Reset Printed Tax Forms to Pending 50
Group - Un-voiding Tax Forms 50
Group - Voiding Printed Tax Forms 50
Group Actions 50, 130

Copyright 1099 Pro® 2017
- H -

Hacienda Control Numbers 152
Halt 343
header records 237
Help & Extras 28
Help File 68
history 127, 359
Hosted Solutions 118
Hours 59

- I -

IBN 117
IBN Print codes 117
Idaho State Filing Requirement 184
Illegal Expression 349
IMB Tracing 312
Implied Decimal Formatting 215, 241
Import 81, 230, 264, 292
Import - QuickBooks 245
Import Data 211, 223
Import Errors 156
Import File Conventions 237
Import Filers 223
Import Files - Sample Files 237
Import Information Request Batch Wizard 342
Import Map Reports 290
Import Overview 210
Import Recipients 223
Import Session Status 226
Import Session Summary Report 243
Import SQL 223
Import Status Options 225
Import Wizard - Export Map 160
IMPORT WIZARD - Step 1: Importing Data 223
IMPORT WIZARD - Step 2: Validate Data 227
IMPORT WIZARD - Step 3: Post Results 227
IMPORT WIZARD Overview 211
Import Zero Drops - CS 331
Important Dates 23
Incremental Index 149
independent contractor 369
Indiana State Filing Requirements 184
Information Request Batch Report 337
Information Request Overview 333
Information Request Summary Report 336
Information Request Wizard 338
Information Requests Screen 334
INI File Edits 192
INI Files 64
INI Files - Magnetic Media, Electronic Filing 192
Initial PDF Options Window 254
Inserting a Custom Print Message 251
Install 119
Install Multi-User Software 62
Install Single-User Software 61
Insufficient Memory 349
Intelligent Mail Barcode Tracing 312
Intermediary / Sponsored Entity 37
Invalid Clarion File 343
Invalid Data File 349
Invalid Drive 349
Invalid Field Type Descriptor 349
Invalid Filename 349
Invalid Index String 349
Invalid Key File 349
Invalid Key Length 349
Invalid Memo File 349
Invalid Number Of Parameters 349
Invalid Record Declaration 349
Invalid Table Declaration 349
Invalid Tax Country 230
Iowa State Filing Requirements 184
IRS Assistance 59
IRS Bulk TIN Matching Program 164
IRS Code 151
IRS codes 142
IRS Filing upload 188
IRS FIRE Site 188
IRS FIRE System 187
IRS format 173
IRS Forms 132
IRS Help 59
IRS Incorrect TIN Flowchart 166
IRS Instructions 132
IRS Missing TIN Flowchart 167
IRS Name Control 194
IRS Telephone Numbers 132
IRS/MCC 23

- J -

Job Frequency Detail - CS 310
- K -
K Record 203
Kansas State Filing Requirements 184
Kaspersky 343
Keep Pending Status 381
Key File Must Be Rebuilt 349
Keyboard Shortcuts 25

- L -
Late Add/Corrections Report - CS 290
layout 51
Letter Display Issues 67
License Agreement 198
Limitations of Export - eFileViewer 204
Limits 94
Loading a New File 204
Local 93
Location Code 38
Login as Different User 120
Logon as Different User 120
LOGOUT Already Active 349
Look up City 150
Look up City Name 150
Look up Zip Code 150
Lookup 45
Louisiana State Filing Requirement 184

- M -
MA 1099-INT 179
Magmedia 192
Magmedia File Viewer Main Screen 201
Magmedia File Viewer Overview 197
Magmedia File Wizard 173
Magmedia States Subset File Wizard 181
Magnetic Media 173
Maine Quarterly Filing 284
Maine State Filing Requirement 184
Maintain Pending Status 381
Making a Revision 278
managing 356, 358, 369
Manage Automated Email Messages - CS 295
Manage Custom Codes and Text 81
Manage Email Recipients - CS 294
Manage File Import Maps 212
Manage Profiles 86
Manage PS/ACL Access Control (CS version only) 112
Managed Services 369
Manual Override 281
Manual Transfer Options 319, 323
Manual Update 21
Map by Name Import 54
Margin Alignments 266
Maryland State Filing Requirement 184
masking 385
Massachusetts State Filing Requirement 184
Master Audit Trail Browser 54, 127
Master Recipient Record 51
Master Tax Form 55, 136, 137
Maximum Field 264
Maximum Printed 264
Maximum Size 264
McAfee 343
Memo File Missing 349
Memory Corrupted 349
Menu bar 55
Microsoft Access 247
Minimum Password Length 84
Modify Access Rights 85
Module Preferences - Corporate Suite 92
Moore Wallace 162
Multiple Recipients - One TIN 51
Multiple Transactions 136, 137
Multi-User Considerations 63
Multi-User Installations 62

- N -
Name Control 194
Navigation 26
Networks 62
New Jersey State Filing Requirement 184
NIL Reporting 38
No Create Attribute 349
No Email Client 260
No Logout Active 349
Non-Employee Compensation Box 7 23
Norton 343
Notes 141
- O -
OFAC 358
office of foreign assets control 358
Ohio State Filing Requirement 184
Oil & Gas Fields 121
One to Many Corrections 73
Online Help 64
Online Help Tutorials 55
Online Knowledge Base 55
Open Window Cutoff 94
Optimize Posting 65
Optional Fields - 1099-MISC Specific 121
Options for Tax Form Data Entry 147
Order 173, 192
Overnight 292
Overview 18

- P -
Participating States 193
Password - Individual Tax Forms 259
Password Expiration Options 84
Password Format Options 84
Password Lockout Reset 84
Password Options 84
Password Protected PDF Documents 254
Password Requirements 84
Passwords 89
Patches 21
Path Not Found 343, 349
Payer Code 38
PCL Printing 267
pcode 38, 42
PDF File Generation Overview 253
PDF Print Options 254
PDF Recipient Forms 259
Penalties 18, 158
Pending Status 208
PFFI 143
Phone number 59
Post Commit Rate 65
Post Results 227
Preferences 108
Preferences - Corporate Suite 92
Preparing My Forms Task Panel 26
Preprinted Forms Alignment 270
Preprinted Paper 327
Pressure Seal Forms 327
Pressure Seal Printing 258
Pressure Seal Stock 255
Pressure Seal/Alternate Combined Layout 270
Previously Imported/Created Batches (CS) 341
Pricing - Service Bureau 313
Print 276
Print an Import Map Report 290
Print Code 117
Print Codes 102, 117
Print Corrections Myself 270
Print Forms Myself 270
Print IRS Form & Instructions 255
Print Options 251
Print Preview Toolbar 28
Print Session Report 269
Print Status 208
Print Tax Forms 270
Print Users By Name Report 90
Print Wizard 270
Print Zeros Instead of Blanks 251
Print/View Record Reports 148
Printed Status 208
Printed Status - Shortcut 207
Printing 249, 261, 306
Printing - Pressure Seal/AP Formats 255
Printing & Mailing Task Panel 27
Printing Blank Forms 254
Printing Tax Forms Wizard 270
Prior Year Corrections 75
Pro Tips 343
Profiles 86
Program already in use 354
Program Areas/Functions Report 90
Protected Forms 52, 77
ProTips 343
Puerto Rico Control Numbers (CS) 152
Puerto Rico Printing 272
Puerto Rico subset files 181
Puerto Rico Tax Forms 16
Purge 127
Purge Audit Trail 127
Purge Audit Trail Log Records 127

Copyright 1099 Pro® 2017
- Q -
Quarterly Electronic Filing 284
Queries Dynamic 154
Query - Manual Override 281
Query Wizard 280
Quick 276
Quick Print 276
Quick Tour 18
QuickBooks Import Wizard 245
QuickBooks Troubleshooting 245
- R -
Recipient Listing Report 50
Recipient Lookup Account Selection 46
Recipient Lookup Screen 45
Recipient Notes 141
Recipient options 95
Recipient Record Details 44
Recipient Search 45, 46
Recipient TIN Code - 1042-S 237
Recipient TIN Unknown 44
Record Changed By Another Station 349
Record History 127
Record Is Already Held 349
Record Limit 20
Record Limit Exceeded 349
Record Locking 63
Record Not Available 349
Record Not Found 349
Referential Integrity Delete Error 66
Region Code Update - CS 117
Region Code W-2 - CS 117
Region Codes Form W-2 (CS) 116
Registration & Upgrades 20
Registration code 55
Reject Errors 156
Reject Imports 244
Remove audit trails 127
Removing software 124
Repair Files 66
Report: Electronic File Log Summary 206
Reporting Thresholds 112
Reports 50
Reports Overview 282
Reprint 1096 Form 69
Reprint Corrections 78
Reprint Originals 79
Reprint Print Sessions 277
Reprints 261, 306
requests 359
Reset (Void) Import Session 228, 244
Reset (Void) Upload 320
Reset 1096 Session 69
Reset E-File Session 195
Reset Import Session 243
Reset Magmedia Session 195
Reset Print Session 278
Reset to Pending 208, 278
Residence State 147
Restore Archived Data - CS Only 56
Restore Data 92
results 358, 359
Review Import Data 227
Revising a Tax Form 278
Revisions 208, 278
RFID 75
Rights Summary Report 90
Roll Forward Error 348
Roll Forward Utility 381
Roll Over 381
Rollup 136, 137, 247
Rollup Option 123
RTN 38
Rules 110
Rules for Aggregation 123
Runtime Errors 349
- S -
Safeguard TIN 66
sample import files 237
SB Filed Status 208
SB Print+Mail Status 208
SB Step 1 - Create an Upload File 315
SB Step 2 - Submit Service Bureau Upload 319, 323
Scheduled 81
scheduler 81, 292, 294, 300, 310
Scheduler Archive - CS 310
Scheduling Jobs - CS 296
Screen 68

Copyright 1099 Pro® 2017
Screen Resolution 68
Script Custom 223
SDN 358
Seal - Paper Stock 255
Search 149
Search By Account Number 45
Search by Name 45
Search by TIN 45
Second B Notice 339
Section 6721 158
security 81, 360
Security - Access Group: Step 2 85
Security - Add Users to a Profile: Step 5 88
Security - Add/Update Individual Users: Step 4 87
Security - Manage Profiles: Step 3 86
Security Access Log 90
Security Audit 383
Security Password Options 84
Security Reports 90
Security Settings 84
Select a City/Zip/State 150
Select a Form 149
Select a Recipient 48
Select a User 282
Select Country 229
Select Department 147
Select Fields for Aggregation 123
Select Filer 41
Select Form Type 150
Select IRS Code 151
Select States 236
Seminars 52
Server Hosting 118
Service Bureau Overview 312
Service Bureau Packages 313
Service Bureau Toolbar 27, 30
Service Bureau Upload Reports 314
Service Bureau Wizard
  Step 1 - Creating an Upload File 315
  Step 2 - Approve Control Totals 315
  Step 3 - File Upload Transfer & Completion 315
services 313, 369
Set Password Requirements 84
Setting Aggregation Rules 123
Setting Rollup Options 123
Sharing Violation 349
Shortcut 208
Shortcut - Pending to Printed Status 207
Single User Version Error 354
sizes 264
Small Fonts 67
Social Security Number 385
social security number masking 385
Software Updates 21
Software version 98
Sophos 343
Sort 192
Sort by TIN Order 192
Spaces 264
Special Cases for State Filing 184
Special Help 67
Special Help Button 68
Special print 117
Specially Designated Nationals 358
Spon ENT Type Codes 37
Sponsored Entity Import 37
Spreadsheets 240
SQL Script on Import 223
SSAE 16 SOC I Type II 383
SSN 385
SSN Masking 385
SSN Matching 322
Standard (Custom) Rules 115
Standard Rules 115
Standard Threshold Rules 115
State Direct Filing 179, 181, 184
State File Generation Wizard 179, 181, 184
State Filing 179, 184
State Filing Deadlines 23
State Filing Thresholds 115
State Filing Wizard 181
State ID 180
State ID Number 180
State Identification Number 180
State Limits 115
State Quarterly Electronic Filing 284
State Reporting 179, 181, 184
State Reporting - Manage State CFS Limits and
  Settings (Corporate Suite Only) 115
State Reporting Thresholds 115
state status 138
State Status Legend 138
State Subset 138, 179, 181, 184
State Tax Reporting 179, 181, 184
State Threshold Rules 115
State Thresholds 179, 181, 184

Copyright 1099 Pro® 2017
Index 397

States Code Table 236
States Subset File Wizard 181, 184
status 367
status codes 53, 209, 367
Status Overview 52, 77
Step 1 - Create Bulk TIN Upload File 322
Step 2 - Validate your Data 227
Step 3 - Final Import - Post Results 227
stock 255
Stored Procedure 223
Stream Error 349
Submitter Information 328, 329
supersceded 138
SUTA State Table 116
SUTA State Update - CS 117
SWIFT Code H Error 176, 286
SWIFT Filing System 176, 286
Switch user 120
SWT 94
System Requirements 22, 60
System Security Settings/Password Requirements:
Step 1 84
SystemID.TPS Error 346

- T -

T Record 203
Tag Filers 41
Tag Key Shortcuts 41
Tag Recipients 48
Tagging Records 150
Task Panel 26, 27, 28
Task Panel: Corporate Suite 29
Tax Form Notes 141
Tax Identification Number 385
Tax State 147, 179, 181, 184
Tax Supplies 326
TCC for AIR Site 328
TCC for FIRE System 328
Technical Support & Maintenance 59
Test Files 193
Text Alignments 67
the specified module could not be found. 349
Theme "Effects" button 67
Thresholds 112, 194
TIN 359, 367, 385
TIN & Name Matching 354
TIN Management 333
TIN Management (CS) 341
TIN Masking 385
TIN Masking - On/Off 251
TIN Match Results 169, 325
TIN Matching Overview 321
TIN Missing 44
TIN Type - Change SSN to EIN or EIN to SSN 134
TIN Unknown 44
tin validation 367
Tin Validation OFAC DMF SDN SSN EIN 135
tincheck 321, 354, 356, 359, 360, 367
TINcheck Built-in 360
TINCheck Installation 360
TINCheck Integration 360
Too Many Open Files 349
Tool Bar 26
TOP SPEED 343
TOPSPEED 343
Tour 18
Transaction Button 136, 137
Transfer Data 381
Transmittal Wizard 58
Transmittal Wizard 328
Transmitter Information 328, 329
Trappable Runtime Errors 349
TREASURY OFAC/SDN LIST 354
Trigger Error 349
Troubleshoot Import Issues 223
Troubleshoot Printer Issues 278
Troubleshooting Control Totals 284
Troubleshooting Pressure Seal Forms 327
Turn Audit Trails On/Off 128
Turn On/Off Security 88
tutorials 55, 59
Types of Corrections 79

- U -

Unable To Access Index 349
Unable To Log Transaction 349
Unable to Open Required File (ProTips): 2 - File Not Found 345
Unable to Open Required File (ProTips): 3 - Path Not Found 345
Unable to Open SystemID file: 53 - Invalid Clarion File 347
Unable to Open SystemID: 2 - File Not Found 346
Unable to Open SystemID: 3 - Path Not Found 346
Unable to Open SystemID: 5 - Access Denied
Unable To ROLLBACK Transaction
UNC Mapping
Un-Delete a Record
Un-Installing software
Unknown Error Posted
Unsupported Data Type In File
Unsupported File Driver Function
Update Information Requests
Update Options
Update Software
Update Users
Updates
Updating a Form
Updating a Record
Updating Transactions (CS Version only)
Upgrade
Upgrade Single-User/DEMO to Multi-User
Upload Form Summary
Upload Session Summary
Upload to Service Bureau
User Detail Report
User Group Detail Report
USER32.DLL
Using Print Codes (CS version only)
Using Rollup Options

- W -
W-2 Filing Deadline
W-2 Specific Reports - CS Version
W-8 Series
W-9 Main Screen
W-9 Overview
W-9 Report
W-9 Single/Batch Requests
W-9 Wizard
Warnings
What To Expect From the State Subset File Wizard
When To File?
Where To File?
WIKI Download Site
Windows "Effects" button
Windows 10 Small Fonts
Windows Operating Systems
Withholding
Withholding State
Work With My Tax Forms

- X -
X - Correction Box
XLS Data Shells

- Y -
Year-to-Date Imports - CS

- Z -
Zero Drop Import
Zero Drop Overview
Zero Drop Process
Zero Drop Process Date Range
Zero Drop Session - Void
Zeros in Boxes
Zip Code Look up
ZIP Magnetic Media File

Validate your data during import
Validation
Validation Checking
Variable Not Found
Video Display Issues
Video tutorials
Videos
View a Map Report
View Deleted Records
Viewing as Field List
Viewing as Text
Viewing Transactions (CS Version only)
Virtual Mapping
Virus Checkers
Void Batches (CS)
Void Box - Force an X
Void Import Session
Void Records